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IMPORTANT INSTALLATION INSTRUCTIONS

Power, input, and output wiring must be in accordance with Class I, Division 2 wiring methods, Article 501-4 
(b) of the National Electrical Code, NFPA 70 for installation in the U.S., or as specified in Section 18-1J2 of the 
Canadian Electrical Code for installations in Canada, and in accordance with the authority having jurisdiction. 
The following warning must be heeded:

WARNING - EXPLOSION HAZARD - SUBSTITUTION OF COMPONENTS MAY IMPAIR SUITABILITY FOR CLASS 1, 
DIV. 2.

WARNING - EXPLOSION HAZARD - WHEN IN HAZARDOUS LOCATIONS, TURN OFF POWER BEFORE REPLACING 
OR WIRING MODULES.

WARNING - EXPLOSION HAZARD - DO NOT DISCONNECT EQUIPMENT UNLESS POWER HAS BEEN SWITCHED 
OFF OR THE AREA IS KNOWN TO BE NON-HAZARDOUS.

THIS DEVICE SHALL BE POWERED BY CLASS 2 OUTPUTS ONLY.

MVI (Multi Vendor Interface) Modules

WARNING - EXPLOSION HAZARD - DO NOT DISCONNECT EQUIPMENT UNLESS POWER HAS BEEN SWITCHED 
OFF OR THE AREA IS KNOWN TO BE NON-HAZARDOUS.

AVERTISSEMENT - RISQUE D’EXPLOSION - AVANT DE DÉCONNECTER L’ÉQUIPEMENT, COUPER LE COURANT OU 
S’ASSURER QUE L’EMPLACEMENT EST DÉSIGNÉ NON DANGEREUX.

WARNINGS

North America Warnings

Power, input, and output wiring must be in accordance with Class I, Division 2 wiring methods, Article 501-4 
(b) of the National Electrical Code, NFPA 70 for installation in the U.S., or as specified in Section 18-1J2 of the 
Canadian Electrical Code for installation sin Canada, and in accordance with the authority having jurisdiction. 
The following warnings must be heeded:

A Warning - Explosion Hazard - Substitution of components may impair suitability for Class 1, Div. 2.
E Warning - Explosion Hazard - When in hazardous locations, turn off power before replacing or wiring 

modules.
F Warning - Explosion Hazard - Do not disconnect equipment unless power has been switched off or the 

area is known to be non-hazardous.
Avertissement - Risque d’explosion - Avant de déconnecter l’équipment, couper le courant ou s’assurer que 
l’emplacement est désigné non dangereux.

G Suitable for use in Class I, Division 2 Groups A, B, C and D Hazardous Locations or Non-Hazardous Loca-
tions.

ATEX Warnings and Conditions of Safe Usage

Power, input, and output (I/O) wiring must be in accordance with the authority having jurisdiction.

A Warning - Explosion Hazard - When in hazardous locations, turn off power before replacing or wiring 
modules.

E Warning - Explosion Hazard - Do not disconnect equipment unless power has been switched off or the 
area is known to be non-hazardous.

F These products are intended to be mounted in an IP54 enclosure. The devices shall provide external 
means to prevent the rated voltage being exceeded by transient disturbances of more than 40%. This 
device must be used only with ATEX certified backplanes.

G DO NOT OPEN WHEN ENERGIZED.
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MARKINGS

Electrical Ratings

• Power Requirements: 7.1 W typical, 9.1 W max.
• Operating Temperature: -20 °C to +70 °C
• Storage Temperature: -40 °C to +85 °C
• Relative Humidity: 5–95%

For the electrical ratings of power supplies, I/O modules, and chassis, see their respective data sheets.

Label Markings

ATEX

II3 G Ex NA IIC T4 Gc
-20 °C ≤ Ta ≤ 70 °C

cULus

Class 1 Division 2, Groups A, B, C, D
T4
-20 °C ≤ Ta ≤ +70 °C

Agency Approvals and Certifications

Agency Applicable Standard

RoHS

CE EMC-EN61326- 1:2006; EN61000-6- 4:2007

Hazardous Locations
ANSI/I.S.A. 12.12.01-2015, Rev. 2015-11-17; CAN/CSA C22.2 
No. 213-16, 2nd Ed., Issued 2016-05-11

ATEX EN60079-15:2003; EN60079-15:2010

cULus UL61010-1: 2010, 3rd Ed.; UL61010-201, 1st Ed.

DFARS



groov EPIC User’s Guide vv

Table of Contents

Chapter 1: Welcome to groov EPIC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1

System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
About This Guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2

What’s in This Guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3

Chapter 2: Additional Safety and Operating Instructions  . . . . . . . . . . . . . . . . . . . . . . . . . 5

Safety instructions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
Safety instructions for installing groov EPIC as part of machinery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
Explanation of labels or symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Operating controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Service and maintenance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Service (Product Support) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

Chapter 3: Assembling your groov EPIC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Gathering your equipment and information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Familiarizing yourself with the Processor and groov I/O modules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
groov I/O Modules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Verifying serial number on the processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Activating groov EPIC and downloading the license file  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Mounting the Power Supply, Processor, and I/O Modules to the Chassis . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

Mounting the Power Supply  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Mounting the groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Mounting the Modules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Connecting power supply wires and field device wires . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18
Connecting Field Devices to the groov I/O Modules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Connecting Ground  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Connecting Power Supply Wires . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Connecting the Ethernet cable  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21
Turn on unit and continue with initializing the Processor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Chapter 4: Initializing the groov EPIC Processor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Creating the First Administrator Account . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25



groov EPIC User’s Guidevi

Choosing Between Quick Start and Configure Device . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25
Completing the Quick Start. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Chapter 5: Navigating Through the groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . .29

Click or Tap Your Way Around groov Manage. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29
Learning the Screen Navigation Aids. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Navigating Through groov Manage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Navigating Through groov Manage on the groov EPIC Processor Touchscreen  . . . . . . . . . . . . . . . . . . 32
Navigating Through groov Manage on a Computer or Mobile Device . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Finding Information About I/O Modules and Their Channels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34

Chapter 6: Controlling Access to groov EPIC  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37

Part of an Overall Security System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37
Managing User IDs through an LDAP Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

Understanding Permissions and How They Are Assigned  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Collecting Information to Configure Communication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Collecting Information to Authenticate Users  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Configuring groov EPIC for LDAP Authentication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Managing User IDs Locally  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Choosing Access Levels for Users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Creating User IDs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Managing the SSL Security Features of your groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46
Learning How SSL Works on groov EPIC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Why Change the SSL Security Features on Your groov EPIC Processor? . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Creating a Self-Signed Certificate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Switching to a CA-signed Certificate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Configuring SSL Communication from groov EPIC to Another Controller/Processor  . . . . . . . . . . . . . 48
Configuring SSL Communication from groov EPIC to an MQTT Broker . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Configuring the Firewall. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51
Creating a Firewall Rule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Changing a Firewall Rule . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Chapter 7: Connecting groov EPIC to a Network or Multiple Networks  . . . . . . . . . . . . .57

Identifying Your Network Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57
Connecting to a Single, Flat Network  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Connecting to Multiple Networks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Keeping Networks Separate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59
Choosing Between Automatic and Manual Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

Automatic Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Manual Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Understanding Advanced Networking Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60
Collecting Network Configuration Information for OpenVPN Connection . . . . . . . . . . . . . . . . . . . . . . . 62

Configuring the Network Interfaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63
Configuring ETH0 or ETH1  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Configuring WLAN0  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Disabling a Network Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Saving the Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  67
Connecting to a Virtual Private Network (VPN). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  67
Configuring for Port Redirection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69



groov EPIC User’s Guide vii

Adding a Static Route . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70
Testing the Network Connections and Fine-Tuning Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71

Chapter 8: Enabling MQTT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

What is MQTT?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73
Learning How groov EPIC Works with MQTT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73
Configuring and Enabling the groov Manage MQTT Client. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  74

Collecting Information About the MQTT Broker . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Specifying Default Topics or Unique Identifiers for the groov EPIC Processor  . . . . . . . . . . . . . . . . . . . . 74
Assigning a Device ID and Reviewing Performance Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Configuring and Enabling the groov Manage MQTT Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

Chapter 9: Enabling Ignition or Ignition Edge  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

What is Ignition and Ignition Edge? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  79
Enabling and Configuring Ignition/Ignition Edge Checklist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80
Choosing Between Ignition or Ignition Edge. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81
Enabling Ignition or Ignition Edge  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81

Disabling Ignition or Ignition Edge . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
Configuring the Ignition Edge Gateway . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83
Licensing Ignition Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85

Obtaining License Keys  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
Installing (Activating) the Ignition Edge License  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
Deactivating the Ignition Edge license . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Changing the Default Password for Ignition Edge Gateway. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87
Installing the OPC UA groov EPIC and SNAP PAC Driver. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  88
Installing the Ignition Edge MQTT Module. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  88

Chapter 10: Configuring System Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

Switching Between PAC Control Engine and CODESYS Runtime Engine. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89
Setting and Adjusting Date, Time, and Time Zones  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Setting the Date and Time Manually . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Setting the Date, Time, and Time Zone by Synchronizing with Time Servers  . . . . . . . . . . . . . . . . . . . . 90
Setting the Time and Time Zone by Selecting a Location  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Selecting Which App to Load After User Log In . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  91
Configuring the groov EPIC Processor for Shell Access. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  92
Connecting Serial Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  92

Connecting a Serial Device Directly to the groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
Connecting a Serial Device Through a groov Serial Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
Device Name, Port Number, CAN Port Number, and CAN Port Name  . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
Finding Device Names, Port Numbers, CAN Port Names, or CAN Port Numbers  . . . . . . . . . . . . . . . . . 95
Configuring the Communication Ports or Handles to Serial Devices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

Connecting a Mouse and a Keyboard  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97
Connecting an External Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97

Connecting an External Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Disconnecting an External Monitor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Connecting a USB Storage Device. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Disabling Access to USB Storage Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101



groov EPIC User’s Guideviii

Mounting and Unmounting USB Storage Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Copying, Moving, or Downloading a File on a USB Storage Device  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Installing an Approved USB WiFi Adapter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  106
Installing an Approved USB Bluetooth Adapter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  107
Calibrating the Processor’s Touchscreen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110
Uploading Files to the groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110

Chapter 11: Configure CODESYS and groov EPIC for IEC61131-3 . . . . . . . . . . . . . . . . . . 111

Obtaining Your CODESYS Activation Key Certificate and Ticket ID. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  112
Downloading and Installing CODESYS Development System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  112
Adding the Opto 22 Library Package to CODESYS Development System . . . . . . . . . . . . . . . . . . . . . . . . . . . .  112

Updating Opto 22 Device Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
Reviewing Network Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  115
Enable the CODESYS Control Engine on the groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116
Connecting Processor to Gateway and Entering the CODESYS Ticket ID. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116
Managing CODESYS Runtime Engine and CODESYS Applications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117

Enabling the CODESYS Runtime Engine  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Disabling the CODESYS Runtime Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Transferring the CODESYS License to Another groov EPIC Processor  . . . . . . . . . . . . . . . . . . . . . . . . . . . 118

Chapter 12: Working with groov EPIC Devices in CODESYS Projects  . . . . . . . . . . . . . . 119

Adding a groov EPIC Device to a CODESYS Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  120
Creating a New CODESYS Project and Adding a groov EPIC Device  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120
Editing an Existing Project to Add a groov EPIC Device . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Adding an Ethernet Interface to the groov EPIC Device . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Adding a CANbus Interface to the groov EPIC Device. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  124
Plugging in groov I/O Modules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  126

Plugging in I/O modules automatically  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Plugging in I/O modules manually  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Configuring Processor Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  127
Configuring Channel Parameters (Features) on a Module  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  128

Configuring Channel Features and Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
Reading and Clearing Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  134

Reading and Clearing a Latch or State  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
Referencing a Channel on a GRV-CCANI-2 Module. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  140
Creating a Symbol Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  142
Referencing Files Stored in the groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  142
Downloading and Running CODESYS Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  142

Starting or Stopping CODESYS Applications on the groov EPIC Processor  . . . . . . . . . . . . . . . . . . . . . . 143
Monitoring Latches, States, and Counters: CODESYS or groov Manage? . . . . . . . . . . . . . . . . . . . . . . . . 143

Chapter 13: Downloading and Running PAC Control Programs . . . . . . . . . . . . . . . . . . .145

PAC Controller vs codesys controller . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145
Identifying the Strategy that is Running on the groov EPIC Processor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146
Enabling or Disabling Background Downloading . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146
Identifying Serial Devices Accessible to the Control Engine. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  147



groov EPIC User’s Guide ix

Disabling the PAC Control Engine. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Enabling the PAC Control Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

Chapter 14: Downloading and Running Custom Control Programs . . . . . . . . . . . . . . . .151

Verifying SSH Access . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Stopping the SSH Server. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Starting the SSH Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Allowing Browser-Based Applications Access to REST APIs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

Chapter 15: Developing and Deploying Node-RED flows  . . . . . . . . . . . . . . . . . . . . . . . . 155

What is Node-RED and how does it work in groov EPIC? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Node-RED in the groov EPIC processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156

Managing the Node-RED Runtime and Projects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Stopping a Flow by Disabling the Runtime . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Restarting the Runtime  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
Backing up a Node-RED Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158
Restoring a Node-RED Project  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
Troubleshooting Node-RED Runtime  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162

Creating Your First Node-RED Flow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162
Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162
Opening the Node-RED Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162
Creating a flow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Deploying the flow and testing it . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
Adding a Function node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 165
Installing groov View nodes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
Adding an Opto 22 PAC Control node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168

Example: Obtaining Data From a Bluetooth-capable Field Device . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
Open the Node-RED Editor and Add the Generic BLE Package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
Add and Configure a Generic BLE Node . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
Add and Configure a Connect Device Inject Node . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179
Add and Configure a Temperature Reading Node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180
Add and Configure a Read Temperature Inject Node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
Add a Convert to Celsius Function Node . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
Add and Configure a Disconnect Device Inject Node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
Deploy and Test the flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187

Chapter 16: Monitoring and Configuring Modules and Channels  . . . . . . . . . . . . . . . . . 189

Configuring groov I/O Modules and Channels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
Working with the Scratch Pad . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195
Working with GRV-IDCIFQ-12 (Quadrature) Modules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
Adding Termination to a GRV-CCANI-2 Module  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199

Checking the Health (Status) of a Module  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
Checking Module Status Through the Module LED  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
Checking Module Status Through groov Manage on a Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202

Working with Quality Indication  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
What is Quality Indication? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202



groov EPIC User’s Guidex

How groov EPIC Informs You About the Quality of a Signal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
Finding the Channel Reporting a Quality Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204

Chapter 17: Managing PID Loops  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207

Understanding How a PID Works . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  207
PIDs and Control Programs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  207
PID Loops on groov EPIC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  208
Understanding PID Algorithms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  208
Configuring a PID Loop  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  210
Changing a PID Loop  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  215
Disabling a PID Loop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  215
Inspecting a PID  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  215

Changing PID Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
View Specific Values on the Chart  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217
Adjusting the Scale of the Charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217

Chapter 18: Maintaining Your groov EPIC  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .219

Backing up Your groov EPIC Processor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  219
Backing up Your Ignition Edge Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 222

Restoring a Backup or Specific Settings from a Backup File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  222
Restoring your Ignition Edge Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

Updating Firmware on a groov EPIC. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  226
Applying a Firmware Update to the groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
Installing an I/O Module Firmware Update . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230

Replacing the Battery  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  232
How to Reset to Factory Defaults  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  234
Collecting Information for Product Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  234
Conducting an OptoSupport Remote Support Service (RSS) Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  236

Initiating an RSS Session  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
Pausing and Resuming an RSS Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237
Ending the RSS Session  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238

Chapter 19: Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 239

Cannot Connect to the SSH Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  239
One of the Modules is Blinking Red . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
One of the Modules is Blinking Violet  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
SSH Server User ID and Password are Rejected. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
Changes Aren’t Saved or They Suddenly Change . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241
groov EPIC Processor Touchscreen Keeps Jumping to Module Information Page . . . . . . . . . . . . . . . . . . . .  241
Touchscreen Doesn’t Respond Accurately to Finger taps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241
Ethernet Cable is Plugged In, but No IP Address . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241
Web Browser Can’t Connect to Processor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241
The SPEED LED on the Processor Changed Color  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241
Time zone change not shown in Ignition Edge . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  242
CODESYS: Can’t Connect to groov EPIC Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  242
Troubleshooting Network Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  243

Ping  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243
Test TCP Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243



groov EPIC User’s Guide xi

Traceroute  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244
NsLookup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244

Troubleshooting Tool: Viewing and downloading log Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245

 Appendix  A: Processor Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247

GRV-EPIC-PR1, GRV-EPIC-PR2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247

 Appendix  B: Power Supply Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249

GRV-EPIC-PSAC, GRV-EPIC-PSDC, GRV-EPIC-PSPT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249

 Appendix  C: Chassis Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251

GRV-EPIC-CHS0, GRV-EPIC-CHS4, GRV-EPIC-CHS8, GRV-EPIC-CHS16. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251

 Appendix  D: I/O Module Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

GRV-CCANI-2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

GRV-CSERI-4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 254
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 254
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255

GRV-IAC-24, GRV-IACI-12, GRV-IACS-24, GRV-IACIS-12  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 256
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 256
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 257

GRV-IACDCTTL-24, GRV-IACDCTTLS-24 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259

GRV-IACHV-24, GRV-IACIHV-12, GRV-IACHVS-24, GRV-IACIHVS-12 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261

GRV-IDC-24, GRV-IDCI-12, GRV-IDCS-24, GRV-IDCSW-12, GRV-IDCIS-12, GRV-IDCIFQ-12. . . . . . . . . . . . . . 262
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 262
Specifications for GRV-IDC-24, GRV-IDCI-12, GRV-IDCS-24, GRV-IDCIS-12, GRV-IDCIFQ-12 . . . . . . . 263
Specifications for GRV-IDCSW-12  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265

GRV-IICTD-12 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267

GRV-IMA-24, GRV-IMAI-8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 268
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 268
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 269

GRV-IICTD-12 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 271

GRV-ITM-12, GRV-ITMI-8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 272
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 272
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273

GRV-ITR-12, GRV-IRTD-8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275



groov EPIC User’s Guidexii

Specifications for GRV-ITR-12 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276
Specifications for GRV-IRTD-8  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 277

GRV-IV-24, GRV-IVI-12, GRV-IVIRMS-10 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  279
Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280

GRV-IVAPM-3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  282
Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 282
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283

GRV-MM1001-10  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  284
Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 285

GRV-OAC-12, GRV-OACI-12, GRV-OACS-12, GRV-OACIS-12 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  290
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291

GRV-ODCI-12, GRV-ODCIS-12 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  292
Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293

GRV-ODCSRC-24 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  294
GRV-OMRIS-8 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  295
GRV-OVMAILP-8, GRV-OVMALC-8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  296

Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 296
Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 297

 Appendix  E: I/O Module Wiring Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299

GRV-CCANI-2 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  299
GRV-CSERI-4 Pinout and Wiring Diagram. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  300
GRV-IAC-24, GRV-IACS-24 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  301
GRV-IACI-12, GRV-IACIS-12 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  302
GRV-IACDCTTL-24, GRV-IACDCTTLS-24 Pinout and Wiring Diagram. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  303
GRV-IACHV-24, GRV-IACHVS-24 Pinout and Wiring Diagram. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  304
GRV-IACIHV-12, GRV-IACIHVS-12 Pinout and Wiring Diagram  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  305
GRV-IDC-24, GRV-IDCS-24 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  306
GRV-IDCSW-12 Pinout and Wiring Diagram  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  307
GRV-IDCI-12, GRV-IDCIS-12 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  308
GRV-IDCIFQ-12 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  309

Wiring to Quadrature Encoders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 309
Wiring to Typical (Signal) Sources  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310

GRV-IICTD-12 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  311
GRV-IMA-24 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  312
GRV-IMAI-8 Pinout and Wiring Diagram. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  313
GRV-IRTD-8 Pinout and Wiring Diagram. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  314
GRV-ITM-12 Pinout and Wiring Diagram  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  315
GRV-ITMI-8 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  316
GRV-ITR-12 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  317
GRV-IV-24 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  318
GRV-IVAPM-3 Pinout and Wiring Diagram. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  319
GRV-IVI-12 Pinout and Wiring Diagram. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  320
GRV-IVIRMS-10 Pinout and Wiring Diagram  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  321



groov EPIC User’s Guide xiii

GRV-MM1001-10 Pinout and Wiring diagram. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 322
GRV-OAC-12, GRV-OACS-12 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 323
GRV-OACI-12, GRV-OACIS-12 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 324
GRV-ODCI-12, GRV-ODCIS-12 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325
GRV-ODCSRC-24 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326
GRV-OMRIS-8 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327
GRV-OVMAILP-8 Pinout and Wiring Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 328
GRV-OVMALC-8 Pinout and Wiring Diagram. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329

 Appendix  F: Quality Indicator Codes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 331

 Appendix  G: Installing the Correct License  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333

Installing Licenses on Processors with Firmware Earlier Than 1.3.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333
Installing the groov Plus or groov Enterprise License  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333

Adding Ignition Edge or CODESYS when you Upgrade to 1.3.0 or Later . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334

 Appendix  H: Advanced Networking Configurations  . . . . . . . . . . . . . . . . . . . . . . . . . . . 335

Redirecting Traffic Initiated by an Incoming Connection Request . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335
Outbound Traffic Not Initiated by an Incoming Connection Request . . . . . . . . . . . . . . . . . . . . . . . . . . . 336

 Appendix  I: Network Information Tables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337

 Appendix  J: Installing groov EPIC Firmware with Ignition Version 8 . . . . . . . . . . . . . 339



groov EPIC User’s Guidexiv



groov EPIC User’s Guide 11

Appendix A

1: Welcome to groov EPIC

The groov EPIC® system is the next step in the evolution of automation. The system includes:
• An Edge Programmable Industrial Controller with an embedded Linux® operating system and gateway 

functions. We call it the groov EPIC processor because it can do controller functions and so much more:
– Edge–Moving more visualization, control, and data acquisition functions to the place where it all 

happens: at the edge.
– Programmable–Offering more ways to support the creation of control programs that fit your needs: 

flowchart programming through PAC Control, IEC 61131-3 compliant programming through 
CODESYS®, or custom programming in popular programming languages with access to the Linux 
operating system through a secure shell.

– Industrial–Designed to work in a wide range of environments, meeting UL and ATEX requirements 
for hazardous locations.

– Controller®–You can rely on real-time control and I/O from an automation manufacturer with 45+ 
years of experience. Opto 22’s worldwide reputation for quality was built on solid state relays and 
I/O, and all our experience is poured into the design of groov EPIC.

• groov® I/O modules, most guaranteed-for-life and available in discrete, analog, and serial models. All are 
configurable by the groov EPIC processor and have up to 24 channels per module.

• groov EPIC power supplies for AC power, DC conversion, and adapters for pass-through connections from 
a DC power supply you already own.

• groov EPIC chassis that holds the processor, I/O modules, and power supply. Available in 4-, 8-, and 
16-module models.

SYSTEM REQUIREMENTS
• To build PAC Control strategies with the PAC Project Basic Software Suite that comes with groov EPIC, you 

will need:
– A computer with a standard or mainstream processor and (at least) the minimum memory required 

for your version of Microsoft Windows. (Low-end CPUs are not recommended.) Additional memory 
may be required for some configurations.

– One of the following operating systems:
– Microsoft Windows 10 Professional (32-bit or 64-bit)
– Windows 8.1 Professional (32-bit or 64-bit)
– Windows 7 Professional (32-bit or 64-bit)

• To build operator interfaces with groov View, you’ll need:
– Any computer with a web browser (does not have to be a Windows PC)
– One or more of the following:

– A Modbus/TCP device
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– A database, online service, or software program to get data from or put data into a Data Store 
using the groov API

– A groov EPIC processor or SNAP PAC controller (SNAP PAC S-series, R-series, or SoftPAC, with 
firmware R9.2a or newer), running a PAC Control strategy

– An Opto 22 SNAP PAC I/O unit
– A database, cloud application, API, or serial device accessible via a Node-RED node.
– OPC UA-compatible automation system or equipment. Ignition Edge supplies an internal 

server and drivers for groov EPIC. Additional drivers or an external OPC UA server may be 
required for your equipment.

• To build control programs with the CODESYS Development System, you’ll need:
– A computer that meets the minimum requirements established by CODESYS. For more information, 

visit the CODESYS website (www.codesys.com).
– The Opto 22 Library Package, which contains the information that CODESYS Development System 

needs to correctly configure and connect to a groov EPIC processor. For instructions on 
downloading and installing this package, see “Adding the Opto 22 Library Package to CODESYS 
Development System” on page 64.

– CODESYS Development System, V3.5 SP17 Patch 0 or newer (32-bit version). For instructions, see 
“Downloading and Installing CODESYS Development System” on page 64.
If you are using CODESYS PROFINET Controller SL, you will need CODESYS Development System, 
V3.5 SP15 Patch 10 or newer. You also want to make sure the CODESYS PROFINET device is at version 
3.5.15.10 or newer. To check:
1. Click Tools > Device Repository.
2. Expand Fieldbusses > Profinet I/O > Profinet I/O Device.
3. Find CODESYS Profinet Device and check the version.

– A groov EPIC processor (GRV-EPIC-PR1, GRV-EPIC-PR2) with minimum firmware version 3.3.0.

Note: If you are using CODESYS PROFINET Controller SL, you need version 1.5.0 or newer.

ABOUT THIS GUIDE

This user’s guide shows you how to assemble and initialize your groov EPIC, how to configure the software and 
I/O modules, how to configure system settings, and more.

Throughout this guide, you might see two versions of the same page. This is done to show you important 
differences between viewing a page through the groov EPIC processor’s touchscreen and viewing the same 
page through a computer web browser or mobile device.

groov EPIC touchscreen Computer web browser

https://www.google.com/url?q=https://store.codesys.com/engineering/codesys.html%23Systemvoraussetzung&sa=D&ust=1548358892443000&usg=AFQjCNGRd0Vaoa47MgwUqz6uQnS9aaaLfg
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What’s in This Guide

Chapter 1: Welcome to groov EPIC (this chapter) introduces this user’s guide and groov EPIC.

Chapter 2: Additional Safety and Operating Instructions describes important safety and operating 
information.

Chapter 3: Assembling your groov EPIC describes how to assemble the parts of a groov EPIC unit (the 
processor, the power supply, the chassis, and the I/O modules).

Chapter 4: Initializing the groov EPIC Processor describes the configuration steps you might want to do 
first to get your groov EPIC system up and running.

Chapter 5: Navigating Through the groov EPIC Processor describes how to navigate through software 
on the groov EPIC processor touchscreen, some differences between navigating on the touchscreen and 
navigating through a web browser, and introduces you to some of the important features of some of the 
screens, like the Modules page.

Chapter 6: Controlling Access to groov EPIC describes the security features available on the groov EPIC 
processor and how you might want to configure these features to control who has access to your unit.

Chapter 7: Connecting groov EPIC to a Network or Multiple Networks describes the options available to 
connect a groov EPIC processor to more complex networking environments.

Chapter 8: Enabling MQTT describes the options available for publishing automation data in a MQTT 
infrastructure, as well as what to do to set up these options.

Chapter 9: Enabling Ignition or Ignition Edge describes why and how you enable the Ignition or Ignition 
Edge software included with your groov EPIC firmware, as well as how to update your firmware if you plan on 
using version 8 of Ignition software.

Chapter 10: Configuring System Features describes how to modify features (like networking) so they work 
the way you need them to in your application.

Chapter 11: Configure CODESYS and groov EPIC for IEC61131-3 describes how to enable the CODESYS 
Runtime Engine so you can build and download applications developed with the CODESYS Development 
System.

Chapter 12: Working with groov EPIC Devices in CODESYS Projects describes how to add and configure 
a groov EPIC processor to your CODESYS Development System, and how to configure processor parameters 
and channel features so you can begin programming.

Chapter 13: Downloading and Running PAC Control Programs describes how to download and run PAC 
Control strategies.

Chapter 14: Downloading and Running Custom Control Programs describes how to access the secure 
shell feature to develop and download control programs written in other programming languages.

Chapter 15: Developing and Deploying Node-RED flows describes how to get started building and 
deploying Node-RED flows, including how to add the Opto 22 nodes.

Chapter 16: Monitoring and Configuring Modules and Channels describes the features available on the 
groov EPIC processor to help view the status of your modules and how to configure them.

Chapter 17: Managing PID Loops explains how PID loops work and how to create them through 
groov Manage.

Chapter 18: Maintaining Your groov EPIC describes the tasks you can do to keep your groov EPIC unit 
running in top shape, like applying maintenance. It also describes how to start an OptoSupport Remote 
Support Service session.

Chapter 19: Troubleshooting describes what to do when you encounter problems (troubleshooting).
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Appendix A: Processor Specifications provides the technical specifications of the groov EPIC processor.

Appendix B: Power Supply Specifications provides the technical specifications of the groov EPIC power 
supply, power converter, and power adapter.

Appendix C: Chassis Specifications provides the technical specifications of the groov EPIC chassis.

Appendix D: I/O Module Specifications provides the technical specifications of all the groov I/O modules.

Appendix E: I/O Module Wiring Diagrams provides the wiring diagrams for all the groov I/O modules.

Appendix F: Quality Indicator Codes lists the quality indicator codes that some modules may report and 
what those codes mean.

Appendix G: Installing the Correct License describes how to properly install licenses for groov EPIC 
processors that have versions of firmware older than 1.3.0.

Appendix H: Advanced Networking Configurations describes special networking functions that are 
usually managed by network administrators for specific and rare situations.

Appendix I: Network Information Tables contains a collection of tables set up as forms that you can use to 
help you organize information you need to configure groov EPIC when connecting it to multiple networks, 
particularly if you need to use some of the advanced network configurations, like port redirecting.

Appendix J: Installing groov EPIC Firmware with Ignition Version 8 explains the additional steps you 
need to take to install groov EPIC firmware that includes version 8 of Ignition software.
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Appendix B

2: Additional Safety and 
Operating Instructions

SAFETY INSTRUCTIONS

Read all the guidelines described in this section before operating or servicing your groov EPIC unit:
• CAUTION: There is a possibility of electric shock. Before accessing any terminals connected to modules 

rated as HAZARDOUS LIVE voltage, disconnect or isolate the groov EPIC unit from HAZARDOUS LIVE 
voltage.

• Use only Opto 22-provided parts or accessories and in a manner instructed in this guide; do not use 
un-authorized parts or accessories. If un-authorized parts or accessories are used on your groov EPIC unit, 
the protection provided by the groov EPIC unit may be impaired.

• Use your groov EPIC unit only in a manner in which it complies with all safety and additional instructions 
described in this guide. If the groov EPIC unit is used in a manner not specified by Opto 22, the protection 
provided by the groov EPIC unit may be impaired.

• The normal environmental conditions for a groov EPIC unit in regards to temperature and humidity are 
those conditions that fall within the ranges described in the specifications listed in Appendix A: Processor 
Specifications, Appendix B: Power Supply Specifications, Appendix C: Chassis Specifications, and 
Appendix D: I/O Module Specifications.

• The groov EPIC unit is to be used indoors or installed in a protective cabinet that provides the conditions 
described in Appendix A: Processor Specifications, Appendix B: Power Supply Specifications, Appendix C: 
Chassis Specifications, and Appendix D: I/O Module Specifications.

• The groov EPIC unit is rated to withstand transient overvoltages up to the levels of overvoltage 
category II.

• The groov EPIC unit is rated to be installed in environments where non-conductive pollution occurs 
except where occasionally a temporary conductivity caused by condensation might be expected 
(Pollution Degree 2).

• The groov EPIC unit can operate in altitudes of up to 2000 m.

SAFETY INSTRUCTIONS FOR INSTALLING groov EPIC AS PART OF MACHINERY

When you permanently install your groov EPIC into another machine, you must attach a power disconnect 
device to your groov EPIC. The power disconnect device must comply with the following requirements:
• It must be a switch or a circuit breaker that is easy to reach and operate from the outside of the machine.
• It must disconnect all power lines simultaneously.
• It must be clearly labeled as a power disconnecting device for the controller.
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EXPLANATION OF LABELS OR SYMBOLS

The following table explains the labels or symbols you might see on the groov EPIC power supplies, processor, 
or modules:

OPERATING CONTROLS

The following diagrams describe the operating controls available on the groov EPIC processor. The bottom 
view shows the network interfaces and ports. The front view shows the processor’s touchscreen. 
Administrator and operator controls are provided through the touchscreen interface.
• If you log in with a user ID that has administrator level privileges, you can access controls to view and 

change settings such as network addresses, channel IDs, or to do some tasks, like restarting the device.
• If you log in with a user ID that has operator level privileges, you can access controls that run the 

machinery, equipment, and processes that are controlled and monitored by the control program running 
on the groov EPIC processor.

Label or Symbol Explanation

CAUTION: Please consult the user’s guide for additional safety information and 
instructions for proper installation, operation, maintenance, and service of this unit.

CAUTION: Possibility of electric shock.

(bottom view)

(front view)

USB port (2)

HDMI port

Ethernet Interface (2)

Touchscreen
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SERVICE AND MAINTENANCE

To keep your groov EPIC unit up-to-date with the latest software and firmware fixes and features, you’ll want to 
regularly check for and apply maintenance to your unit, as described in “Updating Firmware on a groov EPIC” 
on page 226.

If you encounter any problems with your groov EPIC unit, follow the instructions in “Collecting Information for 
Product Support” on page 234 to collect information before contacting Opto 22 Product Support.

Service (Product Support)

If you are having problems installing or using groov EPIC products and cannot find the help you need in this 
guide or on our website, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 toll-free 
in the U.S. and Canada)
951-695-3080
Monday through Friday, 
7 a.m. to 5 p.m. Pacific Time

Email: support@opto22.com

Opto 22 website: www.opto22.com

NOTE: Email messages and phone calls 
to Opto 22 Product Support are 
grouped together and answered in the 
order received.

mailto:support@opto22.com
https://www.opto22.com
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Appendix C

3: Assembling your groov EPIC

GATHERING YOUR EQUIPMENT AND INFORMATION

Gathering up all the supplies, information, and equipment you need to help you assemble your groov EPIC 
can make assembling your unit easier:
• A work table and good lighting.
• An accessible power source that complies with the requirements described in Appendix B: Power Supply 

Specifications or in the groov EPIC Power Supplies, Converters, and Adapters Data Sheet (form 2246).
• The proper gauge wires to connect the groov EPIC power supply to your power source. For guidance on 

selecting the correct wire gauge, see Appendix B: Power Supply Specifications or the groov EPIC Power 
Supplies, Converters, and Adapters Data Sheet (form 2246).

• The proper gauge wires to connect your field devices to the I/O modules. For guidance on selecting the 
correct wire gauge, see “Connecting Field Devices to the groov I/O Modules” on page 18 or review the 
groov I/O module data sheets.

• Pen and paper to note important information that you might need during this process or to keep for 
future reference.

• If you are connecting the processor to a network, an Ethernet cable.
• The groov EPIC power supply you selected for your project.
• The groov EPIC chassis you selected for your project. Make sure you have the correct size chassis to hold 

the number of modules you are installing.
• The groov I/O modules that you selected for your project.
• The screwdriver that ships with your I/O modules, which helps you connect field device wires to the 

terminal connector.

In addition, make sure you have a list of all the I/O channels (sometimes referred to as points) that you need 
set up. This might be in a form of a document that maps which channel of which module will connect to a 
specific field device/point. If you are working with a terminal strip, review the terminal number assignments, 
making sure you understand which terminal numbers are assigned to specific modules and channels.

Any additional information you might need will depend on other factors, like any special configurations for 
your network or whether you need to create additional users that have limited access.

After you assemble your unit, you’ll initialize it as described in Chapter 4: Initializing the groov EPIC Processor. 
After you finish initializing the processor, it will be ready to run.

FAMILIARIZING YOURSELF WITH THE PROCESSOR AND groov I/O MODULES
Take a few minutes to review the next couple of pages, which show you the different features of the processor and groov I/O modules. 
The installation instructions in this section rely on these terms to explain how to handle a processor and a module.

http://documents.opto22.com/2246_groov_EPIC_Power_Supplies_Data_Sheet.pdf
http://documents.opto22.com/2246_groov_EPIC_Power_Supplies_Data_Sheet.pdf
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groov EPIC Processor

Face View:

LED Indicates

SPEED LED
Indicates link speed (Off = 10 Mbps, 
Green = 100 Mbps, Orange = 1000 Mbps)

LINK ACT LED
Indicates link status or activity 
(on/solid = link present, blinking = link 
present and local activity)

POWER LED
Indicates status of power (Green = on; 
Red = on, resetting)

STATUS LED

Indicates whether the unit is running with 
full functionality. (Green = all normal; blink 
green and red = starting a restore to 
defaults)

SPEED LED

LINK ACT LED

ETH0

ETH1

HDMI

USB

POWER LED

STATUS LED

RESET button

Back View:

Connector

Connector Pins

Bottom View:
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groov I/O Modules

To learn what colors the module LED displays, see “Through the Modules page of groov Manage” on 
page 201.

VERIFYING SERIAL NUMBER ON THE PROCESSOR

When you unpack your groov EPIC processor, open the LCD display and verify that you can find the serial 
number on the label attached to the back of the LCD display.

ACTIVATING groov EPIC AND DOWNLOADING THE LICENSE FILE

Each groov EPIC processor comes with an activation code, which helps you obtain your license file.
1. Make a note of the serial number of your groov EPIC processor, which is on a label attached to the back of 

the LCD display.
2. On a computer or mobile device connected to the Internet, go to manage.groov.com.

Touch-sensitive pad

Module LED

Module cover

Discrete channel indicators 
(discrete modules only)

Module cover 
grip tab

Wireway

Terminal connector (removable)

Strain relief tab

Module retention screw

Hinge (2-position)

Terminal connector screw

Pin numbers

Alignment tab (on the 
underside of the module)

Module grip tab

Catch tab 
(on the 
top of the 
module)

http://manage.groov.com
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3. Follow the directions for activating your groov EPIC processor and obtaining a license file.
4. Save the license file onto your computer or mobile device and remember where you saved it.

If you purchased additional licensed products (for example, GROOV-LIC-EDGE), you will receive activation keys 
for those licensed products. For each of those licensed products, you will do steps similar to steps 1 through 4:
• If you purchased GROOV-LIC-CRE, finish assembling your groov EPIC and then see “Obtaining Your 

CODESYS Activation Key Certificate and Ticket ID” on page 112.
• If you purchased GROOV-LIC-EDGE or GROOV-LIC-EDGE8, you received an activation key from Opto 22. 

Repeat steps 1 through 3, but instead of receiving a license file, you will received a license key. Copy and 
save that license key. After you finish assembling your groov EPIC, do the steps in “Installing (Activating) 
the Ignition Edge License” on page 85.

• If you purchased GROOV-LIC-SHELL, you received an activation key from Opto 22. Repeat steps 1 through 
4. After you finish assembling your groov EPIC, upload the license file as described in “Configuring the 
groov EPIC Processor for Shell Access” on page 92.

MOUNTING THE POWER SUPPLY, PROCESSOR, AND I/O MODULES TO THE 
CHASSIS

After you complete the steps in this section, you will have mounted the power supply, the processor, and the 
I/O modules on to the chassis. In the section that follows, you’ll wire the I/O modules to field devices, and the 
power supply to the power source.

CAUTION: For electrical safety, do not turn on the power supply. Make sure to de-energize field devices wired to the 
module terminal connectors before proceeding with these steps.

Mounting the Power Supply

1. Orient the groov EPIC chassis so that the module connector numbers are right-side up, with zero on the 
left, as shown in the diagram below.
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2. Hold the power supply at a 45° angle, with the tabs at the back of the supply aligned with the notches on 
the chassis.

3. Lower the front-end of the supply onto the chassis until you feel the plug snap into the slot.

Mounting the groov EPIC Processor

You’ll want to make sure you take extra care in mounting the groov EPIC processor to avoid damaging the 
connector pins located in the back of the processor (see “groov EPIC Processor” on page 10). You may want to 
view a helpful video on our website (www.opto22.com) that carefully explains each step, in addition to 
reviewing the instructions on the next few pages.

Step 2

Step 3

https://www.opto22.com/support/resources-tools/videos/playlist-epic-hardware?wchannelid=hfpu03yb9a&wmediaid=253h023vg0
https://www.opto22.com/
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1. Lift the LCD display so you can see the notch on the processor.

2. Hold the processor by the left side and make sure that the notch on the processor aligns with the guide 
tab on the power supply.

3. Align and then seat the processor:

Notch
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a. Align the processor. With the LCD display open, slowly guide the processor straight onto the 
chassis—holding it flush against the side of the power supply—until you feel the processor start to 
touch the connector on the chassis.

b. When it touches, lightly jiggle the processor to help the pins on the processor’s connector properly 
align themselves into the holes of the chassis’ connector.
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c. Seat the processor. Push the processor (not the LCD display) into the connector until it resists 
further pressure.

IMPORTANT: Do not push on the LCD display.

4. Tighten the retention screws that attach the processor to the power supply and the chassis to the 
recommended torque listed in Appendix A: Processor Specifications.

5. Close the LCD display.

Retention screws
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Mounting the Modules

1. Hold the module at a 45° angle, lining up the alignment tab on the back tip of the module with the slot 
at the back of the chassis.

2. Pivot the front of the module down to the module connector on the chassis. Push to snap the module 
into the connector.

Step 1

Step 2
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3. Swing the module cover up so you can access the module hold-down screw. Secure the module into 
position by tightening the module hold-down screw.

CAUTION: Do not over-tighten. See the torque specs in Appendix D: I/O Module Specifications.

CONNECTING POWER SUPPLY WIRES AND FIELD DEVICE WIRES

After you complete the steps in this section, you will turn on you groov EPIC processor and move on to 
initializing the processor.

Connecting Field Devices to the groov I/O Modules

Before you begin wiring, do the following tasks:
• Select the appropriate wire. The terminal connectors are rated for 28–14 AWG wire. If you’re using 

stranded wire, you can make an easier and better connection by tinning the strands or adding ferrules.

Note: For GRV-IVAPM-3 modules, you must use copper wires, either solid core or tinned strands with ferrules.

• Ensure that you have the groov spring-clamp terminal tool, typically supplied with a groov EPIC chassis. 
(You can order a replacement on our website, www.opto22.com. Search for GRV-TEX-SCTOOL.)

• It may be easier to insert wires if you remove the terminal connector from the module. To remove the 
terminal connector, loosen the terminal connector screw at one end of the connector, then pull the 
connector straight out to remove it from the module.

• If you have never used a spring-clamp wiring system, take a moment to familiarize yourself with the 
“Inserting Wires” diagram. The clamp release hole is where you will insert the spring-clamp terminal tool. 
The field wiring hole is where you will insert your field wires.

If you look into the field wiring hole, you will see a highly reflective surface. If you can see that surface, that 
means that the clamp is closed.

Hold-down screw

https://www.opto22.com/
https://www.opto22.com/products/product-container/grv-tex-sctool
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Inserting Wires:

Follow these instructions to connect your field wires to the module:

CAUTION: For electrical safety, before starting, de-energize field devices wired to the terminal connector.

1. Orient the module or terminal connector to match the wiring diagrams in “E: I/O Module Wiring 
Diagrams” on page 299.

2. To make it easier to handle the spring-clamp terminal tool and the field wires, secure the module by 
doing one of the following:
– If you are working with the terminal connector while it is attached to the module, make sure the 

module is screwed securely to the chassis.
– If you are working only with the terminal connector, secure the terminal connector with a clamp.

3. Insert the spring-clamp terminal tool into the clamp release hole, then press and hold down the tool to 
open the clamp. Look into the field wiring hole. If it is dark, the clamp is open. You can go to step 4. If you 
can still see the highly reflective surface, gently push down again and keep downward pressure on the 
spring-clamp terminal tool. Look into the field wiring hole. If it is dark, the clamp is open.

Note: If you push in too hard, the spring-clamp terminal tool might pop out of the clamp release hole.

4. Insert the wire into the field wiring hole until it meets complete resistance. Then pull out the 
spring-clamp terminal tool.

5. Test that the wire is secure by gently pulling on it. If the wire pulls out, repeat steps 3 and 4.

To remove a wire, push the spring-clamp terminal tool into the clamp release hole as described in step 3 
above, and then pull the wire out.

Pin numbers

Field wiring holes

Terminal connector screw

In this example, pin 3’s clamp release hole and corresponding field 
wiring hole are open.

Clamp release holes
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Connecting Ground

Connect a ground strap to the ground lug on the chassis. The ground lug is colored green on the chassis to 
make it easier to identify.

Connecting Power Supply Wires

Here are a few guidelines to review before connecting your power supply wires:

Always Use a Separate Field Supply

Use a separate power supply for the field side of the I/O. Using the chassis supply for field actuation and 
monitoring defeats the isolation the I/O modules offer and therefore increases the chance of a ground loop 
within the control system. Additionally, fluctuations on the field side can cause undesirable voltage 
fluctuations that may interfere with the processor’s operation.

Some modules (for example, the GRV-OVMALC-8) provide their own isolated, regulated, field-side power 
supply.

Power Wiring Guidelines

Opto 22 recommends you follow these wiring guidelines:
• Use a mains-isolated 24 to 48 VDC power source or supply to feed the GRV-EPIC-PSDC.
• Use the appropriate gage wire:

– For GRV-EPIC-PSDC or GRV-EPIC-PSPT with DC input, use 16 to 12 AWG. Keep the wires as short as 
possible.

– For GRV-EPIC-PSAC, use 18 to 12 AWG . Keep the wires as short as possible.

Power Wiring Diagrams

Before wiring the GRV-EPIC-PSAC, GRV-EPIC-PSDC or GRV-EPIC-PSPT, verify that your wiring cables conform to 
the requirements described previously.

Ground Lug
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CONNECTING THE ETHERNET CABLE

If the LCD display is closed, lift it so you can more easily access the Ethernet network interfaces. Connect your 
Ethernet cable to the network interface labeled ETH0.

TURN ON UNIT AND CONTINUE WITH INITIALIZING THE PROCESSOR

If the LCD display is closed, lift it so you can access the power switch. Flip the power switch and then close the 
LCD display. The LCD display shows you the progress of the processor’s start-up sequence. When you see the 
“Welcome!” screen, you are ready to initialize your groov EPIC; see Chapter 4: Initializing the groov EPIC 
Processor.

GRV-EPIC-PSAC GRV-EPIC-PSDC, GRV-EPIC-PSPT
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4: Initializing the groov EPIC 
Processor

After you assemble your groov EPIC and turn it on, the groov EPIC processor runs through its start-up sequence 
and then displays the Welcome! screen, shown below. If the Eth0 IP Address box does not show an IP address, 
see “Ethernet Cable is Plugged In, but No IP Address” on page 241.

If the Eth0 IP Address box shows an IP address, try connecting to that IP address with a web browser by typing 
https://<ip address> in the browser’s URL bar. The browser displays the same Welcome! screen, 
shown below. If the Welcome! screen does not appear in the browser, see “Web Browser Can’t Connect to 
Processor” on page 241.

groov EPIC touchscreen

For security reasons, the hostname and 
IP address are blurred in this image.
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Before you click or tap on Let’s get started! ( ), make sure you have the following information and 
supplies:
• Your license file. If you don’t have one, you can get one by following the instructions in “Activating groov 

EPIC and downloading the license file” on page 11.
• A computer or mobile device connected to the Internet.
• A cutsomized hostname for your processor. You may want to consult with your network administrator for 

guidance on selecting a hostname.
• A user name and password that follows strong security recommendations. This username and password 

is the first administrator level user for your Learning Center. Remember it! groov EPIC does not provide a 
way to recover a lost password or username.

• Pen and paper to note important information that you might need during this process or to keep for 
future reference.

If this is the first time you navigate through a controller with a touchscreen or you are new to the groov EPIC 
processor, you might want to read through Chapter 5: Navigating Through the groov EPIC Processor to 
become familiar with how to operate it and how it behaves.

You may also want to make note of the information shown in the lower-half of the Welcome! screen:
• You want the firmware version number so that you can compare it to the firmware updates available on 

the Opto 22 web site. If the firmware on the web site is newer than the one installed on the processor, 
you may want to apply the new firmware after you finish initializing the groov EPIC processor.

• If the Eth0 IP Address box displays an IP address and you were able to connect to it through a browser, 
you can finish the steps in this chapter by navigating through the web browser with a mouse and 
entering data with the keyboard.

For security reasons, the hostname and 
IP address are blurred in this image.
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CREATING THE FIRST ADMINISTRATOR ACCOUNT

Click or tap on Let’s get started! ( ). You’ll see the Create an Account screen, shown below.

Read the information in the warning box. This first administrator account is very important because it provides 
administrator privileges over the groov EPIC processor, which gives you access to all the functions you need to 
configure the processor, maintain it, and create other accounts.

It’s also important to remember the password to this account. The groov EPIC processor does not provide a 
way to recover this password nor an alternate way to access this account if you forget the password. Also, 
Opto 22 cannot recover this password or provide access to the account.

It is a good idea to follow best practices regarding passwords (for example, mixing cases and including 
numbers) when you create your password. Your password must be a minimum of 1 character and can be a 
maximum of 128 characters.

After you type in the user ID and password, click or tap on Create Account.

CHOOSING BETWEEN QUICK START AND CONFIGURE DEVICE

After you create an account, the groov EPIC processor displays the screen below.

Computer web browsergroov EPIC touchscreen
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• Quick Start. The quick start provides a list of suggested configuration steps that you should complete first 
to get your groov EPIC up and running. You may want to choose this option if this is the first time you 
configure a groov EPIC. 

• Configure Device. If you select this option, the groov EPIC processor displays the main groov Manage 
page, where you can make any configuration changes. You may want to choose this option if you have 
configured a groov EPIC processor before or you feel confident you have all the information and 
understand the technology and software installed on the processor to complete any configuration steps.

If you choose to run Quick Start, the rest of this chapter can help you make additional decisions about the 
initial configuration steps. If you choose Configure Device, you can skip the rest of this chapter and configure 
your groov EPIC processor, referring to the rest of the user’s guide for additional information.

COMPLETING THE QUICK START

When you click or tap Quick Start ( ), the groov EPIC processor displays the page below.

Computer web browsergroov EPIC touchscreen
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The boxes are organized to suggest an order in which to complete the configuration. However, you do not 
have to follow this order nor do a configuration task for every box. Here’s why you might want to complete 
each step:
• Networking. You might want to configure or change networking settings because:

– You noticed that the Eth0 IP address box displayed the message Not Available and you want to set 
the IP addresses manually or configure settings so that the processor can connect to a DHCP server 
and obtain an IP address automatically.

– You want to change the IP address that was assigned to the processor. You might want to connect 
to a specific DHCP server or set the IP address manually (which would make it a static IP address).

• License. Your groov View license comes with the purchase of the groov EPIC processor. If you ordered 
some of the optional licenses (for example, GROOV-LIC-EDGE) and you have that license file handy, you 
can also upload it. You’ll need to do this step on a computer or mobile device; you can’t upload licenses 
through the groov EPIC processor’s touchscreen.

• Accounts. You might want to create additional accounts as required by the design of your control 
program and HMI.

• Display. You might want to calibrate the groov EPIC processor’s touchscreen to ensure smooth operation. 
If you want to connect an external monitor, you might want to connect it through the HDMI port and 
configure it at this time.

• Time. You can choose between manually setting the date and time, selecting a time zone from a list, or 
selecting a time server that will synchronize your processor’s date and time with that time server’s date 
and time.

After you complete these initial configuration steps, you should check whether you have the latest firmware 
installed on your groov EPIC processor. If you do, you can continue on to more advanced configuration or 
begin to download and run a strategy or other control program.
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5: Navigating Through the 
groov EPIC Processor

You navigate through the groov EPIC processor touchscreen in much the same way you navigate through a 
smart phone or tablet. You can tap on navigation aids, swipe up or down to see more information, or swipe 
right to return to a previous page. The touchscreen responds to the touch of a finger or a stylus, although it 
might require a slightly stronger push or slide than a typical smart phone or tablet. When you connect an 
external touchscreen monitor to the processor, you navigate in the same manner as if you were touching the 
processor touchscreen.

The groov modules include a touch-sensitive pad. When you place your finger on the touch-sensitive pad of a 
module for more than two seconds, groov Manage displays information about that module on the 
touchscreen. The following diagram shows what the groov EPIC processor displays on the touchscreen after 
you touch the touch-sensitive pad of a module (GRV-IAC-24) mounted on slot 1, and then tap on the Info tab.

When you connect to the processor through a web browser on a computer, you navigate through the web 
browser in much the same way you navigate through any other web application on your computer. You can 
click on navigation aides like the navigation bar or links, and scroll up and down with a mouse.

CLICK OR TAP YOUR WAY AROUND groov MANAGE

After you configure your groov EPIC processor with an IP address, you can connect to the processor through a 
web browser with that IP address. When you connect through a web browser, the processor displays the login 

Press the touch-sensitive pad for 2 seconds. The groov EPIC 
processor displays that module’s information. Tap on the 
Info tab to see the wiring diagram.
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page. If you enter a user ID with administrator privileges, the processor displays groov Manage. You can 
navigate through groov Manage in much the same way you navigate through any web application.

Because you can access the processor through a browser or through the processor’s touchscreen, the 
directions in this guide are written with both methods in mind. So, you may notice that instructions include 
the phrase “Click or tap”: ”click” as a reference to clicking with a mouse on a computer screen, “tap” to indicate 
touching the processor’s touchscreen with your finger or a stylus.

LEARNING THE SCREEN NAVIGATION AIDS

The diagram below shows some of the differences and similarities between pages when you look at them 
through the groov EPIC processor or a web browser (either on a computer or a mobile device). The diagram 
also identifies some of the important navigation aids, which are described on the following page:

A

B

C

D

E

groov EPIC touchscreen Computer web browser
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A Menu button ( ). Click or tap on this button to access a list of frequently visited pages. This button 
can help you quickly jump to these pages.

B Cancel or previous page. The upper-left area of the screen provides a way to cancel any changes you 
might have made to a page, to return to the previous page, or both.

C Save or Configure. If there are settings on the page that you can change, the upper-right area of the 
page displays the word Configure. Click on Configure to open up the page where you actually make 
the changes.
If this area shows the word Save, you must click on it to save any changes you made to settings on 
the page. If, after saving, the processor must restart an application or service, it displays a message to 
let you know.
If this area is blank, that means you can’t make any changes to this page.

D Tabs. A method of grouping information related to one object into different categories. For example, 
information related to a module is divided into three categories: Channels, Info (specification 
information), and Config (module-specific information, like serial number). Each of these categories 
is in its own tab.

E Links. When you see these arrows, it indicates that clicking or tapping on the arrow will open another 
page that displays more information and provides more functions related to the item. For example, 
when you click or tap on Project Management in the Node-RED page, the processor displays another 
page with information and functions to help you manage a Node-RED project.
There is a small difference you might notice with links, depending on whether you are viewing a 
groov Manage page through the groov EPIC processor’s touchscreen or a web browser. In a web 
browser, you can click on any area along the same row where the link is located to navigate through 
that link. In the groov EPIC touchscreen, you must tap on the arrow to navigate through that link.

NAVIGATING THROUGH groov MANAGE

At the top of the groov Manage page is a navigation bar that always remains visible as you navigate through 
the screens. This navigation bar contains a menu button ( ) that gives you quick access to the most 
frequently visited screens of groov Manage:

• Home, the main page of groov Manage.
• I/O, the page that displays a visual representation of the chassis, indicating which slots have modules 

mounted on them, what type of modules are mounted on those slots, and the status of the modules.
• Controller, the page that guides you to either the PAC Control Engine page or the CODESYS Runtime 

Engine page. From either of those two pages, you can access several features, including:
– Viewing the status of the engine.
– Viewing the name of the strategy or applications running on the processor.
– Disabling or enabling the engine.

Navigation bar, with the menu 
button closed.

Navigation bar, with the menu button 
open.
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• System, the page that displays functions to help you configure system-level settings, like network 
settings, display settings (for the touchscreen and external monitors), time zone settings, licenses, and 
the ability to restart the processor.

• Info and Help, the page that displays functions to help you learn more information about the processor, 
like system logs, current system up-time information, firmware versions, as well as a way to access the 
Quick Start feature.

• User, the page that displays the user name of the current user and the fields to change the current user’s 
password.

Navigating Through groov Manage on the groov EPIC Processor Touchscreen

Some screens contain more information than can fit in the display. Remember to slide your finger or stylus up 
and down on the screen to view more information.

While navigating through the screens on the groov EPIC processor touchscreen, in addition to tapping on 
buttons or other navigation aids, you can swipe your finger or stylus across the screen from left to right to 
return to a previous page.

The following example shows how to navigate through a set of screens by either swiping or tapping the 
buttons on the screen:

1. Starting from the Home page, tap on System ( ) to open the System page.
2. Tap on Time ( ) to open the Time Settings page.
3. To go from the Time Settings page back to the System page, tap on System near the top left corner or 

swipe your finger on the screen from left to right.
4. To go from the System page to the Home page, tap on Home near the top left corner or swipe your finger 

from left to right.

As a quick alternative, you can go from the Time Settings page to the Home page by tapping on the menu 
button ( ), then tapping on Home.

Whenever you change settings, remember to press Save (usually at the top right corner of screen) to save your 
changes. If you don’t want to save your changes, press Cancel (usually at the top left corner of the screen) or 
swipe from left to right. Some changes might require a restart of the processor or a service; the processor will 
notify you of these instances.

1. 2.

3.
4.
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There are some functions that can only be done through a computer or mobile device. When that happens, 
the processor’s touchscreen displays a message like the following:

Navigating Through groov Manage on a Computer or Mobile Device

You can navigate through groov Manage on a computer or mobile device in much the same way you navigate 
through any other web application. There are some differences, however:
• Drag-and-drop—This is a feature commonly used on a computer to visually and easily move files from 

one location to another. You can drag-and-drop files into the groov EPIC processor on any groov Manage 
page with an upload button.

• Editors—You can’t build Node-RED flows or groov View HMIs through the processor’s touchscreen. 
That’s why, on some pages, you’ll see buttons or options when you are on a computer that you can’t see 
when you are on the processor’s touchscreen. For example, on the Node-RED page, you won’t see the 
Open Node-RED Editor button when you are on the processor’s touchscreen:

Computer web browsergroov EPIC touchscreen
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FINDING INFORMATION ABOUT I/O MODULES AND THEIR CHANNELS

To view information about and making changes to I/O modules and their channels is through the Modules 
page of groov Manage. To reach that page, log into your groov EPIC processor with a user ID that has 
administrator privileges and then do any of the following:
• Click or tap on the menu button ( ), then select I/O.
• In the Home page, click or tap on I/O ( ).

Either action displays the Modules page. The page displays an image that simulates the chassis and the I/O 
modules mounted on the chassis, along with colors that match the color shown by the module LED. The 
following diagram displays a 16-module chassis with 9 modules mounted on the chassis in slots 0, 4, 5, 7, 9, 
11, 13, 14, and 15. All modules are operating normally, which is indicated by the blue color on the right of each 
box that represents a mounted module.

Each box represents a slot on the chassis. If the box is gray and shows the word “Empty”, that means no 
module is installed in that slot on the chassis. If the box is black, that means a module is installed in that slot 
on the chassis. The following diagram explains the information displayed in the black boxes:

Two-digit code indicating module type:
• First digit: A for Analog, D for digital
• Second digit: I for input, O for output

The vertical bar represents the module LED. 
The color matches the current color being 
shown on the module LED.

Numbers represent the 
module connector number 
(slot) on the chassis.

The part number of the groov module, without the GRV- prefix. In 
this diagram, a GRV-IAC-24, GRV-IDCI-12, GRV-ODCI-12 and a 
GRV-IACI-12 module are installed on the chassis.
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You can click or tap on a black box to show current information about that module. For example, if you click or 
tap on module 3 ( ), the groov Manage displays the following page:

The three tabs display the following information:
• The Channels tab lists the channels on the module, displays the status of each channel, and provides a 

link to the configuration page for each channel. In the configuration page, you can change the name of 
the channel, get more information about a quality error, or change options that are specific to each 
module.

• The Info tab shows you information about the module, like the wiring diagram, the specification 
information, and firmware version.

• The Config tab, when you view it through a computer or mobile device, provides a way for you to upload 
new firmware to the module.

groov EPIC touchscreen Computer web browser
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6: Controlling Access to groov EPIC

PART OF AN OVERALL SECURITY SYSTEM

When you control access to the groov EPIC processor, consider it as part of a total security system that includes 
other best practices you might want to implement; for example, requiring that authorized users change their 
passwords every three months or securing the control equipment in a locked cabinet with keys accessible to a 
limited number of personnel.

The groov EPIC Security Design and Best Practices Technical Note (form 2310) describes some of the security 
features designed into the groov EPIC processor. Review this technical note carefully and coordinate with your 
IT department to determine which security features provided by the groov EPIC processor will work best with 
your application and network. This chapter provides more detail about the following security features:

• User accounts—How to create and remove user IDs, either locally (managed by groov EPIC) or through 
an LDAP service, and how to control the services and applications that a user can access. See:
– “Managing User IDs through an LDAP Service” on page 37
– “Managing User IDs Locally” on page 45

• SSL—A basic explanation of how it works, when to use it, and how to set it up in groov EPIC. See 
“Managing the SSL Security Features of your groov EPIC Processor” on page 46.

• Firewall—A basic explanation of how it works and how to set it up in groov EPIC. See “Configuring the 
Firewall” on page 51.

IMPORTANT: groov Manage does not provide timeout-based logout. You must implement the important practice 
of always logging out of any ID that has administrator privileges to prevent unauthorized access to the processor.

MANAGING USER IDs THROUGH AN LDAP SERVICE

If your site manages user IDs through an Lightweight Directory Access Protocol (LDAP) service, you can 
configure your groov EPIC to connect to the LDAP server to authenticate a user and help determine which 
services a user can access:
1. If you haven’t already done this, create a user ID with administrator privileges on your groov EPIC (see 

“Creating the First Administrator Account” on page 25).

Note: This ID gives you direct, local access to your groov EPIC and is not managed by your LDAP service.

2. Learn how groov Manage grants a user permission to use a service and what information you need about 
your LDAP server and database to configure groov EPIC. See:
– “Understanding Permissions and How They Are Assigned” on page 38
– “Collecting Information to Configure Communication” on page 39
– “Collecting Information to Authenticate Users” on page 40

https://www.opto22.com/support/resources-tools/documents/2310-groov-epic-security-design-and-best-practices?utm_campaign=groov%20EPIC%20Security%20Tech%20Note
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3. Configure groov EPIC (see “Configuring groov EPIC for LDAP Authentication” on page 41).

Understanding Permissions and How They Are Assigned

groov Manage grants users permission to specific services as described in “Choosing Access Levels for Users” 
on page 45. The following chart summarizes the available permissions:

When a user logs into groov Manage, groov Manage sends a request to the LDAP server to authenticate the 
user. After the LDAP server authenticates the user, groov Manage determines which services the user can 
access by reviewing the default permissions. This is called local permissions. It works well for simple user 
management or if your application has a small set of users.

Important: Carefully consider what access you grant as default permissions. Remember that any authenticated 
LDAP user is granted default permissions. If security and safety are a concern, it is good practice to specify either:

• no permissions, or

• a minimal set of permissions to some services and no System Administrator permission.

If your application requires more complex user management (for example, you want to manage groups of 
users in an LDAP database, with each group granted different permissions), then you want to work with 
permission mapping. In groov Manage, you can map an LDAP group to a specific set of permissions. In this 
situation, after checking the default permissions, groov Manage checks through its list of groups to determine 
if the user is a member of any of those groups. If so, it grants the user the same permissions to the services as 
are granted to that group.

Resolving Multiple Permission Levels

What if a user is a member of a group that is granted a permission level that is either lower or higher than the 
default permissions? Or, what if the user is a member of multiple groups? groov Manage always assigns the 
user the highest permission level that it finds. Therefore, if groov Manage finds that a user is in a group with a 
higher permission level to a service than the default permission, it assigns that higher level to the user. If 
groov Manage finds the user in multiple groups, it assigns the highest level of permission to a service that it 
finds in any of the groups.

For example, if you set the permission level for groov View to Editor in the default permissions, but a user is a 
member of an LDAP group granted Operator permission, groov Manage grants the user Editor permission. 
(Because Editor is a higher permission level than Operator.)

Changing Permissions

How to change a user’s permissions and when the changes take effect depends on whether you selected local 
permissions or permissions mapping.
• Local permissions—After the user logs in, a groov EPIC system administrator can change the user’s 

permissions. groov Manage saves these changes and they persist after the user logs out.
• Permissions mapping—A groov EPIC system administrator cannot change the user’s permission after the 

user logs in. Any changes must be made on the LDAP server by any of the following methods:
– Updating the permissions in the group map.

System 
Administrator

groov Manage groov View Node-RED
PAC Control 

REST API

Yes or No
Matches System 
Administrator

If not System Admin, 
select one:
• Editor
• Operator
• Kiosk
• None

Select one:
• Editor
• None
Note: System Admin 
is always Editor

Select one:
• Read-Write
• Read-Only
• None
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– Adding a user to or removing a user from the group in the LDAP database. (See note on next page.)
– Creating a new group and adding that user to the group in the LDAP database. (See note on next 

page.)
– Changing the default permissions. This would be the least preferred method because it would affect 

any LDAP user currently logged in.

Note: groov Manage enforces the changes in group membership after the time set in the Group Update field 
(see step 3 in “Configuring groov EPIC for LDAP Authentication” on page 41). At that moment, any logged in 
LDAP user whose group membership changed would be immediately affected.

Updating your LDAP Database

Remember to create users and groups on your LDAP server database before configuring groov EPIC. You will 
also want to gather information that groov Manage needs to request authentication of a user:
• Information about how to connect to the LDAP server:

– The ID and password of the manager account, the account that typically routes authentication 
requests from LDAP clients to the LDAP server.

– Connection information like server hostname, password, as well as security and encryption 
requirements.

You can find descriptions of the specific details in “Collecting Information to Configure Communication”  
(below).

• Information about how to find a user in the database:
– The absolute and relative distinguished names (DNs) of objects that, when concatenated, identify 

where LDAP stores user and group information in the database.
– Group names, which can be stored in an LDAP database as either:

– the name of an attribute on a user object
– group objects

– Objects that should be ignored (filtered out of searches).
You can find descriptions of the specific details in “Collecting Information to Authenticate Users” on 
page 40.

Collecting Information to Configure Communication

Work with your LDAP administrator to collect the following information:

Server hostname and port number. The hostname and port number of the LDAP server through which it 
communicates to LDAP clients. The hostname must be in x.y.z format. The port numbers are generally:
• 389 for LDAP and LDAP over StartTLS
• 636 for LDAPS (in rare cases, this may change)

Group Update. How frequently, in minutes, groov Manage requests updates to its local cache of information 
from the LDAP server. Specify 0 to disable these updates.

TLS Mode. Determines the type of encryption:
• Clear Text. The LDAP communication is not encrypted. Avoid selecting this option to protect sensitive 

information.
• Start TLS. The connection is started without encryption, and then TLS encryption is added. No sensitive 

information is sent until TLS is added to the connection. This is the preferred setting.
• LDAPS. The connection is started with TLS encryption. All information is sent after TLS is added to the 

connection. Select this only if your site uses this (deprecated) standard.
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Validate Certificates. This applies only when you select Start TLS or LDAPS as the TLS Mode. If you enable 
this option, the LDAP server checks the public key certificate in groov Manage to verify the identify of its 
LDAP client.

The following table may help you organize this information:

Collecting Information to Authenticate Users

You’ll want to work with your LDAP administrator to obtain the following information:

Typically, LDAP servers provide a specific account through which authentication requests are routed:
• Manager Distinguished Name. (Abbreviated to manage DN.) The fully-qualified distinguished name of 

the manager account, which queries the LDAP server for user and groups information.
• Manager Password. The password for the manager account (manage DN).

groov Manage sends the following information to LDAP, which it then uses to compose a query to find a user:
• Root Distinguished Name. (Commonly abbreviated to root DN.) The unique key for an object in the 

LDAP database that serves as the root when LDAP server concatenates the following objects to it:
– User Search Base (see below)
– Group Search Base (when Group Mode is set to Group Query; see below)
The format of root DN is a series of relative distinguished names. For example: dc=example,dc=com

• User Search Base. The relative distinguished name that the LDAP server concatenates to the root DN, 
creating the parent DN. The LDAP server queries through the parent DN to find a user. 

• User Filter. A list of objects that an LDAP query should include while searching through the User Search 
Base. Any object not matching the filter will be ignored (filtered out). Must be in the form 
attribute={0}. One example: for an Active Directory database, you may want to specify 
sAMAccountName={0}. (sAMAccountName is a specialized login name).

• Email attribute. The name of the attribute on a user object that contains the user's email address.

In an LDAP database, you can indicate that a user belongs to a specific group or groups by either listing the 
name of the group in an attribute of the user object, or by listing the user in an attribute of a group object.
• If your LDAP database is set up to list the name of the group in an attribute of the user object, you 

provide the name of that attribute in the User Attribute field.
• If your LDAP database is set up to list the user in an attribute of a group object, then you need to collect 

the following information:
– Group Search Base. The relative DN that holds group objects. The LDAP server concatenates this 

DN to the root DN.
– Group Filter. A list of objects that an LDAP query should include while searching through the 

Group Search Base. Must be in the form attribute=value. Any object not matching the filter 
will be ignored (filtered out).

– Group Member Attribute. The name of the attribute on a group object that lists all the users that 
belong to the group.

Setting Value

Server Hostname and port number: _________________________________________:___________

Group Update: _____ minutes (0 to disable)

TLS Mode:

Select one:
• Clear Text
• Start TLS
• LDAPS

Validate Certificate: Yes or No; If yes, file name of certificate: _________________________
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Configuring groov EPIC for LDAP Authentication

Before you begin, make sure you have the information described in “Collecting Information to Configure 
Communication”  and “Collecting Information to Authenticate Users” on page 40. If your LDAP server requires 
SSL, make sure the public key certificate is stored on the computer or mobile device that you are using to 
connect to the groov EPIC processor.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click Accounts. groov Manage displays the main LDAP page.

3. Click Settings. groov Manage displays the LDAP Settings page.
a. Enter the Server and Root DN information you collected in “Collecting Information to Configure 

Communication” on page 39.
b. Options. Set Permissions Mode to either Local Permissions or Permissions Mapping. To understand 

the difference, see “Understanding Permissions and How They Are Assigned” on page 38.
c. In the Group Update field, enter how often (in minutes) groov Manage should request an update of 

its local cache of information.
d. Click TLS Mode to select the type of security encryption for the connection to the LDAP server (see 

“Collecting Information to Configure Communication” on page 39).
e. Search Subtree. Enable this switch if you want the LDAP server to search through the subtrees that 

branch off the User Search Base or the Group Search Base.
f. For the Manager and User Search sections, enter the information you collected in “Collecting 

Information to Authenticate Users” on page 40.
g. Group Search. If Permissions Mode is Local Permissions, do not specify anything for Group Search. 

If Permissions Mode is Permissions Mapping, click Group Mode to specify how group information is 
stored in the LDAP database (see “Updating your LDAP Database” on page 39).
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– Select User Attribute if group membership is stored as an attribute to the user object. Enter 
the name of the attribute in the User Member Of Attribute field.

– Select Group Query if the group membership is stored in group objects. Enter the information 
you collected in “Collecting Information to Authenticate Users” on page 40 in the fields.

4. Click Save. groov Manage validates the information and then saves it.
If groov Manage finds any invalid information, it highlights (in red) the fields with invalid information and 
shows a message with guidance on how to fix it. After you fix the information, click on Save.

5. Click Permissions. groov Manage displays the LDAP Permissions page.

Default Permissions. Enter the information you collected in “Collecting Information to Authenticate 
Users” on page 40.
If Permissions Mode is Permissions Mapping, then specify the permissions you want granted to your 
LDAP groups:
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a. Click Add Permissions.

b. Enter the group distinguished name, making sure it matches what LDAP would return.
c. Select the permissions you want to grant to the users in this group for each service.
d. Click OK.
If you want to create more groups, return to step a.

6. Click Save. groov Manage validates some of the information and then saves it.
If groov Manage finds any invalid information, it highlights (in red) the fields with invalid information and 
shows a message with guidance on how to fix it. After you fix the information, click Save.

7. If your LDAP server requires SSL encryption, upload the certificate:
a. Click Accounts > Home > Security > Client SSL to open the Client Certificates page.

b. Click Add/Update.
c. Navigate to the folder where you stored the public key certificate and select the certificate file.
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d. Click Open. groov Manage uploads the file and you’ll see it listed in the Certificates section.

e. Click Back > Home > Accounts > LDAP Settings to return to the LDAP page.
8. In the LDAP page, click Restart Client.

9. You can test your configuration by entering the user name and password of a user in your LDAP 
database, then clicking Test Connection.
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MANAGING USER IDs LOCALLY

With groov Manage, you can create user IDs and limit access to functionality, features, or even HMIs. You 
manage these IDs (their creation, deletion, and their access to services/resources) on your groov EPIC. Before 
you create a user ID, consider the following questions:
• How many users do you want to create?
• What functions do you want the users to access?
• How will you secure (encrypt or password-protect) the information about the users?

Choosing Access Levels for Users

The following information can help you determine what access to give a user and what level of access to give 
a user for a particular service or feature:
• A system-wide administrator can do the following:

– Create other user accounts
– Access all applications and services running on this processor
– Change the passwords of other accounts
– Sign out any and all users currently logged into this processor
– Disable the control engine
– Change system-level settings like network, I/O, display, time and date, etc.

• groov Manage
groov Manage is an administrator-level function, so if the user is a system-wide administrator, they have 
access to groov Manage. If the user is not a system-wide administrator, they do not have access to groov 
Manage.

• groov View
There are several levels of access to groov View. These levels are available only if the user is not a 
system-wide administrator.
– Editor
– Operator
– Kiosk
– None
A system-wide administrator has administrator access to groov View, which means that they can switch 
to groov View and, when connected to the processor through a web browser, switch to build mode to 
build groov View HMIs.

• Node-RED
Access to Node-RED is either Editor or Off. For system-wide administrators, Editor is the automatic and 
only access level. For all other users, you can set the access level to either Editor or Off.

• PAC Control REST API
Access to the PAC Control REST APIs can be one of the following:
– Read-Write
– Read-Only
– None

Creating User IDs

After you consider what types of users you want to create and what they will have access to, do the following:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap Accounts ( ).
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3. Click or tap Add (in the upper right corner).
4. Type in the required information and select the permissions you want that user to have.
5. Click or tap Save (in the upper right corner).

Repeat these steps for every user account you want to create.

MANAGING THE SSL SECURITY FEATURES OF YOUR groov EPIC PROCESSOR

The SSL security features on the groov EPIC processor help you establish secure communication between the 
groov EPIC processor and web browsers, servers, brokers, and cloud services.

Learning How SSL Works on groov EPIC

If you are not familiar with SSL, you might want to spend some time reading the following OptoBlog, 
Understanding SSL/TLS and HTTPS.

Each groov EPIC processor comes with a unique certificate (called a self-signed, server SSL certificate) to 
enable communication between its internal web applications (like groov Manage, groov View, and Node-RED) 
and web browsers on computers and mobile devices. When you connect to the groov EPIC processor through 
a web browser for the first time, the browser will display a warning message that the site (in this case, the 
groov EPIC processor) is untrusted. To avoid the warning, you can install the self-signed, server SSL certificate 
into the certificate store of the web browser. Afterwards, the browser will “trust” your processor (the site) and 
no longer display that warning.

Why Change the SSL Security Features on Your groov EPIC Processor?

A self-signed certificate is useful for network situations with few users, limited accessibility, or limited scope. 
For example, an internal test lab where the groov EPIC processor communicates only to one computer or 
when you are developing your control application so that you can conduct testing in your own closed control 
network.

However, you might want to change the SSL security features on your groov EPIC processor for any of the 
following situations:
• You want to allow access to the processor by many more users and through many devices (like 

computers, smartphones, and tablets).
• You want to allow access to the processor by servers, brokers, and cloud services, like MQTT or Node-RED.
• You want to allow communication to travel through the Internet.

In these situations, you might want to switch to using a CA-signed certificate, where CA means “Certificate 
Authority”. A Certificate Authority is an organization which vouches for your groov EPIC processor’s identity. 
CA-signed certificates relieve you of the work of installing the certificate on the countless number of web 
browsers, servers, brokers, and cloud services that might want to connect to your processor. When the 
CA-signed certificate is installed on the groov EPIC processor and devices that access the processor, the 
certificate validates the connection between the user and the processor. So long as you stay connected 
directly to the groov EPIC processor on a secure connection (using https), you are protected from a 
man-in-the-middle attack.

Creating a Self-Signed Certificate

1. On a computer or mobile device, log into your groov EPIC processor with a user ID that has administrator 
privileges.

2. Click Security > Server SSL > Create Certificate.

https://blog.opto22.com/optoblog/understanding-ssl-tls-and-https
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3. In the Create Certificate page, enter the information requested.
Server Name—Enter the fully qualified domain name or IP address of this groov EPIC processor that 
client browsers will use to access it. The server name may contain letters a–z (case insensitive), digits 0–9, 
or a hyphen (-). No other characters are allowed. The server name must not start with a hyphen.
Example:
If the URL you will use to access the processor in client browsers is https://process1.acme.com, then type 
in process1.acme.com
Example:
If the URL that the client browsers will use to access the processor is https://mobilehmi.mydomain.com, 
then type in mobilehmi.mydomain.com
Email—The email address of the individual in your organization requesting the certificate and who 
would be responsible for responding to any inquiries about this certificate.
Department—Information to differentiate between divisions within an organization. For example, 
“Engineering” or “IT”. If applicable, you can enter the DBA (doing business as) name in this field.
Organization—The legally registered name of your business. The listed organization must be the legal 
registrant of the domain name in the certificate request. If you are enrolling as a small business or sole 
proprietor, please enter the certificate requester’s name in this field, and the DBA (doing business as) 
name in the Organizational Unit field.
City or Locality—Name of the city or locality where your organization is located. Please spell out the 
name of the city or locality. Do not abbreviate.
State—Name of state, province, region, territory where your organization is located. Please enter the full 
name. Do not abbreviate.
Country Code—The two-letter International Organization for Standardization (ISO-) format country 
code for the country in which your organization is legally registered. See 
http://www.digicert.com/ssl-certificate-country-codes.htm for a list of codes. For example, the code for 
the United States is US.
Days until expiration—Enter the number of days before the certificate is expired and has to be 
replaced. Opto 22 recommends 3560 (10 years).
RSA key size—Enter the size of the RSA key. The default size of 2048 is a generally recommended value. 
Higher values will take longer to create.

4. Click Create. groov Manage immediately installs the new private key and certificate, and then restarts 
groov Manage.

The processor now has new copies of the Public Certificate, Private key, and CSR, which you can download 
when you need to request a CA-signed certificate.

Switching to a CA-signed Certificate

When you switch to a CA-signed certificate, consider the following:
• The cost of a certificate from a certificate authority ranges from free to $300 or more, depending on the 

features and company you buy them from. Please work with your IT department before you begin this 
task.

• You will send the CSR to the certificate authority of your choice. The certificate authority verifies the 
identification information and signs the CSR, which then becomes a CA-signed certificate. That’s why it is 
important that you enter accurate information in step 3 of “Creating a Self-Signed Certificate” on page 46.

If you have not created a self-signed certificate, do that first. (See “Creating a Self-Signed Certificate” on 
page 46.)
1. On a computer or mobile device, log into your groov EPIC processor with a user ID that has administrator 

privileges.
2. Click Security > Server SSL > Download CSR.

http://www.digicert.com/ssl-certificate-country-codes.htm
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3. Navigate to a folder where you want to store the CSR file. Make a note of the file name and path to the 
folder. Click Save.

4. Go to the certificate authority (most likely a web site) and provide them with the information they 
request in whatever format they request.
When filling out a form for a CA-signed certificate, keep in mind that an SSL certificate works with any 
operating system. If you are asked to select an operating system, select “other” if it is an option. It’s OK to 
select a specific operating system, if necessary.

5. Finish the transaction with the certificate authority and receive your new SSL certificate.
6. Upload the new SSL certificate to your groov EPIC processor

a. Return to the View Certificate page. (See steps 1 through 2.)
b. Click Upload Certificate.
c. Click Public Certificate.
d. Navigate to the folder where you stored the new SSL certificate. Click Open. groov Manage uploads 

the file and then displays the Upload Certificate page.
e. Click Private Key.
f. Navigate to the folder where you stored the private key file. Click Open. groov Manage uploads the 

file and then displays the Upload Certificate page.
g. Click Upload (in the top right). groov Manage displays a message that it must restart. Click on Reload.

After groov Manage restarts, you can begin working with services that requires a CA-signed certificate.

Configuring SSL Communication from groov EPIC to Another Controller/Processor

If you want secure communication (with HTTPS or TLS/SSL) between your groov EPIC processor and a 
PAC Control strategy or a Node-RED flow running on another device, then you need to set up groov EPIC as a 
client and the other device as a server. You need to obtain the public key certificate from the other device (the 
server) and upload it to the groov EPIC processor (the client). The other device can be any of the following:
• another groov EPIC processor
• a groov Edge Appliance
• a SNAP PAC controller

Refer to the device’s user’s guide for instructions on obtaining the public key certificate.

Before you begin, make sure the public key certificate is stored on a computer or mobile device that can 
connect to the groov EPIC processor. On that computer or mobile device:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click Security > Client SSL.
3. In the Client Certificates window, click Add/Update.
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4. Navigate to the folder where you stored the public key certificate and select the certificate (.pem) file.
5. Click Open. groov Manage uploads the file and you’ll see it listed in the Certificates section.

If you need to upload another certificate, repeat steps 3 through 5.

Configuring SSL Communication from groov EPIC to an MQTT Broker

If you are publishing string or Sparkplug B payloads through MQTT directly from the groov EPIC processor (in 
other words, not through Ignition software) and you want to secure the communication with SSL, you need to 
setup groov EPIC as an MQTT client. As an MQTT client, groov EPIC needs to have a CA-signed certificate. If you 
don’t have a CA-signed certificate, follow the directions in “Switching to a CA-signed Certificate” on page 47 to 
request a CA-signed certificate and upload it to groov EPIC.

After you upload the CA-signed certificate:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap MQTT.
3. For each MQTT Broker that you have listed on the MQTT page and for which you want to enable SSL:

a. Click or tap the broker name to open its MQTT Broker settings window.
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b. Move the slider to the right so that it shows green ( ). groov Manage displays a new row 
below the SSL row.

Click or tap the CA Certificate field. groov Manage displays the CA Certificate window with a list of 
public key certificates installed on the processor. Select the certificate that will authenticate the 
groov EPIC processor’s MQTT client to the MQTT broker.

groov Manage refreshes the MQTT Broker settings window to show the name of the certificate you 
selected.

c. Click OK.
4. When you are done modifying all the MQTT Brokers that you wanted to change, click or tap Save.

If there are any errors in any of changes you made, groov Manage highlights the broker with the error in red. 
Select that broker to view more information about the errors. Make any necessary changes and try saving 
again.
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CONFIGURING THE FIREWALL

You might be accustomed to hearing or reading about firewalls to protect corporate networks, home 
networks, and even individual computers. The groov EPIC processor also contains firewall technology to 
protect it from unauthorized connections and communication.

Before you configure the firewall on the processor, make sure you understand the following:
• Firewall rules and how they work.
• If you need to create a new rule, you need to know the protocol you want to select (TCP, UDP, or both) 

and the port number, or range of port numbers, to which this rule will apply.
• The default firewall rules. These rules are in the firewall as part of the default factory settings:

• The reserved firewall rules. These rules are created when the corresponding license product is applied to 
your groov EPIC processor:

Creating a Firewall Rule

When you make changes to the groov EPIC processor’s firewall, the changes take effect immediately. So, make 
sure you schedule this change during a time that minimizes the impact to your system and users. If necessary, 
notify your users of this change so they can plan accordingly.

To create a new rule for the firewall:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap Security.

Component/System Port Numbers Network Interface

groov EPIC 80, 443
Allow: ETH0, ETH1, WLAN0
Deny:

OptoMMP 2001
Allow: ETH0
Deny: ETH1, WLAN0

ModbusTCP 8502
Allow: ETH0
Deny: ETH1, WLAN0

PAC Controller 22001, 22002
Allow: ETH0
Deny: ETH1, WLAN0

CODESYS Controller TCP 1217, 4840, 11740
Allow: ETH0
Deny: ETH1, WLAN0

CODESYS Controller UDP 1740–1743, 4840, 22006–22007
Allow: ETH0
Deny: ETH1, WLAN0

Component/System Port Numbers Network Interface

Ignition Edge 8043, 8060
Allow: ETH0
Deny: ETH1, WLAN0

Designer Access to Ignition Edge 8088
Allow: ETH0
Deny: ETH1, WLAN0

Shell 22
Allow: ETH0, ETH1, WLAN0
Deny:
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3. Click or tap Firewall. The Firewall page displays the rules currently in effect and may look similar to this:

[

4. Click or tap on Add Rule. Type in information for the new rule:
– Title—This will display as a new section title, which has limited space. A title of less than 30 

character fits well in the space.
– Protocol—Select which protocol this rules applies to.
– Port—Type in the port number or port number range. Specify a port range by typing in the first 

port number in the range, followed by a colon, then the last number in the port range, with no 
spaces between the numbers and the colon.

– eth0, eth1, or wlan—Select which port this rule applies to by moving the slider to the right so that 
it shows green ( ).



CHAPTER 6: CONTROLLING ACCESS TO GROOV EPIC

groov EPIC User’s Guide 53

5. Click or tap OK. If there are any errors in your selections groov Manage highlights the error and displays an 
error message.

Fix the error or errors and then click OK.
6. Repeat the previous two steps for any additional rules you want to create.
7. Click Save. groov Manage displays a message that it is configuring the firewall.

After groov Manage finishes saving and implementing the changes, it displays the Security page.

Please note that adding or changing firewall rules (which effectively opens ports in the firewall) does not start 
the listening services that may or may not be behind those ports. If you encounter problems accessing those 
services, check that the services are on and listening.
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Changing a Firewall Rule

When you make changes to the groov EPIC processor’s firewall, the changes take effect immediately. So, make 
sure you schedule this change during a time that minimizes the impact to your system and users. If necessary, 
notify your users of this change so they can plan accordingly.

To change a firewall rule:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap Security > Firewall. The Firewall page displays the rules currently in effect and may look 

similar to this:

[

3. Click or tap on the rule you want to change.
4. Make changes.
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5. Click or tap OK. If there are any errors in your changes, groov Manage highlights the error and displays an 
error message.

Fix the error or errors and then click OK.
6. Click or tap Save. groov Manage displays a message that it is configuring the firewall. If there are any 

conflicts with existing rules, groov Manage will highlight the row with the conflict and then you can 
change the rule to eliminate the conflict.

After groov Manage finishes saving and implementing the changes, it displays the Security page.

Please note that adding or changing firewall rules (which effectively opens ports in the firewall) does not start 
the listening services that may or may not be behind those ports. If you encounter problems accessing those 
services, check that the services are on and listening.
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7: Connecting groov EPIC to a 
Network or Multiple Networks

groov EPIC provides a rich set of features and functionality to connect to networks both simple and complex. 
For simple networks, groov EPIC is ready to connect right-out-of-the-box. Just plug an Ethernet cable into 
ETH0 and let the network’s DHCP server do the rest. For complex networks, there may be more factors you 
have to consider before connecting a groov EPIC processor to a network, particularly if your site runs multiple 
networks, wireless networks, or a virtual private network. You want to make sure you understand your 
network requirements and what information you need to configure your groov EPIC to successfully connect it 
to the network:
• If your site has an IT department that manages the connections of devices to the network(s), they’ll want 

to review “Identifying Your Network Setup” on page 57 to understand all of groov EPIC’s networking 
capabilities.

• If you do not have an IT department that manages your site’s network or you want to learn more about 
how networks operate in an automation setting, see Guide to Networking groov Products, (form 2161). 
This guide can help you understand:
– The basics of networking that apply to many industrial automation applications and how to 

connect groov products to these networks.
– The type of network running at your site and how you might want to connect your groov products 

to that network.
– The different ways you can communicate to the Internet from a groov product.
This chapter uses many of the concepts and terms introduced in that guide to explain how to connect a 
groov EPIC processor to a network.

Important: Begin with a wired connection to ETH0. When you assembled and initialized your 
processor, you were connected to ETH0, a wired network connection. After you complete your network configurations 
and you switch to your desired networking configuration, you may not need an active network connection to ETH0. 
In this case, you can do any of the following:

• Remove the Ethernet cable from ETH0.

• Disable ETH0 through groov Manage.

• Leave ETH0 connected to a network, though you may want to implement features to protect the processor.

IDENTIFYING YOUR NETWORK SETUP

As described in Guide to Networking groov Products (form 2161), the network at your site may be categorized 
as either a single, flat network or containing separate networks subnets (or LANs). The groov EPIC processor 
can:
• connect to a single, flat network “straight out of the box”, with little to no changes to the default network 

configurations, or

https://www.opto22.com/support/resources-tools/documents/2161-guide-to-networking-groov
https://www.opto22.com/support/resources-tools/documents/2161-guide-to-networking-groov
https://www.opto22.com/support/resources-tools/documents/2161-guide-to-networking-groov
https://www.opto22.com/support/resources-tools/documents/2161-guide-to-networking-groov
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• connect to multiple LANs, even if each LAN has different network configuration requirements.

Connecting to a Single, Flat Network

In a single, flat network, the DHCP server assigns the following to devices that join the network:
• IP address
• Subnet mask
• DNS server (its IP address and domain name)
• Gateway IP address

By default, the groov EPIC processor is set up to work in a single, flat network: you plug an Ethernet cable into 
ETH0, turn on the processor, and it automatically connects to the network. If your groov EPIC is running in a 
single, flat network and:
• you don’t need to change any of the default network settings, you can skip most of the information in 

this chapter and go straight to “Testing the Network Connections and Fine-Tuning Security” on page 71.
• you need to do either of the following:

– override the DNS server settings, and/or
– change the Gateway IP address,
then you need to obtain the new addresses and names from your IT administrator. After you obtain this 
information, configure your chosen network interface (ETH0, ETH1, or WLAN0) with this information (see 
“Configuring the Network Interfaces” on page 63).

Connecting to Multiple Networks

The groov EPIC processor provides several different network interfaces so that you can connect it to up to four 
different separate network subnets (or LANs) within the same location:
• One or two wired networks through an 

Ethernet cable connected to either ETH0 or 
ETH1.

• A wireless network through one approved 
USB WiFi adapter connected to either USB 
port. For a list of approved adapters, see 
“Installing an Approved USB WiFi Adapter” 
on page 106. (You cannot have more than 
one USB WiFi adapter plugged into the 
processor.)

• A virtual private network (VPN), connected 
through either ETH0, ETH1, or WLAN0.

ETH0, ETH1, and WLAN0 are physically separated 
from each other, which means—by default—
there is no communication or routing between 
the networks.

In very unique circumstances, you may route network traffic between two of these interfaces through a mechanism 
called port redirection. However, because there are risks to port redirection, make sure you review “Port Redirection” 
on page 61 before selecting this option.

Examples: Connecting groov EPIC to Multiple Networks (LANs)

As described in Guide to Networking groov Products (form 2161), complex networking environments can 
contain several separate network subnets (or LANs); some can be categorized as trusted, others as untrusted. 

ETH0
ETH1

USB (WLAN0)

https://www.opto22.com/support/resources-tools/documents/2161-guide-to-networking-groov
https://www.opto22.com/support/resources-tools/documents/2161-guide-to-networking-groov
https://www.opto22.com/support/resources-tools/documents/2161-guide-to-networking-groov
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You can configure the groov EPIC network interfaces in a variety of combinations to meet your networking 
needs; for example:
• Configure ETH0 to connect to a local control network (trusted) and configure ETH1 to connect to a local 

office network (untrusted).
• Configure ETH0 to connect to a local network (trusted), configure OpenVPN Tunnel 0 to connect to a 

virtual private network (trusted), and leave the other two interfaces alone or, for enhanced security, 
disable them.

• Configure ETH0 to connect to your local control network (trusted) and configure WLAN0 to connect to 
the Internet (untrusted).

In addition, your IT administrator may want to override some of the settings that the DHCP server assigns to 
the groov EPIC processor:
• Example 1—Your IT department may want to assign the groov EPIC processor a specific IP address and 

subnet mask.
• Example 2—Your IT department may want to assign a specific gateway address or assign a specific DNS 

server IP address and domain name to a network interface.
• Example 3—Your IT department may want to route traffic leaving the groov EPIC processor through a 

specific path by controlling which DNS server the processor queries.
• Example 4—Your IT department may want to route traffic from one network interface (ETH0, ETH1, 

WLAN, or OpenVPN Tunnel 0) to another network interface. This is referred to as port redirection.

All of these examples demonstrate how important it is to work with your IT administrator before you begin 
making changes to more advanced network settings.

KEEPING NETWORKS SEPARATE

Each groov EPIC network interface (ETH0, ETH1, and WLAN0) must be connected to a separate network1. 
Because complex networks include networking equipment like routers, hubs, and switches, it’s possible that 
some of the networking equipment might be connected to the same network. Before you connect a 
groov EPIC to a network, check the following items:
• Do not connect the Ethernet cables that are connected to ETH0 and ETH1 to the same switch, hub, or 

router.
• If you do connect the cables to different switches, hubs, or routers, make sure that those switches, hubs, 

or routers are not connected to the same network. Check with your IT department to ensure these 
devices are not on the same network.

• Make sure that the wireless access point (SSID) that you select for WLAN0 is not on the same network as 
either ETH0 or ETH1.

CHOOSING BETWEEN AUTOMATIC AND MANUAL CONNECTIONS

Each network interface on the groov EPIC processor can connect to a network automatically or manually. By 
default, all the interfaces are configured to connect automatically.

Automatic Connections

The DHCP server assigns the IP address and subnet mask. Select this method if:

1 If you configure port redirection, you’ll have two network interfaces connected to the same network. Make sure 
you understand the risks and how port redirection works.



UNDERSTANDING ADVANCED NETWORKING CONFIGURATIONS

groov EPIC User’s Guide60

• The groov EPIC processor is connecting to a single, flat network and you don’t need to change any of the 
default network settings.

• The DHCP server can assign the IP address and subnet mask, but you or your network administrator want 
to override the gateway address or DNS IP address and name server that may have been assigned by the 
DHCP server.

For wired connections: There is no additional information that you need to collect.

For a wireless connection: You need to collect the following information:
– SSID—A text string from 1 to 32 characters that uniquely identifies the wireless network. This 

should be the name of the wireless network access point you want the groov EPIC processor to join.
– Encryption—The type of encryption that the wireless network uses to secure the packets. Available 

options are: None (packets are not encrypted), WEP, WPA, and WPA2.
– Key Type—WLAN0 supports the following options:

– Passphrase (ASCII)—This is the typical key type for WPA.
– PSK (HEX)—This is the typical key type for WEP.

– Key—The password the groov EPIC processor must provide when it tries to join the wireless 
network. For security reasons, keep this information secure.

Manual Connections

You’ll want to choose manual connections if you need to implement any of the advanced network 
configurations described in “Understanding Advanced Networking Configurations” on page 60. Work with 
your IT department (if available) to collect the following information:
• IP Address and Subnet Mask—These two pieces of information work together to create a unique 

network address. It’s very important that you create a unique network address by assigning each network 
interface a different IP address and subnet mask. While the IP address must be different than any other 
device on the same network, the subnet mask must be the same as all other devices on the same network. 
For example:
– All the devices on network A are assigned a subnet mask of 255.255.0.0.
– All the devices on network B are assigned a subnet mask of 255.0.0.0.
If you connect the processor to network A, make sure to specify 255.255.0.0 as the subnet mask.

• For wireless communications, in addition to the IP address and subnet mask, you need to collect the 
SSID, Encryption, Key Type, and Key, as described “Automatic Connections” on page 59.

UNDERSTANDING ADVANCED NETWORKING CONFIGURATIONS

The advanced network configuration settings described in this section are for IT administrators that have 
special requirements for devices that connect to the network(s) they maintain. These settings require 
knowledge of advanced networking concepts and practices. Most of the following options are available on all 
the network interfaces (ETH0, ETH1, WLAN0, and TUN0):
• “Port Redirection” on page 61
• “Overriding the DNS Server IP Address and Domain Name Assigned by DHCP Server” on page 61
• “Adding DNS Servers and Specifying the Order in which DNS Servers are Queried” on page 61
• “Adding Gateway IP Address or Overriding Gateway IP Address Assigned by DHCP Server” on page 62 
• “Altering Gateway Query Order” on page 62
• “Static Routes” on page 62
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Port Redirection

You should only implement port redirection on your groov EPIC if you are redirecting packets between two 
trusted networks connected to the groov EPIC network interfaces (ETH0, ETH1, WLAN0, or TUN0). Make sure 
you read the following two documents and discuss your plans with your IT administrator:
• Guide to Networking groov Products (form 2161)
• groov EPIC Cybersecurity Design and Best Practices Technical Note (form 2310)

It’s important to understand the risks and create mitigation plans for those risks.

You’ll need to collect the following information to create rules in groov Manage to indicate that network traffic 
that arrives through a port on one network interface (the external port) is redirected to a port on another 
interface (the redirect port).
• Title—(Optional) A descriptive name for the rule. The name can be only letters (in either upper-case, 

lower-case, or mixed case) and numbers; no spaces or special characters.
• Protocol—The protocol (tcp, udp, or both) used by the packets.
• External Port—The port number through which packets arrive.
• External Interface—The network interface (ETH0, ETH1, WLAN0, or TUN0) through which packets 

arrive.
• Redirect Address—groov EPIC sends (redirects) the packets to this IP address.
• Redirect Port—groov EPIC sends (redirects) the packets to this port number. 
• Redirect Interface—groov EPIC sends (redirects) to this network interface (ETH0, ETH1, WLAN0, or 

TUN0).
• Source—(Optional) Indicates that this rules applies only to packets received from this IP address or 

subnet. This is a way to limit which device (if you specify an IP address) or devices (if you specify a subnet) 
on a network can use port redirection.

Overriding the DNS Server IP Address and Domain Name Assigned by DHCP Server

If your network policy is for the DHCP server to assign the IP address and subnet mask, but the IT administrator 
manually assigns the domain name server (DNS), you will need the IP address and domain name of that 
server. You can specify up to three DNS servers.

Adding DNS Servers and Specifying the Order in which DNS Servers are Queried

You can assign up to three domain name servers to each network interface on the groov EPIC processor and 
indicate the order in which to communicate with the servers. You can set the DNS Order of a network 
provisioning domain to specify the priority that name servers and search domains are added to the DNS 
resolver's configuration, which has a maximum limit of three name servers and six search domains. When a 
DNS request is made, the resolver queries name servers in series in the order defined in the configuration. If a 
response is received with either a successful resolution or with a reply code such as "Name not found", no 
other name servers are queried. If the DNS request times out, the next name server is tried until all name 
servers are exhausted. Be aware that name resolution of secondary and tertiary name servers may be slow due 
to the sequential nature of queries by the DNS resolver.

For each network interface that requires this configuration, you will need:
• DNS Server Override and DNS Domain Override—The DNS server IP addresses and domain name. 

You can specify up to three DNS servers.
• DNS Order—A number, beginning with 1, that identifies the order in which network interfaces are 

queried. Number 1 indicates the first network interface to be queried.

https://www.opto22.com/support/resources-tools/documents/2161-guide-to-networking-groov
https://www.opto22.com/support/resources-tools/documents/2310-groov-epic-security-design-and-best-practices
https://www.opto22.com/support/resources-tools/documents/2310-groov-epic-security-design-and-best-practices
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Adding Gateway IP Address or Overriding Gateway IP Address Assigned by DHCP Server

If your network policy requires the assignment of a specific gateway IP address, review the information in 
“Redirecting Traffic Initiated by an Incoming Connection Request” on page 335 to understand how the 
groov EPIC processor manages gateway assignments and prioritizes their use.

For each network interface that requires this configuration, you will need the gateway IP address.

Altering Gateway Query Order

The Gateway Order controls the order in which a network interface's gateway is queried for off-subnet 
destination-based routing, with 1 being the highest priority (the network interface queried first). You can alter 
this order by changing the number. The gateway associated with the active interface with the lowest gateway 
order will be used as the default gateway. For more information about this topic, see “H: Advanced 
Networking Configurations” on page 335.

Static Routes

Network administrators create static routes to help balance network traffic in small networks. As a packet 
travels through a network, it travels through different networking equipment and devices (like a groov EPIC) 
on its way to its destination. Each piece of equipment or device that it travels through is called a hop. If a 
network administrator identifies that certain packets destined for a specific IP address create a heavy traffic 
pattern, the administrator can help alleviate the heavy traffic by modifying one of the hops along the route.

If a network administrator identifies a groov EPIC as one hop in a heavily traveled route, the administrator can 
modify the groov EPIC’s network interface to redirect the packets through a different gateway. To indicate 
which gateway the packet should travel and which packets should travel through that gateway, you’ll need:
• Nexthop Address or Subnet—The IP address of the next hop along the route that the packet would 

normally travel through.
• Gateway Address—The IP address of the gateway through which the packet should travel.
• Interface—Identifies the network interface on the groov EPIC through which the packets travel.

You can have multiple static routes so that you can direct packets with different next hop addresses to 
different gateways.

Collecting Network Configuration Information for OpenVPN Connection

There are many resources available online to help you learn about and set up a virtual private network (VPN) 
with OpenVPN technology. This section assumes you have a functioning OpenVPN server. The groov EPIC 
processor works as an OpenVPN client that connects to the OpenVPN server. (The groov EPIC processor cannot 
be set up as an OpenVPN server.) You’ll need the OpenVPN server administrator to provide you with the 
following:
• A username and password to login to the OpenVPN server.
• If necessary, a username and password for proxy connections.
• Depending on the security and authentication configuration of the OpenVPN server, you may need some 

or all of these files or information:
– A public key, also known as a certificate, which is typically available as a file that ends in .crt.
– A private key that is created specifically for the groov EPIC processor. It is typically available as a file 

that ends in .key.
– A Certificate Authority (CA) certificate and key, which helps verify the public and private keys. These 

are also typically provided in files, with the certificate file that ends in .crt and the key file that 
ends in .key.

– An OpenVPN static key, if required. Not all sites implement OpenVPN static keys. This key is typically 
stored in a file called static.key.
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• The following server information:
– Protocol–The communications protocol used by the OpenVPN server.
– OpenVPN server hostname and port number–The hostname is usually a fully-qualified domain 

name (for example, vpnserver.example.com) or it could be an IP address.
– Encryption Cipher–The encryption cipher used by the OpenVPN server.
– LZO Compression–If the OpenVPN server uses LZO compression, then you will need to enable it 

on the groov EPIC processor.

Some of this information can be provided in a configuration file, which you can then upload into the 
groov EPIC processor. Uploading a configuration file could make configuring the processor easier and you will 
be less likely to introduce typing errors. When you receive the configuration file, review it to make sure it has 
the following information (and in the format indicated), as appropriate for your OpenVPN server’s security and 
authentication configuration:
• Certificate Authority (CA)—The CA section should be surrounded by <ca> and </ca> tags. Inside those 

tags, the certificate text should be surrounded by <cert> and </cert> tags.
• Private and Public Key—The key text should be surrounded by <key> and </key> tags.
• Open VPN static key—The key text should be surrounded by <tls-auth> and </tls-auth> tags.

If it doesn’t contain this information, you can edit the file and add it, making sure it is surrounded by the tags 
described previously.

If the administrator can’t provide a configuration file, print the following table to collect the above 
information, save it in a secure place, and have it handy when you follow the instructions in “Connecting to a 
Virtual Private Network (VPN)” on page 67.

CONFIGURING THE NETWORK INTERFACES

Changes to network interfaces require a restart of the network connections on the processor. Schedule this 
task at a time that minimizes the impact on your application and equipment.
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap Network.
3. Click or tap Configure. groov Manage displays the Network configuration page. The example below 

shows the default settings.



CONFIGURING THE NETWORK INTERFACES

groov EPIC User’s Guide64

If you are connecting to a single, flat network, and you only need to provide overrides for gateway 
and DNS (and adjust their order), enter the new information in this page.

If you are connecting to multiple networks, make sure you’ve decided which interface will connect to 
which network and that you gathered all the information you need to configure those interfaces. With that 
information, configure each interface:
• “Configuring ETH0 or ETH1” on page 64 (wired)
• “Configuring WLAN0” on page 65 (wireless)
• “Connecting to a Virtual Private Network (VPN)” on page 67

If you want to disable a network interface, see“Disabling a Network Interface” on page 66.

When you are done with all the configurations, go to “Saving the Configuration” on page 67.

Configuring ETH0 or ETH1

You’ll want to have the information you collected when you read through “Choosing Between Automatic and 
Manual Connections” on page 59 and “Understanding Advanced Networking Configurations” on page 60 
available as you follow these steps:
1. From the Network configuration page, click or tap the IPv4 Method currently assigned (the text in green) 

to ETH0 or ETH1. groov Manage displays the IPv4 Method window.

The Ethernet 1 section shows the current settings for ETH1 
(see the diagram on page 58).

Wi-Fi shows the current settings for WLAN0 (see the 
diagram on page 58).

OpenVPN Tunnel 0 shows the current settings for a virtual 
private network.

The Ethernet 0 section shows the current settings for ETH0 
(see the diagram on page 58).
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2. Click or tap the connection method you want.
– If you selected Automatic and you don’t want to override the DHCP server settings for gateway, DNS 

address, and DNS name server, skip to step 3. Otherwise, now is when you enter those override 
values you collected in “Automatic Connections” on page 59.

– If you selected Manual, the Network configuration page changes to display additional fields.

What you enter in these fields depends on which advanced configuration you want to implement 
(see “Understanding Advanced Networking Configurations” on page 60).

Note: For DNS Server 1 and DNS Domain 1, these two fields must be specified as a set. If you need to enter more 
than one set, groov Manage displays another set of fields after you enter the first set:

•DNS Server 1 Override with its corresponding DNS Domain 1 Override
•DNS Server 2 Override with its corresponding DNS Domain 2 Override
•DNS Server 3 Override with its corresponding DNS Domain 3 Override

3. Choose from the following:
– If you need to configure another network interface for wired communication, return to step 1.
– If you need to configure WLAN0 for wireless communications, go to “Configuring WLAN0” on 

page 65.
– If you are done configuring the physical network interfaces, go to “Saving the Configuration” on 

page 67.

Configuring WLAN0

1. From the Network configuration page, click or tap the IPv4 Method in the Wi-Fi section and select the 
connection method you want. groov Manage updates the Network configuration page as shown below 
(automatic on the left, manual on the right):
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– If you selected Automatic and you don’t want to override the DHCP server settings for gateway, DNS 
address, and DNS name server, skip to step 2. Otherwise, now is when you enter those override 
values you collected in “Automatic Connections” on page 59.

– If you selected Manual, what you enter in these fields depends on which advanced configuration 
you want to implement (see “Understanding Advanced Networking Configurations” on page 60).

2. Choose from the following:
– If you need to configure a network interface for wired communication, see “Configuring ETH0 or 

ETH1” on page 64.
– If you are done configuring the network interfaces, go to “Saving the Configuration” on page 67.

Disabling a Network Interface

When you disable a network interface, the network interface is closed and network access is denied.

Important: Do not disable all network interfaces unless you have physical access to the processor. If you disable 
all the interfaces, the only way to reopen needed interfaces and gain network access is for an authorized 
groov Manage user with administrator privileges to log in through the built-in display and enable the needed 
interfaces. If you do not have such a user, you will need reset your processor to factory defaults (see “How to Reset to 
Factory Defaults” on page 234).

1. From the Network configuration page, click or tap the IPv4 Method currently assigned (the text in green) 
to the network interface you want to disable. groov Manage displays the IPv4 Method window.

2. Click Disabled.
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SAVING THE CONFIGURATION

In the Network configuration page, click or tap on Save. groov Manage displays a message that it will restart 
the network connections.

After the network is restarted, you can test the network connections and fine-tune your security settings. If 
you need to set up a virtual private network (VPN), see “Connecting to a Virtual Private Network (VPN)” on 
page 67.

CONNECTING TO A VIRTUAL PRIVATE NETWORK (VPN)

Before you begin:
• Make sure you’ve configured at least one physical network interface (see “Configuring the Network 

Interfaces” on page 63) and that it’s functioning.
• Check that you have all the information you collected when you reviewed “Collecting Network 

Configuration Information for OpenVPN Connection” on page 62.
• Verify that the OpenVPN server is reachable.

Let’s begin:
1. From a browser, connect to the groov EPIC processor and log into groov Manage with a user ID and 

password that has administrator privileges.
2. If you will be entering the configuration manually (without a configuration file as described in “Collecting 

Network Configuration Information for OpenVPN Connection” on page 62), upload the public key.
a. From the groov Manage Home page, click Security > Client SSL.
b. Click Add/Update.
c. Navigate to the folder where you stored the public key (.crt) file.
d. Select the key, then click Open.

3. Click Back > Home to return to the groov Manage Home page, then click System > Network.
4. Click Configure.
5. In the OpenVPN Tunnel 0 section, click IPv4 Method and select Automatic (DHCP).
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6. Enter the configuration information you collected when you reviewed “Collecting Network Configuration 
Information for OpenVPN Connection” on page 62.
– If your VPN information is in a client configuration file, click Upload Configuration File. Navigate to 

the folder where you stored the configuration file, select it, then click Open. Click Set User 
Credentials to enter the OpenVPN server user name and password. If necessary, click Set Proxy 
Credentials to enter the proxy credentials. Go to step 7.

– If you need to enter the configuration information manually, click the User Configuration Wizard 
switch so that it turns green.

a. Click Protocol to select the protocol used by your 
OpenVPN server.

b. Enter the IP address or full domain name of the 
OpenVPN server in the Remote Host field

c. To enter the port number, click in the space 
between the - and + sign. Type in the port 
number.

d. Click Select Certificate and select the certificate 
you uploaded in step 2 on page 67.

e. In the Username and Password fields, type in the 
OpenVPN server username and password. (Not 
the proxy username and password.)

f. Click Encryption Cipher and select the cipher 
used by your OpenVPN server from the list.

g. If the OpenVPN server users LZO compression, 
slide the LZO Compress switch to the right, until it 
turns green.

h. If you need to modify the Gateway and DNS order, click on those numbers and change them.
7. Click Save. If groov Manage reports any errors, fix those errors and click Save. Otherwise, groov Manage 

displays a message that it will restart the network connections.



CHAPTER 7: CONNECTING GROOV EPIC TO A NETWORK OR MULTIPLE NETWORKS

groov EPIC User’s Guide 69

CONFIGURING FOR PORT REDIRECTION

Make sure you reviewed “Port Redirection” on page 61 and that you collected all the information described in 
that section.
1. Log in with ID that has system level privileges.
2. Click Network > Port Redirect. groov Manage displays the Port Redirect page:
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3. Click Add Rule. groov Manage displays the New Rule page:

4. Fill out the fields with the information described in “Port Redirection” on page 61.
5. Click OK. If groov Manage reports any errors, fix those errors and click Save. Otherwise, groov Manage 

displays a message that it will restart the network connections.
6. If you need to create another rule, repeat steps 3 through 5.
7. Click Save.

ADDING A STATIC ROUTE

Make sure you reviewed “Static Routes” on page 62 and that you collected all the information described in 
that section.
1. Log in with ID that has system level privileges.
2. Click Network > Static Routes. groov Manage displays the Static Routes page:
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3. Click Add Route. groov Manage displays the New Route page:

4. Fill out the fields with the information you collected in “Static Routes” on page 62.
5. Click OK. If groov Manage reports any errors, fix those errors and click Save. Otherwise, groov Manage 

displays a message that it will restart the network connections.
6. If you need to create another route, repeat steps 3 through 5.
7. Click Save.

TESTING THE NETWORK CONNECTIONS AND FINE-TUNING SECURITY

To test the network connections, do one of the following:
• If you switched to Automatic, wait a few seconds for the processor to receive an IP address from the 

DHCP server. The logon page will refresh and display the IP address after it receives it.
• If you switched to Manual, verify that the IP address works by trying to connect to the processor from a 

web browser. Or, from a Windows computer that’s connected to the same network, you can try the ping 
command in a command prompt window.

If you encounter any issues with ETH0, ETH1, and WLAN0, see Chapter 19: Troubleshooting for topics 
regarding network connections. If you are troubleshooting issues with an OpenVPN connection, you can 
review the VPN client logs for messages. To access the logs, from the groov Manage home page, click Info and 
Help > Logs > OpenVPN Client.

For enhanced security, disable any network interfaces you aren’t using. For example, if you are not using ETH0, 
remember to do one of the options listed in the note labeled “Important: Begin with a wired connection to 
ETH0” on page 57.

You may also want to update your security options and firewall settings:
• “Managing the SSL Security Features of your groov EPIC Processor” on page 46
• “Configuring the Firewall” on page 51
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8: Enabling MQTT

WHAT IS MQTT?

MQTT is a publish/subscribe (pub/sub) protocol that’s suited to many IIoT applications because of its 
architecture.

In a pub/sub architecture, a central source, called a broker, receives, distributes, and, in some cases, stores data. 
MQTT clients can publish data to the broker or subscribe to get data from a broker (or both). Clients who 
publish data send it only when the data changes. Clients who subscribe to data automatically receive it from 
the broker only when it changes. To view a video that explains how an MQTT broker works and why it’s a great 
choice for automation applications, visit our website (www.opto22.com), and search for “What is an MQTT 
broker?”

Contrast this with a client/server architecture. With this architecture, the client and server must be connected, 
because the client requests data directly from the server. The client doesn’t know when the data changes, so it 
must request it at regular intervals.

MQTT pub/sub offers three main advantages over client/server for IoT applications:
• Network traffic is reduced overall, because data is published and sent only when it changes, rather than 

at regular intervals.
• Because the broker is a central source that manages data, servers don’t have to strain to serve multiple 

clients. And even remote devices with irregular connections or low bandwidth can publish or subscribe 
to data. If a publisher can’t connect to the broker, for example, the publisher can optionally buffer its data 
and send it at a later time.

• For data publishers and subscribers, there’s another important advantage: data is published and 
subscriptions are initiated through an outbound connection. Most firewalls block inbound traffic 
requests (for example, an external OPC client requesting data from an internal OPC server), but they allow 
outbound connections over secure TCP ports.

For more information about the protocol, see mqtt.org.

LEARNING HOW groov EPIC WORKS WITH MQTT

There are many things to consider when you include a groov EPIC into an existing MQTT infrastructure. 
groov EPIC offers two different MQTT clients and can publish data in two different payload formats: string and 
Sparkplug B. To help you choose the MQTT client and payload format best suited for your application, review 
Getting Started with MQTT in groov Products (form 2350). That guide describes important factors that can 
influence which client and payload format you choose. It also provides high-level instructions on how to 
configure your groov EPIC for specific scenarios. After reviewing that document, you can get more information 
in this guide about:

https://www.opto22.com/support/resources-tools/documents/2350-getting-started-with-mqtt-in-groov-products
http://mqtt.org/
https://www.opto22.com
https://www.opto22.com/support/resources-tools/videos/video-what-is-an-mqtt-broker
https://www.opto22.com/support/resources-tools/videos/video-what-is-an-mqtt-broker
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• Configuring and enabling the groov Manage MQTT client, which is described in this chapter.
• Configuring and enabling the Ignition/Ignition Edge MQTT client, which is described in Chapter 9: 

Enabling Ignition or Ignition Edge.

Running Multiple MQTT Clients on a groov EPIC Processor

You can run the Ignition/Ignition Edge MQTT client with either of the following clients at the same time:
• groov Manage MQTT client publishing Sparkplug B payloads
• groov Manage MQTT client publishing string payloads

However, you cannot run the groov Manage MQTT client and publish both Sparkplug B payloads and string 
payloads at the same time.

CONFIGURING AND ENABLING THE groov MANAGE MQTT CLIENT

To help the configuration go more smoothly, it’s helpful to first collect some information about the MQTT 
broker, what you need to define or include the groov EPIC processor in a topic namespace, and review some 
settings that may affect the transmission performance of the processor.

Collecting Information About the MQTT Broker

You’ll need to collect the following information about the MQTT broker:
• Broker URL—The URL of the MQTT server. If your connection to the broker is secured with SSL, begin 

the URL with ssl:\\; if not, begin it with tcp:\\.
• Client ID— This is optional. Only enter a client ID if one was supplied. If you do not enter a client ID, the 

MQTT service will generate one.
• Username—The username you need to access the broker.
• Password—The password you need to access the broker. This is optional, not all MQTT implementations 

require a password.
• SSL—If your MQTT server requires SSL, make sure you upload the correct SSL certificate (before you 

begin configuring the MQTT service), as described in “Configuring SSL Communication from groov EPIC 
to an MQTT Broker” on page 49.

• ConnTimeout (ms)—The default connection timeout value is 5000 milliseconds. You can adjust this 
value to account for slower or faster infrastructures. (For example, if your groov EPIC processor is in an area 
with “spotty” or slow connection, you may want to increase this value.) The minimum is 1000; the 
maximum is 30,000.

• Keep Alive (s)—The number of seconds between heartbeats. If there is no heartbeat for longer than the 
keep alive time, the last will and testament is sent.

Specifying Default Topics or Unique Identifiers for the groov EPIC Processor

You’ll need to collect or create the following information to uniquely identify your groov EPIC processor in your 
MQTT infrastructure (topic namespace). If necessary, consult with someone that assigns topics to determine if 
the processor will be assigned a specific set of topics, and whether you should follow a particular naming 
convention.

For String Payloads

All of the following information is required:
• MQTT Base Topic—The base topic is prefixed to the MQTT topic used to publish data.
• MQTT Group Topic—Identifies the group that your groov EPIC processor belongs to.
• MQTT Subgroup Topic —Identifies a subdivision within the group.
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In addition, you’ll need:
• MQTT Device Topic—Identifies your groov EPIC processor within the subgroup.
• Use Comma in Floats—If your application uses a comma to separate values (for example, pi is denoted 

as 3,14 instead of 3.14), you’ll want to indicate that when you enter configuration information in 
groov Manage.

For Sparkplug B Payloads

• Group ID—Identifies the group that your groov EPIC processor belongs to.
• Edge Node ID—Identifies a subdivision within the group.
• Device ID—Identifies your groov EPIC processor within Edge node.

You will also need:
• Primary Host ID—This is optional. It enables notifications as to the “state” (offline or online) of the MQTT 

server.
• Compression—The algorithm used to compress payloads before they are published to the MQTT 

server, if necessary.

Assigning a Device ID and Reviewing Performance Settings

The content of the payload can be either tag data or OptoMMP memory maps; you can transmit one or both 
types of content. This flexibility can make the groov EPIC processor look like two differences devices:
• The device that transmits tag data is of type Controller.
• The device that transmits OptoMMP memory maps is of type OptoMMP.

You create unique ID called a device ID to differentiate one from the other. Each device can have its own 
performance and connectivity settings, which can affect throughput in an MQTT infrastructure. You configure 
these settings when you create the device and then you can fine-tune the settings as you monitor the device’s 
performance.

For each device you want to create, collect the following information:
• Device ID—This is a unique ID that identifies the type of device data you are transmitting from your 

groov EPIC processor: tag or OptoMMP memory maps. If you want to transmit both tag data and 
OptoMMP memory maps, you will create two devices and each will require a device ID, so it would be 
helpful to indicate in the name which is OptoMMP and which is tag data. For example, MyEPIC_tags 
for tag data and MyEPIC_OptoMMP for OptoMMP memory maps.

• Host TCP Port—(Controller only.) This is the value of the groov EPIC processor's host TCP port. The 
default TCP port number is 22001. If you change this value, the new value must match the processor's 
host port.

• CommTimeout(ms)—The number of milliseconds that MQTT waits for the controller to respond to a 
request. If you set this value too small, you may see erratic communication timeouts.

• Scan Time (ms)—The scan interval in milliseconds. You may need to adjust this if the scans can’t finish 
before the time is up.

• Historic Queue—(Sparkplug B format only) The maximum number of publications that may be saved 
in memory when the connection to the broker fails. The value may range from 0 to 65535. Opto 22 
recommends a value of 3600, a value that takes into account the fixed size of memory, which is also 
utilized by system applications. You may want to change this value after considering the following 
factors:
– Memory is limited. Saving publications can quickly consume memory. The publications are 

stored in memory, so when you specify a large value, memory can be consumed quickly.
– Scan Time and frequency of change in values. The following examples show why these two 

factors can create a large difference in the number of publications created:
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– Scan Time: 1 millisecond vs 1 second scan time. In a 2 second time period, the 1 millisecond 
scan time could create 2000 publications, whereas the 1 second scan time could create only 
two publications. (The Scan Time is the value you entered in the Scan Time field; see above.)

– A tag that changes value every second versus every hour. In a 2 hour time period, a tag that 
changes value every second could create up to 7200 publications, whereas a tag that changes 
value every hour could create only two publications.

Scan Time and frequency of change are closely related: a publication is produced only when the 
value of a tag changes. Working with the example we created with Scan Time (above): If a tag is 
scanned every millisecond, but the values changes only ever 10 milliseconds, then the number of 
publications created would be 200, instead of 2000.
Review your Scan Time and how frequently the values of your tags may change within a given time 
period to help you estimate how many publications might be created.

– The size of a publication can vary greatly. Publications created by a PAC Control strategy can 
contain many tags (in the thousands). Publications created directly by the MQTT service on your 
EPIC processor or RIO module can contain as few as one tag.

– The number of devices creating publications simultaneously. If you are configuring MQTT on a 
groov EPIC processor, you can create one or two MQTT devices to scan for values, each creating 
publications. (To learn more about multiple devices, see the first paragraph under “Assigning a 
Device ID and Reviewing Performance Settings” on page 75.) If you are running two devices, you are 
creating more publications than if you run one device.

– If you are configuring MQTT on a RIO module, the two previously mentioned factors (size of 
publications and number of devices) are less likely to quickly consume memory because:
– A RIO module doesn’t run PAC Control strategies, therefore the publications won’t be as large as 

those produced by a PAC Control strategy. If you are creating publications straight from the 
MQTT service (instead of from a PAC Control strategy), a RIO module creates publications with 
fewer tags than an EPIC processor, so it creates smaller publications.

– A RIO module can run only one MQTT device, therefore you won’t have a second device also 
creating publications.

For these two reasons, you may be able to specify a higher value for Historic Queue. However, you 
should still evaluate how Scan Time and frequency of tag changes (as described above) can affect 
how many publications are generated, which then affects how much memory is consumed.

If the number of publications exceeds this value, the oldest entries are discarded to make room for newer 
entries.

Configuring and Enabling the groov Manage MQTT Client

Make sure you are logged into your groov EPIC processor with an ID with administrator privileges before 
starting:
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1. From the groov Manage Home page, click MQTT, then Configuration.

2. In the Edge Node section:
a. If you need to change the payload format, click MQTT Payload, and then select the format that you 

want.

b. In the fields under the MQTT Payload field, enter the information you collected in “Specifying 
Default Topics or Unique Identifiers for the groov EPIC Processor” on page 74.

3. Click Add MQTT Broker. 

Enter the information you collected in “Collecting Information About the MQTT Broker” on page 74. Click 
OK to close the MQTT Broker window and return to the MQTT page.
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4. Click Add Device.

Using the information you collected in “Assigning a Device ID and Reviewing Performance Settings” on 
page 75, click Device Type and select either Controller or OptoMMP. Then fill out the rest of the fields with 
the information you collected.

5. Click OK.
6. Click Save. groov Manage validates the information that you entered.

– If there are errors, groov Manage prompts you to fix the errors, highlighting (in red) the fields with 
invalid information. After you fix the errors, you can click Save.

– If there are no errors, groov Manage saves the settings and then prompts you to confirm that you 
want to start the MQTT service. Click Yes. When it is done, groov Manage displays the MQTT page.
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9: Enabling Ignition or Ignition 
Edge

WHAT IS IGNITION AND IGNITION EDGE?

Ignition and Ignition Edge are Industrial Internet of Things (IIoT) software applications developed by Inductive 
Automation to help you develop applications for the network’s edge. They are included in your groov EPIC 
processor and provide two key connectivity tools for IIoT applications:
• An internal OPC UA server and drivers for a number of commonly used PLCs, plus devices that 

communicate through Modbus/TCP. Additional drivers may be available for purchase from Inductive 
Automation and their partners.

• An MQTT module that enables the transmission of payloads that follow the Sparkplug B specification. 
MQTT is a transport protocol that is highly useful in IIoT applications because of its architecture. To 
understand what sets it apart from other protocols, see “What is MQTT?” on page 73.

Because Ignition and Ignition Edge are included in the groov EPIC processor, you can use their tags (in your 
groov View operator interface, Node-RED flows, and MQTT with Sparkplug payload communications):
• Without having to purchase a separate OPC UA server
• Without requiring a PC at the network’s edge

The groov EPIC processor with Ignition or Ignition Edge are especially useful for the plant floor, geographically 
dispersed locations, and OEMs, because everything is included in one compact, secure, industrial appliance. 

With Ignition or Ignition Edge in the groov EPIC processor:
• Data from many PLCs becomes easier to access for IIoT applications. 
• Authorized operators can monitor and control these PLC systems from your groov View operator 

interface.
• All data in Ignition or Ignition Edge can be published and subscribed to via MQTT.
• Node-RED flows can use tags from the Ignition or Ignition Edge tag database.
• It’s easy to add other Inductive Automation products: 

– Other Ignition- or Ignition Edge-compatible modules
– Additional drivers like DNP3, Omron®, and TCP/UDP
– Ignition Edge Panel or Enterprise Administration Module (EAM)

You can work with either the Ignition or Ignition Edge applications on the groov EPIC processor:
– Through the Ignition Edge application, only the Ignition Edge applications and internal applications 

(like Node-RED and groov View) can access the OPC UA server. (This option requires the 
GROOV-LIC-EDGE license.)

– Through the Ignition platform, external applications can access the OPC UA server. (This requires the 
purchase of a full Ignition license; the GROOV-LIC-EDGE license is not compatible with the Ignition 
platform.)

https://www.opto22.com/products/product-container/groov-lic-edge
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The version of Ignition and Ignition Edge software:
• GRV-EPIC-PR1: Ships with version 7, though it can be upgraded to version 8 through a firmware update.
• GRV-EPIC-PR2: Ships with version 8. It cannot run version 7.

ENABLING AND CONFIGURING IGNITION/IGNITION EDGE CHECKLIST

groov EPIC processors can support several ways of running Ignition or Ignition Edge software. You can:
• Select between running with version 7 (GRV-EPIC-PR1 only) or version 8 (GRV-EPIC-PR1 or 

GRV-EPIC-PR2).
• Select between running Ignition or Ignition Edge.

Carefully go through this checklist to properly select, enable, and configure the combination that’s right for 
your application:
 Select between Ignition version 7 or Ignition version 8.

– If you select Ignition version 7, continue to the next step. Remember that version 7 runs only on 
GRV-EPIC-PR1.

– If you select Ignition version 8 on a GRV-EPIC-PR1, you need to download and install another 
groov EPIC firmware file. For instructions, see Appendix J: Installing groov EPIC Firmware with 
Ignition Version 8, then return to this list and continue to the next step.

Important: If your groov EPIC processor is running firmware version earlier than 3.0.0, you cannot go directly 
from your version of the groov EPIC firmware to the groov EPIC firmware version that contains Ignition version 
8. You must first install groov EPIC firmware 3.0.0 (or later) that has ignition7 in the file name, then install 
groov EPIC Firmware with Ignition Version 8 (which as ignition8 in the file name).

 Select between Ignition or Ignition Edge and make sure you have the correct license. For an explanation 
of the two types and how to obtain the correct license, see “Choosing Between Ignition or Ignition Edge” 
on page 81.

 In groov Manage, select your preferred Ignition software platform. For step-by-step instructions, see 
“Enabling Ignition or Ignition Edge” on page 81.

 Configure the gateway to:
– Set the correct authentication and tag exposure settings for the OPC UA server.
– Set the correct SSL security settings.
If you selected Ignition Edge, see “Configuring the Ignition Edge Gateway” on page 83.
If you selected Ignition, refer to the Ignition User Manual for any configuration information regarding 
security and authentication.

 License the Ignition software.
– If you selected Ignition Edge, see “Installing (Activating) the Ignition Edge License” on page 85.
– If you selected Ignition, refer to the Ignition User Manual.

 Change the default password on the Ignition Edge Gateway. For step-by-step instructions, see “Changing 
the Default Password for Ignition Edge Gateway” on page 87.

 Install the Opto 22 groov EPIC and SNAP PAC Driver. For detailed instructions, see “Installing the OPC UA 
groov EPIC and SNAP PAC Driver” on page 88.

 Install the MQTT module. For detailed instructions, see “Installing the Ignition Edge MQTT Module” on 
page 88.

https://docs.inductiveautomation.com
https://docs.inductiveautomation.com
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CHOOSING BETWEEN IGNITION OR IGNITION EDGE

Ignition and Ignition Edge are two platforms by Inductive Automation. Either platform can help you with the 
functions listed in “What is Ignition and Ignition Edge?” on page 79. One of the major differences between the 
two platforms is that, with Ignition Edge, the OPC UA server and drivers are available only to internal 
applications—applications running on the groov EPIC processor (for example, Node-RED and groov View). 
With full Ignition, the OPC UA server and drivers are also available to external applications.
• If you choose Ignition Edge, you’ll need to purchase and install the Opto 22 Ignition Edge license 

(GROOV-LIC-EDGE); contact Opto 22 Sales at sales@opto22.com for more information.
• If you choose Ignition, you can’t use the Opto 22 Ignition Edge license (GROOV-LIC-EDGE). You will need 

to purchase and install a full Ignition license. Contact sales@opto22.com for details. If you select this 
option, support from Opto 22 is limited.

ENABLING IGNITION OR IGNITION EDGE

Log into your groov EPIC processor with a user ID that has administrator privileges. From the groov Manage 
Home page, click Ignition.

To enable Ignition Edge, click the Enable Ignition Edge switch so that it shows green, then click Save. 
Review the Ignition by Inductive Automation® Software License and click Accept.

If you don’t see the Enable Ignition Edge switch, that’s because the Platform setting is set to Ignition. Click Platform, 
then select Ignition Edge. groov Manage now displays Ignition Edge as the platform.



ENABLING IGNITION OR IGNITION EDGE

groov EPIC User’s Guide82

After Ignition Edge is enabled, the Ignition page refreshes to indicate the status and show the Open 
Ignition Edge link.

To enable Ignition, click Platform, then select Ignition. 



CHAPTER 9: ENABLING IGNITION OR IGNITION EDGE

groov EPIC User’s Guide 83

Click the Enable Ignition switch so that it shows green, then click Save.

Disabling Ignition or Ignition Edge

Log into your groov EPIC processor with a user ID that has administrator privileges. From the groov Manage 
Home page, click Ignition. Click the Enable Ignition or Enable Ignition Edge switch so that it turns grey. Click 
Save.

CONFIGURING THE IGNITION EDGE GATEWAY

The Ignition Edge Gateway is a service that runs on the groov EPIC processor, in the background. You access it 
through a web browser (either through groov Manage or by entering a URL in the browser). The Gateway 
helps you connect to devices and databases, configure its settings (including options like security and 
authentication), and add Ignition Edge modules that add more capabilities to the Ignition Edge platform.

These instructions help you configure the Ignition Edge gateway. If you selected the full Ignition platform, 
refer to the Ignition User Manual for instructions on configuring the Ignition Gateway.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. From the groov Manage Home page, click Ignition, then Open Ignition Edge.

NOTE: In the future, you can open Ignition Edge from this page in groov Manage, or you can go directly to 
Ignition Edge in your web browser by entering as the URL:
https://[your groov EPIC’s hostname]:8043
Don’t forget the “s” in https. Example:
https://opto-00-d2-da:8043

3. Wait while Ignition Edge starts. (It may take a few minutes initially.)
The Ignition Edge gateway webpage appears, showing that it’s running in trial mode.

https://docs.inductiveautomation.com
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4. Sign in using the default username admin and password password and press Enter. (When you 
license Ignition Edge for full use, you will change your Ignition Edge password.)

5. In the top navigation bar, click Configure.
6. In the left navigation panel, scroll down and choose OPC-UA Server > Settings.
7. Change only the following:

a. Under Authentication, check the box to Allow Anonymous Access. 
Allowing anonymous access does not create a security issue, because the Ignition Edge OPC server 
is on the same box as groov EPIC.

b. Under Expose Configured Tags, check the box to Expose Tag Providers (allows the server to get tags 
automatically for some manufacturers’ devices).

8. Scroll to the bottom of the page and click Save Changes.
9. In the left navigation panel, choose System > Gateway Settings. 
10. Scroll down and check the box next to Use SSL:

Note that you 
are signed in 
with the ID 
“admin”.
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Because Ignition Edge is in the groov EPIC processor and it includes a self-signed certificate, a purchased 
certificate may not be necessary. For more information on certificates, see “Managing the SSL Security 
Features of your groov EPIC Processor” on page 46.

11. Scroll to the bottom of the page and click Save Changes. 

LICENSING IGNITION SOFTWARE

The Ignition software on the groov EPIC processor runs for only two hours (trial mode), after which you will 
have to restart it. You can reset the trial as often as you wish. To run the software without the time restraint, 
you will need to purchase the correct license for the platform you selected in “Choosing Between Ignition or 
Ignition Edge” on page 81.

Important: For any of the following situations, follow the instructions in “G: Installing the Correct License” on 
page 333, not the instructions in this section:

• You are installing and running with groov EPIC firmware earlier than version 1.3.0.

• You are restoring to defaults, the default groov EPIC version is earlier than 1.3.0, and you want to run 
with that version of firmware.

The rest of the instructions in this section help you license Ignition Edge. For instructions on licensing Ignition, 
refer to the Ignition User Manual.

Obtaining License Keys

To obtain an Ignition Edge License Key, you must purchase part number GROOV-LIC-EDGE from Opto 22. For 
more information about purchasing GROOV-LIC-EDGE, see “Choosing Between Ignition or Ignition Edge” on 
page 81.

Installing (Activating) the Ignition Edge License

1. If it’s not already open in a browser, open the Ignition Edge gateway page:
– By entering a URL in your browser: https://[your groov EPIC’s hostname]:8043
– From groov Manage Home page, click Ignition Edge > Open Ignition Edge.

2. Click Activate Ignition (upper right).

https://docs.inductiveautomation.com
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3. Under License Management at the right, if your groov EPIC processor has Internet access, click Activate 
Online.

4. To activate online, enter the Ignition Edge license key you received from Opto 22 and click Activate.
A confirmation message appears, stating that your license was successfully activated.

Deactivating the Ignition Edge license

Before you update your groov EPIC processor or reset it to factory defaults, be sure to deactivate your Ignition 
Edge license. After the update or reset is finished, activate the license again. By deactivating and then 
reactivating, you avoid having to contact Ignition Edge to have the license reinstated. 
1. If it’s not already open in a browser, open the Ignition Edge gateway page:

– By entering a URL in your browser: https://[your groov EPIC’s hostname]:8043
– From groov Manage Home page, click Ignition Edge > Open Ignition Edge.

2. Click the Configure tab. In the left navigation panel, choose System > Licensing.

IMPORTANT: Make sure you have a record of your license number, so you can reactivate it later.

3. To deactivate, click the trash can button next to your license number. 
4. To confirm, click Yes, Unactivate.
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When you’re ready to activate your license again, follow the steps in “Installing (Activating) the Ignition Edge 
License” on page 85.

CHANGING THE DEFAULT PASSWORD FOR IGNITION EDGE GATEWAY

You can change your username and password for Ignition whenever you want to. Be sure you change them 
after you license Ignition software. These instructions apply to Ignition Edge. For instructions on changing the 
default password for Ignition, refer to the Ignition User Manual.
1. If it’s not already open in a browser, open the Ignition Edge gateway page:

– By entering a URL in your browser: https://[your groov EPIC’s hostname]:8043
– From groov Manage Home page, click Ignition Edge > Open Ignition Edge.

2. In the Ignition Edge gateway webpage, click the Configure tab.
3. In the left navigation panel, choose Security > Users, Roles.

4. For the default user, click the manage users button. 

5. Click Edit and complete the following fields:
– Username: enter new username
– Check Change Password? 
– Password/Password: enter new password
– (Optional) First Name/Last Name and Language: enter or change as necessary

6. Scroll to the bottom of the screen and click Save Changes. 
7. In the top right corner of the page, locate Sign Out. 

https://docs.inductiveautomation.com
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8. Click Sign Out. Then sign back in using your new username and password. 

INSTALLING THE OPC UA groov EPIC AND SNAP PAC DRIVER
1. If it’s not already open in a browser, open the Ignition Edge gateway page:

– By entering a URL in your browser: https://[your groov EPIC’s hostname]:8043
– From groov Manage Home page, click Ignition Edge > Open Ignition Edge.

2. In the top navigation, click Configure. 
3. In the left navigation, click Modules (under the System heading). Scroll down until you see the Opto 22 

groov EPIC and SNAP PAC Driver module.
4. Click Install. Confirm that you want to install the module.
5. Review the Module License Agreement.
6. Check “I accept the terms in the License Agreement”. Click Accept License.

When the success message appears, you can scroll down and see the Opto 22 groov EPIC and 
SNAP PAC Driver module listed under Cirrus Link Solutions.

To see documentation for the module, click More > documentation. 

INSTALLING THE IGNITION EDGE MQTT MODULE

The MQTT module from Inductive Automation adds to Ignition Edge the capability of creating and managing 
MQTT with Sparkplug payload transmissions.
1. If it’s not already open in a browser, open the Ignition Edge gateway page:

– By entering a URL in your browser: https://[your groov EPIC’s hostname]:8043
– From groov Manage Home page, click Ignition Edge > Open Ignition Edge.

2. In the top navigation, click Configure. Scroll down till you see MQTT.

3. Click Install. On the next page, scroll down to find Quarantined modules and click the install button for 
MQTT Transmission. Then follow directions on the screen to accept the license.

4. Check “I want to add this certificate to my trusted certificates and install the module” and then click the 
button to install.
When the success message appears, you can scroll down and see the MQTT Transmission module listed 
under Cirrus Link Solutions.

To see documentation for the module, click More > documentation.
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10: Configuring System Features

A user with administrator privileges is the only user that can change system features. System features provide 
services like access control, device management, and time management.
“Switching Between PAC Control Engine and CODESYS Runtime Engine” on page 89
“Setting and Adjusting Date, Time, and Time Zones” on page 90
“Selecting Which App to Load After User Log In” on page 91
“Configuring the groov EPIC Processor for Shell Access” on page 92
“Connecting Serial Devices” on page 92
“Connecting a Mouse and a Keyboard” on page 97
“Connecting an External Monitor” on page 97
“Connecting a USB Storage Device” on page 100
“Installing an Approved USB WiFi Adapter” on page 106
“Installing an Approved USB Bluetooth Adapter” on page 107
“Calibrating the Processor’s Touchscreen” on page 110
“Uploading Files to the groov EPIC Processor” on page 110

SWITCHING BETWEEN PAC CONTROL ENGINE AND CODESYS RUNTIME ENGINE

The PAC Control Engine and the CODESYS Runtime Engine are mutually exclusive; you can run one or the 
other, but not both. When you switch between these engines, please be aware of the following:
• If you are running any control programs through secure shell, they will continue to run. As you design 

your control programs, make sure that they do not interfere with each other. For example, make sure they 
do not try to control the same channel.

If you are switching from PAC Control Engine to CODESYS Runtime Engine, your PAC Control 
strategy will be erased and Sparkplug will be disabled. Any CODESYS applications you might have previously 
downloaded will not be restored. You will need to restore them.

When you are ready to switch from the PAC Control Engine to the CODESYS Runtime Engine, follow the 
instructions in “Enabling the CODESYS Runtime Engine” on page 73.

If you are switching from CODESYS Runtime Engine to PAC Control Engine, your CODESYS 
applications will be erased. Any PAC Control strategy you might have previously downloaded will not be 
restored. You will need to restore it.

When you are ready to switch from the CODESYS Runtime Engine to the PAC Control Engine, follow the 
instructions in “Enabling the PAC Control Engine” on page 148. After you restore your PAC Control strategy, if 
you were publishing tag information to an MQTT broker, you need to enable MQTT before you try running the 
strategy:
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1. Log into the groov EPIC processor with a user ID that has administrator authority.
2. From the groov Manage home page, click or tap MQTT.
3. In the MQTT Status box, click or tap Enable in the MQTT Runtime field. After the MQTT Status field 

displays Running, then you can run the strategy.

SETTING AND ADJUSTING DATE, TIME, AND TIME ZONES

Setting and adjusting the date, time, and time zones can help you with more than just setting your groov EPIC 
processor to your local time:
• You can change the date and time of your groov EPIC processor to test time-sensitive features of your 

control program.
• You can synchronize the clock on your groov EPIC processor to any number of time servers from around 

the world.
• You can specify multiple time servers to function as backups of each other, or specify a device (for 

example, a router) as a time server.

When you turn on your groov EPIC processor for the first time and after it establishes network connectivity, it 
will set the time from a default time server. To see the default time server, from the groov Manage Home page, 
click or tap System > Time. The bottom half of the screen lists the time servers.

Setting the Date and Time Manually

There might be a few reasons why you want to set the date and time manually instead of synchronizing to 
time servers:
• You want to test time-sensitive features in your control program, so you want to be able to adjust the 

date and time to test those features.
• You are working in an environment (for example, a disconnected test environment) where changes in 

time will not affect production or other critical applications.

Note: Changing the time manually will log out any users that are currently logged onto your groov EPIC processor. 
Carefully choose when you will change the time to minimize any adverse effect on other users.

To set the date and time manually:
1. Log into the groov EPIC processor with a user ID that has administrator authority.
2. Click or tap System ( ), then Time ( ).
3. In the Time Servers section, turn off the Enable NTP setting by moving the slider to the left so that it 

shows grey ( ).
4. Click Set NTP.
5. In the Time section, select values for Year, Month, Day, Hour, Minute, and Second.
6. Click or tap Set Time.

Now your date and time are set.

IMPORTANT: If you set the date and time manually, the time will not be updated for Daylight Savings Time (for 
those areas that observe Daylight Savings Time). So, you must remember to manually update the date and time 
during those events.

Setting the Date, Time, and Time Zone by Synchronizing with Time Servers

If you are not familiar with time servers, you can learn more about them through the NTP Pool Project at 
www.pool.ntp.org. When you are selecting a time server, remember the following:

http://www.pool.ntp.org
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• It is a good idea to select a couple of time servers to serve as backups in case the groov EPIC processor 
cannot establish a connection to the primary time server or if that time server becomes unavailable. The 
steps below instruct you to set two additional time servers.

• If you had set your date and time manually, setting the date and time as described in this section will 
overwrite your manual settings.

Note: Changing the time manually will log out any users that are currently signed into your groov EPIC processor. 
Carefully choose when you will change the time to minimize any adverse affect on other users.

To select the primary time server and a few backups:
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap System ( ), then Time ( ).
3. In the Time Servers section, click or tap Time Server 1. Enter the host name of the time server.
4. Click or tap Time Server 2. Enter the host name of a second time server.
5. Click or tap Time Server 3. Enter the host name of a third time server.
6. Click or tap Set NTP.

Now your date and time are set, as well as the time zone. The date and time will be updated automatically 
during the switches between Standard Time and Daylight Savings Time, according to the schedule set by the 
time servers.

Setting the Time and Time Zone by Selecting a Location

If you want to change the time by selecting your location, do the following steps:
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap System ( ), then Time ( ).
3. In the Time Zone section, click or tap Region to select a general geographical area of the world.

To set the time for cities or regions in the United States of America, select America as the region. America 
encompasses North, Central, and South America.

4. In the Time Zone section, click or tap Locality to select a specific city that most closely approximates the 
city within the time zone you want to set. 

5. Click or tap Set Zone.

SELECTING WHICH APP TO LOAD AFTER USER LOG IN

By default, the groov EPIC processor starts groov Manage after a user logs in. You can change this:
1. From the groov Manage home screen, click or tap System > Settings. groov Manage displays the Settings 

page.

2. Click or tap on the name of the app to change it.
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3. Click or tap Save.

CONFIGURING THE groov EPIC PROCESSOR FOR SHELL ACCESS

Accessing the groov EPIC processor through the secure shell is for advanced programming. There is no 
additional configuration needed, other than uploading the groov EPIC SSH Access license file:
1. Make sure you have your license file (see “Activating groov EPIC and downloading the license file” on 

page 11).
2. Log into your groov EPIC processor with a user ID that has administrator privileges.
3. From the groov Manage Home page, click System > License.
4. Click Upload license, then navigate to the folder where you stored the groov EPIC SSH Access license file.

Connect to the shell through whatever SSH client you prefer. If you need to find the IP address and port 
number to connect your SSH client, see “Verifying SSH Access” on page 151.

IMPORTANT: Be aware that Opto 22 provides very limited support if you choose to connect to and run through 
SSH.

CONNECTING SERIAL DEVICES

There are two ways to connect serial devices:
• Directly to the groov EPIC processor by inserting a USB-to-serial adapter into one of the USB ports on the 

groov EPIC processor
• To the groov I/O unit by installing a groov serial module (GRV-CSERI-4 or GRV-CCANI-2)
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Connecting a Serial Device Directly to the groov EPIC Processor

To connect serial devices directly to the groov EPIC processor, insert a USB-to-serial adapter into the USB port 
of the processor. The following table lists USB-to-serial adapters supported by the processor.

There are two USB ports on the processor, which means you can connect up to two serial devices directly to 
the processor. However, you can expand the number of serial devices by installing USB hubs. When you do 
this, it’s important to keep track of the device names and port numbers that the processor assigns to the serial 
devices attached to each USB port (see “Understanding How the Processor Assigns Numbers and Names to 
Serial Devices” on page 93). If you move a serial device from one USB port to another, the processor assigns it 
a new port number, and possibly a new device name. These changes might require changes to your PAC 
Control strategy, CODESYS application, or custom control program.

Connecting a Serial Device Through a groov Serial Module

To connect a serial device through a groov serial module, review the specifications in the groov Serial Module 
Data Sheet (form 2296) for information about the transmission mode supported by each module, as well as 
the wiring diagrams to properly wire your serial field devices to the module.

Device Name, Port Number, CAN Port Number, and CAN Port Name

The groov EPIC processor assigns device names, port numbers, CAN port numbers, and CAN port names to 
channels on groov serial modules and USB ports with USB-to-serial adapters attached. You use these names 
and numbers in your control program to access the serial device. Which one you use depends on the module 
and your control program:

Understanding How the Processor Assigns Numbers and Names to Serial Devices

The groov EPIC processor follows two conventions for assigning device names, port numbers, CAN port 
numbers, and CAN port names:
• If the serial device is connected to the processor directly (through a USB-to-serial adapter), the 

convention is based on the location of the USB port relative to other USB ports.

IMPORTANT: If you move the adapter from one USB port to another USB port, the processor will assign a new 
port number and name to the adapter. Any PAC Control strategy, CODESYS application, or custom control 
program that references the old port number and name will need to be modified to refer to the new port number 
and name.

Device 
Manufacturer

Model

B&B Electronics
USOPTL4 (isolated RS-485)
USPTL4 (non-isolated RS-485)
USO9ML2 (isolated RS-232)

Gearmo
GM-482422 (non-isolated RS-485/RS-422)
GM-FTD1-A12 (non-isolated RS-232)
SERIAL-B (non-isolated RS-232)

PAC Control CODESYS Node-RED
Shell

(custom control program)

USB-to-serial 
Adapter

Port number Port number Device name

GRV-CCANI-2 CAN port name CAN port number CAN port name

GRV-CCSERI-4 Port number Port number Device name

https://www.opto22.com/products/product-container/grv-cseri-4
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• If the serial device is connected through a groov serial module, the convention is based on a calculation 
that factors in the fixed number of ports on the groov serial module and the number of the slot (where 
you mounted the module) on the chassis.

Device names and port numbers for serial devices connected to USB ports with USB-to-serial 
adapters. When the serial devices are connected through the USB ports, the device name and port number 
is based on the USB port location. If you connect a serial device and its corresponding adapter directly to the 
groov EPIC processor, the processor assigns port numbers and names as follows:

If you connect a USB hub to either of the USB ports, the groov EPIC processor includes a suffix to the device 
name and port number to identify the port number on the USB hub: .USB_hub_port_number. For example, if 
you connect a 4-port USB hub to USB port 0 on the groov EPIC processor, then the processor assigns device 
names and port numbers as follows:

If you connect an 8-port USB hub to USB port 1 on the groov EPIC processor, then the processor assigns port 
numbers as follows:

Device names, port numbers, CAN port name, and CAN port numbers for serial devices 
connected through groov I/O serial modules. Unlike connecting through USB ports, where you can 
expand the number of ports by adding USB hubs, groov serial modules have a fixed number of ports:
• GRV-CCANI-2 has 2 ports.
• GRV-CSERI-4 has 4 ports.

The processor assigns device names, port numbers, CAN port names, and CAN port numbers as follows:
• GRV-CCANI-2—CAN port names (can<number>) or CAN port numbers (<number>), where 

<number> is calculated based on a formula that uses the channel number and chassis slot number.

A USB-to-serial adapter connected to USB port... is assigned a device name of... and a port number of

0 /dev/ttySer0 0

1 /dev/ttySer1 1

A USB hub connected to 
groov EPIC USB port...

with a USB-to-serial adapter connected to port x 
of the USB hub...

is assigned a device 
name of...

and a port 
number of...

0 1 /dev/ttySer0.1 0.1

0 2 /dev/ttySer0.2 0.2

0 3 /dev/ttySer0.3 0.3

0 4 /dev/ttySer0.4 0.4

A USB hub connected to 
groov EPIC USB port...

with a USB-to-serial adapter connected to port x 
of the USB hub...

is assigned a device 
name of...

and a port 
number of...

1 1 /dev/ttySer1.1 1.1

1 2 /dev/ttySer1.2 1.2

1 3 /dev/ttySer1.3 1.3

1 4 /dev/ttySer1.4 1.4

1 5 /dev/ttySer1.5 1.5

1 6 /dev/ttySer1.6 1.6

1 7 /dev/ttySer1.7 1.7

1 8 /dev/ttySer1.8 1.8
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• GRV-CSERI-4—Device names are in the format 
/dev/ttySerMod<slot number>.<channel number> and port numbers are in the format 
<slot number>.<channel number>, where:
– <slot number> can be 0, 1, 2, or 3, and corresponds to the slot on the chassis.
– <channel number> corresponds to the channel number, which is listed in the wiring diagram 

for the serial module. (See “GRV-CSERI-4 Pinout and Wiring Diagram” on page 300.)
For example, if you connect a serial device to channel 3 of a GRV-CSERI-4 module, which is mounted into 
slot 1, the device name is: /dev/ttySerMod1.3. The port number is 1.3.

Finding Device Names, Port Numbers, CAN Port Names, or CAN Port Numbers

You can find device names, port numbers, CAN port names, or CAN port number through groov Manage or 
through shell commands.

Finding Device Names and Port Numbers Assigned to USB ports or a GRV-CSERI-4 Module

You can view a list of device names and port numbers of the USB-to-serial adapters plugged into USB ports 
and ports of GRV-CSERI-4 modules currently mounted on the chassis by doing the following:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ).
3. Click or tap System > Serial Devices. The Serial Devices page shows the device names and port numbers 

for any USB-to-serial adapters plugged into USB ports and GRV-CSERI-4 modules currently mounted on 
the chassis. The diagram below shows two examples.

A These are the port numbers you use for PAC Control and Node-RED.
B These are the port numbers you use for CODESYS; do not include the Sys that prepends the number.

Finding CAN Port Names and Numbers Assigned to a GRV-CCANI-2 Module

To view a list of the port numbers and port names for any GRV-CCANI-2 module currently mounted on the 
chassis:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click I/O.

An example of one USB-to-serial adapter 
connected to USB port 1.

An example of a GRV-CSERI-4 module mounted on 
to slot 1 of the chassis.

A

B
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3. Click on a GRV-CCANI-2 module.
4. In the Channels tab, click on the channel. You’ll see the CAN Port Number and CAN Port Name.

Finding Device Names Through Shell Commands

If you are accessing the processor through secure shell (SSH), enter the ls /dev/ttySer* command. The 
following diagrams show two examples.
• An example of one USB-to-serial adapter connected to port 1.

• An example of a GRV-CSERI-4 module mounted on to slot 0 of the chassis.

Configuring the Communication Ports or Handles to Serial Devices

Configuring the communications ports or handles in your control program depends on your programming 
environment.
• If you are writing PAC Control strategies, you specify the initial value of the communication handle 

variable with ser to access a serial device attached:
– to a GRV-CSERI-4 serial module.
– to a groov EPIC processor through a USB port.
For a description of Format 2 (which describes ser), see “Creating a communications handle for serial 
devices” in PAC Control User’s Guide (form 1700).

• If you are developing CODESYS applications, review the instructions in “Configuring Processor 
Parameters” on page 127 for tips on configuring channels on GRV-CSERI-4 and GRV-CCANI-2 modules.

• If you are writing your own control programs, refer to your programming language’s reference for 
instructions on where to specify the device name.

https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
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CONNECTING A MOUSE AND A KEYBOARD

You can connect a mouse or a keyboard to the groov EPIC processor through the USB ports.

Before you connect a mouse, it’s a good idea to enable the Show Mouse Pointer feature. If you try to connect 
your mouse first, then you won’t see the small pointer on the touchscreen. You’ll have a hard time navigating 
through the groov Manage screens because you won’t see a pointer that helps you aim accurately.

These steps will require that you restart your groov EPIC processor’s display, which means you will be logged 
out and then you will have to log back in.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ), then select System.
3. Click or tap Display ( ).
4. In the Display page, look for the Show Mouse Pointer field in the External Monitor section. Move the 

slider to the right so that it shows green ( ).
5. Click or tap Save. groov Manage displays the following message: 

6. Click or tap Restart Display ( ).
After your processor restarts the display, you’ll be able to see a small pointer on the touchscreen.

7. Plug your mouse into either USB 0 or USB 1 and wait a few seconds for the processor to connect to the 
mouse. Move the mouse and verify that the small pointer moves around the screen in response to your 
movements.

Now you can click around the groov EPIC processor’s touchscreen in much the same way you click around 
your computer screen.

For a keyboard, you don’t have to do anything else other than to plug it into an available USB port. Wherever 
you can enter data, you can type it in with your keyboard.

CONNECTING AN EXTERNAL MONITOR

The groov EPIC processor supports the option of connecting an external monitor, with or without touchscreen 
capability, to display groov Manage and your HMI. When you connect an external monitor, the touchscreen on 
the groov EPIC processor becomes disabled.
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• If the monitor is non-touchscreen, you’ll also need to connect a mouse to navigate through 
groov Manage and your HMI. If you don’t want to enter information through the on-screen keyboard, you 
can also connect a keyboard to the processor to type in information. Remember that the groov EPIC 
processor has two USB ports and one HDMI port; check which type of connector is on your monitor, 
keyboard, and mouse and make sure you have ports available for all three devices.

• If the monitor is a touchscreen, it must be single-touch and comply with one of the following:
– Use P-CAP (projected capacitive) technology.
– A resistive touchscreen from the list below.
Remember that the groov EPIC processor has two USB ports and one HDMI port; check which type of 
connectors are on your monitor and make sure you have ports available for all the connectors.

Opto 22 has tested and approves the following resistive touch monitors for use with groov EPIC processors:
• The following touchscreen monitors are manufactured by American Industrial Systems (AIS) and are 

listed by AIS part number
– ITM-TMNA0U-12AC-000C—12.1 inch, HDMI input, 9–36 VDC powered
– ITM-TMNA0U-21AC-000C—21.5 inch, widescreen, HDMI input, 9–36 VDC powered
Note that for these two monitors, 640 x 480 resolution is not supported and only Landscape mode is 
supported. For more information about American Industrial Systems (AIS) monitors, visit the AIS website 
at www.aispro.com. You can also check with a local distributor, such as Avnet (avnet.com), for small 
quantity orders.

• SL-LCD-17A-RTOUCH-2 by SuperLogics. For more information about this monitor, visit the SuperLogics 
website at www.superlogics.com.

• HIS-UM15-CTBH by Hope Industrial Systems. For more information about this monitor, visit the Hope 
Industrial Systems website at www.hopeindustrial.com.

• Dell 2314T, a 23-Inch Touchscreen LED-lit Monitor by Dell.

Connecting an External Monitor

When you connect an external monitor, groov Manage will automatically detect the monitor, stop displaying 
on the groov EPIC touchscreen and start displaying on the external monitor. You will want a computer or 
mobile device with access to the groov EPIC nearby so you can change the orientation and resolution of the 
external monitor; these changes cannot be made through the external monitor.
1. For non-touchscreen monitors, connect the keyboard and mouse. groov Manage will automatically 

detect them. You can verify this by moving the mouse and seeing the mouse pointer on the groov EPIC 
processor’s touchscreen move.

2. Connect the monitor. groov Manage will automatically detect the monitor.

If you want to change the resolution and orientation, see “Changing Resolution and Orientation” on page 98. 
For touchscreen monitors, if you want to calibrate the touchscreen, see “Calibrating an External Touchscreen 
Monitor” on page 100.

Changing Resolution and Orientation

1. On a computer or mobile device, log into your groov EPIC processor with a user ID that has administrator 
authority.

2. Click System > Display. The External Monitor section of the Display page lists the options you can adjust 
on the external monitor.

http://www.aispro.com/
http://www.avnet.com/
https://www.superlogics.com
https://www.hopeindustrial.com/
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In groov Manage on the computer, make the following changes while checking the results on the 
external monitor:
– To change what is commonly called the resolution, click on the current value of Video Mode. The list 

is dependent on what your monitor supports and the default value is typically set at the best 
resolution.

– To change the orientation of the screen, click on the current value of Orientation and select another 
value:

Landscape - Normal
The longest part of the screen is oriented 
horizontally.

Portrait - Right
The longest part of the screen is oriented 
vertically and groov Manage and your HMI 
are rotated 90° clockwise.

Portrait - Left
The longest part of the screen is oriented 
vertically and groov Manage and your HMI 
are rotated 90° counterclockwise.
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– To scale the text and HMI elements to a larger size, change the Zoom In level. Keep in mind that the 
larger the size, the more likely that text and HMI elements on groov Manage or your HMI may not all 
fit on the screen. You’ll have to swipe up and down, left and right to view text and HMI elements.

3. Click Save. groov Manage will ask you to verify your changes. Click Restart Display.
The external monitor will restart. This might take 15 to 30 seconds. If your selections don’t create the 
result you want, return to step 2 to make different selections.

Calibrating an External Touchscreen Monitor

You can start the calibration from either the browser or on the touchscreen monitor directly.
1. On a computer or mobile device, log into your groov EPIC processor with a user ID that has administrator 

authority.
2. Click System > Display.
3. Click or tap Calibrate Touchscreen at the top of the page. groov Manage displays the Touch to Calibrate 

message, which will indicate how much time you have left to complete the calibration process.

4. On the external touchscreen monitor touch the screen. Follow the instructions on the screen.
5. When the calibration is done, groov Manage displays the following message:

Calibration settings are saved in groov EPIC backups.

Disconnecting an External Monitor

When you disconnect an external monitor, groov EPIC processor enables its touchscreen. You can resume 
using it to navigate through groov Manage and your HMI.

CONNECTING A USB STORAGE DEVICE

You can connect a USB storage device to either USB port on the groov EPIC processor, then use groov Manage 
on the processor’s touchscreen to copy files to and from the processor’s internal storage. Adding a USB storage 
device can increase the amount of storage available for your PAC Control strategy, CODESYS application, 
Node-RED flow, or custom control program to create, read, and write to files.



CHAPTER 10: CONFIGURING SYSTEM FEATURES

groov EPIC User’s Guide 101

Important: You should store any files critical to your control program in the processor's internal storage. Internal 
storage utilizes a power-fail safe file system that prevents data, file and file system corruption in the event that power 
is removed. USB storage devices do not utilize a power-fail safe file system.

The groov EPIC processor supports reading and writing to USB storage devices formatted in either FAT or 
FAT32 file systems. This means that the largest partition that the groov EPIC processor can access is 32 GB. You 
can either:
• select USB storage devices no larger than 32 GB, or
• on a computer, format a USB storage device that is larger than 32GB with multiple FAT32 partitions.

If you do connect a USB storage device, keep the following points in mind:
• Because there is no mechanism to physically secure (or lock) the USB storage device to the processor, it 

can be removed by anyone that has access to the processor. It’s important to apply important security 
practices, like keeping the processor secured under lock and key and providing the key to only trusted 
individuals.

• It’s also important to remember not to remove the USB storage device without first evaluating the 
consequences; for example, would it cause an interruption to your control program or automation 
process? After evaluating consequences and taking measure to mitigate those consequences, to remove 
the USB storage device, go through groov Manage to unmount it (see “Mounting and Unmounting USB 
Storage Devices” on page 102) before pulling out the USB storage device.

• To prevent someone from inserting an unauthorized USB storage device that could contain malicious 
software, automounting is disabled by default. Carefully consider the security risks before disabling 
automount for an extended period of time. It would be a good practice to disable automount after 
mounting the USB storage device; you will still be able to access files on the storage device with 
automount disabled.

• If you do not plan on using USB storage devices, it would be a good security practice to disable the ability 
to access USB storage devices. You can still use the USB ports for other devices, like USB-to-serial 
adapters, keyboards, or supported WiFi adapters. For instructions, see “Disabling Access to USB Storage 
Devices” on page 101.

• Determine whether you want the USB storage device to be listed in the secured or unsecured areas. The 
following table describes which applications or services can access files stored in secured and unsecured 
areas.

Disabling Access to USB Storage Devices

If you disable access to USB Storage Devices, you can still use the USB ports for other devices, like USB-to-serial 
adapters, keyboards, or supported Wi-Fi adapters.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. From the groov Manage Home page, click or tap System > USB.
3. If you have any USB storage devices connected to the groov EPIC processor, unmount them.

a. Click or tap USB Files.

Secured Area Unsecured Area

• groov Manage
• custom control programs through shell access
• Node-RED flows

• groov Manage
• custom control programs through shell access
• Node-RED flows
• CODESYS applications
• PAC Control strategies
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b. Click or tap Safely Remove. groov Manage displays the following message; click or tap OK to 
continue:

When groov Manage successfully unmounts the storage device, it displays the following message. 
Click or tap Close to continue.

c. Repeat these steps for each USB storage device connected to the processor. When you are done, 
click or tap Done to return to the USB page.

4. Move the Enable USB slider to the left or tap it so that it shows gray ( ).
5. Click Save. You have now disabled access to USB storage devices. groov Manage displays the System 

page.

Mounting and Unmounting USB Storage Devices

Follow the instructions below before inserting a USB storage device into a USB port, and unmount USB 
storage devices (see “Unmounting a USB Storage Device” on page 104) before pulling it out of a USB port.

Note: If you change the Permissions setting (see step 2 below), you will need to restart the controller for the change 
to take effect. Make sure to schedule this activity during a time that won’t disrupt your applications or systems.

Mounting a USB Storage Device

1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. From the groov Manage Home page, click or tap System > USB.

– If Enable USB shows gray, it’s disabled. Click or tap on the slider so that it shows green: .
– If Automount shows gray, it’s disabled. Click or tap on the slider so that it shows green: .
– Click or tap on Permissions to select whether you want the USB storage device to be listed in the 

secured or unsecured area. To understand the difference, review the table on page 101.
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3. Click Save. groov Manage briefly displays a message that it’s saving your changes.

4. If you changed the Permissions, groov Manage prompts you to restart the controller:

– If you are running the PAC Controller, click Go to PAC Status Page. In the PAC Controller page, click 
Disable (in the Runtime field). After groov Manage indicates that the controller is disabled, click 
Enable. After groov Manage indicates that the controller is enabled, remember to download and run 
your strategy. For instructions, see PAC Control User’s Guide (form 1700).

– If you are running the CODESYS Controller, click Go to CODESYS Status Page. Click Disable (in the 
Runtime field). After groov Manage indicates that the controller is disabled, click Enable. After 
groov Manage indicates that the controller is enabled, remember to download and run your 
CODESYS application. For instructions, see “Downloading and Running CODESYS Applications” on 
page 142.

Important: Click Back > Home > System > USB to finish the rest of these steps.
5. Insert the USB storage device into a USB port.

https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
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6. To verify that groov Manage can access the USB storage device, in groov Manage, click or tap USB Files. 
groov Manage displays the Files page. You can see the USB storage device when it’s listed in a section 
called USB Drive, typically followed by a number:

At this point, you can copy or move files from the USB storage device to the processor’s internal storage. 
You could also download a file from the USB storage device to your local machine. (See “Copying, 
Moving, or Downloading a File on a USB Storage Device” on page 105.)

Unmounting a USB Storage Device

1. From a computer or mobile device, log into your groov EPIC processor with a user ID that has 
administrator privileges.

2. From the groov Manage Home page, click or tap System > USB, then USB Files.
3. Click or tap Safely Remove. groov Manage displays the following message; the message reminds you that 

if you want to reconnect the storage device in the future, you will have to physically reinsert it. Click or 
tap OK to continue:

When groov Manage successfully unmounts the storage device, it displays the following message. Click 
or tap Close to continue.
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4. Click or tap Done in the Files page. Now you can pull out the storage device.

Copying, Moving, or Downloading a File on a USB Storage Device

Before you begin, make sure you have properly mounted the USB storage device as described in “Mounting a 
USB Storage Device” on page 102. You need to log into groov Manage from a computer or mobile device to 
copy, move, or download files.
• Copy and move means to transfer a file from the USB storage device to the groov EPIC processor’s internal 

storage.
• Download means to transfer a file from the USB storage device to you computer or mobile device.

These instructions describe how to copy, move, or download one file at a time.
1. From a computer or mobile device, log into your groov EPIC processor with a user ID that has 

administrator privileges.
2. From the groov Manage Home page, click or tap System > USB, then USB Files.
3. Click on Partition 1, or, if you have multiple partitions or USB drives mounted, scroll to the correct 

partition or drive and click the partition name. groov Manage displays the Files page:

4. In the Dir Listing section, navigate to the file you want to copy, move, or download. groov Manage 
displays a list of all the actions you can take on the file:
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– To copy a file to the processor’s internal storage, click Copy.
– To move a file to the processor’s internal storage, click Move.
– To copy a file to the internal storage of your computer or mobile device, click Download.

5. If you need to copy, move, or download another file, click Back (top left) to select another file. If you are 
done working with this file, click Done (top right corner). groov Manage returns you to the USB page.

INSTALLING AN APPROVED USB WIFI ADAPTER

If you want to use the groov EPIC processor on a wireless network, you must purchase and install one of the 
following USB WiFi adapters that Opto 22 has tested and approved for use with groov EPIC processors. 
Unapproved WiFi adapters should not be used. 
• Netis® WF2180
• Netis® WF2190

You can install the WiFi adapter with the processor on or off. The following instructions assume that the 
processor is on:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Insert the WiFi adapter into the USB connector on the bottom of the processor.

USB connectors
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3. To verify that the processor is communicating with the WiFi adapter, go to the Network page (Home > 
System > Network). Note that the Wi-Fi section of the Network page now has a MAC Address.

Continue on to Chapter 7: Connecting groov EPIC to a Network or Multiple Networks.

INSTALLING AN APPROVED USB BLUETOOTH ADAPTER

The groov EPIC processor provides a Bluetooth adapter service, which enables Bluetooth connectivity 
between an approved USB Bluetooth adapter (the TP-Link UB400 Bluetooth 4.0 Nano USB Adapter) and a TE 
MEAS M5600 Wireless Pressure Transducer (model M5600-000005-300PG). 

These are the only two devices approved for use. Do not attempt to use any other Bluetooth-capable field device or 
USB Bluetooth adapter. You can obtain the data from transducer through Node-RED flows (see “Example: Obtaining 
Data From a Bluetooth-capable Field Device” on page 171).

You can install the Bluetooth adapter with the processor on or off. The following instructions assume that the 
processor is on:
1. Log into your groov EPIC processor with a user ID that has system-level privileges.
2. From the groov Manage Home page, click or tap System > USB.

– If Enable USB shows green, that means groov EPIC will detect a USB device inserted into either USB 
port. Click System to return to the System page.

No WiFi adapter installed; no MAC address WiFi adapter installed; MAC address available
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– If Enable USB shows gray, groov EPIC will not detect a USB device inserted into either USB port. 
Enable the detection by clicking or tapping on the slider so that it shows green: . Click Save. 
groov Manage briefly displays a message that it’s saving your changes.

After groov Manage saves the new USB setting, it displays a message reminding you to restart 
whichever controller you are running.

Since you did not change any permissions, you do not have to restart PAC nor CODESYS. Click Close. 
groov Manage returns you to the System page.

3. Click Bluetooth.
4. Insert the Bluetooth adapter into one of the USB connectors on the bottom of the processor.

USB connectors
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5. In the Bluetooth page, click or tap Enable on the Runtime field.

When the Bluetooth adapter service is running, groov Manage displays Running in the Status field.

Runtime—Click this button to disable the Bluetooth adapter service. If the service is not running (you 
see Disabled as the Status), the button will say Enable.
Restart—Click this button to disable the Bluetooth adapter service, after which groov Manage restarts 
the Bluetooth adapter service, displays a message after it successfully restarts the service, then refreshes 
the Bluetooth page to indicate the service is running.
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CALIBRATING THE PROCESSOR’S TOUCHSCREEN
1. Log into your groov EPIC processor through the touchscreen with a user ID that has administrator 

privileges.
2. Tap System ( ).
3. Tap Display ( ).
4. Tap Calibrate Screen Settings.
5. Follow the instructions on the screen to run through the calibration exercise. You might have to repeat 

the exercise several times.
6. After you successfully complete the exercise, the processor returns to the Display page. Tap Save.
7. The processor asks if you want to restart the display. Tap OK.
8. The processor will restart and you will have to log back in.

UPLOADING FILES TO THE groov EPIC PROCESSOR

The groov EPIC processor identifies files that you upload as “user files”. Before you upload files, you must decide 
whether they need to be uploaded as secured files:
• Secured. Secured files are files that services can access only with authentication (for example, a user 

name and password, or an API key) over a secure protocol (HTTPS).
• Unsecured. Unsecured files are accessed primarily by PAC Control strategies, though services that access 

secured files can also access unsecured files.
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11: Configure CODESYS and groov 
EPIC for IEC61131-3

Developing and running IEC61131-3 applications on a groov EPIC processor becomes possible when you add 
the Opto 22 Library package to the CODESYS Development System and enable the CODESYS Runtime Engine 
on the groov EPIC processor.

To correctly configure CODESYS Development System and the groov EPIC processor, you’ll need the following:
• A MyOpto account. For instructions on creating one, visit the Login page at www.opto22.com.
• An activated groov EPIC processor. To verify that you have activated your groov EPIC processor, review the 

instructions in “Activating groov EPIC and downloading the license file” on page 11.
• A computer that meets the requirements described in “System Requirements” on page 1, and that can 

access the groov EPIC processor and the internet.

After you complete the following configuration tasks, you can go on to develop and run a CODESYS 
application on your groov EPIC processor:
1. “Obtaining Your CODESYS Activation Key Certificate and Ticket ID” on page 112.

You’ll need the CODESYS Activation Key Certificate and the Ticket ID to fully enable the CODESYS Control 
Engine.

2. “Downloading and Installing CODESYS Development System” on page 112.
If you already have CODESYS Development System installed on your computer, make sure it’s the correct 
version listed in “System Requirements” on page 1.

3. “Adding the Opto 22 Library Package to CODESYS Development System” on page 112.
The Opto 22 Library Package contains all the information that CODESYS Development System needs to 
correctly identify and communicate with a groov EPIC processor and the groov I/O modules.

4. “Reviewing Network Configurations” on page 115.
The groov EPIC processor has default networking configurations to communicate with CODESYS 
Development System. However, if you have a unique networking situation, you might have to make 
some changes to the groov EPIC processor. This section helps you identify the changes you may need to 
make.

5. “Enable the CODESYS Control Engine on the groov EPIC Processor” on page 116.
The CODESYS Runtime Engine is preinstalled on the groov EPIC processor. However, by default, it is not 
enabled; if you do enable it, it runs for only two hours (trial mode). To remove trial mode, follow the 
instructions in this section to license the CODESYS Runtime Engine (which requires the CODESYS Ticket 
ID you obtained in step 1).

6. “Connecting Processor to Gateway and Entering the CODESYS Ticket ID” on page 116
In the CODESYS Development System, the gateway manages communication with many devices, 
including the groov EPIC processor. After you add the processor to the gateway, you’ll be able to enter the 
CODESYS ticket ID you obtained in step 1 above, which will install the license on to the processor.

https://www.opto22.com/logon?returnurl=%2f
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Note: Throughout this section, instructions may use CODESYS terminology that differs from standard Opto 22 
terminology. For example:

• In the CODESYS Development System interface, the term “device” refers to many different objects: a 
controller, an Ethernet adapter, a field device, or an I/O module. In this guide, “device” typically refers 
to a field device (a valve, a pump, a quadrature encoder, etc.). When you read other sections of the 
guide that do not discuss CODESYS, you can interpret “device” to mean the latter definition.

• In CODESYS terminology, a groov EPIC processor, a groov RIO, and channels on a groov RIO are 
referred to as “devices”; throughout other sections of this guide, a groov EPIC processor is referred to 
as a processor, a groov RIO is referred to as a RIO module, and a channel is referred to as a channel.

• An application, in CODESYS terminology, is roughly equivalent to a PAC control strategy in Opto 22 
terminology.

OBTAINING YOUR CODESYS ACTIVATION KEY CERTIFICATE AND TICKET ID

You need to obtain an Activation Key Certificate from Opto 22 to help you get your CODESYS ticket ID. You’ll 
use the ticket ID when you do the steps in “Connecting Processor to Gateway and Entering the CODESYS 
Ticket ID” on page 116 to license the CODESYS Runtime Engine on your groov EPIC processor.
1. Contact Opto 22 Sales to order (at no additional cost) part number GROOV-LIC-CRE. Opto 22 will send 

you an Activation Key Certificate. After you finish all the steps in this section, make sure to save the 
certificate in a safe place.

2. Open a web browser. Log into manage.groov.com with your email address and your MyOpto password. 
3. Click the Activate button.
4. Enter your activation key and click Activate.
5. In the list of products, select the GRV-EPIC-PR1 or GRV-EPIC-PR2 for which you want to obtain a CODEYS 

Ticket ID. If you select the incorrect product, you’ll have to contact Opto 22 Pre-Sales Support for 
assistance.

6. When the website displays the CODESYS ticket ID, copy and save it in a safe place.

DOWNLOADING AND INSTALLING CODESYS DEVELOPMENT SYSTEM

If you have CODESYS Development System, V3.5 SP13 Patch 1 or newer (32-bit version) installed on your 
computer, you can skip this section. Otherwise, follow these steps:
1. If you are new to the CODESYS Store, register (create an account) on the website (store.codesys.com).
2. Find and download CODESYS Development System (32-bit version) from the CODESYS Store.
3. Double-click on the package to install it, choosing typical installation options.

ADDING THE OPTO 22 LIBRARY PACKAGE TO CODESYS DEVELOPMENT SYSTEM
1. Go to the Opto 22 website, www.opto22.com.
2. Enter “Opto 22 Library Package” in the search box to find the page “Opto 22 Library Package for CODESYS 

Development System” and click the link.
3. Review the readme file (link is available on the Library Package page, as well) to learn about the latest 

enhancements and fixes delivered in the package, plus any special instructions.
4. Click Download and save the package to the same computer where you installed CODESYS 

Development System.

https://store.codesys.com/
http://manage.groov.com
https://www.opto22.com
https://www.opto22.com/support/resources-tools/documents/rm-library-package-for-codesys-readme
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5. Open CODESYS Development System and install the package. For instructions on how to do this, see 
Installing/Uninstalling a Package in the CODESYS Online Help.

Updating Opto 22 Device Information

When you install the Opto 22 Library Package for CODESYS Development System, the package adds the 
features and capabilities of the following devices to your CODESYS Development System:
• groov EPIC processors
• groov I/O modules
• groov RIO modules

You should periodically check the Opto 22 website for updates to the library package. As new modules are 
introduced, Opto 22 updates the package to include the features and capabilities of these new modules.

It’s also a good idea to review the library package’s readme to:
• Learn about the enhancements, features, or bug fixes included in each new release of the library 

package.
• Make a note of any pre- or co-requisites—like a new version of firmware for a groov I/O module—that 

might be required by one of these enhancements, features, or bug fixes. Also make a note of additional 
requirements; you’ll want to remember to do them at the end of these instructions.

If you have any existing CODESYS applications with any of devices listed above, you may want to update the 
device information for those devices:
1. Open the project and, in the Device tree, expand the Ethernet interface, then the GRV-EPIC-PR1 or 

GRV-EPIC-PR2 device to see all the modules.

2. Right-click GRV-EPIC-PR1 (or GRV-EPIC-PR2) and select Update Device. If the Update Device window 
does not automatically select the groov EPIC processor, navigate through the window to find it and select 

https://help.codesys.com/webapp/_cds_installing_package;product=codesys;version=3.5.14.0
https://www.opto22.com/support/resources-tools/downloads/opto-22-library-package-for-codesys-development-sy
https://www.opto22.com/support/resources-tools/documents/rm-library-package-for-codesys-readme
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it. Note that the Version column and Version number in the information box match and show the most 
recently installed version.

3. Click Update Device. You do not have to close the Update Device window after CODESYS finishes the 
update.

4. In the Device view, click a module under the GRV-EPIC-PR1 (or GRV-EPIC-PR2). CODESYS changes the 
Update Device window to the Plug Device window and selects the same module. (If it doesn’t, scroll 
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through the list and select the same module.) Note that the Version column and Version number in the 
information box match and show the most recently installed version. Click Plug Device.

5. Repeat the previous step for each module on the GRV-EPIC-PR1 (or GRV-EPIC-PR2). (You must do this for 
every module.)

6. Save your project.

Now that you have updated the device information for all of your groov devices in this project, review the list 
of notes you made when you read the readme. Make the changes that you noted. Rebuild your project, test 
the changes, and verify that your application works as expected.

When you create a new project, it’s a good practice to double-check the version number to verify that you are 
selecting the most recently installed version of the Opto 22 Library Package.

REVIEWING NETWORK CONFIGURATIONS

The groov EPIC processor assigns the ETH0 network interface as the default network interface for 
communication between CODESYS Development System and the CODESYS Runtime Engine. Communication 
runs through the firewall through specific ports, which are listed in tables on page 51.
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If these default settings work for your networking environment, you can move on to the next task. However, 
for the following situations, you’ll need to change the network settings on the groov EPIC processor:
• The default settings don’t work for your networking environment
• You are using CODESYS PROFINET Controller SL. (You’ll need to assign a static IP address to the network 

interface and add a new firewall rule.)

If you need to change the network interface, do both of the following steps. If you only need to change the 
firewall rules, skip to step 2.
1. If your networking environment is moderately complex (for example, you have an IT network and an OT 

network), you’ll want to review “Identifying Your Network Setup” on page 57.
If the only change you need to make is to assign a static IP address to ETH0 so that you can use CODESYS 
PROFINET Controller SL, collect information as instructed in obtain the IP address from your network 
administrator. Then change the settings for ETH0, following the instructions in “Configuring ETH0 or 
ETH1” on page 64. 

2. To change the firewall rules, see “Changing a Firewall Rule” on page 54.
If the only change you need to make is to add a new firewall rule so that you can use CODESYS PROFINET 
Controller SL, follow the instructions in “Creating a Firewall Rule” on page 51.
– For Title, you may want to enter something like “CODESYS PROFINET Controller UDP”.
– For Protocol, select UDP.
– For Port, enter 49152:65535, then press Enter, then enter 34964 in the second port field that 

appears.
– Select eth0, unless you changed the assigned network interface in the previous step. If you did, 

then select that network interface.

ENABLE THE CODESYS CONTROL ENGINE ON THE groov EPIC PROCESSOR

Complete these instructions within two hours to prevent delays in completing the steps in the section that 
follows:

Note: If the PAC Control Engine is running when you enable the CODESYS Runtime Engine, the processor disables 
the PAC Control engine and deletes any PAC Control strategy on the processor. For more details about anything else 
that changes on the groov EPIC processor when you switch control engines, see “Switching Between PAC Control 
Engine and CODESYS Runtime Engine” on page 89.

1. Log into your groov EPIC processor with a user ID that has administrative privileges.
2. Click or tap Controller.
3. Click or tap CODESYS Controller.
4. Click or tap Enable. When the processor is done, the status will change to Running.

CONNECTING PROCESSOR TO GATEWAY AND ENTERING THE CODESYS TICKET ID

The CODESYS Gateway manages communication between your computer and your controllers, processors, 
and other devices. You can have multiple gateways, each running on different computers, and you can 
configure access to those gateways from other computers with CODESYS Development System. These 
instructions assume you have one gateway on your computer and that the gateway connects directly to the 
groov EPIC processor.
1. If CODESYS Development System isn’t open, go ahead and open it.
2. Click Tools > License Manager.
3. In the Select target dialog, select Device and click Next.
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IMPORTANT: Do NOT select Workstation.

4. In the Select container dialog, select Softcontainer and click Next.
5. Click Scan network. CODESYS Development System will look for controllers on your network. Select your 

groov EPIC processor and click OK.
If your groov EPIC processor does not show up:
– If you weren’t able to use the default network configurations (as described in “Reviewing Network 

Configurations” on page 115), you’ll need to click on Add Device and specify the new IP address or 
port number.

– Check through the list in “CODESYS: Can’t Connect to groov EPIC Processor” on page 242 for some 
options to help you troubleshoot the issue. Keep in mind the two-hour time limit on the CODESYS 
Runtime Engine. After checking all these options, you may have to either repeat the scan of the 
network or close CODESYS Development System and return to step 1.

6. In the License Manager window, click Install licenses.
7. In the Install Licenses window, select Activate license and click Next.
8. Enter the ticket ID that you saved from Opto 22 into the Ticket ID field. Click Next.

CODESYS Development System automatically creates a license backup file (*.WibuCmRau), as described in 
Restoring licenses in the CODESYS Online Help. It would be a good idea to create a backup of your groov EPIC 
processor soon after completing these steps (see “Backing up Your groov EPIC Processor” on page 219), in 
case you need to restore your CODESYS Development System and all the licenses.

Keep in mind that you cannot transfer your license from one groov EPIC processor to another by simply 
installing the ticket ID on the new processor. You must follow the instructions in “Transferring the CODESYS 
License to Another groov EPIC Processor” on page 118.

MANAGING CODESYS RUNTIME ENGINE AND CODESYS APPLICATIONS

Enabling the CODESYS Runtime Engine

Before you download and run a CODESYS application, make sure you enable the CODESYS Runtime Engine on 
the groov EPIC processor.

Note: If the PAC Control Engine is running when you enable the CODESYS Runtime Engine, the processor disables 
the PAC Control engine and deletes any PAC Control strategy on the processor. For more details about anything else 
that changes on the groov EPIC processor when you switch control engines, see “Switching Between PAC Control 
Engine and CODESYS Runtime Engine” on page 89.

1. Log into your groov EPIC processor with a user ID that has administrative privileges.
2. Click or tap Controller.
3. Click or tap CODESYS Controller.
4. Click or tap Enable. When the processor is done, the status will change to Running.

You can now go to the CODESYS Development System to download and run your CODESYS application on 
the groov EPIC processor.

Disabling the CODESYS Runtime Engine

When you disable the CODESYS Runtime Engine, the processor stops any running CODESYS applications. 
However, this does not erase the CODESYS applications. (Enabling the PAC Control Engine does erase 
CODESYS applications. For more information, see “Switching Between PAC Control Engine and CODESYS 
Runtime Engine” on page 89.)

https://help.codesys.com/webapp/_cds_installing_license;product=codesys;version=3.5.14.0#restoring-licenses
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1. Log into your groov EPIC processor with a user ID that has administrative privileges.
2. Click or tap Controller.
3. Click or tap CODESYS Controller.
4. Click or tap Disable. When the processor is done, the status will change to Disabled.

After you disable the CODESYS Runtime Engine, the CODESYS Development System is disconnected from the 
groov EPIC processor. You will likely see a message like the following from the CODESYS Development System:

Transferring the CODESYS License to Another groov EPIC Processor

Transferring a CODESYS license requires contacting CODESYS product support for specific instructions. Be 
aware that this may not be an immediate process, so allow for a day or two to complete the process. The 
general steps include:
1. Email CODESYS product support, indicating that you want to transfer your license from one (we’ll call it 

the “old”) groov EPIC processor to another (a “new“) groov EPIC processor.

You may want to specify the part number (GRV-EPIC-PR1 or GRV-EPIC-PR2), instead of “groov EPIC processor”.

2. When CODESYS provides you with a “return” ticket ID, install it on the old processor through License 
Manager:
a. Open CODESYS Development System, then select Tools > License Manager.
b. In the Select target dialog, select Device and click Next.

IMPORTANT: Do NOT select Workstation.

c. In the Select container dialog, select Softcontainer and click Next.
d. In the License Manager window, click Install licenses.
e. In the Install Licenses window, select Activate license and click Next.
f. Enter the “return” ticket ID that you received from CODESYS into the Ticket ID field. Click Next.

3. Email CODESYS product support to indicate that you completed the previous step.
4. When CODESYS provides you with a new ticket ID, install it on the new groov EPIC processor in the same 

way you installed your first ticket ID. For instructions, see “Connecting Processor to Gateway and Entering 
the CODESYS Ticket ID” on page 116.
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12: Working with groov EPIC 
Devices in CODESYS Projects

This chapter describes how to add groov EPIC processors and groov I/O modules to a CODESYS project so that 
you can:
• build a CODESYS application that runs on a groov EPIC processor, and
• communicate with the processor’s local I/O or remote I/O (on another groov EPIC processor or a 

groov RIO).

The first step is to add a groov EPIC to your project (see “Adding a groov EPIC Device to a CODESYS Project” on 
page 120).

Then, you configure the project to correctly access the local I/O:
• “Adding an Ethernet Interface to the groov EPIC Device” on page 122
• “Adding a CANbus Interface to the groov EPIC Device” on page 124

Note that if you add a GRV-CCANI-2 module to your project before you physically install the module on 
to the chassis, you will need to restart the CODESYS Controller or the processor after you install the 
module on the chassis.

• “Plugging in groov I/O Modules” on page 126

Next, configure parameters to ensure proper performance and I/O configuration:
• “Configuring Processor Parameters” on page 127
• “Configuring Channel Parameters (Features) on a Module” on page 128

If you need to learn how to obtain or assign values to channels on your modules or how to add/access files 
stored in the processor’s storage, see:
• “Reading and Clearing Features” on page 134
• “Referencing a Channel on a GRV-CCANI-2 Module” on page 140
• “Referencing Files Stored in the groov EPIC Processor” on page 142

The following step is only necessary if you have groov EPIC firmware 1.3.0 or if you need to access application 
variables through OPC UA:
• “Creating a Symbol Configuration” on page 142

When you are ready to download the application to the groov EPIC processor to run it and debug it, follow the 
instructions in “Downloading and Running CODESYS Applications” on page 142.

This chapter does not explain how to design and build applications with the CODESYS Development System. 
(For this type of information, see the CODESYS Online Help at help.codesys.com.)

The instructions in this chapter assume you have prepared your groov EPIC processor and CODESYS 
Development System as described in Chapter 11: Configure CODESYS and groov EPIC for IEC61131-3.

https://help.codesys.com/
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Note: Throughout this section, instructions may use CODESYS terminology that differs from standard Opto 22 
terminology. For example:

• In the CODESYS Development System interface, the term “device” refers to many different objects: a 
controller, an Ethernet adapter, a field device, or an I/O module. In this guide, “device” typically refers 
to a field device (a valve, a pump, a quadrature encoder, etc.). When you read other sections of the 
guide that do not discuss CODESYS, you can interpret “device” to mean the latter definition.

• In CODESYS terminology, a groov EPIC processor, a groov RIO, and channels on a groov RIO are 
referred to as “devices”; throughout other sections of this guide, a groov EPIC processor is referred to 
as a processor, a groov RIO is referred to as a RIO module, and a channel is referred to as a channel.

• An application, in CODESYS terminology, is roughly equivalent to a PAC control strategy in Opto 22 
terminology.

ADDING A groov EPIC DEVICE TO A CODESYS PROJECT
If this is a new CODESYS project, see “Creating a New CODESYS Project and Adding a groov EPIC Device” on 
page 120. If you’re adding the EPIC to an existing CODESYS project, see “Editing an Existing Project to Add a 
groov EPIC Device” on page 121. You can add more than one groov EPIC device to your project if your applica-
tion requires it.

Creating a New CODESYS Project and Adding a groov EPIC Device

1. Open CODESYS Development System.
2. Click File > New Project. In the Templates box, make sure Standard project is selected.
3. In the Name field, type in a name for your project, then click OK.
4. In the Standard Project window, select GRV-EPIC-PR1 as the device. In the PLC_PRG field, select your 

preferred IEC61131-3 programming language, then click OK.

NOTE: If you see an error message about missing Opto 22 library files, in the Library Manager tab, click the 
Download Missing Libraries button and follow the on-screen instructions.

After CODESYS Development System creates the project, you may want to change the standard name that 
CODESYS gives your device (which is “Device”) to something more helpful (for example, “Pump_Station_1”).
1. In the Devices view, right click Device (GRV-EPIC-PR1 or GRV-EPIC-PR2) and select Properties.
2. In the Properties - Device window, change the name “Device” to your preferred name. Click OK.
3. CODESYS prompts you to refactor (which means it changes all references of the name “Device” to your 

preferred name throughout the entire project). Click Yes. In the Refactoring window, click OK. CODESYS 
updates the Devices view to show your preferred name for the device.

If you want to add more groov EPIC devices to this project, go to step 3 in the next section.

Default device name

Preferred device name
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Editing an Existing Project to Add a groov EPIC Device

1. Open CODESYS Development System.
2. Click File > Open Project. Navigate to the folder where you stored the project file, select the project file, 

and then click Open.
3. In the Devices view, right-click the project name and select Add Device.

4. In the Add Device window, type a name for your groov EPIC processor in the Name field.

5. Expand the PLCs branch and select GRV-EPIC-PR1 or GRV-EPIC-PR2.
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6. Click Add Device. CODESYS Development System adds the GRV-EPIC-PR1 or GRV-EPIC-PR2 to the Devices 
view and leaves the Add Device window open, in case you want to add more devices.

If you don’t need to add any more devices, click Close in the Add Device window.

ADDING AN ETHERNET INTERFACE TO THE groov EPIC DEVICE

As the CODESYS application runs in your groov EPIC processor, it communicates to I/O (both local and remote) 
through an Ethernet interface device, which you create in CODESYS Development System. You can create up 
to three Ethernet interface devices:
• Io, the interface that communicates with the local I/O.
• eth0 and eth1, the interfaces that correspond to the ETH0 and ETH1 Ethernet interfaces on the 

groov EPIC processor (see “Identifying Your Network Setup” on page 57).

In the simplest case, where you only need to communicate with the local I/O, you will create one Ethernet 
interface device (to Io). However, if you have more complex network requirements, you may have to create 
additional Ethernet interface devices (to eth0 and/or eth1). Work with your IT department, if available, to 
configure the Ethernet network interfaces on the groov EPIC processor (“Identifying Your Network Setup” on 
page 57) before you start creating the Ethernet interface devices in your CODESYS application. You will need 
some of the information you used during that configuration in the following steps.

Note: If the processor was configured with a static IP address, you’ll need to know its subnet mask and default 
gateway address.

Before you start, you must have completed the instructions in “Connecting Processor to Gateway and Entering 
the CODESYS Ticket ID” on page 116 and have gone online with the processor at least once.
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1. In the project's Devices view, right-click your groov EPIC processor and select Add Device.

2. Under the Fieldbuses folder, expand Ethernet Adapter and select Ethernet.
3. Click Add Device. CODESYS Development System adds an Ethernet branch to your groov EPIC processor’s 

branch. Click Close.

4. In the Devices view, double-click Ethernet (Ethernet).
5. In the Ethernet View, make sure the General tab is selected.

6. On the Interface field, click the more button ( ) to see a list of network interface options.

NOTE: If you receive a “No device detected” message, check “CODESYS: Can’t Connect to groov EPIC Processor” 
on page 242 for possible causes.

7. In the Network Adapters window, select the network interface for this Ethernet interface device.
– To connect to local I/O, select Io.
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– If you need to connect to remote I/O on other networks, select either eth0 or eth1.

8. Click OK.
9. If necessary (for example, if you are connecting to a static IP address), enter the IP address, subnet mask, 

and default gateway addresses. (This is where you enter the information you collected when you 
configured ETH0 and ETH1 on the groov EPIC processor.)

10. Click File > Save.

If you or your IT department needed to configure your groov EPIC processor with multiple network interfaces, 
you may need to repeat these steps for each additional network interface.

ADDING A CANbus INTERFACE TO THE groov EPIC DEVICE

There are a couple of ways you can add a GRV-CCANI-2 module:
• Through low-level programming with the CANbus API library that is built into CODESYS Development 

System. This method requires programming experience. The application developer must:
– Specify the port number (which identifies the specific GRV-CCANI-2 module and channel) as a 

parameter to the APIs. For an explanation of the port number, see “Referencing a Channel on a 
GRV-CCANI-2 Module” on page 140.

– Add logic to the CODESYS application that properly formats and transmits the messages correctly, 
as well as correctly interprets all received messages. 

You can learn more about the built-in library through the CANbus Example, available on the CODESYS 
Store website.

• Through a third party protocol library, which can take care of the low-level programming, the proper 
formatting and transmission of sent messages, and the correct interpretation of received messages. 
There are several libraries available that support popular protocols, like J1939 and CANopen. In your 
CODESYS project, you will add a CANbus interface (instructions below), add the third party library 
interface to, and then plug in the GRV-CCANI-2 module.

https://store.codesys.com/can-bus-example.html?___store=en&___from_store=default
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With either method, each end of a CANbus must be terminated with a 120 Ohm resistor. If the GRV-CCANI-2 
module is connected to either end of the bus, you can configure the channels of the module to provide this 
termination. For instructions, see “Configuring Channels to Provide Termination on a CANbus” on page 134.

You add a CANbus interface only if you selected the option to use a third party protocol library (see above).
1. In the project's Devices view, right-click your groov EPIC processor and select Add Device.

2. Under the Fieldbuses folder, expand CANbus and select CANbus.
3. Click Add Device. CODESYS Development System adds a CANbus branch to your groov EPIC processor’s 

branch. Click Close.

4. Configure the CANbus device to identify which channel on the GRV-CCANI-2 module it communicates to 
and at what baud rate:
a. Review “Referencing a Channel on a GRV-CCANI-2 Module” on page 140 to get the port number, a 

number that identifies a specific channel on a GRV-CCANI-2 module on a specific slot on the chassis.
b. Double-click on the CANbus device.
c. Click the General tab.
d. In the Network field, enter the port number you identified in step a.
e. In the Baudrate (kbits/s) field, enter the data rate (in kilobits per second) of the CANbus attached to 

the port number (channel of the GRV-CCANI-2 module).
5. Add and configure the third party protocol library to the CANbus device. Each library has its own set of 

requirements; consult the library’s help/documentation or online tutorials for this information.

Now you can plug in your GRV-CCANI-2 modules (see “Plugging in groov I/O Modules” on page 126.) If the 
GRV-CCANI-2 module is connected to either end of the CANbus, you must configure the channels of the 
module to provide the required termination. For instructions, see “Configuring Channels to Provide 
Termination on a CANbus” on page 134.
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PLUGGING IN groov I/O MODULES

In CODESYS Development System, adding a groov I/O module requires that you first add a GRV-EPIC-PR1 or 
GRV-EPIC-PR2 device to an Ethernet interface, then you “plug in” (right-click on a slot on GRV-EPIC-PR1 or 
GRV-EPIC-PR2 in the Device tree then select Plug Device) the module. You can plug in the modules manually 
(see “Plugging in I/O modules manually” on page 127) or have CODESYS Development System plug them in 
automatically (see “Plugging in I/O modules automatically” on page 126).
1. In the Devices view, right-click Ethernet (Ethernet) or the preferred name for the interface, and select Add 

Device. 
2. In the Add Device dialog box, expand Miscellaneous and the GRV-EPIC-PR1 or GRV-EPIC-PR2.
3. Click Add Device. 

CODESYS Development System establishes communication to your groov EPIC processor and then adds 
the processor to the Device tree, along with a default 16-slot chassis model. Your actual chassis model 
may be smaller; keep that in mind as you continue.

4. Click Close.

If you want CODESYS to automatically add the modules, continue to the next section. If you want to add the 
modules manually, see “Plugging in I/O modules manually” on page 127.

Plugging in I/O modules automatically

1. Connect to the I/O unit by clicking Online > Login. If you are prompted to create an application on the 
device, click Yes.

2. In the Devices view, right-click GRV-EPIC-PR1 or GRV-EPIC-PR2 and select Scan For Devices. 
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The Scan Devices window opens and displays the modules installed on the chassis.
3. Click Copy All Devices to Project. 

CODESYS Development System updates the Devices view to show the modules under the I/O unit, 
GRV-EPIC-PR1 or GRV-EPIC-PR2.

4. Click Online > Logout.
5. If you want to change the name of each module from the standard GROOV_MODULE (or its variants):

a. In the Devices view, right click the module you want to rename and select Properties.
b. In the Properties window, change the name “GROOV_MODULE” (or its variant) to your preferred 

name. Click OK.
When CODESYS displays the following message, it’s asking you if you want all references of the 
name “GROOV_MODULE” changed to your preferred name throughout the entire project (this is 
called Automatic Refactoring).

Click Yes. In the Refactoring window, click OK. CODESYS updates the Devices view to show your 
preferred name for the module.

Plugging in I/O modules manually

You may want to plug in modules manually if you don’t have access to your groov I/O modules (they are not 
mounted to your chassis). After you plug in your I/O modules, you can continue on with configuration, 
mapping, and even some programming.
1. In the Devices view, right-click a module slot that shows “Empty.” Select Plug Device.
2. In the Plug Device window, select the groov I/O module you want to add. To give that module a name, 

type the name in the Name field. Click Plug Device, then click Close.
3. Repeat the previous two steps for each module you want to add.

CONFIGURING PROCESSOR PARAMETERS

Processor parameters help you control several performance factors and processor settings, like:
• Timeouts and data streaming rates
• IP addresses, port numbers, and temperature units (Celsius or Fahrenheit)

To find and set these parameters:
1. Start CODESYS Development System and open a project that contains your GRV-EPIC-PR1 or 

GRV-EPIC-PR2 device.
2. In the Devices view, expand Ethernet.
3. Double-click your GRV-EPIC-PR1 or GRV-EPIC-PR2 device.
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4. In the GRV-EPIC-PR1 or GRV-EPIC-PR2 view, click the GRV-EPIC-PR1 or GRV-EPIC-PR2 Parameters tab.

5. Review all the parameters, paying particular attention to the following:
– Address—Make sure the IP address or hostname of the GRV-EPIC-PR1 or GRV-EPIC-PR2 is correct in 

the Value column and surrounded by single quotes (‘).
– Streaming Interval (ms)—This is the rate at which the I/O unit will stream input data to the 

CODESYS Runtime Engine. This parameter might require some fine-tuning.
– Auto-Reconnect—This parameter helps with communication error handling.

6. Save your project.

CONFIGURING CHANNEL PARAMETERS (FEATURES) ON A MODULE

Many groov I/O modules offer configurable features; for example, on some analog input modules, you can 
select from a set of available input ranges. CODESYS Development System lists these features as parameters in 
the Parameters tab of the module view. Depending on the requirements of the feature, you configure a 
feature by entering values, selecting an option from a list, or both.

The image that follows shows how CODESYS displays features in the Parameters tab for two different modules:
• GRV-ITMI-8, an analog input module with 8 channels. Each channel on this module has several 

configurable parameters. The image shows the parameters of the first two channels (0 and 1).
• GRV-IAC-24, a digital input module with 24 channels. Each channel on this module has one 

configurable parameter, shown in the Feature row. The image shows the first 4 channels (0 through 3).
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The parameters of channel 0, 
each on their own row. For 
Channel Type, you select from 
a list of options. For the rest of 
the parameters, you enter 
values.

The parameters of channel 1.

The Feature parameter of channel 0 lists the 
features available for this channel. You 
select the feature you want from that list.

The Feature parameter of channel 1.

The Feature parameter of channel 2.

The Feature parameter of channel 3.
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The following table lists the channel features for the listed modules that you can configure in CODESYS 
Development System.

Configuring Channel Features and Parameters

1. If you haven’t started CODESYS Development System, start it and open your project.
2. Open or select the Devices view, expand the Ethernet branch, then expand the branch of your groov EPIC 

processor.
3. Double-click the module that contains the channel you want to configure. CODESYS Development 

System opens a module view for that module. Check that the Parameters tab is selected.
4. Find the channel you want to configure, then expand it to view the features and parameters you can set. 

For more details on how to configure a particular channel, see the following:
– “Configuring Channels for Counting” on page 132

Categories Module Part Number Configurable Channel Features

Input 
Modules

Digital

• GRV-IACDCTTL-24
• GRV-IAC-24
• GRV-IACHV-24
• GRV-IACI-12

• GRV-IACIHV-12
• GRV-IDC-24
• GRV-IDCI-12

• Counting

• GRV-IDCIFQ-12 • Counting
• Quadrature
• Quadrature Index on Rising Edge
• Quadrature Index on Falling Edge

• GRV-IACDCTTLS-24
• GRV-IACHVS-24
• GRV-IACIHVS-12
• GRV-IACIS-12

• GRV-IACS-24
• GRV-IDCIS-12
• GRV-IDCS-24

• No configurable channel parameters

Analog

Modules with selectable temperature/input ranges:
• GRV-IICTD-12
• GRV-ITMI-8
• GRV-ITR-12

• Input Range or Type (except GRV-IICTD-12)
• Upper/Lower Scale
• Offset
• Gain
• Filter Weight

Modules with selectable input ranges:
• GRV-IMA-24
• GRV-IMAI-8
• GRV-IV-24

• Input Range
• Upper/Lower Scale
• Offset
• Gain
• Filter Weight

Communication

• GRV-CCANI-2 • CAN bus termination

• GRV-CSERI-4 • RS-232, RS-485 2-wire/4-wire,
termination & bias

Output 
Modules

Digital

• GRV-OAC-12
• GRV-OACI-12
• GRV-OACIS-12
• GRV-OACS-12
• GRV-ODCI-12

• GRV-ODCIS-12
• GRV-ODCSRC-24
• GRV-ODCSRCHCS-12
• GRV-OMRIS-8

• Watchdog

Analog

• GRV-OVMALC-8
• GRV-OVMAILP-8

• Output Range
• Upper/Lower Scale
• Watchdog
• Upper/Lower Clamp

For a list of all modules and their features, see Appendix D: I/O Module Specifications. If a feature listed in that appendix is not listed in 
this table, the feature is not configurable through CODESYS Development System.
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– “Configuring Channels for Thermistor: Custom Curve” on page 133
– “Configuring Channels With Selectable Input Ranges/Types” on page 131
– “Configuring Channels for Scaling” on page 131
– “Configuring Channels for Clamping” on page 132
– “Configuring Channels for Quadrature” on page 133
– “Configuring Channels to Provide Termination on a CANbus” on page 134

5. Repeat step 4 to configure another channel on the same module.
6. To configure channels on another module, return to step 3.

Remember to save your project periodically.

Configuring Channels With Selectable Input Ranges/Types

Several modules offer a pre-determine list of options, typically for temperature and input ranges. (For a list of 
these modules, see the table on page 130.) After you have expanded the channel branch:
1. On the Channel Type row, double-click the Value cell to display the drop-down arrow.

2. Click the arrow to display the list of available values. Each module will have a different list of values for 
Channel Type. Below are a couple of examples.

3. Select the input range/type that you want.

Continue on to setting features or parameters on other channels or modules, as described in “Configuring 
Channel Features and Parameters” on page 130.

Configuring Channels for Scaling

Several modules offer scaling, a method of transforming measurements (values from a channel) at a fixed 
ratio. (For a list of these modules, see the table on page 130.) If you want to scale values, first determine the 
upper and lower ends of the scale. For example, if your input range is ± 600 mV and it is connected to a tank 
that can hold 1000 liters, you can set the lower end of the scale (-600 mV) to represent 0 liters and the upper 
end of the scale (+600 mV) to represent 1000 liters.

After you have expanded the channel branch:

GRV-CSERI-4 module

GRV-ITMI-8 module
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1. Double-click the Value cell on the Upper Scaled row. Type in the upper end of your scale. For our 
example, we type in 1000. Press Enter.

2. Double-click the Values cell on the Lower Scaled row. Type in the lower end of your scale. For our 
example, we type in 0. Press Enter.

To set default scaling, leave the Value cells blank or enter 0.

Continue on to setting features or parameters on other channels or modules, as described in “Configuring 
Channel Features and Parameters” on page 130.

Configuring Channels for Clamping

Several modules offer clamping, a way to limit the output sent to the device attached to the channel. (For a list 
of these modules, see the table on page 130.) If you want to add a clamp to a channel, first determine the 
upper and lower end of that range. For example, suppose you want the output range to be 5–15 mA. On a 
GRV-OVMALC-8 module, you can select the Channel Type to 4–20 mA and then specify 15 mA as the upper 
clamp limit and 5 mA as the lower clamp limit.

After you have expanded the channel branch:
1. Double-click the Value cell on the Upper Clamp row. Type in the upper end of your range. For our 

example, we type in 15. Press Enter.
2. Double-click the Value cell on the Lower Clamp row. Type in the lower end of your range. For our 

example, we type in 5. Press Enter.

To indicate no clamping, set both Value cells to 0.

Continue on to setting features or parameters on other channels or modules, as described in “Configuring 
Channel Features and Parameters” on page 130.

Configuring Channels for Counting

Several modules offer counting, a way to limit the output sent to the device attached to the channel. (For a list 
of these modules, see the table on page 130.)

After you have expanded the channel branch:
1. On the Feature row, double-click the Value cell to display the drop-down arrow.

2. Click the arrow to display a list, then select Counter.

Continue on to setting features or parameters on other channels or modules, as described in “Configuring 
Channel Features and Parameters” on page 130.
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Configuring Channels for Thermistor: Custom Curve

GRV-ITR-12 modules offer preset curves and the ability to create your own custom curves by specifying the 
Steinhart-Hart coefficients. (Make sure you that first select “Thermistor: Custom Curve (°C) (0x60000043)” as 
the Channel Type. See “Configuring Channel Features and Parameters” on page 130.)

After you have expanded the channel branch:
1. Double-click the Value cell for the corresponding parameter. The following figure shows what the Value 

cell for Steinhart-Hart Coefficient A looks like after you double-click it:

2. Type your desired value, then press Enter.

Continue on to setting features or parameters on other channels or modules, as described in “Configuring 
Channel Features and Parameters” on page 130.

Configuring Channels for Quadrature

The GRV-IDCIFQ-12 module offers quadrature, as well as counting. To understand how GRV-IDCIFQ-12 
modules work, review “Working with GRV-IDCIFQ-12 (Quadrature) Modules” on page 197. (Do not follow the 
steps in that section; they describe how to configure the module through groov Manage, which does not 
apply when you work in CODESYS Development System.) Then, review the module wiring diagram on “Wiring 
to Quadrature Encoders” on page 309. Select which Axis (1, 2, 3, or 4) you want to use for the encoder and 
then wire your encoder as indicated in the wiring diagram. Begin configuring the channel as described in 
“Configuring Channel Features and Parameters” on page 130, keeping in mind the following:
• If you selected axis 1, you will be configuring channels 0, 1, and optionally 2.
• If you selected axis 2, you will be configuring channels 3, 4, and optionally 5.
• If you selected axis 3, you will be configuring channels 6, 7, and optionally 8.
• If you selected axis 4, you will be configuring channels 9, 10, and optionally 11.

When you expand a channel branch to configure it:
1. Double-click the Value cell for the Feature parameter. The following figure shows what the Value cell 

looks like after you double-click it:

2. Click on the arrow and select as follows:
– For channels 0, 1, 3, 4, 6, 7, 9, and 10, select Quadrature.
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– For channels 2, 5, 8, and 11, if your application requires an index signal, select either Quadrature 
Index on Rising Edge or Quadrature Index on Falling Edge. If your application doesn’t require an 
index signal, you can leave this channel as None, or, if needed by your application, configure it as a 
counter.

The following figure shows an example of a GRV-IDCIFQ-12 module configured for an index signal on the 
falling edge of axis 1:

Continue on to setting features or parameters on other channels or modules, as described in “Configuring 
Channel Features and Parameters” on page 130.

Configuring Channels to Provide Termination on a CANbus

The GRV-CCANI-2 module, when connected to either end of a CANbus, can be configured to provide the 
termination required by a CANbus. You must have the module mounted on slots 0, 1, 2, or 3 of the groov EPIC 
chassis before you begin. After you have expanded the channel branch:
1. Double-click on the Value cell of the Channel Type row. The following figure shows what the Value cell 

looks like after you double-click it:

2. Click on the arrow and select CAN, with termination.

Continue on to setting features or parameters on other channels or modules, as described in “Configuring 
Channel Features and Parameters” on page 130.

READING AND CLEARING FEATURES

In CODESYS, you map variables to parameters to work with channels on a module. The variable doesn’t have 
to pre-exist; you can create it “on the fly”.

Channels 0, 1, and 
2 configured for an 
index signal on the 
falling edge of 
channel 2.
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CODESYS Development System displays a list of features, organized by channel, in the Mapping tab of the 
module view. The following image shows the Mapping tab for GRV-IAC-24, a digital input module:

When you expand the Discrete Inputs or Discrete Inputs Control branch, you see a list of channels. The 
following images shows those branches expanded in the same GRV-IAC-24 module:

The Discrete Inputs branch is 
where you map a variable to read 
a latch or state.

The Discrete Inputs Control branch 
is where you map a variable to clear 
a latch or state.
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The following image shows the same module with channel 0 expanded under the Discrete Inputs and 
Discrete Inputs Control branches.

These instructions will show images for a GRV-IAC-24, though instructions for a specific module will also be 
provided:
1. If you haven’t started CODESYS Development System, start it and open your project.
2. Open or select the Devices view, expand the Ethernet branch, then expand the branch of your groov EPIC 

processor.
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3. Double-click the module that contains the feature that you want to clear or read. CODESYS Development 
System opens a module view for that module. Click the Mapping tab.

4. Expand the appropriate branch:
– If you are mapping a variable read a feature, expand the Discrete Inputs branch.
– If you are mapping a variable to clear a feature, expand the Discrete Inputs Control branch.

5. Expand the branch of the channel you want. In the following example, we show both the Discrete Inputs 
and Discrete Inputs Control branches of Channel 0 expanded:

6. Determine if you want to map a variable to a channel or a specific feature:
– To a channel: If you map a variable to a channel, you can access any configured feature on that 

channel by appending a dot (.) and then the name of the configured feature to the variable name. 
For example, if you map a variable to channel 0 and call the variable MyInput, if you want to 
access the On Latch feature to read the value of the latch, you write the reference as 
MyInput.OnLatch. If you want to access the feature that clears the On Latch, you write the 
reference as MyInput.OnLatchClear.

– To a specific feature: You can map a variable to a specific feature of a channel. The variable can’t 
read or clear other features on the same channel or any other channel.

Expanded 
channel 0
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7. Create a variable or map an existing variable to a channel or feature:
– Create a variable that maps to a channel: Click the Variable cell on the Channel x row, where x is 

the channel number. Type in the new variable name, then press Enter. The following example shows 
a new variable mapped to Channel 0 of the GRV-IAC-24 module.

– Map an existing variable to a channel: Click the Variable cell on the Channel x row, where x is the 
channel number. Click the more button ( ) to open the Input Assistant. Navigate or search 
through the Input Assistant to find the variable, select it, then click OK.

– Create a new variable that maps to a specific feature:
– To read a feature, under the Discrete Inputs branch, expand the channel that contains your 

desired feature. Then, click the Variable cell on the row of the feature you want to read. Type in 
the new variable name, then press Enter. The following example shows a new variable mapped 
to State on channel 1 of a GRV-IAC-24 module.

– To clear a feature, under the Discrete Inputs Control branch, expand the channel that contains 
the feature you want to clear. Then, click the Variable cell on the row of the specific latch. Type 
in the new variable name, then press Enter. The following example shows a new variable 
mapped to On Latch Clear of channel 2 of a GRV-IAC-24 module.

In the above examples, if the name of the existing variable is too long to fit on the space available, CODESYS 
Development System shows ellipses (...) to indicate that the name is longer than what’s shown.

This icon indicates a new variable was created.
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– Map an existing variable to a specific feature:
– To read a feature, under the Discrete Inputs branch, expand the channel that contains the 

feature you want to read. Then, click the Variable cell on the row of the specific feature. Click the 
more button ( ) to open the Input Assistant. Navigate or search through the Input Assistant 
to find the variable, select it, then click OK.

– To clear a feature, under the Discrete Inputs Control branch, select the channel that contains 
the feature you want to clear. Then, click the Variable cell on the row of the specific feature. 
Click the more button ( ) to open the Input Assistant. Navigate or search through the Input 
Assistant to find the variable, select it, then click OK.

8. Repeat steps 3 through 6 for each channel and module you want to map to a variable.

Remember to save your project periodically.

Reading and Clearing a Latch or State

In CODESYS, you read latches or states with one variable and you clear latches with a different variable. The 
following images shows you where you find them in the Parameters tab.

The following table lists the modules that offer latch or state. (For completeness and clarity, modules that do 
not offer latch or state are also listed.)

To read a state or 
latch, map a variable 
to these parameters.

To clear a latch, map 
a variable to these 
parameters.



REFERENCING A CHANNEL ON A GRV-CCANI-2 MODULE

groov EPIC User’s Guide140

REFERENCING A CHANNEL ON A GRV-CCANI-2 MODULE

The CODESYS controller identifies each channel on a GRV-CCANI-2 module with a port number that is a 
number between 0-7 and assigned as follows:

You can find this information in groov Manage, as well. You must have the GRV-CCANI-2 module mounted in 
slot 0, 1, 2, or 3 of your groov EPIC chassis before you begin:
1. Open a browser and log into your groov EPIC processor with an ID that has system administrator 

privileges.

Module Part Number
Latch, State, or
Not Applicable

Input
Modules

Digital

• GRV-IACDCTTL-24
• GRV-IAC-24
• GRV-IACHV-24
• GRV-IACI-12
• GRV-IACIHV-12

• GRV-IDC-24
• GRV-IDCI-12
• GRV-IDCIFQ-12

• On Latch
• Off Latch
• State

• GRV-IACDCTTLS-24
• GRV-IACHVS-24
• GRV-IACIHVS-12
• GRV-IACIS-12
• GRV-IACS-24

• GRV-IDCIS-12
• GRV-IDCS-24

• State

Analog
• GRV-IICTD-12
• GRV-IMA-24
• GRV-IMAI-8

• GRV-IV-24
• GRV-ITMI-8
• GRV-ITR-12

Not applicable

Communication
• GRV-CCANI-2
• GRV-CSERI-4

Not applicable

Output
Modules

Digital

• GRV-OAC-12
• GRV-OACI-12
• GRV-OACIS-12
• GRV-OACS-12

• GRV-ODCI-12
• GRV-ODCIS-12
• GRV-ODCSRC-24
• GRV-OMRIS-8

• State

Analog
• GRV-OVMALC-8
• GRV-OVMAILP-8

Not applicable

Slot Number Channel Number Port Number

0 0 0

0 1 1

1 0 2

1 1 3

2 0 4

2 1 5

3 0 6

3 1 7
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2. Click I/O, then select your GRV-CCANI-2 module. groov Manage displays the Module x page, where x is 
the slot number.
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3. Click on a channel on the module. groov Manage displays the channel’s configuration page, where you 
can see the CAN Port Number.

CREATING A SYMBOL CONFIGURATION

For either of the following situations, create a symbol configuration object following instructions in Creating a 
symbol configuration of the CODESYS Online Help:
• Accessing application variables via OPC UA.
• You are running groov EPIC firmware version 1.3.0 on the processor. If you are running version 1.3.1 or 

later, you don’t have to do this.

REFERENCING FILES STORED IN THE groov EPIC PROCESSOR

You can upload files to the groov EPIC processor through groov Manage. If you want your CODESYS application 
to access these files, you must upload them to the unsecured area. (For details, see “Uploading Files to the 
groov EPIC Processor” on page 110.)

When you reference these files (either programmatically or through the CODESYS Development System user 
interface), you must prefix the file name with either of the following paths:

– /home/codesys/unsecured/
– /home/dev/unsecured/

If you don’t specify a path (in other words, you write only a file name), CODESYS will look for the file in 
whatever folder CODESYS has defined for that particular program or user interface function. These folders 
aren’t accessible to groov Manage.

DOWNLOADING AND RUNNING CODESYS APPLICATIONS

The online help for CODESYS Development System offers detailed instructions on downloading and running 
CODESYS Applications, under the section “Transferring Applications to the PLC”. For the simplest instructions, 
see “Downloading the Application Code, Logging in, and Starting the PLC”. However, you should review all the 
information under the first section to learn about options, features, or requirements that might help your 
application run more efficiently.

IMPORTANT: If you don’t license your GRV-EPIC-PR1 or GRV-EPIC-PR2, you can download and run programs; 
however, the CODESYS Runtime Engine runs for only two hours. After the two hours expire, the CODESYS Runtime 

https://help.codesys.com/webapp/_cds_symbolconfiguration;product=codesys;version=3.5.14.0#creating-a-symbol-configuration
https://help.codesys.com/webapp/_cds_symbolconfiguration;product=codesys;version=3.5.14.0#creating-a-symbol-configuration
https://help.codesys.com/webapp/_cds_struct_application_transfer_to_plc;product=codesys;version=3.5.14.0
https://help.codesys.com/webapp/_cds_loading_application_login_starting;product=codesys;version=3.5.14.0
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Engine stops running. You’ll have to disable it (see “Disabling the CODESYS Runtime Engine” on page 117) and then 
re-enable it (see “Enabling the CODESYS Runtime Engine” on page 117).

In addition, the groov EPIC processor offers features (through groov Manage) that can help you manage your 
CODESYS application.

Starting or Stopping CODESYS Applications on the groov EPIC Processor

In groov Manage, you can start or stop a CODESYS application that you downloaded to the groov EPIC 
processor.
1. Log into your groov EPIC processor with a user ID that has administrator authority.
2. Click or tap Controller.
3. Click or tap CODESYS Controller.

– To stop a running application, click or tap Stop Application. Confirm that you want to stop the 
application by clicking or tapping OK. After the application is stopped, the Status is changed to 
Stopped.

– To start a stopped application, click or tap Run Application. Confirm that you want to start running 
the application by clicking or tapping OK. After the application starts running, the Status is changed 
to Running.

Monitoring Latches, States, and Counters: CODESYS or groov Manage?

While you are running or debugging your CODESYS application, you can monitor the following in 
groov Manage:
• On Latch
• Off Latch
• Counter

However, due to differences in how groov Manage and CODESYS Runtime Engine monitor and report 
information, the values you see in the CODESYS debugger won’t match what you see in groov Manage. For 
CODESYS applications, it’s more accurate to monitor this data from CODESYS, not from groov Manage.
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13: Downloading and Running 
PAC Control Programs

The PAC Project Software Suite from Opto 22 provides software that can help you with industrial automation, 
process control, building automation, remote monitoring, data acquisition, and Industrial Internet of Things 
(IIoT) applications in any field. PAC Project software works with all groov EPIC processors, along with SNAP PAC 
controllers.

PAC project comes in two editions:
• PAC Project Basic, which includes the following two tools that work with groov EPIC processors:

– PAC Control Basic, a full-featured, flowchart-based tool for developing control programs.
– PAC Display Basic, for creating Microsoft Windows-based human-machine interfaces (HMIs) for 

operators and technicians to monitor and interact with groov EPIC (and SNAP PAC) systems.
• PAC Project Professional, which contains everything in PAC Project Basic, plus tools to help you:

– Work with complex network architectures
– Configure redundant SNAP PAC controllers
– Support legacy Opto 22 FactoryFloor systems
– Configure OPC communication and database connectivity

See a comparison chart for PAC Project Basic and PAC Project Professional.

Because groov EPIC processors include an HTTP/HTTPS server and a RESTful API (application program 
interface based on the REST architecture), you can securely access I/O point and variable data in your 
PAC Control program using the language of your choice. Data is returned in JSON format. For complete 
information, see developer.opto22.com.

When you create your control program with PAC Control, you add a control engine that specifies your 
groov EPIC processor, just as you do when you add a SNAP PAC controller. You develop, download, run, and 
debug your PAC Control strategies as you do with a SNAP PAC controller. For specific instructions on adding 
your groov EPIC processor as a control engine, see PAC Control User’s Guide (form 1700).

This chapter describes the tools to help you manage the PAC Control Engine and specify additional domains 
permitted to access resources.

PAC CONTROLLER VS CODESYS CONTROLLER

The PAC Control Engine and CODESYS Runtime Engine are mutually exclusive: you can run one or the other, 
but not both.

IMPORTANT: If you switched the controller from the PAC Control Engine to the CODESYS Runtime Engine, you 
must switch back to the PAC Control Engine before running PAC Control programs. For instructions, see “Enabling the 
PAC Control Engine” on page 148.

http://documents.opto22.com/1700_PAC_Control_Users_Guide.pdf
http://developer.opto22.com/
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IDENTIFYING THE STRATEGY THAT IS RUNNING ON THE groov EPIC PROCESSOR
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ) and select Control Engine.

The bottom half of the screen displays the name of the strategy currently running.

ENABLING OR DISABLING BACKGROUND DOWNLOADING

Background downloading enables you to download a strategy onto a groov EPIC processor without stopping 
the strategy that is currently running on the processor. However, for this feature take effect, you must stop the 
Control Engine and then restart it. This will also disable Sparkplug. Schedule a time to do this task so that it has 
minimal impact on your application and equipment.
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ) and select Controller.
3. Click or tap PAC Controller, then Configuration.
4. In the PAC Controller configuration page:

– To enable background downloading, move the slider to the right so that it shows green ( ).
– To disable background downloading, move the slider to the left so that it shows grey ( ).

5. Click or tap Save.
6. In the PAC Controller page, click or tap Disable. Read the warning message, then click OK.

7. Wait a few seconds the processor to stop the Control Engine. When it is done, groov Manage changes the 
Control Engine page to show that the Control Engine was disabled.
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8. Click Enable. Acknowledge the message by clicking OK. Wait a few seconds for the processor to restart 
the Control Engine. You might see the screen momentarily display Stopped, then change to Running.

The next time you download a strategy, the currently running strategy will continue running while you 
download another strategy.

IDENTIFYING SERIAL DEVICES ACCESSIBLE TO THE CONTROL ENGINE
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ) and select Control Engine.
3. Click or tap Serial Devices ( ). The Serial Devices page shows the devices attached to the 

groov EPIC processor. In the following example, the Serial Devices page shows that there is one serial 
device connected to USB port 1.
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DISABLING THE PAC CONTROL ENGINE

When you disable a control engine, the strategy that is currently running stops and MQTT (if enabled) is 
disabled. Make sure you consider all the consequences of disabling a control engine before you continue with 
this procedure.
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ) and select Control Engine.
3. Click or tap Disable. The processor display a warning message to verify that you understand the 

consequences of disabling a control engine and want to proceed.
4. Click OK to proceed with disabling the control engine. After a few seconds, the Status section of the 

Control Engine page indicates that the control engine is disabled and the Runtime button has been 
changed to a green Enable button.

ENABLING THE PAC CONTROL ENGINE

Note: If the CODESYS Runtime Engine is running when you enable the PAC Control Engine, the processor disables 
the CODESYS Runtime Engine and deletes any CODESYS applications on the processor. For more details about 
anything else that changes on the groov EPIC processor when you switch control engines, see “Switching Between 
PAC Control Engine and CODESYS Runtime Engine” on page 89.

1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ) and select Control Engine.
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3. Click or tap Enable. Wait a few seconds for the processor to restart the Control Engine. You might see the 
screen momentarily display Stopped, then change to Running.
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14: Downloading and Running 
Custom Control Programs

The groov EPIC processor can run control programs developed any programming language that can run on 
Linux OS. These programs can run independently of the PAC Control Engine or CODESYS Runtime Engine.

If you develop custom programs, Opto 22 offers a variety of tools to help you access groov EPIC services and 
groov I/O modules. You can find information about these tools, as well as instructions to help you get started 
using them, at our developer web site, developer.opto22.com.

This user’s guide does not describe how to create custom control programs. The guide describes some of the 
features available on the groov EPIC processor to help you run your custom programs. A comprehensive guide 
to developing custom programs for the groov EPIC processor is available on developer.opto22.com, called 
Developing with groov EPIC.

Review the specifications of the groov EPIC processor (see Appendix A: Processor Specifications) to make sure 
your custom program can run on the Linux operating system and available hardware.

You can download and run your program through secure shell (SSH) access. The groov EPIC processor offers 
services to help you verify that you have access to the secure shell (SSH), and, if necessary, start and stop the 
SSH server.

IMPORTANT: Be aware that if you are running through SSH access, the product support offered by Opto 22 is 
limited.

VERIFYING SSH ACCESS
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ) and select System.
3. Click or tap Shell ( ).
4. In the Shell page, if you have access to the secure shell, the Status section displays the SSH Server as 

running. Underneath that, it displays the IP address and port number to specify on an SSH client to access 
the SSH server.

http://developer.opto22.com/
http://developer.opto22.com/
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STOPPING THE SSH SERVER

To stop the SSH server, you must have the shell user ID and password.
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ) and select System.
3. Click or tap Shell ( ).
4. In the Runtime section of the Shell page, enter the SSH user ID in the Shell Username field, the SSH user 

password in the Shell Password field, and then click or tap the red Disable button.

– If the credentials are valid, the processor displays the following message immediately proceeds to 
stop the SSH server.

– If the credentials are invalid, the processor highlights the Shell Username and Shell Password field in 
red and indicates that they are invalid. Repeat step 4 to try again.

After the SSH server is disabled, groov Manage refreshes the Shell page and changes the SSH server button to 
Enable ( ).
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STARTING THE SSH SERVER

To start the SSH server, you must have the shell user ID and password.
1. Log into the groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ) and select System.
3. Click or tap Shell ( ).
4. In the Runtime section of the Shell page, enter the SSH user ID in the Shell Username field, the SSH user 

password in the Shell Password field, and then click or tap the green Enable button. The processor 
displays the following message and immediately proceeds to stop the SSH server.

After the SSH server is started, groov Manage refreshes the Shell page and changes the SSH server button to 
Disable ( ).

ALLOWING BROWSER-BASED APPLICATIONS ACCESS TO REST APIS

By default, web browsers prevent JavaScript on web pages from making requests to the PAC Control REST API 
on your groov EPIC processor. If you are developing a browser-based application and want it to access your 
groov EPIC processor, you can do so by a mechanism known as Cross-Origin Resource Sharing (CORS). In 
groov Manage, you specify the domains allowed access:
1. Log into the groov EPIC processor with an account that has administrator privileges.
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2. Click Controller > PAC Controller > Configuration.

3. Click Add Origin. In the text box, type in the URL. Click OK.

4. Repeat the previous step for each domain you want to add.
5. Click Save when you are done adding domains.
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15: Developing and Deploying 
Node-RED flows

Node-RED is an open-source, multi-platform software program, where you wire together devices, databases, 
cloud applications, and APIs (application programming interfaces) to create simple logic flows to accomplish 
specific goals. It is pre-installed on your groov EPIC processor

Because Node-RED is integrated with the groov EPIC processor, you do not have to download and install it on 
a computer or embedded device. You can just log into your groov EPIC processor and start using Node-RED. 
This tight integration also means that some system-level functions, like backup, apply to your Node-RED 
projects.

WHAT IS Node-RED AND HOW DOES IT WORK IN groov EPIC?

Node-RED is a visual tool originally designed at IBM® Emerging Technologies to connect hardware devices, 
APIs, and online services. Many people develop Internet of Things (IoT) applications with Node-RED.

In Node-RED you connect prebuilt nodes (provided by device manufacturers or software developers) together 
to make a flow. The flow provides the logic to accomplish your goal. You can also add function nodes 
containing JavaScript to enhance the flow with functionality that may not be available in existing nodes.

Opto 22 provides Node-RED nodes to obtain data and information 
from:
• Tags added to a groov View Data Store, a handy way to get 

information from groov View projects.
• PAC Control strategies running on Opto22 groov EPIC 

processors and SNAP PAC controllers, which are reliable, 
industrial-grade controllers used in thousands of applications 
worldwide.

• groov I/O modules mounted on a groov EPIC chassis or 
groov RIO modules, a great way to access I/O data without 
needing access to the PAC Control strategies or any other 
control programming.

The Opto 22 developer website (developer.opto22.com) provides a 
wealth of information about each of the Node-RED nodes, including 
tutorials, configuration information, and instructions with examples.

http://developer.opto22.com/


MANAGING THE Node-RED RUNTIME AND PROJECTS

groov EPIC User’s Guide156

Node-RED in the groov EPIC processor

Pre-installed in the groov EPIC processor is the Node-RED runtime—the engine that runs Node-RED flows—
and the tools you need to:
• Create and debug flows
• Enable, disable, and restart the runtime
• Troubleshoot issues with the runtime
• Backup and restore Node-RED projects

Node-RED Editor. You can include one or many flows in your Node-RED project, which you build in the 
standard, browser-based Node-RED Editor. You can access the editor directly through a URL or navigate to it 
through groov Manage.

Because Node-RED is a general-purpose programming environment, you have the freedom to create flows 
with nodes from a wide variety of third-party sources, in addition to those provided by Opto 22 (see 
page 155).

Debugging. With few programming restraints, it’s easy to write bugs into your flow. The Node-RED Editor can 
help you debug flows. If Node-RED crashes, it automatically restarts. You can also start and stop Node-RED 
yourself from within groov Manage.

Files. Your Node-RED project consists of two files: the main file with all your flows, and a separate file 
containing all the sensitive credential information used by some nodes, such as usernames and passwords for 
an email node. The groov EPIC processor provides ways to backup and restore Node-RED projects, either 
separately or as part of the complete system backup and restore.

MANAGING THE Node-RED RUNTIME AND PROJECTS

There are several tools that can help you manage the runtime and projects.

Stopping a Flow by Disabling the Runtime

If you need to stop a Node-RED flow from running, but not disrupt other services running on the processor, 
you may want to disable the runtime.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
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2. From the groov Manage Home page, click Node-RED. In the Status section, click Disable.

groov Manage displays a message to remind you that disabling the runtime also stops the flows. Click OK 
to close the message. groov Manage displays the Node-RED Status page and updates the Status field to 
show that it’s stopping the runtime.

Restarting the Runtime

1. Log into your groov EPIC processor with a user ID that has administrator privileges.
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2. From the groov Manage Home page, click Node-RED. Select one of the following:
– If the runtime is running, click Restart.

– If the runtime is stopped, click Enable.

Backing up a Node-RED Project

The groov EPIC backup feature (see “Backing up Your groov EPIC Processor” on page 219) can back up 
Node-RED projects. However, you may want to use the Node-RED backup feature if you are working primarily 
in Node-RED and want to back up your projects more frequently than you backup your entire processor.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
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2. From the groov Manage Home page, click Node-RED > Project Management.

3. Click Download Project. Wait a few moments while groov Manage creates the backup file.
4. Navigate to the media and folder where you want to store the backup file. groov Manage suggests a 

default name of node-red.project.zip. You can keep this file name or rename it by typing over 
the default name. Click Save.

5. Opto 22 recommends that you apply some form of security on the backup file because it contains 
sensitive information (like user names and passwords).

You can click on Status to return to the main Node-RED page.

Restoring a Node-RED Project

The groov EPIC restore feature (see “Restoring a Backup or Specific Settings from a Backup File” on page 222) 
can help you restore Node-RED projects. However, if you are working primarily in Node-RED and backup your 
projects with the Node-RED backup feature, you’ll want to restore projects with the Node-RED restore feature.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. From the groov Manage Home page, click Node-RED > Project Management.
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3. In the Backup/Restore section, click Upload Project.
4. Navigate to the media and folder where you stored the backup file. Select the file and then click Open.

groov Manage displays a message that reports progress.

5. When the restore finishes, click Start to restart Node-RED and start the flow.
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groov Manage displays a progress message while Node-RED restarts:

6. Click Close after reviewing the last message.

7. Click Status to return to the Node-RED page. The Status should be Running and your flow should be 
running.
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Troubleshooting Node-RED Runtime

If you are experiencing issues with the Node-RED Runtime, the Node-RED page provides a few tools and 
displays information to help you identify or correct some issues:

CREATING YOUR FIRST Node-RED FLOW

If you have never created a Node-RED flow, this section takes you through the creation of a simple Node-RED 
flow, then builds on that first flow to include real-world communication to a PAC Control strategy running on a 
groov EPIC processor or a SNAP PAC controller.

Requirements

• A groov EPIC processor
• A computer that can communicate with the groov EPIC processor
• For the real-world communication section, you need one of the following:

– A groov EPIC processor running a PAC Control strategy
– Opto 22 SNAP PAC R-series or S-series controller with firmware R9.5 or higher, running a PAC Control 

strategy R9.5 or higher, with its built-in RESTful API configured (see Quick Start steps on 
developer.opto22.com).

Opening the Node-RED Editor

You can open the Node-RED editor with either of the following methods:
• Open a web browser and enter either of the following in the URL bar:

Click here to access the log file, which 
contains time-stamped messages 
about the actions and results of those 
action performed by the Node-RED 
runtime and flows.

Information that can help Opto 22 
Product Support troubleshoot your 
issues, as well as provide information 
about the runtime’s performance and 
the resources it consumes.

http://developer.opto22.com/rest/pac/quickstart/
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– https://[your groov EPIC processor’s hostname]/node-red
– https://[your groov EPIC processor’s IP address]/node-red
Don’t forget the “s” in https. Examples:
– https://opto-00-d2-da/node-red
– https://192.0.2.20/node-red

• If you are in groov Manage, click the menu button ( ), then select Home. From the Home page, click 
on Node-RED ( ), then Open Node-RED Editor ( ).

If you are new to the Node-RED Editor, take a moment to review the following diagram to familiarize yourself 
with the different parts of the editor.

Creating a flow

1. In the Nodes palette on the left, locate the inject node. Click and hold on it, then drag it to the workspace.
The inject node lets you inject messages into a flow, either by clicking the button on the node or by 
setting a time interval between injects.

Nodes palette Workspace Menu

Tips 
box
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2. In the info tab on the right side-bar, click the inject node to see information about its properties and a 
description of what it does:

You might want to close the Tips box to remove it so that you can see more information in the info tab.
3. Scroll down in the Nodes palette and locate the debug node. Drag it to the workspace.
4. Wire the inject and debug nodes together by dragging from the output port of inject to the input port of 

debug.

Deploying the flow and testing it

The nodes exist only in the editor and must be deployed to the server.
1. Click the Deploy button in the upper right. 
2. In the sidebar, select the debug tab. Click the button on the inject node. 

Numbers appear in the sidebar:
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This number is a timestamp representing the number of milliseconds since January 1, 1970. This is the 
default payload of the Inject node.

Adding a Function node

Let’s make the timestamp more readable by using a Function node. Function nodes let you pass each 
message though a JavaScript function. If you don’t know JavaScript, you may be able to find code you need 
using an Internet search. 
1. Click and hold on the function node, then drag it to the workspace, placing it between the inject and 

debug nodes. If the wire between the inject node and debug node becomes a dashed line, let go of the 
mouse button. The Node-RED editor automatically wires the Function node to the inject node and the 
debug (msg.payload) node.

If you didn’t see a dashed line, you need to delete the existing wires by selecting them and pressing 
Delete on the keyboard. Add two new wires: one to link the output of the inject node to the input of the 
function node, the second wire to link the output of the function node to the input of the debug 
(msg.payload) node.
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2. Double-click the Function node to edit it. The Node-RED editor displays the Edit function node panel.

3. In the Name field, type Human Date.
4. Copy the following code into the Function field, at line 1:

// Create a Date object from the payload
var date = new Date(msg.payload);
// Change the payload to be a formatted Date string
msg.payload = date.toString();

5. Leave this code in place at the end:
return msg;

6. Click Done to close the edit dialog box and then click the Deploy button.
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7. Now when you click the Inject button, the message in the sidebar shows a more readable time stamp:

Installing groov View nodes

Your groov EPIC processor must have access to the Internet to install groov View nodes.
1. Click the menu button ( ), then select Manage palette. 
2. Click the Install tab.
3. In the search field, enter groov. 

4. Find node-red-contrib-groov in the list and click the Install button next to it.
5. The Node-RED Editor displays a message about checking dependencies and reviewing node 

documentation. Click Install. When installation is finished, the small Install button changes color to gray 
and changes text to Installed. Click Close.

Install tab Search field

groov View nodes
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The new groov nodes appear at the bottom of the nodes palette. These groov View nodes can read and write 
data from a groov View Data Store. For an introduction to Data Stores and how to create them in groov View, 
see “Adding a Data Store” in the groov View User’s Guide (form 2027). After you create the Data Store in groov 
View, you can access the Data Store in your Node-RED flow by accessing the groov View project that contains 
the Data Store.

Adding an Opto 22 PAC Control node

For this section, you’ll add nodes to establish real-world communication with groov View Data Stores and tags 
in PAC Control strategies. You need either of the following:
• An Opto 22 groov EPIC processor running a PAC Control strategy, or
• a SNAP PAC S-series or R-series industrial controller with firmware R9.5 or higher, running a PAC Control 

R9.5 or higher strategy. 

For either of these options, you need to complete the configuration instructions on developer.opto22.com. At 
the website, click on Node-RED for PAC Control, then expand Getting Started. For the groov EPIC processor, 
click on groov EPIC Controller Configuration; for the SNAP PAC controller, click SNAP PAC Controller 
configuration.

http://developer.opto22.com/rest/pac/quickstart/
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4361
http://www.opto22.com/site/pr_selector.aspx?cid=1&qs=1002
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You’ll also need the following information, which you can collect as you complete the processor or controller 
configuration:
• API Key Name and Value
• SSL Certificate

After you set everything up and gathered this information, you can start:
1. Install Node-RED for PAC Control nodes just as you installed the groov View nodes. (Menu > Manage 

palette > Install tab. Search for node-red-contrib-pac.)
2. Make sure you have an inject and a debug node in the workspace.
3. Near the bottom of the Nodes palette, click and hold on the pac read node and drag it to the workspace, 

in between inject and debug (msg.payload).
The pac read node lets you read I/O and variable data in the PAC Control strategy.

4. Wire the pac node to the inject node and debug node, in the same way you wired the Function node. 
5. Click the node and click the info tab to see helpful information about the node. 
6. Double-click the pac read node to edit it.

7. Click the pencil at the right of the Controller field.

8. Complete the fields:
a. For PAC Address, choose a protocol (HTTPS is strongly recommended because it is secure) and enter 

the IP address of the groov EPIC processor or the SNAP PAC controller.
b. If you are configuring a SNAP PAC Controller, enter the API Key ID and Value. If you are configuring a 

a groov EPIC processor, leave this field blank.
c. If you are using HTTPS as recommended, as directed in the info tab. The information you enter in 

this section is dependent on where Node-RED is running, so read the help carefully to make sure 
you enter the correct information.

d. Click Add.
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The Node-RED editor returns you to the Edit pac read node panel, where your node is now configured to 
access the I/O and variable data in the PAC Control strategy running on the groov EPIC processor or the 
SNAP PAC controller:

9. Choose the Data Type from the dropdown list. 
The data type determines what other fields appear. In this example we chose Analog Input, so a field 
appears for Tag Name.

a. Tag Name—Enter the exact I/O point or variable name from the PAC Control strategy running on 
this controller. If you leave this field blank, you’ll receive values for all tags of this type (in this 
example, all analog inputs).

b. Start Index and Length—For a table, enter the starting index and length of the data you want to 
use.

c. Node Name—(Optional) By default, the tag name is used for this node. If you want to give it a 
different name, enter it here.

d. Click Done.
10. Click the down arrow next to Deploy to see your choices. 
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11. Click Deploy. Now click the inject button and see what message appears in the debug tab.
You should see the data from your PAC Control strategy. Here’s how our example looks:

EXAMPLE: OBTAINING DATA FROM A BLUETOOTH-CAPABLE FIELD DEVICE

This example focuses on how to obtain temperature data from a supported Bluetooth-capable field device: a 
TE MEAS M5600 Wireless Pressure Transducer (model M5600-000005-300PG). (This device is the only 
Bluetooth-capable device approved for use with a groov EPIC processor; see “Installing an Approved USB 
Bluetooth Adapter” on page 107.) This device includes a temperature sensor; in this example, you will learn 
how to create a Node-RED flow that obtains the temperature data from that sensor. The example is designed 
to work manually:
• You will click on an inject node to connect to the transducer.
• You will click on an inject to take a temperature reading, then view the output in the Debug panel.

This example does not describe how to send the data to a control program or an HMI.

Requirements

• A groov EPIC processor.
• A computer that can communicate with your groov EPIC processor.
• Node-RED enabled on your groov EPIC processor (see “Managing the Node-RED Runtime and Projects” 

on page 156).
• Basic knowledge and experience building and deploying Node-RED flows and adding packages. If you 

need to learn, see “Creating Your First Node-RED Flow” on page 162.
• The approved Bluetooth adapter installed on the USB port of your groov EPIC (see “Installing an 

Approved USB Bluetooth Adapter” on page 107).
• A TE MEAS M5600 Wireless Pressure Transducer (model M5600-000005-300PG) and intermediate 

knowledge and experience with the transducer, specifically:
– How it stores information in a Generic Attribute Profile (GATT)
– The characteristic that hold the temperature data (f000 ab31 0451 4000 b000 0000 

0000 0000).

You can deploy everything, or if you don’t want to disturb running 
flows, you can choose to deploy only the changed flows or 
changed nodes. 

The gray box around the icon shows what will happen when you 
click the Deploy button. In this example, everything is deployed 
(Full).
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– Knowledge that the transducer returns raw temperature data which then needs to be converted to 
degrees Celsius. The transducer documentation provides the conversion formula:

temperatureCelsius = temperatureRaw / 100

The device manufacturer typically provides this information in the user manuals and software protocol 
specification, which come with your field device.
If you are not familiar with GATT, you can learn more about it and the Attribute Protocol—a client/server 
model for transmitting and sending data (GATT) between Bluetooth devices—through online resources.

Open the Node-RED Editor and Add the Generic BLE Package

1. Log in to your groov EPIC processor with an ID that has system-level privileges.
2. Click Node-RED and verify that it is running. Then click Open Node-RED Editor.

3. Add the node-red-contrib-generic-ble package. If you already have the package installed, check that it’s 
at the latest version.
a. Click the main menu icon ( ), then select Manage Palette. Node-RED displays the User Settings 

panel.
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b. Click the Install tab. In the search field, type node-red-contrib-generic. Node-RED displays 
a list of packages matching that name.

c. Click install on the node-red-contrib-generic-ble package. When prompted to confirm this action, 
click Install.

d. Wait for Node-RED to display the list of nodes it installed, then click Close in the User Settings panel.

4. If you don’t have a blank flow open, create one: click the main menu icon ( ), then select Flow > Add.

Add and Configure a Generic BLE Node

In this section, you will learn how to add a generic BLE out node and set it to scan for the field device. During 
the scan, Node-RED will obtain the following information and then you will assign it to the node:
• MAC address
• UUID
• GATT characteristics
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1. Drag a Generic BLE out node to the palette.

2. Double click on it to open the Edit Generic BLE out node dialog. Type in a name for the node. For this 
example, we type in Transducer. In the BLE field, make sure Add new Generic BLE is selected.
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3. Click on the Pencil button. Node-RED opens the Add new Generic BLE config node dialog.

4. Click BLE scanning. Node-RED starts to “listen” for a BLE device and adds a Scan Result field to the dialog.
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5. On the field device, follow the manufacturer’s instructions to start advertising. The transducer begins 
advertising when it is charged and not connected to a charging device.

6. Wait for the field device and the Bluetooth adapter on the groov EPIC processor to establish Bluetooth 
communication. After communication is established, Node-RED adds the device to the Scan Result 
drop-down list.

7. Click the down arrow in the Scan Result drop-down list and select your field device.
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8. Click Apply. After a few moments, Node-RED adds the field device’s MAC address, UUID, and GATT 
characteristics to the appropriate fields in the Properties page. The following image shows an example.

9. Click Add to close the Add new Generic BLE config node dialog, then click Done to close the Edit Generic 
BLE out node dialog. Your Node-RED workspace should look like the following:
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Add and Configure a Connect Device Inject Node

Add an inject node that, when pushed, triggers the Node-RED flow to connect to the transducer.
1. Drag an inject node from the palette to the workspace.

2. Double click the inject node to open the Edit inject node dialog.
3. In the Name field, type in a name. For our example, we type in Connect Device.
4. For msg.topic, type in connect. The following image shows the completed dialog.

5. Click Done.
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6. Connect the Connect Device node to the Transducer node.

Add and Configure a Temperature Reading Node

Add a generic BLE node that will hold the value of a temperature reading.
1. Drag a Generic BLE in node onto the workspace.

2. Double click the node to open the Edit Generic BLE in node dialog.
3. In the Name field, type in a name for the node. For our example, we type in Temp Sensor Value.
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4. In the BLE field, select the transducer, if it’s not already selected. The following image shows the 
completed dialog.

5. Click Done.

Add and Configure a Read Temperature Inject Node

Add an inject node that, when pushed, reads the temperature data from the transducer.
1. Drag an inject node onto the workspace.

2. Double click the inject node to open the Edit inject node dialog.
3. In the name field, type in a name for the node. For our example, we type in Read Temperature.
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4. In the msg.topic field, type in the GATT characteristic that holds the raw temperature data: 
f000ab3104514000b000000000000000

The following image shows the completed dialog.

5. Click Done.
6. Connect the Read Temperature node to the input side of the Temp Sensor Value node.
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Add a Convert to Celsius Function Node

Add a node that converts the temperature data from its raw format to degrees Celsius.
1. Drag a function node onto the workspace.

2. Double click the function node to open the Edit function node dialog.
3. In the Name field, type in a name for the node. For our example, we type in Convert to Celsius.
4. In the text entry box of the Function tab, type in the conversion formula. For our example, type in the 

following Javascript above the return msg; line:
temperatureRaw = 
msg.payload.characteristics.f000ab3104514000b000000000000000.readInt16LE(0);
temperature = temperatureRaw / 100;
msg.payload = temperature + " (°C)";
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The following image shows the completed dialog:

5. Click Done.
6. Connect the output side of the Temp Sensor Value node to the input side of the Convert to Celsius node.
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Add and Configure a Disconnect Device Inject Node

Add an inject node that disconnects the transducer.
1. Drag an inject node from the palette to the workspace.

2. Double click the inject node to open the Edit inject node dialog.
3. Type in a name for the node. For this example, we type in Disconnect Device.
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4. For msg.topic, type in disconnect. The following image shows the completed dialog:

5. Click Done.
6. Connect the Disconnect Device node to the Transducer node.
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Deploy and Test the flow

1. Make sure the transducer has adequate battery voltage.
2. Click Deploy.

3. Click the button on the Connect Device node.

If the device doesn't connect, then do the following:
a. Click the button on the Disconnect Device node.

b. Double click the Transducer node to open the Edit Generic BLE out node dialog.
c. Click the pencil icon next to the BLE field.
d. Remove the check on the BLE Scanning check box.
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e. Click Cancel to close the Edit Generic BLE node dialog, then click Cancel again to close the Edit 
Generic BLE out node dialog.

f. Return to step 3.
4. Wait a moment.
5. Click the button on the Read Temperature node.

6. Click the Debug tab in the sidebar. Look for the temperature reading. The bottom of the following image 
shows the temperature reading.



groov EPIC User’s Guide 189189

16: Monitoring and Configuring 
Modules and Channels

groov EPIC is designed to help you monitor and configure I/O in a variety of settings, from an independent I/O 
system (publishing I/O data to cloud and SCADA systems) to its own complete automation system (running 
control programs created with PAC Control, CODESYS, or custom programs). As such, how to configure I/O is 
dependent on the setting your working in. Regardless of that, though, with groov Manage you can:
• Check the health (status) of a module at a glance with the module LED or in more detail through the 

Modules page
• View the following information about each module:

– channel names and status
– wiring diagrams
– specification information
– module-specific information like serial number, module ID, and firmware versions

• Monitor the status of channels on each module and identify some problems through quality indicators 
(available on some modules)

• Assign names to channels, enable or disable quality indicators, and select features (on some modules) 
that a channel measures

CONFIGURING groov I/O MODULES AND CHANNELS

There are several ways to configure groov I/O modules and channels. You can do it through programming:
• If your groov EPIC processor is running a PAC Control strategy, you configure the I/O in PAC Control. For 

instructions, see PAC Control User’s Guide (form 1700).
• If your groov EPIC processor is running as part of your CODESYS application, you configure the I/O in 

CODESYS Development System. For instructions, see “Configuring Processor Parameters” on page 127.
• If your groov EPIC processor is running a custom control program, there are several ways to configure 

your I/O. You can do it through OptoMMP memory maps, through SDKs, or even through Node-RED 
flows. For instructions, see our special website dedicated to helping custom control programmers, 
developer.opto22.com.

Another method, which is independent of any control programming, is through groov Manage. This method is 
helpful if you want to manage and transmit I/O strictly through MQTT (with either Sparkplug B or string 
payloads) or Node-RED flows. This means that the EPIC processor isn’t running any control programs that 
might configure I/O.

If you choose to configure I/O modules and channels through this method, remember the following:
• If you run a control program that configures groov EPIC I/O modules and channels, your control program’s 

configuration will over-write any changes you made through groov Manage. The opposite is true, as well: 

https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
http://developer.opto22.com/
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if your control program configures I/O, then you change the any of that I/O configuration through 
groov Manage, the changes made through groov Manage could cause errors in your control program.

• It’s also important to remember that the changes you make to your channels through groov Manage are 
lost whenever the processor is restarted. If you want to save the configurations made through 
groov Manage, backup your information as described in “Backing up Your groov EPIC Processor” on 
page 219.

To configure an I/O channel on a module:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ), then select I/O.
3. In the Modules page, click or tap the box that represents the module that contains the channels you 

want to configure.
groov Manage displays a module page similar to the one below. The number of channels on the page 
depends on the module type. If the module has 24 channels, then the page shows 24 channels.

4. Click or tap on the channel you want to configure. groov Manage displays a channel page. The 
information on the page depends on the module type. Here are a few examples:
GRV-IACI-12 module—An AC digital input module with 12 channels.
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GRV-OMRIS-8 module—A mechanical relay output module with 8 channels.

GRV-ODCI-12 module—A DC digital output module with 12 channels.

5. Click on Configure. Again, the information displayed on the page depends on the type of module. Here 
are the configuration pages for the same modules shown in the previous step:
GRV-IACI-12 module—An AC digital input module with 12 channels.
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GRV-OMRIS-8 module—A mechanical relay output module with 8 channels.

GRV-ODCI-12 module—A DC digital output module with 12 channels.

6. Select the changes you want to make. Some of the most frequently occurring fields are:
– Name—You can view this name on the channels page and groov Manage saves it when you 

backup your I/O configuration.
– Module Type and Channel Type are for your information. You can’t edit these fields
– Quality Indication—(Available on some modules.) This switch enables or disables whether the 

module LED changes color to indicate that there is a quality error on one or more channels. To 
determine whether you should enable or disable this feature, see “Working with Quality Indication” 
on page 202.

– Watchdog—(Available on some modules.) Select whether you want a Watchdog on a channel. 
With a Watchdog, the groov EPIC processor monitors activity on the channel. If no activity is received 
for the time specified in the Watchdog Timeout field, the channel assumes a Watchdog state; the 
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output immediately goes to the value you enter or selected. (To find the Watchdog Timeout field, 
from the groov Manage Home page, click I/O > Config.)
The default is disabled (the slider shows grey). If you move the slider to the right to show green, you 
enable Watchdog on that channel. Then you can enter or select a value in the Value field. The value 
you enter or select is what the output is set to after the timer expires. 

– Feature—This is for modules with full feature sets. Simple modules (modules with part numbers 
that end in “S”) don’t have features. When you click on None (or a feature name, if shown), 
groov Manage displays a list of features that this particular module supports. Select a feature you 
want. The following example shows the feature list for the GRV-IDC-24 module:

If you select Off-Pulse from this list, after you save your changes, the channel page will show 
Off-Pulse.
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– Public Access—A switch that can make the tags from this channel available to services like 
Sparkplug and Node-RED. When you enable this for discrete channels, you see the following 
options:

When you enable this for analog channels, you see the following options:

7. Click Save. groov Manage refreshes the channel page with any changes we made.
In the previous example, we selected the Off-Pulse feature. The follow diagram shows how groov 
Manage added Off-Pulse to the channel page.
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Working with the Scratch Pad

groov EPIC processors contain Scratch Pad areas within their memory maps. The Scratch Pad areas can hold 
data to transfer from one peer to another on the network.

The Scratch Pad is user-defined, meaning that you define and use its addresses to fit your needs, and you can 
redefine them whenever necessary. The Scratch Pad area includes several sections to accommodate different 
types of data: strings, floats, and integers.
• The Scratch Pad strings section is a table of 64 elements. Each element can hold 128 characters or 128 

bytes of binary data.
• The Scratch Pad float section is a table of 10,240 elements; each float is four bytes.
• The Scratch Pad 32-bit integer section is also a table of 10,240 four-byte elements.
• The Scratch Pad 64-bit integer section is a table of 1024 eight-byte elements.

How it works: Your groov EPIC processor can write data (from different sources; see below) to its Scratch Pad 
area. Another peer (another groov EPIC processor, a SNAP PAC controller, or another MMP device) can read the 
data from the Scratch Pad area of your groov EPIC processor. Similarly, another peer (another groov EPIC 
processor, a SNAP PAC controller, or another MMP device) can write to the Scratch Pad area of your groov EPIC 
processor, which can then read the data deposited in its own Scratch Pad area by the peer. You must very 
carefully coordinate the reading and writing of data to the Scratch Pad area by peers to avoid conflicts.

The following can read from and write to the Scratch Pad areas:
• PAC Control strategies—You can use PAC Control Scratch Pad commands. See “I/O Unit—Scratch Pad 

Commands” in Chapter 10 of the PAC Control User’s Guide (form 1700).

Example 1: Your groov EPIC processor writes (1) to its own Scratch Pad at a specific address. Another 
groov EPIC processor reads (2) from that address.

Scratch Pad area:

Example 2: Your groov EPIC processor writes (1) to its own Scratch Pad at a specific address. A SNAP PAC 
R-series controller reads (2) from that address.

Scratch Pad area:

(1)

(2)

(1)

(2)

https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
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NOTE: Scratch Pad float and 32-bit integer tables are not made up of contiguous addresses in the memory 
map; each table is in two address sections. You won’t notice this if you are using PAC Control Scratch Pad 
commands, but if you are addressing these tables in another application, check the memory map appendix in 
the OptoMMP Protocol Guide (form 1465) to make sure you have the correct addresses for the table elements 
you want. For more information on PAC Control Scratch Pad commands, see “I/O Unit—Scratch Pad 
Commands” in Chapter 10 of the PAC Control User’s Guide (form 1700).

• Custom control programs and groov I/O Node-RED nodes—You access the Scratch Pad areas through 
the MMP addresses. The Scratch Pad areas of the memory map are described in the appendix of the 
OptoMMP Protocol Guide (form 1465).

Viewing and Modifying the Scratch Pad

1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click I/O > I/O Tools > Scratch Pad. groov Manage displays the Scratch Pad page. The Settings section is 

where you indicate the specific section of the Scratch Pad you want to view and the data type of that 
section. The Values section is where groov Manage displays the section you selected and the values 
stored in that section.

To view a specific section of the Scratch Pad:
a. Select the data type, which indicates which of the four sections (tables) of the Scratch Pad you want 

to view.
b. Click on Index and enter which table element you want to start to view, then press Enter. (The range 

of values you can enter depends on the data type. If you enter a value that exceeds the range, 
groov Manage displays an error message.)

c. Click on Length (or click the + or - signs) to display a specific number of elements after the index.
d. If it makes it easier to read the values in hexadecimal, click the Hexadecimal switch to enable the 

display of values in hexadecimal.

https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
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To modify a value in the Scratch Pad:
a. Make sure you are viewing the correction section of the Scratch Pad and in the correct format (see 

previous steps).
b. Scroll down the Values rows until you find the specific segment you want to modify.
c. Click that row, type in the value, then click Apply.

Working with GRV-IDCIFQ-12 (Quadrature) Modules

The GRV-IDCIFQ-12 quadrature input module can resolve up to four axes of rotating position information from 
quadrature encoders. For each axis, the module converts a quadrature signal to counts used to keep track of 
direction and position.

For each axis, the module reads the following signals from your encoder:
• Phase A and B signals. Outputs from the encoder that are in quadrature offset from each other.
• Index signal (optional). An output from the encoder that provides a single pulse for every full rotation. 

Typically required by applications that need to know a specific position during a 360° revolution. If your 
application doesn’t require this information, then you do not need to provide this signal.

Phase A and B signals are wired to the first two channels of an axis. If you configure both of these channels for 
quadrature, the counter value on the first channel will return quadrature counts since the last Read & Clear 
counter operation. Counts increase for one direction of rotation of the encoder and decrease for the other. If 
you do not configure both of these channels for quadrature, then you can use them as a discrete input with 
high speed counting capability.

The index signal is wired to the third channel and can be configured with one of the following features:
• Quadrature Index on Rising Edge
• Quadrature Index on Falling Edge

By setting one of these features on the third channel, the counter value on the 2nd channel will return 
quadrature counts since the index edge and the counter value on the 3rd channel will return quadrature 
counts (from the first channel) at the last index edge. If you do not select either of these feature, you can use 
the channel as a discrete input with high speed counting capability.

The module increments or decrements the count as follows:
• Increments by 4 for each encoder pulse when the phase A signal leads the phase B signal.
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• Decrements by 4 for each encoder pulse when the phase B signal leads the phase A signal.

The module has a maximum count of 2,147,483,647, then it rolls over to -2,147,483,648.

Review the specifications of your encoder, specifically the number of cycles per turn (pulses per revolution or 
PPR). Calculate the maximum RPM that the GRV-IDCIFQ-12 module can measure with the following formula:

After you have collected this information, you can wire up your encoder to the module and configure the 
corresponding channel(s) on the module:
1. Review the module wiring diagram on page 309. Select which Axis (1, 2, 3, or 4) you want to use for this 

encoder and then wire your encoder as indicated in the wiring diagram.
2. Mount the GRV-IDCIFQ-12 module to the chassis.
3. Configure your quadrature module:

– If your control program is a PAC Control strategy, configure the module as described in PAC Control 
User’s Guide (form 1700). Do not follow the rest of the steps in this section.

– If your control program is a CODESYS application, see “Configuring Processor Parameters” on 
page 127. Do not follow the rest of the steps in this section.

– If you aren’t configuring your quadrature module through a control program (in other words, your 
groov EPIC is functioning as remote I/O), you can continue with the rest of the steps.

4. Log into your groov EPIC with a user ID that has administrator privileges.
5. From the groov Manage Home page, click I/O, then click the box that represents your GRV-IDCIFQ-12 

module.
6. Configure the channels by clicking Channel number > Configure > Feature for each channel and 

selecting the features as follows:

Axis 
Number

Channel 
Number

Feature

1

0 Quadrature

1 Quadrature

2
(Optional) Select one of the following:
• Quadrature Index on Rising Edge
• Quadrature Index on Falling Edge

2

3 Quadrature

4 Quadrature

5
(Optional) Select one of the following:
• Quadrature Index on Rising Edge
• Quadrature Index on Falling Edge

3 000 000 
PPR

------------------------------- MaxRPM=
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Adding Termination to a GRV-CCANI-2 Module

Each end of a CANbus must be terminated with a 120 Ohm resistor. With groov Manage, you can configure the 
channels of a GRV-CCANI-2 module to provide this termination. You must have the GRV-CCANI-2 module 
mounted in slot 0, 1, 2, or 3 of your groov EPIC chassis before you begin:
1. Open a browser and log into your groov EPIC processor with an ID that has system administrator 

privileges.

2. Click I/O, then select your GRV-CCANI-2 module. groov Manage displays the Module x page, where x is 
the slot number.

3

6 Quadrature

7 Quadrature

8
(Optional) Select one of the following:
• Quadrature Index on Rising Edge
• Quadrature Index on Falling Edge

4

9 Quadrature

10 Quadrature

11
(Optional) Select one of the following:
• Quadrature Index on Rising Edge
• Quadrature Index on Falling Edge

Axis 
Number

Channel 
Number

Feature
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3. Click on a channel on the module, then click Configure. groov Manage displays the channel’s 
configuration page.

4. Click on Channel Type. groov Manage displays the Channel Type window. Click CAN, with termination.

5. Click Save. groov Manage displays the channel’s status page, where you can see that the channel is now 
configured with termination.



CHAPTER 16: MONITORING AND CONFIGURING MODULES AND CHANNELS

groov EPIC User’s Guide 201

CHECKING THE HEALTH (STATUS) OF A MODULE

groov EPIC offers two ways to quickly monitor the status of a module:
• Through the module LED on the cover of a module
• Through the Modules page of groov Manage

Checking Module Status Through the Module LED

The module LED on the cover of a module changes color and blink pattern to indicate the status of a module:

This color and blink pattern: Indicates:

No color Module is off.

Blue, solid Module is operating normally.

Blue, blinking
The groov EPIC processor is currently displaying information about this
module on the touchscreen.

Violet, solid Module is installing a firmware update.

Yellow, solid Module is indicating that there is a quality errora on one or more channels.

aTo learn more about quality errors, see “Working with Quality Indication” on page 202.

Yellow, blinking
Module is indicating that there is a quality errora on one or more channels and 
that the groov EPIC processor is currently displaying information about this 
module on the touchscreen.

Red, solid Module is on but not communicating with the groov EPIC processor.

Red, blinking Module is trying to establish communication with the groov EPIC processor.

Off Blue Yellow RedViolet
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Checking Module Status Through groov Manage on a Browser

Checking module status through groov Manage is very helpful when you cannot be physically near the 
modules or easily view the module.

Note: If you are running a CODESYS application on your groov EPIC processor, check the module status through 
CODESYS Development System, not through groov Manage.

To view the status of modules mounted on the chassis:
1. On a computer or mobile device, log into your groov EPIC processor with a user ID that has administrator 

privileges.
2. In the Home page, click I/O ( ). groov Manage displays the Modules page. The following 

diagram shows examples of two different 16-module chassis:

In the diagram, the chassis on the left has 9 modules mounted on it, all operating normally. The chassis on the 
right has 9 modules mounted on it, with the module in slot 13 (a GRV-OACI-12 module) showing yellow, 
indicating that there is a quality error. To find out more about the quality error, see “Working with Quality 
Indication” on page 202.

WORKING WITH QUALITY INDICATION

What is Quality Indication?

Some groov I/O modules can identify and report on the quality—a characteristic of the value—of the signals 
entering or leaving the channels. This is called the Quality Indication feature. The modules continuously poll 
their channels for current data values and identify deviations between reported and expected values. For 
example, when a channel on a GRV-IV-24 module reports a value greater than 10% above the high end of the 
range, the module sets a quality indicator code of 15 (Input is more than 10% above the maximum range) on 
the channel. When the issue is resolved, the quality indicator code returns to 0 (zero). To view a list of quality 
indicator codes, see Appendix F: Quality Indicator Codes.

The following groov I/O modules have the Quality Indication feature:
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By default, the Quality Indication feature is enabled for all channels on these modules. You can disable this 
feature on a channel-by-channel basis. A good practice while you are configuring a module is to disable this 
feature for all channels that are not connected (wired) to field devices. You do not have to enable the feature 
for all connected channels; however, you should disable it for all disconnected channels. When you configure a 
channel, you can disable the feature:
• In groov Manage, see step 6 in “Configuring groov I/O Modules and Channels.”
• Through PAC Control, when you add or edit a channel, deselect the Enable Quality Indicator check box.
• Programmatically, through the OptoMMP memory map. Review the description of the Configuration 

bitmask in the (Expanded) Analog & Digital Channel Configuration—Read/Write area of the map in the 
OptoMMP Protocol Guide (form 1465).

How groov EPIC Informs You About the Quality of a Signal

groov EPIC can visually inform you about the changes to the quality of a signal that it measures (see Appendix 
F: Quality Indicator Codes), as well as offering you ways to programmatically obtain this information:
• The module LED changes to yellow.

If one connected channel reports a quality error, the module LED turns yellow. To 
determine which channel is reporting a quality error, see “Finding the Channel 
Reporting a Quality Code” on page 204).
It’s important that you disable the Quality Indicator feature for channels that are not 
connected (wired) to field devices. If you do not do this, disconnected channels will 
trigger the module LED to display yellow, which can obscure the reporting of a true 
change in the quality of the signals on connected channels.

• In the Modules page of groov Manage, the box that represents the module turns yellow:

Regardless of whether you enable the Quality Indication feature, the Module page always reports any 
quality errors. 

• GRV-IAC-24
• GRV-IACI-12
• GRV-IDC-24
• GRV-IDCI-12
• GRV-IDCIFQ-12
• GRV-IDCSW-12
• GRV-IMA-24
• GRV-IMAI-8

• GRV-IICTD-12
• GRV-IRTD-8
• GRV-ITM-12
• GRV-ITMI-8
• GRV-ITR-12
• GRV-IV-24
• GRV-IVI-12
• GRV-IVIRMS-10

• GRV-OAC-12
• GRV-OACI-12
• GRV-ODCSRC-24
• GRV-OVMALC-8
• GRV-OVMAILP-8

https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
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• In the Module page of a specific module, the channel reporting a quality error is highlighted in yellow 
and displays a message (see “Finding the Channel Reporting a Quality Code” on page 204):

• Programmatically, you can obtain this information through OptoMMP. There are sections of the memory 
map for groov I/O units dedicated to reporting the quality indicator code for channels, as well as to report 
whether a module has a channel reporting a quality indicator code. For more information, see OptoMMP 
Protocol Guide (form 1465).

Finding the Channel Reporting a Quality Code

If you see a module LED turn yellow or one of the modules in the Module page of groov Manage turns yellow, 
you can find out what triggered the change through groov Manage:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap the menu button ( ), then select I/O. groov Manage shows the Modules page.

In the following diagram, the module in slot 13 is yellow, indicating that a channel on the module is 
reporting a quality issue:

3. In the Modules page, click or tap the box that represents the module that is reporting a quality issue.
In the example from the previous step, click or tap the box labeled 13:OACI-12.

https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
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4. groov Manage displays the list of channels for that module and highlights the channel that is reporting 
the quality issue with a yellow background.

Click or tap that channel.
5. groov Manage displays the specific information about that channel:

The Quality field shows you a message with an error code number and a possible reason for the error. This 
information can help you troubleshoot problems with a field device wired to that specific channel. For a 
complete list of quality indicator codes, see Appendix F: Quality Indicator Codes.
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17: Managing PID Loops

PID loops (or simply PIDs) are used to drive an input (a process variable) toward a particular value (the 
setpoint) and keep the input very close to that value by controlling an output. For example, consider 
temperature control, where the input is a measurement of ambient temperature, the setpoint is the desired 
temperature, and the output is a heater. The PID for this system will use a mathematical formula that controls 
the output to maintain a desired temperature, efficiently adjust to changes in setpoint, and compensate for 
changes in load, such as the influx of cold air. In this example, a temperature sensor (analog input), a 
thermostat (analog input), and a heater control (analog output) are components of one system, controlled by 
a PID loop.

This chapter assumes that you are already familiar with using PIDs. PID calculations are complex and the 
physical qualities of systems suitable for PID control differ greatly. You may be familiar with creating and 
managing PIDs through control programs like PAC Control; however, this chapter explains how to create and 
manage a PID through groov Manage, independent of any control program. If you configured a PID loop 
through PAC Control, you can review the current settings, as well as tune the PID.

PIDs can control isolated systems or be part of cascaded systems where one loop controls the setpoints or 
input variables of others. For maximum flexibility, you can set any PID input, setpoint, or output through 
groov Manage.

UNDERSTANDING HOW A PID WORKS

A proportional integral derivative (PID) control system (often referred to as a PID loop) monitors a process 
variable, compares the variable’s current value to a desired value (a setpoint), and calculates an output to 
correct error between the setpoint and the variable. Because the calculation is complex, it is done by a 
mathematical formula that is adjusted (tuned) for each PID loop. The mathematical formulas vary, but all PID 
systems share these fundamental concepts:
• They evaluate a process variable against its setpoint.
• They control an output to correct the process variable.
• The output comprises proportional, integral, and derivative calculations.
• The effect of proportional, integral, and derivative calculations is modified by user-determined P, I, and D 

constants.
• The P, I, and D constants need to be tuned for each system.

PIDS AND CONTROL PROGRAMS

The PID operates at the I/O unit-level, independently of the processor. Once configured and initialized, a PID 
operates until the I/O unit loses power.
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Each PID loop must be individually configured and tuned.

Configuration steps start in “Configuring a PID Loop” on page 210. For information about PAC Control logic 
commands to read and write various PID parameters, see PAC Control User’s Guide (form 1700).

PID LOOPS ON groov EPIC

groov EPIC provide 96 PID loops. Because PIDs run on the I/O side of the groov EPIC processor, not on the 
control side, these PIDs will keep running on the groov EPIC I/O unit even if any control program running on 
the processor stops.

In groov Manage, you can configure each of the PID loops with unique settings for a large number of 
parameters. For a simple PID loop, you must configure at least the following:
• Input (the process variable being monitored)
• Setpoint (the desired value)
• Output (the I/O point that effects change in the system)
• Scan time (how often the PID loop is run)
• PID algorithm used (several algorithms are available; see “Understanding PID Algorithms”  below).
• Valid range for input
• Upper and lower clamps for output
• Minimum and maximum change for output

You can also configure the following parameters if necessary:
• Forced output value or use of manual mode if input goes out of range
• Feed forward gain
• Square root of input

In groov EPIC, the derivative is applied only to the process variable (the input) and not to the setpoint. This 
means you can change the setpoint without causing spikes in the derivative term. These PIDs also prevent 
integral windup by back calculating the integral without the derivative term. The feed forward term (“bias”) is 
added before output clamping and has a tuning factor.

If desired, you can cascade PIDs by simply using the output channel of one PID loop as the input channel for 
another.

UNDERSTANDING PID ALGORITHMS

When you configure a PID loop, choose one of these algorithms:

• Velocity (Type C)
• ISA
• Parallel
• Interacting

You may also see the following obsolete algorithms:
• Velocity (Type B) Obsolete
• ISA (Obsolete)
• Parallel (Obsolete)
• Interacting (Obsolete)

https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
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These algorithms support PID loops configured before PAC Project R9.5. For details, see the Opto 22 
KnowledgeBase article KB82058You can continue to use these obsolete algorithms, but Opto 22 recommends 
when you configure new PID loops, you select the new algorithms.

Velocity (Type C) is typically used to perform velocity control. The ISA, Parallel, and Interacting algorithms are 
derived from the article “A Comparison of PID Control Algorithms” by John P. Gerry in Control Engineering 
(March 1987). These three equations are the same except for the tuning coefficients; converting from one 
equation to another is merely a matter of converting the tuning coefficients.

Key to Terms Used in Equations

Equations Common to All Algorithms
Err = PV - SP
Span = (OutHi - OutLo) / (InHi - InLo)
Output = Output + FeedForward * TuneFF

Equations Common to ISA, Parallel, and Interacting
Integral = Integral + Err
TermP = Err
TermI = TuneI * ScanTime * Integral
TermD = (TuneD / ScanTime) * ( PV - PV1 )

Velocity (Type C) Algorithm
TermP = ( PV - PV1 )

In this part of the formula, you adjust TuneI.
TermI = TuneI * ScanTime * Err

In this part of the formula, you adjust TuneD.
TermD = TuneD / ScanTime * ( PV - 2 * PV1 + PV2 )

In this part of the formula, you adjust Gain.
Output = Span * Gain * ( TermP + TermI + TermD )

ISA (or “Ideal”) Algorithm
Output = Span * Gain * ( TermP + TermI + TermD )

Parallel (or “Independent”) Algorithm 
Output = Span * ( Gain * TermP + TermI + TermD )

Interacting (or “Classic”) Algorithm 
Output = Span * Gain * ( TermP + TermI ) * ( 1 + TermD )

PV
Process variable; the input to the 
PID

TuneD
Derivative tuning parameter. In units 
of seconds. Increasing magnitude 
increases influence on output.

SP Setpoint Output Output from the PID

InLo, 
InHi

Range of the input Err_1
The Error (PV – SP) from the previ-
ous scan

OutLo, 
OutHi

Range of the output Integral
Integrator. Anti-windup is applied 
after the output is determined to be 
within bounds.

Gain
Proportional tuning parameter. 
Unitless. May be negative.

PV1, PV2 
PV from the previous scan and the 
scan before that.

TuneI
Integral tuning parameter. In units 
of seconds. Increasing magnitude 
increases influence on output. 

ScanTime
Actual scan time (time since previ-
ous scan)

http://www.opto22.com/site/knowledgebase/kb_view_article.aspx?aid=2159
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CONFIGURING A PID LOOP

Important: If you configure a PID loop through your control program, you may not be able to use these instructions:

• If you configure PID loops through PAC Control and then configure PID loops through groov Manage (by 
following the instructions in this section), the configurations you made through groov Manage will be 
overwritten or lost whenever you download your PAC Control strategy, stop it, or restart it.

• If you run a CODESYS application, it cannot access these PID loops directly. For the CODESYS application to 
obtain the data in these PID loops, configure the PID loop as described here, then programmatically obtain the 
data through the PID loop MMP addresses (see OptoMMP Protocol Guide, form 1465).

1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click I/O > PID Loops. groov EPIC supports 96 PID loops, so you will see 96 rows in the PID Loops page, 

numbered sequentially, beginning with 0. The following image shows the first 7 rows (PID loops 0 
through 6).

3. Click on the lowest unconfigured PID loop number. As an example, we will start with PID 0.

https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
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4. Click Configure. groov Manage displays the configuration page.

Fill out the fields and select options as follows:
Name. Type a unique, descriptive name for the PID.
Algorithm. Choose algorithm: Velocity, ISA, Parallel, or Interacting. For details on algorithms, see 
“Understanding PID Algorithms” on page 208.
Mode. Choose whether you want the PID initialized automatically or manually. The main difference 
between Automatic and Manual mode is that in Manual mode, the PID loop stops its mathematical 
calculation. In both modes, the PID's output value is still copied to the analog output.
– Automatic: The PID makes calculations based on the difference between the input and the 

setpoint resulting in changes to the output, which causes the input to move toward the setpoint.
– Manual mode: The PID stops making changes to the output, but continues to write the PID output 

to the configured destination for the PID output. Manual mode allows control program logic or an 
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operator to control the PID output, which in turn is written by the PID loop to the configured 
destination of the PID output.

NOTE: If the value of the analog channel or configured destination is changed, it will be overwritten by the 
PID output.

Scan Time (sec). Enter a scan time to determine how often the input is scanned and the PID output is 
calculated. Minimum value is 0.001 (1 ms). There are many factors you need to consider when calculating 
a scan time; the Opto 22 website (www.opto22.com) provides several resources to help you calculate an 
appropriate scan time. (Enter “PID” in the search box of the website.) You should also consider other PIDs 
and tasks competing for the I/O processor’s power.
In the Input section:
– Select from where the PID receives its input: Input Channel, Output Channel, MMP address, Host, or 

PID Output.
– If the PID’s process variable comes from an input channel on the same unit, select Input 

Channel. Enter the chassis slot number (or click on the + or - signs) to indicate which module 
contains the input channel. Then enter the channel number (or click on the + or - signs) to 
indicate which channel on the module is the input channel.

– If the PID’s process variable comes from an output channel on the same unit, select Output 
Channel. Enter the chassis slot number (or click on the + or - signs) to indicate which module 

https://www.opto22.com/
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contains the output channel. Then enter the channel number (or click on the + or - signs) to 
indicate which channel on the module is the output channel.

– If the PID’s process variable comes from an MMP address on the MMP server, select MMP 
Address. Enter the MMP address in the MMP Address field.

– If the PID’s process variable comes from a control program, select Host. Make sure the control 
program writes the input value to the MMP address listed underneath Value Type. In the 
following diagram, the MMP address shown is for PID 0:

– If the PID’s process variable is the output of another PID on this processor (a cascading control 
loop), select PID Output. Enter the PID loop number (or click on the + or - signs) to indicate 
which loop contains the input value.

– Square Root. (Optional) Check this box if the error should be calculated based on the square root 
of the process variable (applies to flow control systems where volumetric flow is proportional to the 
square root of a signal from a flow transducer).

– Low/Upper Range. Set the valid range of the process variable by entering the low range and the 
upper range. (See Output section for optional responses to out-of-range input.)

In the Setpoint section, choose the source for the setpoint: Input Channel, Output Channel, MMP 
address, Host, or PID output.

– To control the setpoint using a device (on the same processor) such as a potentiometer, select 
Input Channel. Enter the chassis slot number (or click on the + or - signs) to indicate which 
module contains the input channel. Then enter the channel number (or click on the + or - 
signs) to indicate which channel on the module is the input channel.

– To control the setpoint from an output channel on the same unit, select Output Channel. Enter 
the chassis slot number (or click on the + or - signs) to indicate which module contains the 
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output channel. Then enter the channel number (or click on the + or - signs) to indicate which 
channel on the module is the output channel.

– To control the setpoint through a control program, select Host.
–For custom control programs, make sure the control program writes the setpoint value to the 

MMP address listed underneath Value Type.
–For PAC Control strategies, use the Set PID Setpoint command.

– To control the setpoint value through an MMP address on the MMP server, select MMP 
Address. Enter the MMP address in the MMP Address field.

– If another PID loop will control the setpoint, select PID Output. Enter the PID loop number (or 
click on the + or - signs) to indicate which loop contains the setpoint value.

In the Output section:
– Choose the destination for the PID output: Output Channel, MMP address, or Host.

–If the destination is an output channel, select Output Channel. Enter the chassis slot number 
(or click on the + or - signs) to indicate which module contains the output channel. Then 
enter the channel number (or click on the + or - signs) to indicate which channel on the 
module is the output channel.

–If the output should be sent to an MMP address on the MMP server, select MMP Address. 
Enter the MMP address in the MMP Address field.

–If the output should be sent to a control program, select Host. Make sure the control program 
reads the output value from the MMP address listed underneath Value Type. In the 
following diagram, the MMP address shown is for PID 0:

– Min Change/Max Change. (Optional) Enter minimum and maximum change values. The 
output won’t respond until the minimum change is reached (for example, you may not want a 
heater to turn on to correct a 1 degree error). Maximum change prevents too drastic a change 
in output (for example, you could limit the increase in a pump’s output to prevent pipe 
breakage). The default for both minimum and maximum is zero, which disables the feature.

– Lower Clamp/Upper Clamp. Enter upper and lower clamp values to prevent the output from 
exceeding a desirable range. These values should equal the range of the output channel, if 
used. Or choose values to make sure that the output device doesn’t shut off (for example, 
keeping a circulation pump running regardless of the PID output) or that the output never 
reaches a destructively high setting (for example, keeping a motor below maximum).

– Choose how the PID should respond if the input goes out of range:
–To have the control program logic or an operator respond, click Switch to manual mode when 

Input goes out of range.
–To force the output to a specific value, click Force Output when Input is out of range.
For either option, enter the range values in the Value When Input Over Range and Value When 
Input Under Range fields.

NOTE: If both switches are enabled (forced output and manual mode), the output will be forced and 
the PID put into manual mode; but if the PID is already in manual mode, the output will not be forced.

If neither switch is enabled and the PID input goes out of range (as defined by Low/Upper Range) 
then the output will freeze, but only while the input is out of range.
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In the Options section, it’s optional to specify values for Feed Forward/Feed Forward Gain. Enter 
values if you need to offset the processor output in your application. These values are constants that are 
multiplied and added to the processor output; often they are not used in PIDs.

CHANGING A PID LOOP

You can change the PID loop’s configuration.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click I/O > PID Loops. groov Manage displays the PID Loops page, listing all the configured and 

unconfigured PID loops.
3. To change the PID loop’s configuration, click the PID loop number, then click Configure. groov Manage 

opens the configuration page. Change the fields as necessary. For help in completing the fields, see 
“Configuring a PID Loop” on page 210.

DISABLING A PID LOOP

If you no longer need to run a specific loop, you can disable it. All the settings you selected and information 
you entered will remain.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click I/O > PID Loops. groov Manage displays the PID Loops page, listing all the PID loops.
3. Click on a PID loop number. groov Manage displays the PID Loop <number> page.
4. Click Configure.
5. Click Algorithm, then select Disable.
6. Click Save. The PID will stop running.

INSPECTING A PID
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click I/O > PID Loops. groov Manage displays the PID Loops page, listing all the PID loops.
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3. Click on a PID loop number. groov Manage displays the PID Loop <number> page. The following 
example is for PID Loop 0:

You can change PID parameters, view specific channel values on the chart, or adjust the scale of the chart.

Changing PID Parameters

To change the value of any of the PID parameters, click on the name of the parameter and enter a new value. 
You’ll see the changes reflected in the chart on the top half of the screen.
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View Specific Values on the Chart

Move the cursor so that it hovers over a specific point on the chart. groov Manage displays the values for that 
point:

Adjusting the Scale of the Charts

There are a few ways to adjust the scale of the charts so that you can see a longer time period, view a specific 
segment of time, or to adjust the view of only the input chart or the output chart. Note that you can only do 
this through a browser; you can’t adjust the scales through the touchscreen.

To view a longer length of time, click and hold the left endpoint of the slider below the chart and move 
it further away from the right endpoint. This increases the amount time shown on the chart.

To view a specific segment of time, click and hold in the center (blue area) of the slider and then move 
the slider to the specific range of time you want. You may want to adjust the endpoints to narrow or increase 
the time segment.

To adjust the view of only the input portion of the chart, click on the  or  buttons.

To adjust the view of only the output portion of the chart, click on the  or  
buttons.
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18: Maintaining Your groov EPIC

There are some maintenance activities you’ll want to do regularly to keep your groov EPIC up-to-date, running 
smoothly, and to make it easier to restore in the event of a reset:
• Back up your information regularly
• Apply firmware updates to the processor and I/O modules

If you encounter issues while operating your groov EPIC, there are few things you can do:
• You can troubleshoot some issues and, if you can’t resolve your issues, there are some steps you can take 

to help Product Support solve your issues.
• If you had to restore your processor to factory defaults, you can restore the information that you backed 

up.

BACKING UP YOUR groov EPIC PROCESSOR

There are several different recommendations regarding when and how often you should back up your 
groov EPIC:
• Back up before applying a firmware update.
• Back up before installing an update of your control program.
• Back up periodically. For example, if your system is fairly stable with very few updates to your control 

program or firmware, once a year may be enough. However, if you frequently, perhaps once a month 
would be a better frequency.

Whichever recommendation you follow, the groov Manage backup feature can save valuable configuration 
information, which you can then restore at a future date. You can store the backup file on any media that you 
can access from a computer or mobile device that can also access your groov EPIC.

However, keep in mind the following:
• The backup feature does not save:

– Your PAC Control strategy or groov View HMI.
– Your Ignition Edge projects.
– Your CODESYS applications.

• The backup feature saves only the first 10 MB of user files, which are files that either you uploaded 
manually to the processor or were placed there by control programs.

• You can run the backup feature only on a computer or mobile device. You can’t run the backup feature 
from the groov EPIC processor’s touchscreen.

IMPORTANT: The backup file is not a secured or encrypted file. You must apply your own security or encryption 
to the file to protect any sensitive information. Also, be aware that if you send a backup file to Opto 22 without any 
security or encryption, our personnel will have access to all the information in that file.
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Select the media where you will store the backup file, then do the following steps:
1. On a computer or mobile device that can access both the media and the groov EPIC, log in with a user ID 

that has administrator privileges.
2. Click Maintenance.
3. Click Backup. groov Manage displays the Backup page.

4. On the Backup page, select the information you want to backup by moving the corresponding slider to 
the right so that it shows green ( ). By default, everything except Server SSL Certificates. If you do 
not want certain information backed up, move the slider to the left so that it shows grey ( ).
– I/O Configuration—Saves the changes you made to the channels on the modules you had 

mounted on the chassis at the time you ran the backup. It also saves which type of module was 
mounted in each slot.

– PAC REST API Settings—Saves the settings listed in the PAC Controller Configuration page:
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– Background Downloading. For more information, see “Enabling or Disabling Background 
Downloading” on page 146.

– REST API String Encoding. For more information, see Using the PAC Control REST API with groov 
EPIC on developer.opto22.com.

– Advanced REST API: Allowed Origins for CORS Policy.
– Accounts—The local user IDs and passwords, plus the scope of each user ID’s access (the scope of 

access is described in “Managing User IDs Locally” on page 45) and the LDAP client settings (see 
“Managing User IDs through an LDAP Service” on page 37). This does not back up user IDs:
– created to access the secure shell
– managed by an LDAP server

– Networking—Saves all of the following:
– Hostname
– The settings for the ETH0, ETH1, and WLAN0 physical network interfaces.
– The settings for the OpenVPN Tunnel 0 network interface.
– The settings for the Network Options (DNS server IP address(es) and domain name(s), gateway 

IP address, the DNS order, and the gateway order).
This also includes sensitive information like the WiFi SSID and pre-shared key, and the OpenVPN 
server login credentials. If you select this setting, it’s important that you apply your own security or 
encryption to the backup file to protect this information.

– Firewall—The firewall settings you selected, as well as any rules you created.
– Time, Display, and UI—The time zone and time servers configurations.
– License—The most recent groov EPIC license file you uploaded.
– Node-RED—Node-RED flows you created, any nodes you installed, and any credentials file, which 

can contain sensitive information like user names, passwords, and security keys. It’s important that 
you apply your own security or encryption to the backup file to protect this information.

– MQTT/Sparkplug—The information you entered or selected when you configured your groov EPIC 
processor to work with Sparkplug.

– Client SSL Certificates—The most recent SSL certificates you may have uploaded.
– User Files—Only the first 10 MB of files you uploaded manually or were placed there by control 

programs. After you create the backup file, you can review it to see which user files were stored in 
the backup file.

– USB Settings—The settings you selected for USB access (see “Connecting a USB Storage Device” 
on page 100).

– Server SSL Certificates—Any server SSL certificates you uploaded (see “Managing the SSL 
Security Features of your groov EPIC Processor” on page 46). The server SSL certificates include 
sensitive information, like the web server’s private key. If you select this setting, it’s important that 
you apply your own security or encryption to the backup file to protect this information.

5. Click Download Backup.
6. Navigate to the media where you want to store the backup file. groov Manage constructs the file name to 

include the date and time that you run the backup as part of the file name. If you want to give it a 
different name, change the name in the File name field. Click Save.

NOTE: Some browsers might automatically download the file to a specific folder. Check your browser’s 
downloads settings to determine where the browser stored the backup file.

7. Opto 22 recommends that you apply some form of security on the backup file.
8. If you want to back up any of the following, refer to the indicated instructions:

– groov View HMI—For instructions on creating backups of your groov View HMIs, see the groov View 
User’ s Guide (form 2027).

http://documents.opto22.com/2027_groov_View_Users_Guide.pdf
http://developer.opto22.com/rest/pac/epic/
http://developer.opto22.com/
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– PAC Control strategy—For instructions on creating backups with the archive feature in 
PAC Control, see PAC Control User’s Guide (form 1700).

– Ignition Edge projects—For instructions on creating backups of your Ignition Edge projects, see 
“Backing up Your Ignition Edge Projects” on page 222.

– CODESYS applications—For instructions on creating backups of your CODESYS applications, see 
the CODESYS Online Help.

Backing up Your Ignition Edge Projects

It’s important to back up your Ignition Edge projects before you apply maintenance or reset your groov EPIC 
processor to factory defaults. It’s a good idea to back up your Ignition Edge projects at the same time you back 
up your groov EPIC processor and save the backup file to the same location.
1. On a computer or mobile device that is connected to the media or folder where you want to save your 

back up file, open a browser and enter the URL of your groov EPIC processor’s Ignition Edge gateway 
page: https://[your groov EPIC’s hostname]:8043

2. Click the Configure tab.
3. In the left navigation, choose System > Backup/Restore.
4. Click Download Backup.
5. Navigate to the folder or media where you want to store the backup file. Ignition Edge constructs the file 

name to include the date and time that you run the backup as part of the file name. If you want to give it 
a different name, change the name in the File name field.

6. Click Save.

NOTE: Some browsers might automatically download the file to a specific folder. Check your browser’s 
downloads settings to determine where the browser stored the backup file.

RESTORING A BACKUP OR SPECIFIC SETTINGS FROM A BACKUP FILE

There are a few reasons why you might want to restore all or part of a backup:
• If you had to restore your processor to factory settings, a backup can help you quickly restore a 

previously-saved configuration.
• You might want to restore a prior configuration or a specific part of a prior configuration; for example, 

only the firewall settings.
• After you apply an update, restoring a backup can help you quickly restore a previously-saved 

configuration.

When you want to restore a backup file, remember the following:
• You can run the restore feature only on a computer or mobile device. You can’t run the restore feature 

from the groov EPIC processor touchscreen.
• You can restore a subset of the settings stored in a backup file; for example, only the firewall and 

accounts.
• When you run the restore feature, the groov EPIC processor shuts down all services and applications, 

restores the projects and settings, and then restarts the processor. So, make sure to schedule the restore 
during a time that minimizes its impact on your applications and equipment.

• The user IDs and passwords that are restored will not include any user IDs that you created after you 
created the backup file. So, make sure you know the user ID and password of any administrator account 
saved in the backup file so you can use that ID and password when you log into the groov EPIC processor.

To restore a backup file or specific part of a backup file:
1. Locate the media or folder that contains the backup file and remove any security you may have applied 

to the file.

http://documents.opto22.com/1700_PAC_Control_Users_Guide.pdf
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2. On a computer or mobile device that contains the folder or is connected to the media that contains the 
backup file, log into your groov EPIC processor with a user ID that has administrator privileges.

3. Click Maintenance.
4. Click Restore.
5. In the Restore page, select or deselect the settings you want to restore. If you want to restore a particular 

set of settings, leave the slider green ( ). If you do not want to restore a particular set of settings, 
move the slider to the left so that it shows gray ( ).

NOTE: If you select a setting that doesn’t contain any information in the backup, nothing will be restored for that 
setting. This can happen:

– When you created the backup, you deselected the setting.
– You select a setting (below) that was not available in previous versions of the groov EPIC firmware.

6. Click Upload Backup.
7. Navigate to the folder or media device that contains your backup file.
8. Click Open. groov Manage displays the following message, reminding you of what the groov EPIC 

processor will do during the restore:
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9. Click Restore and Restart. groov Manage displays a message that shows you the progress of the restore:

10. When the restore is done, groov Manage shows you this message:

Click Next.
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11. groov Manage shows you a message that gives you a few tips about what you might need to do next. 
Read the message and then click Close.

12. The groov EPIC processor restarts. Wait for the groov EPIC login screen and log back in with any user ID 
that has administrator authority and was stored in the backup file.

13. Review the configuration settings for things like I/O, date and time, network, and controller, to assess 
whether you need to make additional changes that were not stored in the backup file. For example, after 
the restart, the PAC Controller is the control engine running by default. If you want to switch to the 
CODESYS Controller, you’ll have to do this manually (see “Enable the CODESYS Control Engine on the 
groov EPIC Processor” on page 116).

14. Review the following list for additional instructions on other items you may want to restore:
– Because the backup files contain only the first 10 MB of user files, if there were any additional files 

that weren’t included in those 10 MB, you’ll want to upload them, either manually or identify how 
your control programs saved files on to the processor.

– For instructions on restoring your Ignition Edge projects, see “Restoring your Ignition Edge Projects” 
on page 226.

– For instructions on restoring your groov View HMI, see groov View User’ s Guide (form 2027).
– For instructions on restoring your PAC Control strategy, see PAC Control User’s Guide (form 1700).
– For instructions on restoring your CODESYS applications, see “Downloading and Running CODESYS 

Applications” on page 142.

http://documents.opto22.com/2027_groov_View_Users_Guide.pdf
http://documents.opto22.com/1700_PAC_Control_Users_Guide.pdf
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Restoring your Ignition Edge Projects

When you restore Ignition Edge projects, Ignition Edge restarts the Ignition Edge the Ignition Gateway. So, 
make sure to schedule the restore during a time that minimizes its impact on your applications.
1. On a computer or mobile device that contains the folder or is connected to the media that contains the 

backup file, open a browser and enter the URL of your groov EPIC processor’s Ignition Edge gateway 
page: https://[your groov EPIC’s hostname]:8043

2. Click the Configure tab.
3. In the left navigation panel, choose System > Backup/Restore.
4. Click the Restore tab.
5. Click Choose File and navigate to the folder or media that contains the backup file. Click the file name, 

then click Open.
6. Click Restore. The Ignition Edge Gateway page refreshes and displays the status of the restart of the 

gateway.

After the restart finishes, Ignition Edge displays the gateway page.

UPDATING FIRMWARE ON A groov EPIC

Updating firmware on a groov EPIC keeps it up-to-date with the latest features and fixes. You can update 
firmware on the processor or on the groov I/O modules. Updating firmware on a processor can take 10 
minutes or more to complete and your groov EPIC processor will be restarted, so schedule the update during a 
time when it minimizes impact to your control program and equipment. Updating I/O module firmware 
update will take a lot less time and will take that specific module offline during that time. Both updates need 
to be done through a web browser on a computer or mobile device that can connect to the processor.

Important: If you are doing either of the following, see Appendix G: Installing the Correct License.

• Upgrading the firmware on a groov EPIC processor from a version earlier than 1.3.0 to version 1.3.0 or later

• You are re-initializing a groov EPIC processor with firmware earlier than version 1.3.0
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Applying a Firmware Update to the groov EPIC Processor

1. If you do not have an account on manage.groov.com, create one.
2. Log on to manage.groov.com.
3. Follow the instructions on the website to download the latest software update. Make sure to download 

the file to either:
– a computer or mobile device that can connect to your groov EPIC processor, or
– to media that you can then install to a computer or mobile device that can connect to your groov 

EPIC processor.
4. On a computer or mobile device, log into your groov EPIC processor with a user ID that has administrator 

privileges.
5. If you haven’t done so recently, create a backup file (see “Backing up Your groov EPIC Processor” on 

page 219). Keep this file handy and secure.
6. If you are using Ignition Edge, deactivate the license. For instructions, see “Deactivating the Ignition Edge 

license” on page 86.
7. If you are using CODESYS, make sure you have the license file (*.WibuCmRaU) so that you can restore it.
8. Click the menu button ( ), then select Home.
9. Click Maintenance and then Update. 
10. On the Update page, decide:

– If you want to save your current settings and then have the groov EPIC processor restore them after 
the restart, leave the slider in the default position (the slider shows green). If you created a backup 
file in step 5, the information in that backup file is the same information that will be restored if you 
leave this setting on. This saves you some steps later on.

– If you do not want the settings saved and restored after the restart, click the slider so that it shows 
gray ( ). One reason you may want to disable this option is if you want to restore settings from 
a different backup file after you upgrade the firmware.

11. Click Update System.
12. Navigate to the software update file you downloaded in step 3.

http://manage.groov.com
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13. Click Open. groov Manage displays a message to remind you that the update clears all your settings and 
projects, and gives you one more opportunity to cancel and perform that important backup. If you are 
ready to proceed with the update, click on Update and Restart:

14. groov Manage displays an Update message, which shows you the progress of the update. The update can 
take several minutes to complete. During that time, the banner (in the background) will change color to 
yellow.

15. When the update is done, the banner turns red, which indicates the processor is now restarting. groov 
Manage shows you this screen:
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Click Next.
16. groov Manage displays a message with instructions on what to do after the device restarts.

Read the instructions and then click Close. If you can see the groov EPIC processor’s touchscreen, you can 
see the progress of the restart.

17. When the restart is done, you will see one of the following:

Welcome! screen—You’ll see this screen if you deselected the Backup Settings option in step 10 on 
page 227.
a. Make a note of the IP address shown in either the Eth0 IP Address box or the Eth1 IP Address box. 

You’ll need it in the next few steps.
b. Tap Let’s get started! and create an administrator user ID and password. (It does not have to match 

any that might be stored in your backup file; however, you still do have to remember to store it in a 
safe location for later recall.)

c. Click on Configure Device.
Login screen—You’ll see this screen if you selected the Backup Settings option in step 10 on page 227. 
Log into your groov EPIC processor with the user ID that has administrator privileges.

18. If you are running a groov View HMI, restore your groov View HMI as described in the groov View User’ s 
Guide (form 2027).

19. If you are running with Ignition Edge, activate the license. For instructions, see “Licensing Ignition 
Software” on page 85.

20. If you are running CODESYS applications:

Welcome! screen

Login screen

http://documents.opto22.com/2027_groov_View_Users_Guide.pdf
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– Switch to the CODESYS Runtime Engine. For instructions, see “Enabling the CODESYS Runtime 
Engine” on page 73.

– When you restore the groov EPIC processor’s backup file, make sure you select License as one of the 
options on the Restore page to restore the CODESYS license file.

21. Restore your backup file as described in “Restoring a Backup or Specific Settings from a Backup File” on 
page 222, beginning with step 3.

Installing an I/O Module Firmware Update

These instructions work for either installing the most current module firmware or a previous version of module 
firmware. Make sure you do these instructions on a computer or mobile device that has access to the 
groov EPIC that has the module you want to update.
1. Go to the Opto 22 web site (www.opto22.com) and look up the module firmware by entering the 

module part number in the Search box. For example, to find the module firmware for the 
GRV-ODCSRC-24 module, type in GRV-ODCSRC-24 in the Search box, then press Enter.

2. In the Search results, click on the result with the module part number and “Module Firmware” in the title.

3. Do one of the following:
– If you want the most current version of the module firmware–click Download and save the 

file your computer or mobile device.
– If you want a previous version of the module firmware–find the version you want from the list 

provided, click on its link, and save the file your computer or mobile device.

Note: If the file has a file type of .zip, decompress the file with a decompression utility on your mobile device or 
computer before going to the next step.
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4. On that same computer or mobile device, log into your groov EPIC processor with a user ID that has 
administrator privileges.

5. Run a backup of your unit (see “Backing up Your groov EPIC Processor” on page 219).
6. Click the menu button ( ), then select I/O.
7. In the Modules page, select the module you want to update.
8. In the Module page for that module, click the Config link.

9. In the Config tab, click Update Module Firmware ( ).
10. Navigate to the folder or media device where you saved the firmware update.
11. Click Open.
12. groov Manage displays a message to remind you that the module will be offline during the update. 

If you are ready to proceed, click OK. groov Manage displays a message showing you the progress of the 
update:

.
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13. When the update is complete, groov Manage shows you the module page and you can see that the 
Firmware field has an updated release number, like in the following example:

REPLACING THE BATTERY

The battery maintains:
• the date and time
• the RAM that holds persistent data (for example, persistent variables) from the control engine

Battery life is dependent on the ambient temperature; the lower the temperature, the longer the battery life.

You’ll need a BR2032 button cell lithium battery with a nominal voltage of 2.8 volts.

NOTE: Do not use a CR3032 button cell lithium battery because it cannot withstand the same temperature ranges 
that the processor can withstand.

Before the firmware update After the firmware update
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1. On the top of the groov EPIC processor, unscrew the captive screw until the battery holder extends out 
enough to slip a flathead screwdriver in the opening. With the flathead screwdriver, pull out the battery 
holder until you can grasp it with your fingers to completely pull it out.

2. With your fingers, pop out the old battery.

3. Put in the new battery, push in the holder, and secure the captive screw.
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HOW TO RESET TO FACTORY DEFAULTS

You might have to reset to factory defaults if instructed to do so by product support. A reset to factory defaults 
erases all the changes you made to the groov EPIC system, which is why it is important that you perform the 
following, if possible:
• Back up your system. For instructions, see “Backing up Your groov EPIC Processor” on page 219.
• Deactivate your Ignition Edge license. For instructions, see “Deactivating the Ignition Edge license” on 

page 86.
• Make sure you have a copy of the CODESYS license file (*.WibuCmRaU).

Use a paper clip to depress the RESET button for approximately 8 seconds. Release the button when the 
STATUS LED blinks alternately between red and green.

COLLECTING INFORMATION FOR PRODUCT SUPPORT

groov EPIC processor displays messages and collects information in several logs that can help Product Support 
diagnose and solve problems. If you contact Opto 22 to obtain help, the Product Support team will direct you 
with the specific information to collect and how to send it to them.

You might want to create a new folder on your computer or mobile device with the name of the Opto 22 
ticket number, if you have one, and store the log files and additional information into that folder.

If Product Support directs you to send log files:
1. On a computer or mobile device, log into your groov EPIC processor with a user ID that has system 

privileges.

RESET button

STATUS LED
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2. Click Info and Help > Logs. groov Manage 
displays the Logs page.

3. Download either the specific log file(s) (as 
directed by Product Support) or all of the 
logs:
– If you want to download individual 

logs, click on the application, service, or 
system name. groov Manage displays 
the log file’s page. At the top of the 
page, click Download. Note: If you 
click on Ignition, it will direct you to the 
Ignition configuration page, where you 
can go to Ignition (click Open Ignition 
or Open Ignition Edge) and follow their 
instructions to obtain log files.

– If you want to download all the log files, 
click Download Logs. Remember that if 
you need the Ignition logs, go to the 
Ignition configuration page (Home > 
Ignition), open Ignition or Ignition 
Edge, and follow their instructions on 
obtaining log files.

4. Navigate to a folder on your computer or 
mobile device where you want to save the 
log. You might also want to make note of 
the name of the log file or modify it to 
something else.

5. Click Save.
6. If you are downloading individual logs, 

repeat steps 3 through 5 for each log that 
Product Support directs you to download.

If you need to collect information from a screen, 
there are a few ways to collect that information:
• If you are working directly with the 

groov EPIC processor’s touchscreen, you can:
– take pictures of screens;
– open a text editor on a computer or 

mobile device, then type the 
information you see on the screen into 
a text file; or

– on a piece of paper, write down the 
information on the screen.

• If you are connected to your groov EPIC through a computer or mobile device, you can use the screen 
capture feature on the computer or mobile device to save (capture) the screens.

Send this information to Opto 22 as directed by Product Support.
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CONDUCTING AN OPTOSUPPORT REMOTE SUPPORT SERVICE (RSS) SESSION

An OptoSupport Remote Support Service (RSS) session can help expedite the resolution of your support ticket 
by allowing the OptoSupport team member to remotely connect to your groov EPIC processor to continue 
with diagnostics and troubleshooting.

After evaluating the progress of your ticket, your Opto 22 Support team member might determine that your 
situation would benefit from an RSS session and discuss with you the benefits and goals of the session. If you 
agree with this step, our team member will schedule a time to start a Remote Support Service (RSS) session.

Before beginning the session, it’s important that you prepare your groov EPIC processor by checking the 
following:
• Verify that your groov EPIC processor has an internet connection.
• Verify that, if your internet connection travels through a firewall or router, that the firewall or router does 

not prevent outbound connections through ports 555.

An RSS session will typically run like this:
1. At a time agreed upon by you and your OptoSupport team member, you’ll initiate a phone call.
2. When instructed, click Create RSC to initiate the session. For detailed instructions and an explanation of 

what happens during this step, see “Initiating an RSS Session” on page 236.
3. After the session is successfully created, you and your OptoSupport team member will review details of 

your situation and discuss additional steps. These steps might be:
– Continue active discussion of the problem over the phone while the OptoSupport team member 

diagnosis and troubleshoots your groov EPIC processor.
– Agree to a plan of action where you can end the phone call while the OptoSupport team member 

continues to diagnose and troubleshoot your processor.
If the session is lengthy, part of the plan might include pausing the session and continuing it at a later 
time. For additional instructions on pausing and resuming a session, see “Pausing and Resuming an RSS 
Session” on page 237.

4. When it’s time to end the RSS session, click Delete RSC. For important information on what happens 
when you end an RSS session, see “Ending the RSS Session” on page 238

Initiating an RSS Session

1. The Opto 22 Support team member will ask you to navigate to the OptoSupport RSS page, if you haven’t 
already done so. (From the groov Manage home page, click or tap Info and Help > OptoSupport RSS.)

2. The Opto 22 Support team member will ask for the serial number listed on the OptoSupport RSS page. 
This information is necessary for the connection to be successful.

3. When instructed by the Opto 22 Support team member, click .
The first thing you will see is the OptoSupport Remote Support Service Permission and Release 
Agreement. To proceed with the session, accept the agreement.

4. After you click Accept, groov Manage displays a message to indicate the progress of establishing the 
connection before it starts a connection:
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5. When it finishes these steps, click OK to close the message box:

6. While your groov EPIC processor is trying to establish a connection, you will see this message on the 
OptoSupport RSS page:

7. After the connection is established, you will see this message on the OptoSupport RSS page:

Do not turn off your groov EPIC processor after you start the session. If this happens, you will need to start this 
process over.

Pausing and Resuming an RSS Session

During the course of diagnosis and troubleshooting, you and your OptoSupport team member might agree to 
pause the session, then resume it at a later time. Pausing the session prevents communication between 
OptoSupport team member and your groov EPIC processor while preserving the information needed to 
quickly resume the connection.
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• To pause a session, click Pause in the OptoSupport RSS page (Info and Help > OptoSupport RSS). groov 
Manage displays a message confirming the pause. Click OK to close the message. The OptoSupport RSS 
page updates the status to indicate the RSS session is paused:

• To resume a session, click Continue RSC in the OptoSupport RSS page (Info and Help > OptoSupport 
RSS). After the connection is re-established, the OptoSupport RSS page displays the status as Connected.

Ending the RSS Session

When it’s time to end the RSS session, click Delete RSC in the OptoSupport RSS page (Info and Help > 
OptoSupport RSS). All of the information that your groov EPIC processor created to establish the connection 
will be erased. If you need to start another RSS session, you’ll need to start from the first step in “Initiating an 
RSS Session” on page 236.
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19: Troubleshooting

CANNOT CONNECT TO THE SSH SERVER

Verify that you purchased and installed the groov EPIC SSH Access license to enable the SSH server.
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click or tap System ( ).
3. Click or tap License ( ). If you have the groov EPIC SSH Access license, the processor displays 

a page similar to the following:

The License field indicates that you have installed and purchased the correct license. If you don’t see this 
text, see “Licensing Ignition Software” on page 85.

Verify that the SSH server is running.
4. Log into your groov EPIC processor with a user ID that has administrator privileges.
5. Click or tap System ( ).
6. Click or tap Shell ( ). If the SSH server is disabled, the processor displays the following page:
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To enable the SSH server, see “Starting the SSH Server” on page 153.

Check that you entered the correct IP address and port number in your SSH client. To find the correct IP 
address and port number:
7. Log into your groov EPIC processor with a user ID that has administrator privileges.
8. Tap System ( ).
9. Tap Shell ( ). Look underneath the SSH Server field for the IP address and port number for 

shell access:

ONE OF THE MODULES IS BLINKING RED

This usually indicates that the module is trying to establish communication with the groov EPIC processor. For 
more information, see “Through the Modules page of groov Manage” on page 201.

ONE OF THE MODULES IS BLINKING VIOLET

When you update the firmware for a module, its module LED turns violet and blinks. This is normal operation.

SSH SERVER USER ID AND PASSWORD ARE REJECTED

Remember that the SSH user ID and password is different from the groov Manage user ID and password.
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CHANGES AREN’T SAVED OR THEY SUDDENLY CHANGE

Remember to press Save on the upper right corner of the screen after you are done making changes on that 
page.

groov EPIC PROCESSOR TOUCHSCREEN KEEPS JUMPING TO MODULE 
INFORMATION PAGE

If you notice that your screen keeps jumping to the module information for modules mounted on slots 0, 1, or 
2 of the chassis, it might be because you are resting a part of your hand on the touch-sensitive pad of those 
modules while you are working with the processor’s touchscreen. You might have to adjust the angle of your 
hand when you work on the processor to avoid touching or brushing up against that area of those modules.

TOUCHSCREEN DOESN’T RESPOND ACCURATELY TO FINGER TAPS
• You might want to switch to using a stylus.
• To improve the accuracy, you can run the screen calibration feature as described in “Calibrating the 

Processor’s Touchscreen” on page 110.

ETHERNET CABLE IS PLUGGED IN, BUT NO IP ADDRESS
• Make sure the LNK ACT LED is lit (see “groov EPIC Processor” on page 10).
• If you are running on a local network hub, manually set the IP address as described in Chapter 7: 

Connecting groov EPIC to a Network or Multiple Networks.

WEB BROWSER CAN’T CONNECT TO PROCESSOR

If the browser displays a message that indicates the site (the processor) can’t be reached, check any of the 
following:
• Check that the IP address is correct in the address or URL bar. On the processor touchscreen, check the IP 

address and verify that it matches what you typed in the address or URL bar. To check the IP address on 
the processor, tap the menu button ( ), then select System, then tap on Network ( ).
– If your computer or mobile device is connected to the same network as Eth0, compare the IP 

address in the Eth0 field with what you typed in the address or URL bar.
– If your computer or mobile device is connected to the same network as Eth1, compare the IP 

address in the Eth1 field with what you typed in the address or URL bar.
• Verify that your computer or mobile device is connected to the same network as your groov EPIC 

processor. If they are, you might want to use groov Find to locate your EPIC on the network.

THE SPEED LED ON THE PROCESSOR CHANGED COLOR

The SPEED LED on the processor changes color to indicate the current speed of the link. This is part of normal 
operation.
• If the LED is off, the link speed is 10 Mbps (megabits per second).
• If the LED is green, the link speed is 100 Mbps.
• If the LED is orange, the link speed is 1000 Mbps.
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TIME ZONE CHANGE NOT SHOWN IN IGNITION EDGE

You set your time zone in groov Manage (see page 90). If you are running Ignition Edge and change the time 
zone, Ignition Edge does not automatically update it. To update it, restart the Ignition Edge Gateway.

CODESYS: CAN’T CONNECT TO groov EPIC PROCESSOR

You may see this message from CODESYS Development System when you are trying to connect (Online > 
Login) to the groov EPIC processor or it may appear as you are debugging your application:

This could be caused by several different reasons:
• Physical disconnection–check for the following:

– Is the groov EPIC processor turned off?
– Is the Ethernet cable disconnected?
– Did the Ethernet cable get moved to a different Ethernet network interface on the processor? If so, 

you’ll want to review your firewall settings. For instructions, see “Configuring the Firewall” on 
page 51.

– If you are connecting to the groov EPIC processor through Wifi, was the Wifi adapter removed?
• Network instability–check for the following:

– If you are connecting to the groov EPIC processor through Wifi, is the Wifi adapter experiencing 
connectivity problems?

– Is the network experiencing instability issues?
• groov EPIC processor configuration issues–check for the following:

– If you did not license the CODESYS Runtime Engine, you’ve been running in two-hour trial mode 
and the two hours might be up. You can do one of two things:
– Enable the CODESY Runtime Engine for another two hours (see “Enabling the CODESYS 

Runtime Engine” on page 73).
– Obtain and apply the GRV-LIC-CRE license, which removes the two hour time limit (see 

“Licensing the CODESYS Runtime Engine” on page 67).
– Was the CODESYS Runtime Engine on the groov EPIC processor disabled? To enable it, “Enabling the 

CODESYS Runtime Engine” on page 73.
– Was the Ethernet cable plugged into ETH1 and you did not modify the processor’s firewall to open a 

port for CODESYS on ETH1? To open the port, see “Configuring the Firewall” on page 51.
– If you are connecting to the groov EPIC processor through Wifi, did you modify the processor’s 

firewall to open a port for CODESYS on wlan0? To open the port, see “Configuring the Firewall” on 
page 51.
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TROUBLESHOOTING NETWORK ISSUES

Troubleshooting networking issues can be a complex job, though it can be made simpler with the right tools. 
The groov EPIC processor provides a few tools to help you diagnose networking issues. You can access all of 
these tool by clicking or tapping (from the groov Manage Home page) System > Network > Diagnostics.

Ping

A well-known and frequently used tool to determine basic connectivity, click or tap on Ping to access the Ping 
screen, where you can run this tool to test basic connectivity from each of the groov EPIC processor’s 
interfaces.

Test TCP Port

The test TCP port tool can help determine if a port on a particular server is open or closed. Specify the IP 
address or host name of the server in the Host field.
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Traceroute

The Traceroute tool can help you see the route a packet takes to reach its destination. The following example 
shows the route a packet took to reach the destination, www.example.com.

NsLookup

The NsLookup tool can help you determine the domain name and IP address of a DNS server at the host.
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TROUBLESHOOTING TOOL: VIEWING AND DOWNLOADING LOG FILES

groov Manage provides one convenient log page to access all log files:
1. Log into your groov EPIC processor with a user ID that has administrator privileges.
2. Click Info and Help, then click Logs. groov Manage displays the Logs page.



TROUBLESHOOTING TOOL: VIEWING AND DOWNLOADING LOG FILES

groov EPIC User’s Guide246

– To download all the log files into a single zip file, click Download Logs (at the bottom of the Logs 
page). All the files are in text format, though the file names and types may vary.

– To view or download the log file for an individual application, service, or system, click the name of 
the application, service, or system. groov Manage displays its log in the Log Viewer page—in text 
format—with the most recent information at the bottom of the page. The following example shows 
the log for groov Manage:

Click View to display only the text of the log in a separate tab on the browser. Click Download to 
save the log into a text file on your computer or mobile device.
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Appendix A 

A: Processor Specifications

GRV-EPIC-PR1, GRV-EPIC-PR2

The Edge Programmable Industrial Controller is an embedded Linux®, real-time controller with gateway 
functions.

The modern design of the groov EPIC processor offers a condensed and sturdy unit that features a 
resistive-touch, high-resolution LCD display. The LCD display lifts to provide easy access to the power button, 
power supply connectors, network interfaces, ports, and status LEDs.
• Dual, independent Gigabit Ethernet network interfaces enable the processor to maintain separate 

connections to your back office network and your controls network.
• Dual USB ports extend the capabilities of the processor so it can handle serial communications or 

communicate with touchscreen monitors.
• HDMI port displays configuration and groov View HMI on an external large screen, which is also useful for 

OEM applications where the EPIC system is built into a machine.

Software tools include:
• groov Manage for browser-based management of your groov EPIC.
• groov View for building and viewing custom operator interfaces for local, mobile, and browser-based 

devices.
• PAC Project™ Basic Software Suite (installed and running on your Windows computer) for developing 

control programs and a traditional HMI.
• Secure shell access to the Linux operating system to run custom applications (requires the free SSH 

license, GROOV-LIC-SHELL).
• Node-RED for creating data flows to connect cloud services, databases, and APIs through pre-built 

nodes.
• CODESYS Development System and Runtime Engine for creating and running IEC 61131-3 compliant 

programs. (Requires the free CODESYS Runtime Engine License, GROOV-LIC-CRE.)
• Ignition or Ignition Edge® from Inductive Automation® for connecting to other devices, such as 

Allen-Bradley®, via OPC UA, and for efficient IIoT communications using MQTT with Sparkplug payload. 
(Requires purchase of a license: GROOV-LIC-EDGE or GROOV-LIC-EDGE8.)

Two groov EPIC processors are available. Both have the same features and include the same software, with the 
following differences:
• GRV-EPIC-PR1 has 2 GB RAM and 6 GB user space. It ships with Inductive Automation’s Ignition version 7 

pre-installed but can be upgraded to version 8.1 with a firmware update (license required for either).
• GRV-EPIC-PR2 has more memory and disk space: 3.75 GB RAM and 22 GB user space on its embedded 

industrial SSD. It ships pre-installed with Ignition version 8 (license required).
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 Specification GRV-EPIC-PR1  GRV-EPIC-PR2 

Power requirements 7.1 W typical, 9.1 W max.

Memory
2 GB RAM 
2 MB battery-backed RAM 
6 GB user space

3.75 GB RAM 
2 MB battery-backed RAM 
22 GB user space

Backup battery for real-time clock BR2032

Screen size and resolution 5 inches diagonal; 480 x 800 pixels

Ethernet Communication (wired)
Two independent 10/100/1000 Mbps RJ-45 connectors, each with a separate IP address 

(separate IP networks). Supports Auto MDI-X (crossover cable not needed).

USB
USB 2.0

(two ports; can be used to connect serial devices via a USB-to-serial converter with an FTDI chipset)

HDMI
Connector Type: A.
HDMI Specification: Version 1.4a.
Max. Resolution: 1920 x 1080 pixels at 60 Hz

Minimum PAC Project Version 10.000 10.3003

Minimum Opto 22 Library Package 
For CODESYS Version

1.0.0.0 2.0.1.0

Ignition & Ignition Edge Versions 7; 8 with firmware upgrade 8 only

Maximum Number of PAC Control 
Engine Charts

64 64

Torque, bottom hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 

Torque, top hold-down screw 1.5 in-lb (0.17 N-m) 1.5 in-lb (0.17 N-m) 

Operating temperature -20 °C to +70 °C -20 °C to +70 °C 

Storage temperature -40 °C to +85 °C -40 °C to +85 °C 

Humidity 5–95% RH 5–95% RH 

MTBF (minimum, 25 °C) 900,000 hours 750,000 hours

Agency approvals and certifica-
tions

UL/cUL (Class 1 Div. 2a), CE, ATEX (Category 3, Zone 2), RoHS, DFARS

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 70, 
and ANSI/ISA-61010-1 (82.02.01).

Warranty 30 months 30 months 
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Appendix B

B: Power Supply Specifications

GRV-EPIC-PSAC, GRV-EPIC-PSDC, GRV-EPIC-PSPT

The GRV-EPIC-PSAC power supply and the GRV-EPIC-PSDC voltage converter are designed to provide 
power for a groov EPIC chassis with a groov EPIC processor, and groov I/O modules mounted on the chassis.

The GRV-EPIC-PSPT pass-through power adapter is designed to allow you to connect a user-supplied, 
external 12 V power supply to the I/O unit.

Specification GRV-EPIC-PSAC GRV-EPIC-PSDC GRV-EPIC-PSPT

Max Output Power
60 W (-20 °C ≤ Ta ≤ 50 °C)
50 W (50 °C < Ta ≤ 70 °C)

50 W (-20 °C ≤ Ta ≤ 70 °C)
108 W from external 12 VDC supply,
(-20 °C ≤ Ta ≤ 70 °C)

Input Voltage Range
110 to 240 VAC nominal,
100 to 264 VAC max.

24 to 48 VDC nominal,
22 to 50 VDC max.

10 to 15 VDC

Typical Input Current (max load) 0.6 A at 115 VAC 3.5 A at 22 VDC 9 A at 12 VDC

Inrush Current 30 A at 115 VAC 2.5 I2t (A2s) 2.5 I2t (A2s)

Input Frequency Range 50 Hz to 60 Hz n/a n/a

Power Factor >0.98 at 115 VAC, full load n/a n/a

Wire size 28–12 AWG 28–12 AWG 28–12 AWG

Torque (connector screw) 4.4 in-lb 4.4 in-lb 4.4 in-lb

Fuse
2 A 250 V Slow
Opto 22 PN: GRV-EPIC-PSAC-FUSE

4 A 250 V Slow
Opto 22 PN: GRV-EPIC-PSDC-FUSE

10 A 125 V Fast
Opto 22 PN: GRV-EPIC-PSPT-FUSE

Operating Ambient Temperature -20 °C to 70 °C -20 °C to 70 °C -20 °C to 70 °C

Altitude Temperature Derating 5 °C per 1000 m over 2000 m 5 °C per 1000 m over 2000 m n/a

MTBF (minimum, 25 °C) 650 khrs 1.9 Mhrs 4.5 Mhrs

Agency Approvals UL/cUL(Class 1 Div. 2)a, CE, ATEX(Category 3, Zone 2), RoHS, DFARS

Warranty 30 months 30 months 30 months
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Appendix C 

C: Chassis Specifications

GRV-EPIC-CHS0, GRV-EPIC-CHS4, GRV-EPIC-CHS8, GRV-EPIC-CHS16

groov EPIC I/O mounting chassis are designed to hold an intelligent groov EPIC processor, power supply, and 
several I/O modules. The GRV-EPIC-CHS0 is designed to hold only the processor and the power supply, 
making it ideal where no I/O is needed and cabinet space is at a premium.

Since groov analog, discrete, and serial I/O modules all have the same footprint, customers using a groov 
chassis can mix all these modules on the same chassis. Field devices are wired directly to the top-mounted 
connectors on the modules. The module and chassis design allows modules to rock into a specific mounting 
point on the chassis.

groov EPIC chassis are available in four configurations, accommodating up to 0, 4, 8, or 16 modules.

Specification GRV-EPIC-CHS16 GRV-EPIC-CHS8 GRV-EPIC-CHS4 GRV-EPIC-CHS0

Number of module slots 16 8 4 0

Maximum Power Rating
60 W with GRV-EPIC-PSAC
50 W with GRV EPIC PSDC
108 W with GRV-EPIC-PSPT

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Humidity (non-condensing) 5–95% RH

Agency Approvals UL/cUL(Class 1 Div. 2), CE, ATEX(Category 3, Zone 2), RoHS, DFARS; CB Scheme

Warranty 30 months
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Appendix D 

D: I/O Module Specifications

GRV-CCANI-2

The GRV-CCANZI-2 serial module provides 2 independent, isolated serial channels (ports) allowing the 
groov EPIC processor to communicate through a Controller Area Network (CAN).

Specifications

Specifications GRV-CCANI-2

Serial Standards CAN 2.0

Bit Rates
10 Kbps, 20 Kbps, 50 Kbps, 100 Kbps, 125 Kbps, 250 Kbps, 500 Kbps, 750 Kbps, 1 
Mbps

Maximum Bus Length (1 Mbps) 40 m

Maximum Bus Length (50 Kbps) 1000 m

Bus Termination 120 Ohms, selectable

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) 300 V working

Number of Channels 2 individually configurable channels

Indicators Transmit and Receive LEDs for each channel

Chassis Power Consumption 1.5 W

Chassis Compatibility Slots 0–3 only. The maximum number of modules per chassis is 4.

Minimum GRV-EPIC-PR1 Firmware Version 1.5.0

Minimum PAC Project Version Upcoming release

Minimum Library Package for CODESYS Version 1.0.2.0

Wire Size 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 
70, and ANSI/ISA-61010-1 (82.02.01).

 Warranty 30 months
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GRV-CSERI-4

The GRV-CSERI-4 serial module provides 4 independent, isolated serial channels (ports) allowing the 
groov EPIC processor to communicate with RS-232 or RS-485 serial devices. You can set up the module to 
communicate with RS-485 serial devices in half-duplex (2-wire transmission) or full-duplex (4-wire 
transmission) mode. Each channel is selectable between RS-232 mode and RS-485 mode, with configurable 
termination and bias in RS-485 mode. Channel 0 can also be configured to handle modem commands. Baud 
rates of up to 1 Mbps are supported. Please note that GRV-CSERI-4 modules may only be installed in chassis 
slots 0-3, for a maximum of 4 modules (16 channels) per chassis.

Features

Feature Channel 0 Channel 1 Channel 2 Channel 3

 RS-232 Tx / Rx x x x x

 RS-232 RTS / CTS x x x x

 RS-232 DCD, DTR, DSR, RI x    

 RS-485 half-duplex mode (TxRx+/-) x x x x

 RS-485 full-duplex Mode (Tx+/-, Rx+/-) x x x x

 RS-485 termination (120 Ohms) x x x x

 RS-485 Bias (750 Ohms to +V and COM) x x x x
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Specifications

Specification GRV-CSERI-4

Serial Standards RS-232 (DTE), RS-485 half- and full-duplex

Baud Rates 300 bps - 1 Mbps

Maximum Cable Length (RS-232) 10 m

Maximum Cable Length (RS-485) 1200 m at 38.4 Kbps, 500 m at 115.2 Kbps, 50 m at 1 Mbps

Bus Loading (RS-485) 1/8 Unit Load

Bus Termination 5 KOhms (RS-232 mode), 120 Ohms (RS-485 mode, selectable)

Bus Bias 750 Ohms, (RS-485 mode only, selectable)

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) 300 V working

Number of Channels 4 individually configurable channels

Indicators Transmit and Receive LEDs for each channels

Chassis Power Consumption 1.5 W 

Chassis Compatibility Slots 0–3 only. The maximum number of modules per chassis is 4.

Minimum GRV-EPIC-PR1 Firmware Version 1.2.0

Minimum PAC Project Version 10.1000

Minimum Library Package for CODESYS Version 1.0.0.1

Wire Size 28–14 AWG 

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95%

Agency Approvals
UL/cUL (Class 1 Div. 2)a; CE, ATEX (Category 3, Zone 2), RoHS; DFARS; CB 
Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 
70, and ANSI/ISA-61010-1 (82.02.01).

Warranty 30 months
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GRV-IAC-24, GRV-IACI-12, GRV-IACS-24, GRV-IACIS-12

groov AC input modules are used to sense status from devices such as pumps, fans, and motors that use a 85–
140 VAC signal:
• The GRV-IAC-24 modules can sense status from up to 24 devices.
• The GRV-IACI-12 modules each have channel-to-channel isolation. They can sense status from up to 12 

devices.
• The GRV-IACS-24 and GRV-IACIS-12 modules provide input state only, offering a lower cost option for 

projects with simple requirements.

Features

Feature GRV-IAC-24 GRV-IACS-24 GRV-IACI-12 GRV-IACIS-12

Number of channels 24 24 12 12

Channel-to-channel isolation x x

On/off state x x x x

On/off latching x x

Counting x x

On/off totalization x x

Frequency measurement x x

Period measurement x x

Pulse measurement x x
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Specifications

Specification GRV-IAC-24 GRV-IACS-24 GRV-IACI-12 GRV-IACIS-12

Nominal Input Voltage Range (RMS) 85–140 VAC 85–140 VAC 85–140 VAC 85–140 VAC

Turn-on Voltage 85 VAC 85 VAC 85 VAC 85 VAC

Turn-off Voltage 35 VAC 35 VAC 35 VAC 35 VAC

Input Impedance (± 5%) 133 kOhms 133 kOhms 68 kOhms 68 kOhms

Operating Frequency 40 Hz to 400 Hz 40 Hz to 400 Hz 40 Hz to 400 Hz 40 Hz to 400 Hz

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) NONE NONE 300 V working 300 V working

Number of Channels 24 24 12 12

Chassis Power Consumption 1.0 W 1.0 W 1.0 W 1.0 W

Minimum GRV-EPIC-PR1 Firmware Version 1.0.0 1.0.0 1.0.0 1.0.0

Minimum PAC Project Version 10.0000 10.0000 10.0000 10.0000

Wire Size 28–14 AWG 28–14 AWG 28–14 AWG 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95% 5–95% 5–95% 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2); RoHS; DFARS; CB Scheme

Warranty Lifetime Lifetime Lifetime Lifetime

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 
70, and ANSI/ISA-61010-1 (82.02.01).



GRV-IACDCTTL-24, GRV-IACDCTTLS-24

groov EPIC User’s Guide258

GRV-IACDCTTL-24, GRV-IACDCTTLS-24

groov input modules are used to sense the on or off status for AC or DC devices between 2.5–16 V. They can 
sense status from up to 24 devices. The channels are not isolated. Note that all channels share a common 
reference terminal.
• The GRV-IACDCTTL-24 offers a full set of features.
• The GRV-IACDCTTLS-24 module provides input state only, offering a lower cost option for projects that 

require only point states.

Features

Feature GRV-IACDCTTL-24 GRV-IACDCTTLS-24

Number of channels 24 24

On/off state x x

On/off latching x                

Counting x                

On/off totalization x                

Frequency measurement x                

Period measurement x                

Pulse measurement x                
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Specifications

Specification GRV-IACDCTTL-24 GRV-IACDCTTLS-24

Input Voltagea

aThe GRV-IACDCTTL-24 is primarily intended for use as a polarity-insensitive low voltage DC input module. It can be used with AC input 
voltages by reading the On Latch or Off Latch when discrete input latching is enabled. This also applies when using the various fea-
tures other than state and latches.

2–16 VAC / VDC 2–16 VAC / VDC

Turn-on Voltage 2.0 VAC (Peak) / VDC 2.0 VAC (peak) / VDC

Turn-off Voltage 0.8 VAC (Peak) / VDC 0.8 VAC (Peak) / VDC

Input Impedance (± 5%) 2 kOhms 2 kOhms

Max. Freq. (50% square wave 5 Vp-p) 2000 Hz N/A

IEC Input Type N/A N/A

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) None None

Number of Channels 24 24

Chassis Power Consumption 1.0 W 1.0 W

Minimum GRV-EPIC-PR1 Firmware Version 1.0.0 1.0.0

Minimum PAC Project Version 10.0000 10.0000

Wire Size 28–14 AWG 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95% 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)b; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

bFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical 
Code, ANSI/NFPA 70, and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime Lifetime
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GRV-IACHV-24, GRV-IACIHV-12, GRV-IACHVS-24, GRV-IACIHVS-12

These groov AC input modules sense status from devices such as pumps, fans, and motors that use a 120–280 
VAC signal. You can sense status from up to 24 devices using a 24-channel module, or up to 12 devices using a 
12-channel module.
• The GRV-IACHV-24 module provides 24 channels per module. Field devices are isolated from the logic 

side of the module, but channels are not isolated from each other: they share a common connection 
inside the module.

• The GRV-IACIHV-12 module provides 12 channels per module, with channel-to-channel isolation. 
• The GRV-IACHVS-24 and the GRV-IACIHVS-12 modules provide input state only, offering a lower cost 

option for projects that require only on/off status.

Features

Feature GRV-IACHV-24 GRV-IACHVS-24 GRV-IACIHV-12 GRV-IACIHVS-12

Number of channels 24 24 12 12

Channel-to-channel isolation x x

On/off state x x x x

On/off latching x x

On/off totalization x x

Frequency measurement x x

Period measurement x x

Pulse measurement x x
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Specifications

Specification GRV-IACHV-24 GRV-IACHVS-24 GRV-IACIHV-12 GRV-IACIHVS-12

Nominal Input Voltage Range (RMS) 180–280 VAC 180–280 VAC 180–280 VAC 180–280 VAC

Turn-on Voltage 180 VAC 180 VAC 180 VAC 180 VAC

Turn-off Voltage 35 VAC 35 VAC 35 VAC 35 VAC

Input Impedance (± 5%) 532 kOhms 532 kOhms 271 kOhms 271 kOhms

Operating Frequency 40 Hz to 400 Hz 40 Hz to 400 Hz 40 Hz to 400 Hz 40 Hz to 400 Hz

Isolation (field-to-logic) 300 VAC, 1500 V Transient

Isolation (channel-to-channel) N/A N/A 300 VAC working 300 VAC working

Number of Channels 24 24 12 12

Chassis Power Consumption 1.0 W 1.0 W 1.0 W 1.0 W

Minimum GRV-EPIC-PR1 Firmware Version 1.0.0 1.0.0 1.0.0 1.0.0

Minimum PAC Project Version 10.0000 10.0000 10.0000 10.0000

Wire Size 28–14 AWG 28–14 AWG 28–14 AWG 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95% 5–95% 5–95% 5–95%

Agency Approvals UL/cUL (Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, 
ANSI/NFPA 70, and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime Lifetime Lifetime Lifetime
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GRV-IDC-24, GRV-IDCI-12, GRV-IDCS-24, GRV-IDCSW-12, GRV-IDCIS-12, 
GRV-IDCIFQ-12

groov DC input modules can sense the on or off status for 10–30 VDC field devices (proximity switches, push 
buttons, and auxiliary contacts) or 2.5–30 VDC input devices that produce high-frequency signals:
• The GRV-IDC-24 is a leakage-tolerant DC input module.
• The GRV-IDCI-12 is a DC input module that includes channel-to-channel isolation. The 12 channels in 

these modules do not share any field signal connections inside the module.
• The GRV-IDCSW-12 module provides 12 channels of contact status input. It supplies power to an 

external dry contact switch and senses switch closure or opening. The channels can also be configured as 
DC inputs with a nominal range of 5–30 V.

• The GRV-IDCS-24 and the GRV-IDCIS-12 modules provide DC input state only, offering a lower cost 
option for projects with simple requirements.

• The GRV-IDCIFQ-12 module provides 12 high-speed digital input channels capable of measuring 
frequencies up to 25 kHz, channel-to-channel isolation, and can be configured to provide up to 4 axes of 
quadrature input with an index signal for each axes.

Features

Feature GRV-IDC-24 GRV-IDCS-24 GRV-IDCSW-12 GRV-IDCI-12 GRV-IDCIS-12 GRV-IDCIFQ-12

Number of channels 24 24 12 12 12 12

Channel-to-channel isolation x x x

On/off state x x x x x x

On/off latching x x x x

Counting x x x x

On/off totalization x x x x

Frequency measurement x x x x

Period measurement x x x x

Pulse measurement x x x x

Quadrature x
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Specifications for GRV-IDC-24, GRV-IDCI-12, GRV-IDCS-24, GRV-IDCIS-12, 
GRV-IDCIFQ-12

The specifications for GRV-IDCSW-12 are in the next section.

Specification GRV-IDC-24 GRV-IDCS-24 GRV-IDCI-12 GRV-IDCIS-12 GRV-IDCIFQ-12

Input Voltage 15–30 VDC 15–30 VDC
10–30 VDC
10–25 VAC

10–30 VDC 2.5–30 VDC

IEC Input Type Type I Type I Type III Type III N/A

Turn ON Characteristic 15 V, > 2 mA 15 V, > 2 mA 10 V, > 2 mA 10 V, > 2 mA 2.5 V

Turn OFF Characteristic 5 V, < 0.5 mA 5 V, < 0.5 mA 5 V, < 1.5 mA 5 V, < 1.5 mA 1.8 V

Input Impedance (± 5%) See notea

aIEC inputs have non-linear impedance. See the tables for typical V-I curves.

See notea See notea See notea
1.1 K at 5 V,
2.2 K at 12 V,
3.5 K at 24 V

Max. On/Off Frequency
(DC Input, 50% square wave) 

1000 Hz (24 Vp-p) 1000 Hz (24 Vp-p) 1000 Hz (24 Vp-p) 1000 Hz (24 Vp-p)
Counting: 200 kHz,
Quadrature: 50 kHz

Max. On/Off Frequency
(AC Input, 24 VAC, 60 Hz)

N/A N/A 20 Hz N/A N/A

Operating Frequency for AC Input N/A N/A 45–100 Hz N/A N/A

Isolation (field-to-logic)
300 V working,
1500 V transient
(1 minute)

300 V working,
1500 V transient
(1 minute)

300 V working,
1500 V transient
(1 minute)

300 V working,
1500 V transient
(1 minute)

300 V working,
1500 V transient
(1 minute)

Isolation (channel-to-channel) None None 300 V working 300 V working 300 V working

Number of Channels 24 24 12 12 12

Chassis Power Consumption 1.2 W 1.2 W 1.2 W 1.2 W 1.0 W

Minimum groov EPIC Firmware Version 1.0.0 1.0.0
1.0.0
(3.3.0 for VAC input)

1.0.0 1.3.0

Minimum PAC Project Version 10.0000 10.0000
10.0000
(10.4000 for VAC 
input)

10.0000 10.2000

Minimum Library Package for
CODESYS Version

1.0.0.0 1.0.0.0
1.0.0.0
(2.0.3.0 for VAC input)

1.0.0.0
1.0.0.0
(2.0.1.0 for quadrature)

Wire Size 28–14 AWG 28–14 AWG 28–14 AWG 28–14 AWG 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95% 5–95% 5–95% 5–95% 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)b; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

bFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 70, 
and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime Lifetime Lifetime Lifetime Lifetime
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Specifications for GRV-IDCSW-12

Specification GRV-IDCSW-12

Open Circuit Voltage (Switch Open) > 20 V

Channel Current Limit 2.0 mA ±25%

Channel Operating Current 0.7 mA typical

Minimum Off Resistance 50 KOhms

Maximum On Resistance 10 KOhms

Turn ON Characteristic > 5 V

Turn OFF Characteristic < 1.5 V

Maximum Continuous Survivable Input Voltage 32 V

Input Impedance 3.9 KOhms

Max. Freq. (50% square wave) 80 Hz

Debounce Time > 500 microseconds

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) None

Number of Channels 12

Chassis Power Consumption 2.4 W

Minimum GRV-EPIC-PR1 Firmware Version 1.4.2

Minimum PAC Project Version 10.2003

Minimum Library Package for CODESYS Version 1.0.2.0

Wire Size 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, 
ANSI/NFPA 70, and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime
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GRV-IICTD-12

The GRV-IICTD-12 module collects temperature input data from any industry-standard Integrated Circuit 
Temperature Device (ICTD). The module has 12 channels of input.

Features

Features GRV-IICTD-12

Scaling x

Offset and Gain x

Minimum/Maximum Values x

Average Filter Weight x

Simple Moving Average x

Analog Totalizing x

Quality Indicator x
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Specifications

Specification GRV-IICTD-12

Input Range -270.0 °C to 150 °C (-454.0 °F to 302 °F)

Input Range with ICTD Probe -40.0 °C to 100 °C (-40.0 °F to 212 °F)

Input Range µA 3 to 425 µA

Over-range limits -270.0 °C to 150 °C (-454.0 °F to 302 °F)

Resolution 0.005 °C (0.0072 °F)

Accuracy with ICTD PROBE ±0.8 °C (±1.4 °F)

Input Filter -3 dB at 460 Hz

Software Data Filtering:
SMA (simple moving average)
Weighted filter (Original)

1 to 32 Readings, moving average
1 to 4096 Filter Weight

Step Input Response Time 225 ms x SMA value (7.2 s @ 32 SMA, Default SMA = 4)

Data Freshness 225 ms

Analog Data Filtering -3 dB @ 2.4 Hz / -25 dB @ 60 Hz

Common Mode Rejection > -120 dB

Quality Indicator out of range

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) None

Number of Channels 12

Chassis Power Consumption 1.0 W

Minimum GRV-EPIC-PR1 Firmware Version 1.3.0

Minimum PAC Project Version 10.2000

Wire Size 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 70, 
and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime
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GRV-IMA-24, GRV-IMAI-8
• The GRV-IMA-24 module provides 24 channels of analog current input with an input range of ±20 mA, 

0–20 mA, and 4–20 mA.
• The GRV-IMAI-8 module provides channel-to-channel isolation on its 8 channels of analog current input 

with an input range of 0 to 20 mA and 4 to 20 mA.

Features

Features GRV-IMA-24 GRV-IMAI-8

Scaling x x

Offset and Gain x x

Minimum/Maximum Values x x

Average Filter Weight x x

Simple Moving Average x x

Analog Totalizing x x

Quality Indicator x x
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Specifications

Specification GRV-IMA-24 GRV-IMAI-8

Input Range (per channel) -20 to +20 mA, 0 to 20 mA, 4 to 20 mA 0 to 20 mA, 4 to 20 mA

Over-range limits
-22 mA to +22 mA, 0.0 to 22.0mA
1.8 mA to 22.0 mA

0 mA to +22 mA, 1.8 mA to 22.0 mA

Resolution 0.02 µA (20-bits) 0.02 µA (20-bits)

Accuracy ± 0.1% (± 20 µA) ± 0.1% (± 20 µA)

Input Voltage Drop nominal
(Impedance ± 20%)

5.5 V nominal @ 20 mA (275 Ohms) 5.5 V nominal @ 20 mA (275 Ohms)

Input Filter (hardware) -3 dB at 140 Hz -3 dB at 140 Hz

Step Input Response Time
225 ms x SMA value
(7.2 s @ 32 SMA, Default SMA = 4)

11 ms x SMA value
(.355 s @ 32 SMA, Default SMA = 4)

Data Refresh Time 225 ms 11 ms

Analog Data Filtering -3 dB @ 2.4 Hz / -25 dB @ 60 Hz -5 dB @ 60 Hz

Software Filtering:
Simple Moving Average

1 to 32 readings 1 to 32 readings

Software Filtering:
Weighted Average

1 to 4096 1 to 4096

Common Mode Rejection > -120 dB > -120 dB

Max. Survivable Input ± 32 V ± 32 V

Quality Indicators out of range out of range

Isolation (field-to-logic)
300 V working, 1500 V transient
(1 minute)

300 V working, 1500 V transient
(1 minute)

Isolation (channel-to-channel)
300 V between group A (ch 0-11) & group 
B (ch 12-23)

300 V working, 1500 V transient
(1 minute)

Number of Channels 24 8

Chassis Power Consumption 1.0 W
1.8 W externally powered loops, 4.5 W 
chassis powered loops

Minimum GRV-EPIC-PR1 Firmware 
Version

1.0.0 1.3.0

Minimum PAC Project Version 10.0000 10.2000

Wire Size 28–14 AWG 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95% 5–95%

Agency Approvals
UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB 
Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electri-
cal Code, ANSI/NFPA 70, and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime Lifetime
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GRV-IICTD-12

This module collects temperature input data from any industry-standard Integrated Circuit Temperature 
Device (ICTD). The module has 12 channels of input.

Features

Specifications are on the next page.

Features GRV-IICTD-12

Scaling x

Offset and Gain x

Minimum/Maximum Values x

Average Filter Weight x

Simple Moving Average x

Analog Totalizing x

Quality Indicator x
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Specifications

Specification GRV-IICTD-12

Input Range -270.0 °C to 150 °C (-454.0 °F to 302 °F)

Input Range with ICTD Probe -40.0 °C to 100 °C (-40.0 °F to 212 °F)

Input Range µA 3 to 425 µA

Over-range limits -270.0 °C to 150 °C (-454.0 °F to 302 °F)

Resolution 0.005 °C (0.0072 °F)

Accuracy with ICTD PROBE ±0.8 °C (±1.4 °F)

Input Filter -3 dB at 460 Hz

Software Data Filtering:
SMA (simple moving average)
Weighted filter (Original)

1 to 32 Readings, moving average
1 to 4096 Filter Weight

Step Input Response Time 225 ms x SMA value (7.2 s @ 32 SMA, Default SMA = 4)

Data Freshness 225 ms

Analog Data Filtering -3 dB @ 2.4 Hz / -25 dB @ 60 Hz

Common Mode Rejection > -120 dB

Quality Indicator out of range

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) None

Number of Channels 12

Chassis Power Consumption 1.0 W

Minimum GRV-EPIC-PR1 Firmware Version 1.3.0

Minimum PAC Project Version 10.2000

Wire Size 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 70, 
and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime
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GRV-ITM-12, GRV-ITMI-8

The GRV-ITM-12 and GRV-ITMI-8 analog modules provides channels to read input from millivolt or 
thermocouple field devices. Each channel is individually configurable for ±1200 mV, ±600 mV, ±300 mV, ±150 
mV, ±75 mV, ±50 mV, ±25 mV or Type B, E, J, K, N, R, S, or T thermocouples.

Features

Specifications are on the next page.

Features GRV-ITM-12 GRV-ITMI-8

Scaling x x

Offset and Gain x x

Minimum/Maximum Values x x

Average Filter Weight x x

Simple Moving Average x x

Analog Totalizing x x

Quality Indicator x x
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Specifications

Specification GRV-ITM-12 and GRV-ITMI-8

Millivolt Input Ranges ±1200.0 mV, ±600.0 mV, ±300.0 mV, ±150.0 mV, ±75.0 mV, ±50.0 mV, ±25.0 mV

Over range limits (± 10%) ±1320.0 mV, ±660.0 mV, ±330.0 mV, ±165.0 mV, ±82.5 mV, ±55.0 mV, ±27.5 mV

Resolution mV Range / 1,048,576 (20 bits)

Accuracy 0.1% of Range ±1200 µV, ±600 µV, ±300 µV, ±150 µV, ±75 µV, ±50 µV, ±50 µV

Thermocouple ITS90 Types Accuracy (Default) / Accuracy (User-Calibrated) / Resolution

B:  90 °C to 1,820 °C 5.0 °C / 3.0 °C @ 250 °C / 0.05 °C

E:  -270 °C to 1,000 °C 2.0 °C / 0.5 °C @ 0.0 °C / 0.05 °C

J:  -210 °C to 1,200 °C 2.0 °C / 0.5 °C @ 0.0 °C / 0.05 °C

K: -270 °C to 1,372 °C 2.0 °C / 0.5 °C @ 0.0 °C / 0.05 °C

N: -270 °C to 1,300 °C 3.0 °C / 0.8 °C @ 0.0 °C / 0.05 °C

R: -50 °C to 1,768 °C 5.0 °C / 2.5 °C @ 250 °C / 0.05 °C

S: -50 °C to 1,768 °C 5.0 °C / 3.0 °C @ 250 °C / 0.05 °C

T: -270 °C to 400 °C 3.0 °C / 0.5 °C @ 0.0C / 0.05 °C

Specification GRV-ITM-12 GRV-ITMI-8

Cold Junction Compensation Automatic Automatic

Data Refresh Time
mV Ranges = 0.9 s
T/C Ranges = 1.2 s

mV Ranges = 21 ms
T/C Ranges = 46 ms

Analog Data Filtering
-3 dB @ 14 Hz

-25 dB @ 60 Hz
-3 dB @ 14 Hz

-25 dB @ 60 Hz

Software Filtering: Simple Moving Average (SMA) 1 to 32 readings 1 to 32 readings

Software Filtering: Weighted Average 1 to 4096 1 to 4096

Step Input Response Time
1.2 s x SMA value
(38.4 s @ 32 SMA, Default SMA = 6)

85 ms

Common Mode Rejection > -120 dB > -120 dB

Input Resistance 100 megohm 100 megohm

Quality Indicator out of range, open thermocouple out of range, open thermocouple

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute) 300 V working, 1500 V transient (1 minute) 

Isolation (channel-to-channel)
300 V between channel group 0-5 &
channel group 6-11. None within a group.

300 V working, 1500 V transient (1 minute)

Number of Channels 12 8

Chassis Power Consumption 1.3 W 1.4 W

Minimum groov EPIC Firmware Version 1.4.2 1.0.0

Minimum PAC Project Version 10.2003 10.0000

Minimum Library Package for CODESYS Version 1.0.2.0 1.0.0.0

Continued on next page.
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Wire Size 28–14 AWG 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C         

Humidity (non-condensing) 5–95% RH 5–95% RH       

Agency Approvals UL/cUL (Class 1 Div. 2)a; CE, ATEX (Category 3, Zone 2), RoHS; DFARS; CB Scheme

Warranty Period Lifetime  Lifetime 

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 
70, and ANSI/ISA-61010-1 (82.02.01).

Specification GRV-ITM-12 and GRV-ITMI-8
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GRV-ITR-12, GRV-IRTD-8

The GRV-ITR-12 and GRV-IRTD-8 modules can read temperature or resistance:
• The GRV-IRTD-8 module has 8 configurable channels divided into two groups: channels 0-3 are isolated 

from channels 4-7. This module is commonly used for 3-wire RTD temperature inputs but is also suited to 
high-resolution resistance measurements.

• The GRV-ITR-12 module has 12 configurable channels divided into two groups: channels 0-5 are isolated 
from channels 6-11. The module is ideal for NTC thermistors commonly used in HVAC, refrigeration, and 
process control applications. It may also be used with PTC thermistors in resistance sensing applications.

Features

Features GRV-IRTD-8 GRV-ITR-12

Scaling x x

Offset and Gain x x

Minimum/Maximum Values x x

Average Filter Weight x x

Simple Moving Average (SMA) x x

Analog Totalizing x x

Quality Indicator x x
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Specifications for GRV-ITR-12

Specifications for GRV-IRTD-8 are on the following page.

Specification GRV-ITR-12

Input Ranges (Ohms)

400 k, 200 k, 100 k, 50 k,
40 k, 20 k, 10 k, 5 k,
4 k, 2 k, 1 k, 500

and Autorange

Accuracy, normal mode (Ohms @ Range)

0.1%; specific values for indicated range:
400 @ 400 k, 200 @ 200 k,100 @100 k, 50 @ 50 k,
40 @ 40 k, 20 @ 20 k, 10 @ 10 k, 5 @ 5 k,
4 @ 4 k, 2 @ 2 k, 1 @ 1 k, 0.5 @ 500

Accuracy, fast ADC mode (Ohms @ Range)

0.5%; specific values for indicated range:
2000 @ 400 k, 1000 @ 200 k,500 @100 k, 250 @ 50 k,
200 @ 40 k, 100 @ 20 k, 50 @ 10 k, 25 @ 5 k,
20 @ 4 k, 10 @ 2 k, 5 @ 1 k, 2.5 @ 500

Excitation Current
(Range & Load Watts Dissipated)

>7.9 µA (400 K & 25 µW), (200 K & 12.4 µW), (100 K & 6.2 µW), (50 K & 3.1 µW),
>84.7 µA (40 K & 287 µW), (20 K & 144 µW), (10 K & 72 µW), (5 K & 36 µW),

>169.2 µA (4 K & 115 µW), (2 K & 57 µW), (1 K & 29 µW), (500 & 14 µW)

Analog Data Filtering
-3 dB @ 2.4 Hz
-25 dB @ 60 Hz

Software Filtering: Simple Moving Average 1 to 32 readings

Software Filtering: Weighted Average 1 to 4096

Data Refresh Time (normal mode) 900 ms

Data Refresh Time (fast ADC mode) 450 ms

Step Input Response Time (normal mode) 900 ms x SMA value (for example, 28.8 s @ 32 SMA, Default SMA = 4)

Step Input Response Time (fast ADC mode) 450 ms x SMA value (for example,14.4 s @ 32 SMA, Default SMA = 4)

Quality Indicator out of range

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) 300 V between channel group 0–5 & channel group 6–11. None within a group.

Number of Channels 12

Chassis Power Consumption 1.3 W

Minimum groov EPIC Firmware Version 1.3.0

Minimum PAC Project Version 10.2000

Minimum Library Package for CODESYS Version 1.0.0.0

Wire Size 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Humidity (non-condensing) 5–95% RH

Agency Approvals UL/cUL(Class 1 Div. 2), CE, ATEX(Category 3, Zone 2), RoHS, DFARS

Warranty Lifetime
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Specifications for GRV-IRTD-8

Specification GRV-IRTD-8

Input Ranges (Ohms)
8.0 K, 4.0 K, 2.0 K, 1.0 K
800, 400, 200, 100
80, 40, 20, 10, and Autoranges

Accuracy (Ohms @ Range)
4.2@8 K, 2.6@4 K, 1.8@2 K, 1.4@1 K
0.47@800, 0.31@400, 0.23@200, 0.19@100
0.082@80, 0.066@40, 0.058@20, 0.058@10 Ohms

Excitation RMS Current
(Range & Load Watts Dissipated)

>301 µA (8 K & 363 µW), (4 K & 182 µW), (2 K & 91 µW), (1 K & 46 µW)
>1.84 mA (800 Ohms & 1.355 mW), (400 Ohms & 677 µW), (200 Ohms & 339 µW), (100 Ohms & 169 µW)
>3.96 mA (80 Ohms & 627 µW), (40 Ohms & 313 µW), (20 Ohms & 156 µW), (10 Ohms & 78 µW)

3-wire RTD Type Accuracy from factory / Accuracy after setting offset and gain

1000 Ohm @ 70 °F Ni,
a=0.00637,
-45 °C to 250 °C (-49 °F to 482 °F)

0.6 °C (1.1 °F) / 0.4 °C (0.7 °F)

1000 Ohm @ 0 °C Ni,
a=0.00618,
-60 °C to 250 °C (-76 °F to 482 °F)

0.6 °C (1.1 °F) / 0.4 °C (0.7 °F)

1000 Ohm Pt,
a=0.00385,
-200 °C to 850 °C (-328 °F to 1562 °F)

0.8 °C (1.4 °F) / 0.6 °C (1.1 °F)

120 Ohm Ni,
a=0.00672,
-80 °C to 260 °C (-112 °F to 500 °F)

0.6 °C (1.1°F) / 0.4 °C (0.7 °F)

100 Ohm Ni,
a=0.00618,
-60 °C to 250 °C (-76 °F to 482 °F)

0.6 °C (1.1°F) / 0.4 °C (0.7 °F)

100 Ohm Pt,
a=0.00385,
-200 °C to 850 °C (-328 °F to 1562 °F)

0.8 °C (1.4 °F) / 0.6 °C (1.1 °F)

10 Ohm Cu,
a=0.00427,
-200 °C to 260 °C (-328 °F to 500 °F)

1.7 °C (3.1 °F) / 1.7 °C (3.1 °F)

Data Refresh Time 600 ms

Step Input Response Time 600 ms x SMA value (19.2 s @ 32 SMA, Default SMA = 4)

Analog Data Filtering
-3 dB @ 23.5 Hz
-18 dB @ 60 Hz

Software Filtering:
Simple Moving Average

1 to 32 readings

Software Filtering:
Weighted Average

1 to 4096

Total Lead Resistance 200 Ohms Max, > 4 Kft / 1.2 Km (24 AWG)

Quality Indicator out of range

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) 300 V between channel group 0-3 & group 4-7. None within a group.

Number of Channels 8

Chassis Power Consumption 1.3 W

Minimum groov EPIC Firmware Version 1.4.2

Minimum PAC Project Version 10.2003
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Minimum Library Package for CODESYS 
Version

1.0.2.0

Wire Size 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Humidity (non-condensing) 5–95% RH

Agency Approvals UL/cUL(Class 1 Div. 2), CE, ATEX(Category 3, Zone 2), RoHS, DFARS

Warranty Lifetime

Specification GRV-IRTD-8
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GRV-IV-24, GRV-IVI-12, GRV-IVIRMS-10

The GRV-IV-24 and GRV-IVI-12 modules can be configured for any one of the following input ranges on 
each of their input channels.

A couple of differences to note:
• The GRV-IV-24 module offers 24 channels; the GRV-IVI-12 offers 12 channels
• The GRV-IV-24 module does not offer channel-to-channel isolation; the GRV-IVI-12 module does offer 

channel-to-channel isolation.

The GRV-IVIRMS-10 module provides 10 isolated channels of analog input reading 0-300 V of true RMS AC or 
DC.

For more details about other differences, see the features and specification tables.

Features

±160.0 VDC
±80.0 VDC

±40.0 VDC
±20.0 VDC

±10.0 VDC
±5.0 VDC

±2.5 VDC
±1.25 VDC

Features GRV-IV-24 GRV-IVI-12 GRV-IVIRMS-10

Scaling x x x

Offset and Gain x x x

Minimum/Maximum Values x x x

Average Filter Weight x x x

Simple Moving Average x x x

Analog Totalizing x x x

Quality Indicator x x x
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Specifications

Specification GRV-IV-24 GRV-IVI-12 GRV-IVIRMS-10

Input Ranges

±160.0  VDC  ±80.0  VDC
±40.0  VDC  ±20.0  VDC
±10.0  VDC  ±5.0  VDC
±2.5  VDC  ±1.25  VDC

±160.0  VDC  ±80.0  VDC
±40.0  VDC  ±20.0  VDC
±10.0  VDC  ±5.0  VDC
±2.5  VDC  ±1.25  VDC

300.0 Vrms AC/DC 150.0 Vrms AC/DC
60.0 Vrms AC/DC 30.0 Vrms AC/DC
20.0 Vrms AC/DC 10.0 Vrms AC/DC
5.0 Vrms AC/DC 1.0 Vrms AC/DC
0.5 Vrms AC/DC

Over-range limits

±176.0 VDC ±88.0 VDC
±44.0 VDC ±22.0 VDC
±11.0 VDC ±5.5 VDC
±2.75 VDC ±1.375 VDC

±176.0 VDC ±88.0 VDC
±44.0 VDC ±22.0 VDC
±11.0 VDC ±5.5 VDC
±2.75 VDC ±1.375 VDC

333.0 Vrms AC/DC 165.0 Vrms AC/DC
66.0 Vrms AC/DC 33.0 Vrms AC/DC
22.0 Vrms AC/DC 11.0 Vrms AC/DC
5.5 Vrms AC/DC 1.1 Vrms AC/DC

0.55 Vrms AC/DC

Resolution Range / 1,048,576 (20-bits) Range / 1,048,576 (20-bits) Range / 1,048,576 (20-bits)

Accuracy 0.1% of Range
±160 mV ±80 mV ±40 mV
±20 mV ±10 mV ±5 mV
±2.5 mV ±1.25 mV

±160 mV ±80 mV ±40 mV
±20 mV ±10 mV ±5 mV
±2.5 mV ±1.25 mV

N/A

Accuracy @ 50-60 Hz N/A N/A ±200 mV and ±0.2% of reading

Accuracy @ 60-400 Hz N/A N/A ±200 mV and ±0.3% of reading

Input Impedance Nominal 9.7 megohms 9.7 megohms 9.5 megohms

Input Filter -3 dB at 46 HZ -3 dB at 46 HZ N/A

DC Reversal N/A N/A 1% of Range

Software Data Filtering:
• Simple Moving Average (SMA)
• Weighted Average

• 1 to 32 readings
• 1 to 4096

• 1 to 32 readings
• 1 to 4096

• 1 to 32 readings
• 1 to 4096

Step Input Response Time
512 ms x SMA value
(i.e. when SMA = 32, time is 16.4 s)
Default SMA: 4

16.5 ms x SMA value
(i.e. when SMA = 32, time is 0.53 s)
Default SMA: 4

• 0 to 100%: 250 ms x SMA value
(i.e. when SMA = 4, time is 1 s)

• 100 to 0%: 1,100 ms x SMA value
(i.e. when SMA = 4, time is 4.4 s)

Data Refresh Time 512 ms 15.5 ms 50 ms

Analog Data Filtering
-3 dB @ 2.4 Hz
-25 dB @ 60 Hz

-3 dB @ 46 Hz
-5 dB @ 60 Hz

N/A

Common Mode Rejection > -120 dB > -120 dB > -120 dB

Max. Survivable Input 300 V 300 V 330 V

Max. Operating Common
Mode Voltage

250 V 250 V 300 V

Quality Indicator out of range out of range out of range

Isolation (field-to-logic)
300 V working,
1500 V transient (1 minute)

300 V working,
1500 V transient (1 minute)

300 V working,
1500 V transient (1 minute)

Isolation (channel-to-channel)
300 V between
channel group 0-11 & group 12-23

300 V working,
1500 V transient (1 minute)

300V working,
1500 V transient

Number of Channels 24 12 10

Chassis Power Consumption 1.0 W 2.2 W 1.5 W

Minimum GRV-EPIC-PR1
Firmware Version

1.0.0 1.4.2 1.5.0

Minimum PAC Project Version 10.0000 10.2003 10.2005

Minimum Library Package for 
CODESYS Version

1.0.0.0 1.0.2.0 1.0.3.0

Wire Size 28–14 AWG 28–14 AWG 28–14 AWG
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Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C

Relative Humidity
(non-condensing)

5–95% 5–95% 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

Warranty Lifetime Lifetime Lifetime

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 70, 
and ANSI/ISA-61010-1 (82.02.01).

Specification GRV-IV-24 GRV-IVI-12 GRV-IVIRMS-10
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GRV-IVAPM-3

An analog input module that provides an efficient way to monitor AC voltage and current. It can monitor 
three-phase AC current using a standard current transformer (CT) or a 0.333 VAC current transformer (CT).

The module provides 64 channels of data, some from wired inputs and some calculated by the module. For 
each of the three phases, the module includes two channels of measured data and sixteen channels of 
calculated values. It also provides ten channels of summation values.

Features

Specifications listed on next page.

Features GRV-IVAPM-3

Scaling x

Offset and Gain N/A

Minimum/Maximum Values x

Average Filter Weight x

Simple Moving Average N/A

Analog Totalizing x

Quality Indicationa

aThe Quality Indication feature enables a channel to provide a numeri-
cal code that describes a characteristic of the signal entering or leav-
ing the channel. For a list of numerical codes and what characteristic 
they describe, see .

x
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Specifications

Specification GRV-IVAPM-3

Maximum UL61010-3 Measurement Category Category III 600 VAC

Delta Voltage Input Ranges, Vrms 600, 520, 260

Wye Voltage Input Ranges, Vrms 400, 300, 150

Voltage Accuracy
(% of range @ 50-60 Hz, excluding Voltage transformer)

Wye: ±0.35%, Delta: ±0.5%

Current Transformer (CT) Outputs Supported 5.0 A, 1.0 VAC or 0.3333 VAC

Current Accuracy
(% of CT range @ 50-60 Hz, excluding Current trans-
former)

±0.5%

Power Accuracy
(% of (Vrms range) * (CT current rating), @ 50-60Hz)

 ±0.5% 

Data Refresh Time 1 s

Step Response Time 1 s

Quality Indication Vrms out of range, Irms out of range

Isolation (field-to-logic) 3600 VAC working, 5400 VAC transient

Isolation (channel-to-channel) N/A

Number of Data Channels 64

Chassis Power Consumption 1.1W

Minimum groov EPIC Firmware Version 3.3.0

Minimum PAC Project Version 10.4000

Minimum Library Package for CODESYS Version 2.0.3.0

Wire Size 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Humidity (non-condensing) 5–95% RH

Agency Approvals UL/cUL(Class 1 Div. 2), CE, ATEX(Category 3, Zone 2), RoHS, DFARS

Warranty Lifetime
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GRV-MM1001-10

A 10-channel, multi-signal, multifunction module that supports thousands of unique field I/O combinations. 
Programmable through PAC Control, CODESYS, custom control programs, or through groov Manage, you 
select a channel, configure its I/O signal, select any function supported by the selected channel—such as 
counting, latching, clamping, and more—and then save your configuration.

Features

Specifications listed on next page.

GRV-MM1001-10 Signal Type

DI:
• Discrete
• Switch Input, 

Powered

DO:
• DC Sinking

DO:
• Form C

Mechanical
Relay

AI:
• Voltage
• ICTD
• Thermistor
• Resistor

AI:
• Current
• Thermocouple
• Millivolt

AO:
• Voltage
• Current

Channels 0–7 0–7 8–9 0–7 0–3 4–7

Features

On/off State x x x

On/off Latching x

Counting x

On/off Totalization x

Frequency Measurement x

Period Measurement x

Pulse Measurement x

Scaling x x x

Offset and Gain x x

Minimum/Maximum Values x x

Average Filter Weight x x

Simple Moving Average x x

Analog Totalizing x x

Output Pulsing / TPO x

Ramping x

Clamping x

Watchdog Timeout Value x x x

Quality Indicationa

aThe Quality Indication feature enables a channel to provide a numerical code that describes a characteristic of the signal entering or leaving the 
channel. For a list of numerical codes and what characteristic they describe, see “Quality Indication” on page 3.

x x x
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Specifications

Specification GRV-MM1001-10

Voltage Input

Available Channels 0–7 

Input Range 0–10 V DC 

Over-range Limit 0–11 V DC 

Resolution 0.5 mV 

Accuracy ±0.05% of range (±5 mV) 

Gain Temperature Coefficient 10 ppm/°C 

Offset Temperature Coefficient 1 ppm/°C 

Input Impedance > 425 kOhms 

Data Refresh Time 550 ms x SMA value (1.1 s @ 2 SMA, Default SMA = 2) 

50 / 60 Hz rejection > 90 dB 

Current Input

Available Channels 0–3 

Input Range 0–20 mA 

Over-range Limit 0–20.8 mA 

Recommended Fuse 32–40 mA, Fast Acting (for example, Eaton S500-32-R) 

Resolution 1.0 µA 

Accuracy ±0.075% (±15 µA)

Gain Temperature Coefficient 25 ppm/°C 

Offset Temperature Coefficient 1 ppm/°C 

Input Voltage Drop (±10%) 0.9 V @ 4 mA, 2.0 V @ 20 mA, 25 °C 

Equivalent Input Impedance (±10%) 225 Ohms @ 4 mA, 100 Ohms @ 20 mA, 25 °C 

Data Refresh Time 550 ms x SMA value (1.1 s @ 2 SMA, Default SMA = 2) 

50 / 60 Hz rejection > 90 dB 

ICTD Input

Available Channels 0–7 

Input Range with ICTD Probe -40 to +100 °C 

Resolution 0.04 °C 

Accuracy with ICTD Probe ±0.5 °C (0.9 °F) 

Gain Temperature Coefficient 2 ppm/°C 

Offset Temperature Coefficient 175 ppm/°C

Data Refresh Time 550 ms x SMA value (1.1 s @ 2 SMA, Default SMA = 2) 

50 / 60 Hz rejection > 90 dB 

Continued on next page.
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Thermocouple Input

Available Channels 0–3 (see Note) 

Input Range -75 to +75 mV 

Over-range Limit -78 to +78 mV 

Input Resolution 3 microvolts 

Input Impedance > 1 megohm 

Data Refresh Time 550 ms x SMA value (1.1 s @ 2 SMA, Default SMA = 2) 

50 / 60 Hz rejection > 90 dB 

Thermocouple ITS90 Types ± Accuracy / Resolution  

B:   90 °C to 1,820 °C 7 °C / 0.4 °C 

E:  -80 °C to 1,000 °C 2 °C / 0.1 °C 

J: -100 °C to 1,200 °C 2 °C / 0.1 °C 

K:  -80 °C to 1,372 °C 2 °C / 0.1 °C 

N: -100 °C to 1,300 °C 3 °C / 0.1 °C 

R:  100 °C to 1,768 °C 7 °C / 0.3 °C 

S:  100 °C to 1,768 °C 7 °C / 0.3 °C 

T:  -60 °C to  400 °C 3 °C / 0.1 °C 

Note: To achieve the best thermocouple accuracy when also using current outputs or discrete outputs, always configure thermocouples on 
the lowest channel numbers and outputs on the highest channel numbers. 

Millivolt Input

Available Channels 0–3 

Input Ranges ±150 mV, ±75 mV, ±25 mV 

Over-range Limits ±165.0 mV, ±78.0 mV, ±27.5 mV 

Resolution 10 µV, 3 µV, 2 µV 

Accuracy 
±0.05% of Full Scale (±75 µV), ±0.05% of Full Scale (±37.5 µV), ±0.05% of Full Scale 
(±12.5 µV) 

Gain Temperature Coefficient 10 ppm/°C, 10 ppm/°C, 10 ppm/°C 

Offset Temperature Coefficient 1 ppm/°C, 1 ppm/°C, 4 ppm/°C 

Input Impedance > 1 MOhms 

Data Refresh Time 550 ms x SMA value (1.1 s @ 2 SMA, Default SMA = 2) 

50 / 60 Hz rejection > 90 dB 

Specification GRV-MM1001-10
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Thermistor Input

Available Channels 0–7 (see Note) 

Input Range (Ohms) 0-400 k

Accuracy (Ohms @ Range) 
greater of 3 Ohms or 0.5%@0-25k, 400@25k–50k, 900@50k–75k, 1.5k@75k–100k, 
5k@100k–200k, 20k@200k–400k 

Gain Temperature Coefficient 500 ppm/°C 

Resolution (Ohms @ Range) 
0.5@0–1k, 1@1k–5k, 2@5k–10k, 5@10k–25k, 50@25k–100k, 200@100k–200k, 
700@200k–400k 

Power Dissipation @ Resistance (µW@Ohms) 
375@1k, 950@5k, 1075@10k, 875@25k, 600@50k, 450@75k, 350@100k, 
200@200k, 100@400k 

Predefined Thermistor Curves Accuracy (°C) @ Range (°C) 

2252                         0.2@-40 to 70,2.5@ 70 to 150 

3K 0.2@-40 to 70,2.5@ 70 to 150 

10K type 2                   0.75@-40 to -20,0.2@-20 to 120,0.6@ 120 to 150 

10k type 3                   0.5@-40 to -20,0.3@-20 to 120,0.6@ 120 to 150 

Custom                       depends on curve 

Gain Temp Coefficient        0.015/(°C * Ohm) 

Data Refresh Time 550 ms x SMA value (1.1 s @ 2 SMA, Default SMA = 2) 

Note: To achieve the best thermistor accuracy when also using current outputs, always configure thermistors on the lowest channel numbers 
and current outputs on the highest channel numbers. 

0–400 kOhm Input

Available Channels 0–7 (see Note) 

Input Range (Ohm) 0–400k  

Accuracy (Ohm @ Range) 
greater of 3 Ohm or 0.5%@0-25k, 400@25k–50k, 900@50k–75k, 1.5k@75k–100k, 
5k@100k–200k, 20k@200k–400k 

Gain Temperature Coefficient 500 ppm/°C 

Resolution (Ohm @ Range) 
0.5@0–1k, 1@1k–5k, 2@5k–10k, 5@10k–25k, 50@25k–100k, 200@100k–200k, 
700@200k–400k 

Power Dissipation @ Resistance (µW@Ohm) 
375@1k, 950@5k, 1075@10k, 875@25k, 600@50k, 450@75k, 350@100k, 
200@200k, 100@400k 

Data Refresh Time 550 ms x SMA value (1.1 s @ 2 SMA, Default SMA = 2) 

Note: To achieve the best resistance accuracy when also using current outputs, always configure the 0-400 kOhm channel type on the low-
est channel numbers and current outputs on the highest channel numbers. 

Switch Input, Powered

Available Channels 0–7 

Open Circuit Voltage (Switch Open) 10.5 V (minimum) 

Channel Current Limit 1.1 mA max. 

Channel Operating Current 0.63 mA typical 

Minimum Off Resistance 3300 Ohms 

Maximum On Resistance 1200 Ohms 

Minimum ON Voltage 5 V 

Maximum OFF Voltage 1.5 V 

Maximum Continuous Survivable Input Voltage 32 V 

Input Impedance > 425 kOhms 

Max. Freq. (50% square wave) 10000 Hz 

Specification GRV-MM1001-10
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Discrete Counter Input

Available Channels 0–7 

Input Voltage Range 5–30 V DC 

ON Threshold 5 V 

OFF Threshold 1.5 V 

Input Impedance > 425 kOhms 

Max. Frequency (50% square wave):
State, Latches, Counter 

10000 Hz 

Max. Frequency (50% square wave):
On/Off pulse width, Period, Frequency 

2000 Hz 

Max. Frequency (50% square wave):
On/Off totalization 

750 Hz 

Pulse Width Measurement Resolution 100 microseconds 

Pulse Width Measurement Error
(50% square wave) 

0.1% 0 to 20 Hz
1% 21 to 200 Hz
5% 201 to 2000 Hz

Period/Frequency Error
(50% square wave) 

0.05% 0 to 20 Hz
0.1% 21 to 200 Hz
1% 201 to 2000 Hz

Discrete DC Sinking Output

Available Channels 0–7 (4–7 if using any thermocouple inputs) 

Line Voltage Range 5–30 V DC 

Maximum Continuous Current 1.0 A 

Peak Current (< 10 ms) 4.0 A 

Recommended Fuse / Circuit Breaker 1 A at 30 V DC 

Output Voltage Drop 175 mV at 1 A 

Off-State Leakage (per channel) < 80 µA at 24 V, -20 to +70 °C 

Peak Blocking Voltage 32 V 

TPO Period (min, max, resolution) 0.004 seconds, 4294967 seconds, 0.001 seconds

Turn On / Off Time 20 ms nominal

Form C Relay Output

Available Channels 8, 9 

Line Voltage Range 0–250 V AC or 5–30 V DC 

Clamp Voltage 440 V nominal 

Current Rating 3.5 A per channel 

Surge Current 6 A peak for 1 second 

Recommended Fuse / Circuit Breaker 5 A at 250 V AC / > 30 V DC per channel 

Initial Contact Resistance < 100 mOhms 

Turn On Time 8 ms 

Turn Off Time 4 ms 

Operating Life (to specification) Min. 30,000 cycles at max. ratings 

Mechanical Life Min. 10,000,000 cycles 

Specification GRV-MM1001-10
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Voltage Output

Available Channels 4–7 

Range 0–10 V 

Resolution 2.5 mV 

Accuracy ±0.35% of range (±35 mV)

Gain Temperature Coefficient 20 ppm/°C 

Offset Temperature Coefficient 3 ppm/°C 

Output Slew Rate > 15 V/ms 

Minimum Load Resistance 7.5 kOhms 

Output Impedance < 10 Ohms 

Short-circuit Current 20 mA 

Data Refresh Time Nominal 20 ms. Proportional to I/O scan time. 

Current Output

Available Channels 4–7 

Output Range 0–20 mA 

Resolution 5 µA 

Accuracy ±0.4% of range (±80 µA) 

Offset Temperature Coefficient 5 ppm/°C 

Output Slew Rate > 10 mA/ms 

Maximum Loop Resistance 700 Ohms 

Data Refresh Time Nominal 20 ms. Proportional to I/O scan time. 

Common Specifications

Power Consumption 5 W

Max. Survivable Input (channels 0–7) 32 V DC 

Isolation (between channels 0–7) None 

Isolation (between channel 8 or 9 and all others) 3000 V ACrms 1 min. 

Isolation (field to Ethernet / power input) 1500 V ACrms 1 min.

Minimum groov EPIC Firmware Version 3.3.0

Minimum PAC Project Version 10.4000 

Minimum Library Package for CODESYS Version 2.0.3.0 

Wire Size  28–14 AWG

Torque, connector screw       2.5 in-lb (0.28 N-m)         

Torque, hold-down screw       3.5 in-lb (0.4 N-m)          

Temperature (operating) -20 °C to +70 °C 

Temperature (storage) -40 °C to +85 °C 

Relative Humidity (non-condensing) 5–95% 

Agency Approvals              UL/cUL(Class 1 Div. 2); CE, ATEX(Category 3, Zone 2); RoHS; DFARS; CB Scheme  

Warranty                      30 months 

Specification GRV-MM1001-10
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GRV-OAC-12, GRV-OACI-12, GRV-OACS-12, GRV-OACIS-12

groov 12–250 VAC output modules are used to switch up to 12 separate AC loads. They provide 300 volts of 
transient protection for sensitive control electronics from industrial field signals. Output modules that are 
fused use a standard fuse for easy replacement. AC outputs are zero voltage turn on and zero current turn off 
to minimize transients during switching.

Choose the module you need based on your requirements:

• The GRV-OACI-12 and GRV-OACIS-12 modules offer channel-to-channel isolation (sometimes called 
galvanic isolation). The 12 channels in these modules do not share any field signal connection inside the 
module. 

• The GRV-OACS-12 and GRV-OACIS-12 modules switch output on or off only, offering a lower cost 
option for projects with simple requirements.

Module
Channel-to-Channel 

Isolation
On/Off Only

GRV-OAC-12

GRV-OACI-12 x

GRV-OACS-12 x

GRV-OACIS-12 x x
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Specifications

Specification GRV-OACI-12 GRV-OACIS-12 GRV-OAC-12 GRV-OACS-12

Line Voltage 12–250 VAC 12–250 VAC 12–250 VAC 12–250 VAC

Current Rating (per channel) 0.5 A 0.5 A 0.5 A 0.5 A

Recommended Max. Fuse (fast) or 
Circuit Breaker

2 A 250 VAC / channel, 
6 A 250 VAC common

2 A 250 VAC / channel, 
6 A 250 VAC common

2 A 250 VAC / channel, 
6 A 250 VAC common

2 A 250 VAC / channel, 
6 A 250 VAC common

Minimum Load Current 20 mA 20 mA 20 mA 20 mA

Output Voltage Drop 1 V 1 V 1 V 1 V

Off-state Leakage at Nominal Voltage - 
60 Hz

1.25 mA @240 VAC
0.7 mA @120 VAC

1.25 mA @240 VAC
0.7 mA @120 VAC

1.25 mA @240 VAC
0.7 mA @120 VAC

1.25 mA @240 VAC
0.7 mA @120 VAC

Peak Blocking Voltage 500 V 500 V 500 V 500 V

Leakage (mA @ 240 V, 60 Hz) 1.0 1.0 1.0 1.0

Operating Frequency 40 to 60 Hz, 400 Hz 40 to 60 Hz, 400 Hz 40 to 60 Hz, 400 Hz 40 to 60 Hz, 400 Hz

Turn-on Time
≤ 1/2 cycle (zero cross-
ing)

≤ 1/2 cycle (zero cross-
ing)

≤ 1/2 cycle (zero cross-
ing)

≤ 1/2 cycle (zero cross-
ing)

Turn-off Time
≤ 1/2 cycle (zero cross-
ing)

≤ 1/2 cycle (zero cross-
ing)

≤ 1/2 cycle (zero cross-
ing)

≤ 1/2 cycle (zero cross-
ing)

Quality Indicator open circuit none open circuit none

Isolation (field-to-logic)
300 V working, 1500 V 
transient (1 minute)

300 V working, 1500 V 
transient (1 minute)

300 V working, 1500 V 
transient (1 minute)

300 V working, 1500 V 
transient (1 minute)

Isolation (channel-to-channel) 300 V working 300 V working NONE NONE

Number of Channels 12 12 12 12

Chassis Power Consumption 1.3 W 1.3 W 1.3 W 1.3 W

Wire Size 28–14 AWG 28–14 AWG 28–14 AWG 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95% 5–95% 5–95% 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 70, 
and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime Lifetime Lifetime Lifetime
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GRV-ODCI-12, GRV-ODCIS-12

groov DC output modules provide 12 isolated channels of 5–60 VDC output, each switching a separate DC 
load. The module features channel-specific LEDs for troubleshooting.
• The GRV-ODCI-12 includes a full set of features.
• The GRV-ODCIS-12 switches output on or off only, offering a lower cost option for projects with simple 

requirements.

Features

Feature GRV-ODCI-12 GRV-ODCIS-12

Number of channels 12 12

Channel-to-channel isolation x x

On/off state x x

On/off totalization x

Output pulsing x

Watchdog Timeout Value x x
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Specifications

Specification GRV-ODCI-12 GRV-ODCIS-12

Line Voltage Range (nominal) 5–48 VDC 5–48 VDC

Line Voltage Range (max) 5–60 VDC 5–60 VDC

Current Rating 400 mA per channel or 4.8 A per module (70°C) 400 mA per channel or 4.8 A per module (70°C)

Surge Current 5 A peak for 1 second 5 A peak for 1 second

Recommended Max. Fuse (fast) or
Circuit Breaker

3 A 60 VDC / channel, 6 A 60 VDC / module 3 A 60 VDC / channel, 6 A 60 VDC / module

Minimum Load 20 mA 20 mA

Output Voltage Drop 1.2 V max. 1.2 V max.

Off-State Leakage 1 mA at 60 V 1 mA at 60 V

Peak Blocking Voltage 60 V 60 V

TPO Period (min, max, resolution) 0.005 seconds, 429496.72 seconds, 0.001 seconds N/A 

Turn on/ Turn off Time 2.5 ms

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) 300 V working, 1500 V transient (1 minute) 300 V working, 1500 V transient (1 minute)

Number of Channels 12 12

Chassis Power Consumption 1.2 W 1.2 W

Minimum GRV-EPIC-PR1 Firmware Version 1.0.0 1.0.0

Minimum PAC Project Version 10.0000 10.0000

Minimum Library Package for CODESYS Version 1.0.0.0 1.0.0.0

Wire Size 28–14 AWG 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95% 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 70, 
and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime Lifetime
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GRV-ODCSRC-24

The GRV-ODCSRC-24 DC output module (source current to loads) provides 24 DC output channels in one 
groov module. The module can switch 5–60 VDC loads.

Specification GRV-ODCSRC-24

Line Voltage Range (nominal) 12–24 VDC

Line Voltage Range (max) 5–60 VDC

Current Rating (per channel) 0.4 A

Surge Current 1.5 A for 1.0 Second

Recommended Max. Fuse (fast) / Circuit Breaker 2 A, 60 VDC / channel or 20 A, 60 VDC common

Minimum Load 5.0 mA

Output Voltage Drop 0.3 V max. at 0.4 A

Off-State Leakage (per channel) <10 µA (@ 60 V, 70 °C)

Peak Blocking Voltage 60 VDC

Isolation (field-to-logic) 300 V working, 1500 V transient

Isolation (channel-to-channel) None

Number of Channels 24

Chassis Power Consumption 1.2 W

Minimum GRV-EPIC-PR1 Firmware Version 1.0.0

Minimum PAC Project Version 10.0000

Wire Size 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95%

Agency Approvals
UL/cUL(Class 1 Div. 2); CE, ATEX(Category 3, Zone 2), 
RoHS; DFARS; CB Scheme

Warranty Lifetime
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GRV-OMRIS-8

groov mechanical relay output modules offer 8 channels for switching loads of up to 5 amps at 250 VAC or 30 
VDC.

These are form C relays, so each of the 8 mechanical relays can be wired as normally open or normally closed. 
Fusing is not provided; you must provide fusing when wiring the module.

groov mechanical power relay output modules provide channel-to-channel isolation. These modules can 
mechanically switch either AC or DC loads, potentially reducing the number of modules needed.

Additionally, groov mechanical power relay output modules offer little or no leakage current when the 
contacts are open. These modules are suitable for piloting electronic coil contactors.

Note: These modules may not be suitable for low-level switching.

Note: Transient protection is recommended for inductive loads. For DC loads, install a reverse-biased diode, such as 
an 1N4005 (or equivalent) across the load.

Specification GRV-OMRIS-8

Line Voltage Range (nominal) 0–250 VAC or 5–30 VDC

Current Rating 5 A per channel

Surge Current 6 A peak for 1 second

Recommended Fuse / Circuit Breaker 5 A at 250 VAC / > 30 VDC per channel

Leakage Current < 2 µA @ 250 VAC

Contact Resistance ≤100 milliohms

Turn-On Time 8 ms

Turn-Off Time 4 ms

Operating Life (to specification) Min. 30,000 cycles at max. ratings

Mechanical Life Min. 10,000,000 cycles

Transient Clamp Holding Voltage 440 V

Transient Clamping Voltage (max.) 720 V

Isolation (coil-to-contact) 4000 VACrms 1 min., 10 mA detect / channel

Isolation (channel-to-channel) 300 VAC operating, 1500 Vrms max.

Number of Channels 8

Chassis Power Consumption 1.4 W

Wire Size 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C

Shock (misoperation) 5 G

Shock (survival) 100 G

Relative Humidity (non-condensing) 5–95%

Agency Approvals UL/cUL (Class 1 Div. 2)a; CE, ATEX (Category 3, Zone 2), RoHS; DFARS; CB Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electri-
cal Code, ANSI/NFPA 70, and ANSI/ISA-61010-1 (82.02.01).

Warranty 30 months



GRV-OVMAILP-8, GRV-OVMALC-8

groov EPIC User’s Guide296

GRV-OVMAILP-8, GRV-OVMALC-8

The GRV-OVMAILP-8 is an analog output module with 8 channels, individually configurable for any one of 
five voltage or current output ranges. The module provides channel-to-channel isolation. Each range has 4096 
counts (12 bits) of resolution. The GRV-OVMAILP-8 can power current loops from an internal isolated loop 
supply powered from the chassis or, on a channel-by-channel basis, from an externally connected loop supply 
of 22-32 VDC.

The GRV-OVMALC-8 is an analog output module with 8 channels, individually configurable for any one of 
seven voltage or current output ranges. Each range has 4096 counts (12 bits) of resolution.

For mA outputs, the GRV-OVMALC-8 contains an isolated loop supply. Because all current is sourced from 
within the module, outputs are self-sourcing and cannot be used with an external loop supply, loops that are 
loop-powered, or have a self-sourcing device in the loop.

Each channel is individually current or voltage limited and not affected by opens or shorts on adjacent 
channels. Connect both field wires to the specific terminals for each channel, so that a change in output on 
one channel will not affect another channel.

All negative output terminals on the module are tied together internally. To prevent ground loops, drive only 
loads with isolated inputs or loads that share a common ground.

Features

Specifications listed on next page.

Features GRV-OVMALC-8 GRV-OVMAILP-8

Channel-to-Channel Isolation x

Watchdog Timeout Value x x

Scaling x x

Ramping x x

Clamping x x

Quality Indicator x x
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Specifications

Specification GRV-OVMALC-8 GRV-OVMAILP-8

Output Ranges (Resolution)

Voltage
0 to 5 VDC (1.22 mV)
0 to 10 VDC (2.44 mV)
-5 to +5 VDC (2.44 mV)
-10 to +10 VDC (4.88 mV)

Current
4 to 20 mA  (4 µA)
0 to 20 mA  (5 µA)
0 to 22 mA  (6 µA) 

Voltage
0 to 5 VDC (1.22 mV)
0 to 10 VDC (2.44 mV)

Current
4 to 20 mA  (4 µA)
0 to 20 mA  (5 µA)
0 to 24 mA  (6 µA)

Resolution Range / 4096 (12-bits) Range / 4096 (12-bits)

Accuracy ± 0.1% of span ± 0.1% of span

Max Current for Voltage Output 10 mA 10 mA

Output impedance 280 Ohms 280 Ohms

External current loop power N/A, internal loop power only 20-32 VDC, (under 20 VDC switches to internal loop power)

Maximum loop resistance 750 Ohms 500 Ohms @ 20 mA, 400 Ohms @ 24 mA

Minimum loop resistance 50 Ohms 50 Ohms

Data Refresh Time 10 ms 10 ms

Quality Indicator
Current outputs: Open circuit
Voltage outputs: Over-current

Current outputs: Open circuit
Voltage outputs: Over-current

Isolation (field-to-logic) 300 V working, 1500 V transient (1 minute) 300 V working, 1500 V transient (1 minute)

Isolation (channel-to-channel) None 300 V working, 1500V transient (1 minute)

Number of Channels 8 8

Chassis Power Consumption
1.8 W all voltage outputs
6.2 W all current outputs

1.8 W all voltage outputs
6 W all current outputs-chassis powered loops

Minimum GRV-EPIC-PR1 Firmware 
Version

1.0.0 1.3.0

Minimum PAC Project Version 10.0000 10.2000

Wire Size 28–14 AWG 28–14 AWG

Torque, connector screw 2.5 in-lb (0.28 N-m) 2.5 in-lb (0.28 N-m)

Torque, hold-down screw 3.5 in-lb (0.4 N-m) 3.5 in-lb (0.4 N-m)

Temperature (operating) -20 °C to +70 °C -20 °C to +70 °C

Temperature (storage) -40 °C to +85 °C -40 °C to +85 °C

Relative Humidity (non-condensing) 5–95% 5–95%

Agency Approvals UL/cUL(Class 1 Div. 2)a; CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme

aFor use in hazardous locations, equipment must be mounted in an enclosure that meets the requirements of the National Electrical Code, ANSI/NFPA 70, 
and ANSI/ISA-61010-1 (82.02.01).

Warranty Lifetime Lifetime
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Appendix E 

E: I/O Module Wiring Diagrams

GRV-CCANI-2 PINOUT AND WIRING DIAGRAM
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GRV-CSERI-4 PINOUT AND WIRING DIAGRAM
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GRV-IAC-24, GRV-IACS-24 PINOUT AND WIRING DIAGRAM
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GRV-IACI-12, GRV-IACIS-12 PINOUT AND WIRING DIAGRAM
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GRV-IACDCTTL-24, GRV-IACDCTTLS-24 PINOUT AND WIRING DIAGRAM
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GRV-IACHV-24, GRV-IACHVS-24 PINOUT AND WIRING DIAGRAM
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GRV-IACIHV-12, GRV-IACIHVS-12 PINOUT AND WIRING DIAGRAM



GRV-IDC-24, GRV-IDCS-24 PINOUT AND WIRING DIAGRAM
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GRV-IDC-24, GRV-IDCS-24 PINOUT AND WIRING DIAGRAM
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GRV-IDCSW-12 PINOUT AND WIRING DIAGRAM



GRV-IDCI-12, GRV-IDCIS-12 PINOUT AND WIRING DIAGRAM
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GRV-IDCI-12, GRV-IDCIS-12 PINOUT AND WIRING DIAGRAM



APPENDIX E: I/O MODULE WIRING DIAGRAMS

groov EPIC User’s Guide 309

GRV-IDCIFQ-12 PINOUT AND WIRING DIAGRAM

Wiring to Quadrature Encoders



GRV-IDCIFQ-12 PINOUT AND WIRING DIAGRAM
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Wiring to Typical (Signal) Sources
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GRV-IICTD-12 PINOUT AND WIRING DIAGRAM



GRV-IMA-24 PINOUT AND WIRING DIAGRAM
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GRV-IMA-24 PINOUT AND WIRING DIAGRAM
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GRV-IMAI-8 PINOUT AND WIRING DIAGRAM



GRV-IRTD-8 PINOUT AND WIRING DIAGRAM
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GRV-IRTD-8 PINOUT AND WIRING DIAGRAM
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GRV-ITM-12 PINOUT AND WIRING DIAGRAM



GRV-ITMI-8 PINOUT AND WIRING DIAGRAM
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GRV-ITMI-8 PINOUT AND WIRING DIAGRAM
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GRV-ITR-12 PINOUT AND WIRING DIAGRAM



GRV-IV-24 PINOUT AND WIRING DIAGRAM
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GRV-IV-24 PINOUT AND WIRING DIAGRAM
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GRV-IVAPM-3 PINOUT AND WIRING DIAGRAM



GRV-IVI-12 PINOUT AND WIRING DIAGRAM
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GRV-IVI-12 PINOUT AND WIRING DIAGRAM
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GRV-IVIRMS-10 PINOUT AND WIRING DIAGRAM
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Notes:
1. You must supply external fusing.
2. Opto 22 recommends adding external fusing. Review the specification table for specific ratings. Compatible with an externally powered or self powered 

transmitter. Wiring for externally powered transmitter is shown on channels 0 and 1. Wiring for a self powered transmitter is shown on channels 2 and 3.
3. Thermocouple inputs and discrete sinking outputs cannot be mixed on channels 0-3.
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GRV-OAC-12, GRV-OACS-12 PINOUT AND WIRING DIAGRAM

Attention: This 
module requires an 
external fuse or circuit 
breaker. Please see the 
specification table and 
wiring diagram for 
recommended 
operating currents and 
placement. Opto 22 
strongly recommends 
the use of an 
appropriately rated 
and listed device. 
Failure to provide 
protection will void 
the product warranty.
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GRV-OACI-12, GRV-OACIS-12 PINOUT AND WIRING DIAGRAM
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GRV-ODCI-12, GRV-ODCIS-12 PINOUT AND WIRING DIAGRAM



GRV-ODCSRC-24 PINOUT AND WIRING DIAGRAM
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GRV-ODCSRC-24 PINOUT AND WIRING DIAGRAM
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GRV-OMRIS-8 PINOUT AND WIRING DIAGRAM



GRV-OVMAILP-8 PINOUT AND WIRING DIAGRAM
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GRV-OVMAILP-8 PINOUT AND WIRING DIAGRAM
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GRV-OVMALC-8 PINOUT AND WIRING DIAGRAM



GRV-OVMALC-8 PINOUT AND WIRING DIAGRAM
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F: Quality Indicator Codes

The following table lists quality indicator codes and their definitions. Quality indicators codes are reported by 
each channel of a module that supports the Quality Indication feature. For more information about the Quality 
Indication feature and a list of groov I/O modules that support the Quality Indication feature, see “What is 
Quality Indication?” on page 202.

Code Description

0 Data quality is good. No exception conditions occurred.

4 Analog input is not in range; firmware can't determine if above or below range.

5 Analog input above operating limits.

6 Analog input below operating limits.

7
Module isolated field circuitry in reset; part of module firmware to auto-recover field circuitry that may 
be in an undefined state.

8
Module failed communication with isolated field circuitry like analog to digital and digital to analog con-
verters.

9
Digital output is on, but current is not flowing. May indicate an open circuit or blown fuse in field equip-
ment.

13 Table lookup calculation beyond plus table end.

14 Table lookup calculation beyond minus table end.

15

Analog input is 10% above the highest range. Applicable to unipolar (zero and positive values only) 
and bipolar (can include negative and positive values) signal ranges.
In the following examples, the module would set the quality indicator code to 15:
• A channel on a GRV-IV-24 module is configured for ±10 VDC and the field signal is actually 12 VDC.
• A channel on a GRV-IMA-24 module is configured for 0–20 mA and the field signal is actually 23 mA.
• A channel on a GRV-IMA-24 module is configured for 4–20 mA and the field signal is actually 23 mA.
• A channel on a GRV-IVAPM-3 module is configured for 0–5 Arms and the field signal is actually 5.5 Arms.
To determine the highest range value, see the specification table for the module.

16

Analog input is 10% below the lowest range. Applicable only to bipolar (can include negative and pos-
itive values) signal ranges. In the following examples, the module would set the quality indicator code 
to 16:
• A channel on a GRV-IV-24 module is configured for ±160 VDC and the field signal is actually -177 VDC.
• A channel on a GRV-ITMI-8 module is configured for ±150 mV and the field signal is actually -166 mV.
• A channel on a GRV-IICTD-12 module is configured. The over-range limits are -270 °C to 150 °C 

and the field signal is actually -271 °C.
To determine the lowest range value, see the specification table for the module.

17 Analog input is below lower limit for unipolar channels.
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18

Analog output fault.
• When configured for voltage, indicates the load resistance is too low (that is, the load is drawing too 

much current to maintain the voltage).
• When configured for current, indicates very high resistance or possible open circuit.

19 Analog output driver over temperature condition, output may cycle on and off.

20 Field excitation/loop voltage fault

21

Analog output is at the upper range limit. Applicable only when the value written exceeds the maxi-
mum limit. Indicates the module has clamped the output to the limit. Can be caused by a configuration 
or logic error; for example, the strategy sent a value to the channel that is above the channel’s maxi-
mum range.

22

Analog output is at the lower range limit. Applicable only when the value written is lower than the mini-
mum limit. Indicates the module has clamped the output to the limit. Can be caused by a configuration 
or logic error; for example, the strategy sent a value to the channel that is below the channel’s mini-
mum range.

23 Isolated field compensation circuitry or calculation does not give valid data.

24 Digital input feature measurement fault. For feature types 2 (on time totalizer) and 18 (off time totalizer).

30 Channel not present.

Code Description
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G: Installing the Correct License

The information in this section can help you:
• If you have a groov EPIC processor with firmware version earlier than 1.3.0 and you need to re-initialize 

the processor to earlier firmware.
• If you are upgrading the groov EPIC processor’s firmware from a version earlier than 1.3.0 to version 1.3.0 

or later and you want to add Ignition Edge or CODESYS. You need to understand how licensing changed 
with the release of 1.3.0 so that you can purchase the correct new license.

INSTALLING LICENSES ON PROCESSORS WITH FIRMWARE EARLIER THAN 1.3.0

Prior to firmware version 1.3.0, to access some of the following software, you needed to purchase or install 
specific licenses:
• groov View. This software required the installation of the groov Plus license, which you received when 

you purchased a groov EPIC processor (part number GRV-EPIC-PR1).
• groov EPIC SSH Access. The Secure Shell (SSH) Access required the purchase and installation of the 

groov Enterprise license (part number GROOV-LIC-ENT).
• OPC UA. The OPC UA servers required the purchase and installation of the groov Enterprise license (part 

number GROOV-LIC-ENT).
• Ignition Edge. The Ignition Edge software required the purchase and installation of the groov Enterprise 

license (part number GROOV-LIC-ENT).

If you are working with a groov EPIC processor with older module firmware and you need to reload or 
re-obtain a copy of the license it came with, see “Activating groov EPIC and downloading the license file” on 
page 11. Make sure you save the license file in a secure place and remember where you stored it.

If you already have a groov Enterprise license (GROOV-LIC-ENT), make sure you have the Ignition Edge License 
Key for your groov EPIC processor. Follow the instructions in “Licensing Ignition Software” on page 85.

Installing the groov Plus or groov Enterprise License

When you initialized your groov EPIC unit, you may have uploaded your groov Plus or groov Enterprise license. 
If you didn’t upload your license file, do the following steps:
1. On your computer or mobile device, make sure you know where you stored the license file.
2. On that same computer or mobile device, log into your groov EPIC processor with a user ID that has 

administrator authority.
3. Click System ( ).
4. Click License ( ).
5. In the License page, click Upload License ( ).

http://www.opto22.com/products/groov-lic-ent
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6. Navigate to the folder on your computer or mobile device that contains the license file.
7. Select the license file and then click Open. groov Manage displays a message as it uploads the license file. 

After it is done, it refreshes the License page to show the license it installed. The following diagram shows 
an example of a groov Enterprise license:

ADDING IGNITION EDGE OR CODESYS WHEN YOU UPGRADE TO 1.3.0 OR LATER

If you are upgrading to firmware version 1.3.0 and you want to add Ignition Edge or CODESYS, you need to do 
the following steps:
1. Purchase Ignition Edge (part number GROOV-LIC-EDGE) or order CODESYS (GROOV-LIC-CRE).

Important: If you already purchased GROOV-LIC-ENT, you do not need to purchase GROOV-LIC-EDGE.

2. After you receive your Ignition Edge License Key or CODESY Ticket Number, do the following:
– “Installing (Activating) the Ignition Edge License” on page 85
– “Licensing the CODESYS Runtime Engine” on page 67



groov EPIC User’s Guide 335335

 

H: Advanced Networking 
Configurations

The configuration described in this appendix is for IT or network administrators that need to configure devices 
to comply with more complex networking policies. Administrators should review this configuration in 
conjunction with the requirements described in “Understanding Advanced Networking Configurations” on 
page 60.

The IT or network administrator should understand the following networking functions before implementing 
this configuration:
• Gateways and how they direct network traffic.
• DHCP servers and the functions they perform on a network. In particular, how the DHCP server interacts 

with gateways and how they read information in packets to direct them to the appropriate destination.
• The difference between an incoming connection request and an outgoing connection request.

REDIRECTING TRAFFIC INITIATED BY AN INCOMING CONNECTION REQUEST

Each network interface on the groov EPIC processor can be assigned a gateway address. Normally, a DHCP 
server manages the assignment of gateway IP addresses to the network interfaces. Prior to version 1.4.0 of the 
groov EPIC firmware, the groov EPIC processor would select the gateway of the active network interface and 
make it the effective gateway, the gateway that directs traffic. However, in rare instances called off-subnet 
destination-based routing, the effective gateway would prevent the passing of or not properly forward 
legitimate traffic to another network interface on the groov EPIC processor. The device that originated the 
connection request would receive a “timeout” message and report that the network interface on the groov 
EPIC processor was unreachable, even though that was incorrect.

Beginning with version 1.4.0 of the groov EPIC firmware, a network administrator can assign a gateway IP 
address to each network interface on a groov EPIC processor. In addition, the network administrator can assign 
a priority (or order) between all the network interfaces that are assigned a gateway. Therefore, if there are 
multiple active network interfaces, the processor knows that the active network interface with the lowest 
gateway order should be the effective gateway. If that gateway cannot direct the traffic, then the processor 
switches to the active network interface with the next lowest gateway order.

This feature affects traffic initiated by an incoming connection request, with the one exception described in 
“Outbound Traffic Not Initiated by an Incoming Connection Request” .

Before you configure the groov EPIC processor, determine the number of gateways, the IP addresses for the 
gateways, to which network interface to assign them, and what order to use them. You may want to save this 
information in a table such as those listed Appendix I: Network Information Tables so that it is readily available 
when you configure the processor.
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Outbound Traffic Not Initiated by an Incoming Connection Request

If the groov EPIC processor initiates a communication request (called an outgoing connection request), traffic 
travels through the gateway with the lowest order number (the effective gateway). However, if the outbound 
traffic specifies a source address or the IP address of the network interface (which is not a common situation), 
then the second or third gateway in the list order may be used. One example of this uncommon situation is 
issuing a ping command to contact a host that would require directing the packets through a gateway other 
than the effective gateway. The ping command would fail unless you specify the -I option, which is the 
interface option that allows you to specify a different source address.
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I: Network Information Tables

The tables in this appendix work in conjunction with the information in Chapter 7: Connecting groov EPIC to a 
Network or Multiple Networks. They can help you organize the information you need to collect, especially if 
you are setting up your groov EPIC processor to work in a complex networking environment.

If you do choose to use these tables, make sure you save this information in a secure location because some of 
this information is sensitive.

The following table can help you keep track of which groov EPIC network interface will connect to which 
network:

The following table can help you collect basic information for each wired network:

The following table can help you collect basic information for a wireless network:

groov EPIC
Network Interface

Network Name Trusted or untrusted network?

ETH0 (wired)

ETH1 (wired)

WLAN0 (wireless)

TUN0 (VPN)

Configuration Setting ETH0 ETH1

IP address
 Automatic
 Manual, IP address: ____________

 Automatic
 Manual, IP address: _____________

Subnet mask

Configuration Setting WLAN0

IP address
 Automatic
 Manual, IP address: ___________________________

Subnet mask

SSID

Encryption type
 None
 WEP WPA WPA2

Key type
 Passphrase (ASCII)
 PSK (HEX)

Key Do not write down.
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The following table can help you organize your OpenVPN information:

Information Value

Protocol  udp  tcp-client

OpenVPN Server Host Name __________________________________________________________

OpenVPN Server Port Number _______________

Remote Public Certificate Path 
and File Name __________________________________________________________

User Name ___________________________________

Password Do not write down.

Proxy User Name ___________________________________

Proxy Password Do not write down.

Encryption Cipher  none  ________________

LZO Compress  yes  no
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J: Installing groov EPIC 
Firmware with Ignition Version 8

GRV-EPIC-PR1 comes preloaded with Ignition version 7. If you want to run with Ignition version 8, you need to 
install a separate GRV-EPIC-PR1 firmware file.

Important: If your GRV-EPIC-PR1 is running firmware version earlier than 3.0.0, you cannot go directly from your 
version of the GRV-EPIC-PR1 firmware to the special version that contains Ignition version 8. You must first install 
GRV-EPIC-PR1 firmware 3.0.0 or later that has Ignition version 7, then install the GRV-EPIC-PR1 firmware 3.0.0 or later 
with Ignition version 8 (as explained below).

1. Log on to manage.groov.com with the account that is registered with your GRV-EPIC-PR1.
If you do not have an account on manage.groov.com, you can create one.
– If you are working with a brand new GRV-EPIC-PR1, you will need to activate it. The instructions are 

provided in a document that came in the box with your GRV-EPIC-PR1.
– If you don't have access to the account that was used to activate the GRV-EPIC-PR1, contact the 

person who activated it. If necessary, they can use manage.groov.com to transfer the activated PR1 
to your account.

2. Open the profile for your GRV-EPIC-PR1.
3. Under the Latest Releases section, look for the file 

grv-epic-pr1-ignition8-<version_number>-b.<build_number>.field.bin, 
where version_number is 3.0.0 or later, and build_number is any 2 or 3 digit number. Download 
the file to either:
– a computer that can connect to your GRV-EPIC-PR1, or
– to media that you can then install to a computer that can connect to your GRV-EPIC-PR1.

4. On the computer, log into your groov EPIC processor with a user ID that has administrator privileges.
5. If you just installed the GRV-EPIC-PR1 firmware with ignition7 in the file name or you have a new 

GRV-EPIC-PR1 with firmware version 3.0.0 or later, then skip to step 6.
a. If you haven’t done so recently, create a backup file (see “Backing up Your groov EPIC Processor” on 

page 219). Keep this file handy and secure.
b. If you are using Ignition or Ignition Edge, deactivate the license. For instructions, see “Deactivating 

the Ignition Edge license” on page 86.
c. If you are using CODESYS, make sure you have the license file (*.WibuCmRaU) so that you can 

restore it.
d. Click the menu button ( ), then select Home.

6. Click Maintenance and then Update. 
7. On the Update page, decide:

– If you want to save your current settings and then have the groov EPIC processor restore them after 
the restart, leave the slider in the default position (the slider shows green). Leaving this setting on 
would be equivalent to either of the following:

http://manage.groov.com
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– Restoring the backup file you created in step a.
– Installing the GRV-EPIC-PR1 firmware with ignition7-3.0.0 in the file name with this 

setting on.
Either option can save you steps at the end of this process.

– If you do not want the settings saved and restored after the restart, move the slider to the left so that 
it shows gray ( ). You’ll want to select this if you want to restore your processor with settings 
from a different groov EPIC backup file; perhaps one that has a different set of configurations.

8. Click Update System.
9. Navigate to the software update file you downloaded in step 3.
10. Click Open. groov Manage displays a message to remind you that the update clears all your settings and 

projects, and gives you one more opportunity to cancel and perform that important backup. If you are 
ready to proceed with the update, click on Update and Restart:

11. groov Manage displays an Update message, which shows you the progress of the update. The update can 
take several minutes to complete. During that time, the banner (in the background) will change color to 
yellow.
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12. When the update is done, the banner turns red, which indicates the processor is restarting. groov Manage 
shows you this screen:

Click Next.
13. groov Manage displays a message with instructions on what to do after the device restarts.

Read the instructions and then click Close. If you can see the groov EPIC processor’s touchscreen, you can 
see the progress of the restart.



groov EPIC User’s Guide342

14. When the restart is done, you will see one of the following:

Welcome! screen—You’ll see this screen if you deselected the Backup Settings option in step 7 on 
page 339.
a. Make a note of the IP address shown in either the Eth0 IP Address box or the Eth1 IP Address box. 

You’ll need it in the next few steps.
b. Tap Let’s get started! and create an administrator user ID and password. (It does not have to match 

any that might be stored in your backup file; however, you still do have to remember to store it in a 
safe location for later recall.)

c. Click on Configure Device.
Login screen—You’ll see this screen if you selected the Backup Settings option in step 7 on page 339. 
Log into your groov EPIC processor with the user ID that has administrator privileges.

15. If you are running a groov View HMI, restore your groov View HMI as described in the groov View User’ s 
Guide (form 2027).

16. If you are running with Ignition Edge, activate the license. For instructions, see “Licensing Ignition 
Software” on page 85.

17. If you are running CODESYS applications:
– Switch to the CODESYS Runtime Engine. For instructions, see “Enabling the CODESYS Runtime 

Engine” on page 73.
– When you restore the groov EPIC processor’s backup file, make sure you select License as one of the 

options on the Restore page to restore the CODESYS license file.
18. If you need to restore a groov EPIC backup file, see “Restoring a Backup or Specific Settings from a Backup 

File” on page 222, beginning with step 5.

Welcome! screen

Login screen

http://documents.opto22.com/2027_groov_View_Users_Guide.pdf
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You can verify that version 8 is installed on your GRV-EPIC-PR1 by going to the Ignition page (from the 
groov Manage Home page, click Ignition):
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